While Deltek has attempted to verify that the information in this document is accurate and complete, some typographical or technical errors may exist. The recipient of this document is solely responsible for all decisions relating to or use of the information provided herein.

The information contained in this publication is effective as of the publication date below and is subject to change without notice.

This publication contains proprietary information that is protected by copyright. All rights are reserved. No part of this document may be reproduced or transmitted in any form or by any means, electronic or mechanical, or translated into another language, without the prior written consent of Deltek, Inc.

This edition published June 2013.
© 2013 Deltek, Inc.

Deltek’s software is also protected by copyright law and constitutes valuable confidential and proprietary information of Deltek, Inc. and its licensors. The Deltek software, and all related documentation, is provided for use only in accordance with the terms of the license agreement. Unauthorized reproduction or distribution of the program or any portion thereof could result in severe civil or criminal penalties.

All trademarks are the property of their respective owners.
## Contents

Overview of Guide ........................................................................................................................... 1
Module Licenses Configuration ........................................................................................................ 2
Global Icons ..................................................................................................................................... 3
User Options .................................................................................................................................... 4
Dashparts ...................................................................................................................................... 11
Login - Password and User ID Reminder ...................................................................................... 13
Lookups ......................................................................................................................................... 14
Expense Report Configuration ...................................................................................................... 16
Project Info Center Toolbar ........................................................................................................... 20
Opportunity Info Center Toolbar .................................................................................................... 31
Project Info Center List View—Populated with Phase and Task Records .................................... 40
Adobe InDesign Merge Templates ................................................................................................. 45
Analysis Cubes Configuration ........................................................................................................ 96
Billing Invoice Approvals ................................................................................................................ 98
Transaction Auto Numbering ........................................................................................................ 197
Transaction Document Management ............................................................................................. 211
Vision Performance Management Dashboards ............................................................................. 239
Vision Performance Management — Sample Performance Dashboards ..................................... 249
Exchange Rates .......................................................................................................................... 307
Reporting ..................................................................................................................................... 313
Report Administration Utility ......................................................................................................... 324
Reporting - Tax Analysis Report .................................................................................................... 326
Reporting - Tax Analysis General Tab .......................................................................................... 328
Reporting – Tax Analysis Layout Tab ........................................................................................... 331
Reporting – Tax Analysis Report - Tax Code Lookup Dialog Box ................................................ 337
Reporting – Tax Analysis Report - Tax Analysis Columns ............................................................. 338
Reporting – Tax Analysis Report - Tax Analysis Options Tab ....................................................... 341
Reporting – Tax Analysis Report - Personal Tab of Employee Info Center ................................ 343
Resource Kit .................................................................................................................................. 344
Security .......................................................................................................................................... 348
SEPA XML File Formats for Export to Text Payments................................................................. 365
Vision Navigator .......................................................................................................................... 373
Weblink Utility .............................................................................................................................. 390
Overview of Guide

This guide contains new and updated online help topics that will be added to the Vision help system for Vision 7.1. The new help topics cover features added in Vision 7.1, including Transactional Document Management, Invoice Approvals, Custom Proposal Integration with Adobe InDesign, and a brand new presentation layer for the Performance Management module.

These topics will be folded into the new Vision help system, currently under construction and due for release in late summer 2013. The new help system is more tightly organized, easier to navigate, and written in the DITA markup language, which lets us update the online help more quickly and guarantee a more consistent look and feel.
Module Licenses Configuration

Software Licenses for Vision Modules

Depending on your Vision license type, each Vision module may have an expiration date. When you first install a module and enter a password for it in Vision Configuration » Module Activation, the license expiration date displays in the Expiration column on the Module Activation form.

License Expiration Reminder

You will receive a reminder before the license expires.

A reminder email will be sent to your Vision help desk email address if you entered one in the Default Help Desk field on the Email tab in Vision General » System Settings. Also, on the Email tab, you must enter the address of your email server. Vision users with an administrator type security role will also receive a reminder message when they log on to Vision.

Frequency of the Reminder

The expiration reminder email or message for administrators is sent or displayed 14, 10, 7, 5, 4, 3, 2, and 1 day before the expiration date.

You also receive a reminder 30 days before your license expires if the license is a temporary license that provides more than 30 days of software use.

What Happens When Your License Expires

When the license for a module has expired, the following occur:

- Expired displays in the License column on the Module Activation form in Vision Configuration » Module Activation.
- The menu item for the module does not display in the Vision Navigation menu.
- The module does not display anywhere in Vision Security » Roles.

How to Renew an Expired License

Contact your Deltek account manager to renew the license for a module.
Global Icons

Global icons are function keys that let you maneuver around the Vision applications. They are located on the Vision toolbar and can be accessed at any time. The global icons are listed below:

- **Navigation Area** – Shows which part of Vision you currently have open.
- **Back Arrow** – Moves you back to the application you were previously working in.
- **Forward Arrow** – Returns you to the application you were working in before using the Back arrow.
- **Dashboard** – Clicking this icon sends you to the Dashboard application.
- **Navigator** – Clicking this icon opens the Vision Navigator application. If the current project is associated with a Navigator plan, the plan automatically opens in Navigator. If Navigator is not installed or configured, an error message displays.
- **Kona** – Clicking this icon opens the Deltek Kona application. If you are using Kona, and the current project or opportunity is associated with a Kona space, the associated Kona space automatically opens.
- **Search** – Click this icon to open the Info Center Search application.
- **Options** – Click this icon to access the User Options dialog. In this dialog, you can access Activity Reminders, choose reporting preferences, and select a startup application.
- **Help** – Connects you to the Vision Help system. The Help system appears in its own window so you can continue to reference the application while using the help. Please note that other help buttons, found in an application or a form, are intended for the specific application you are working in.
- **Logoff** – Clicking the logoff icon takes you out of Vision and back to the splash screen. From there you can either log on again or exit Vision.
User Options

To set up User Options, complete the following steps:

1. From the Vision title bar, click Options to display the User Options form.
2. Complete the fields on the following tabs:
   - General tab
   - Startup tab
   - Reporting tab
   - Activity tab
   - Misc tab
   - Mobile tab (if your company uses the Mobile Applications Suite)
3. Click OK.

User Options Misc Tab

Use the Misc tab of User Options to enter your user name and password for Deltek's Customer Care (Support) site and to change your system password.

To open User Options, complete the following steps:

From the Vision title bar, click Options to display the User Options form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Support Username</td>
<td>Enter the username that you use for Deltek's Customer Care site; enter up to fifty characters.</td>
</tr>
<tr>
<td>Support Password</td>
<td>Enter the password that you use for Deltek's Customer Care site; enter up to fifty characters.</td>
</tr>
<tr>
<td>Kona Username</td>
<td>If you are using the Deltek Kona application, enter your username. This allows you to open Kona directly from the Vision application. If your Kona Username is not entered in this field, you must open Kona and log in outside of Vision.</td>
</tr>
<tr>
<td>Kona Password</td>
<td>If you are using the Deltek Kona application, enter your password. This allows you to open Kona directly from the Vision application. If your Kona Password is not entered in this field, you must open Kona and log in outside of Vision.</td>
</tr>
</tbody>
</table>

User Options General Tab

Use the General tab of User Options to:
- Set the default country.
- Hide the navigation menu after you select a menu item.
- Determine how Vision searches for and retrieves records.
- Establish Dashboard style.
- Change your user password.

To open User Options, complete the following steps:

From the Vision title bar, click 🌐 Options to display the User Options form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Country</td>
<td>Vision automatically displays the Default Country selected on the Users tab of Role Security. To override the system default setting, select a new default country. This drop-down list includes all countries set up in the Country Code Table. The country that you select is the default country that Vision uses when you create new Info Center records. If there are no entries in this field, then Vision displays a message to ask you to select a language from the Vision Login screen. After you select a country, Vision filters all States/Provinces drop-down lists based on the selected Default Country.</td>
</tr>
<tr>
<td>Automatically hide navigation menu</td>
<td>Select this option if you want Vision to hide the navigational (Applications) menu after you select a menu item. Otherwise, Vision keeps the navigational menu open.</td>
</tr>
<tr>
<td>Use flat dashboard styling</td>
<td>Select this option to change the Dashboard format to a flat style, which includes a different style of graphics and color selections for the header bar. You must log out and back into Vision for your changes to take effect.</td>
</tr>
<tr>
<td>Find words that sound the same when</td>
<td>Select this option if you want Vision to include words that sound alike in its results when performing both finds and searches. For example, if you select this option and search for John Smythe, Vision can find John Smith. Otherwise, Vision only includes exact matches.</td>
</tr>
<tr>
<td>performing searches</td>
<td></td>
</tr>
<tr>
<td>Automatically retrieve records when opening</td>
<td>Select this option if you want Vision to search automatically for all records when the lookups are opened. Note that if a lookup limit rule is in place, Vision applies the rule when the search takes place. You set lookup limit rules in Configuration » General » System Settings, Lookup tab. This option is available only if the option Allow users to automatically retrieve records in lookups is selected. This option is set in Configuration » General » System Settings, Lookup tab.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>Automatically retrieve your record in Employee Info Center/Employee Review</strong></td>
<td>Select this option if you want your employee record to be loaded automatically when you go to the Employee Info Center or to Employee Review. This option is related to the feature that allows employees to update their own employee record and to view details associated with their payroll checks.</td>
</tr>
<tr>
<td><strong>Display Settings</strong></td>
<td>Click this button to display the Display Settings dialog box. Use this dialog box to change the appearance of the Vision interface to match your business requirements.</td>
</tr>
<tr>
<td><strong>Change Password</strong></td>
<td>Click this button to display the Change Password dialog box. Enter your old password, enter your new password, and confirm your new password. Then click OK.</td>
</tr>
</tbody>
</table>

### Display Settings Controls

The Display Settings dialog box displays the common Vision controls that you can customize according to your preferences. These controls function similarly on each Display Settings tab. When you select a tab, the controls that are available display in the **Control Selection** field on the lower left portion of the screen. You can change the control's appearance through the **Background** and **Foreground** group boxes.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Control Selection</strong></td>
<td>The <strong>Control Selection</strong> field is an integral part of this dialog box. This field displays all available controls for the selected tab and allows you to select the control whose appearance you want to modify. You can change a control's appearance through the <strong>Background</strong> and <strong>Foreground</strong> group boxes. As you modify the control's features, the preview fields at the top of the dialog box update to reflect your selections.</td>
</tr>
<tr>
<td><strong>Use Default Values</strong></td>
<td>Select this option to reset a control to its default display setting. This enables the corresponding control and disables the <strong>Background</strong> and <strong>Foreground</strong> group boxes.</td>
</tr>
<tr>
<td><strong>Background</strong></td>
<td>Use this group box to change the background color of a control, including gradient, solid, and border colors. This group box is disabled if <strong>Use Default Values</strong> is selected.</td>
</tr>
<tr>
<td><strong>Gradient</strong></td>
<td>There are certain controls that have color gradients that you can customize. When you select one of these controls, the <strong>Gradient</strong> option becomes enabled. This option determines the hue, saturation, and luminance of the color. You can specify these values by using the Select Hue dialog box or by entering values in the following fields: <strong>Hue</strong> — Select a numeric value from 0 through 359. This number refers to the attribute of a color that allows it to be classified as yellow, blue, and red among others. <strong>Saturation</strong> — Select or enter the gradient’s color saturation value as a percentage of the default</td>
</tr>
</tbody>
</table>
### User Options

#### 7.1 Online Help Updates

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gradient</td>
<td>For half the saturation level, enter 50%. For twice the saturation level, enter 200%. Entering 0% will remove all color, creating a gray-scale gradient. <strong>Luminance</strong> — Select or enter the gradient's perceived brightness level as a percentage of the default gradient. For half the brightness level, enter 50%. For twice the brightness level, enter 200%. Entering 0% will change the gradient to solid black. If you enter very large values, the gradient will change to solid white.</td>
</tr>
<tr>
<td>Solid Color</td>
<td>If the control is using a solid color, you can modify the fill and border. Selecting this option may also enable the <strong>Border Color</strong> field and corresponding <strong>Red</strong>, <strong>Green</strong>, and <strong>Blue</strong> fields. You can specify the color values by using the Select Color dialog box or by entering component values from 0 through 255.</td>
</tr>
<tr>
<td>Border Color</td>
<td>This option and its <strong>Red</strong>, <strong>Green</strong>, and <strong>Blue</strong> fields are enabled only when you select the <strong>Solid Color</strong> option for controls with a border. You can specify the color values by using the Select Color dialog box or by entering component values from 0 through 255.</td>
</tr>
<tr>
<td>Foreground</td>
<td>Use this group box to change the foreground color of a control, including text color, and red, green, and blue settings. This group box is disabled if <strong>Use Default Values</strong> is selected.</td>
</tr>
<tr>
<td>Text Color</td>
<td>Use this option to define the text color settings that Vision uses for labels, fields, and links throughout its interface. You can specify the text color values by using the Select Color dialog box or by entering component values from 0 through 255 in the <strong>Red</strong>, <strong>Green</strong>, and <strong>Blue</strong> fields. [<a href="https://help.deltek.com/Products/(F(MnOF9a2gno_QIzP4QZU-WB3HG81Dx5LKcH9iVMXG_KP2_Iy5FPLjxTh7_OcmVU7C0IX89hE28QD8s-9JRHyvCyGg2_C6KUIBzNipmNK3afptsG1yWSC7IZYTzUTkiMLXVptn88q7nCtmPJv5B6jB3fv-asV18wx6WonacqqgiHFLkssXwveoqXol4qF_NS0)/Vision/71/cf_Display_Settings">https://help.deltek.com/Products/(F(MnOF9a2gno_QIzP4QZU-WB3HG81Dx5LKcH9iVMXG_KP2_Iy5FPLjxTh7_OcmVU7C0IX89hE28QD8s-9JRHyvCyGg2_C6KUIBzNipmNK3afptsG1yWSC7IZYTzUTkiMLXVptn88q7nCtmPJv5B6jB3fv-asV18wx6WonacqqgiHFLkssXwveoqXol4qF_NS0)/Vision/71/cf_Display_Settings</a>](<a href="https://help.deltek.com/Products/(F(MnOF9a2gno_QIzP4QZU-WB3HG81Dx5LKcH9iVMXG_KP2_Iy5FPLjxTh7_OcmVU7C0IX89hE28QD8s-9JRHyvCyGg2_C6KUIBzNipmNK3afptsG1yWSC7IZYTzUTkiMLXVptn88q7nCtmPJv5B6jB3fv-asV18wx6WonacqqgiHFLkssXwveoqXol4qF_NS0)/Vision/71/cf_Display_Settings)">https://help.deltek.com/Products/(F(MnOF9a2gno_QIzP4QZU-WB3HG81Dx5LKcH9iVMXG_KP2_Iy5FPLjxTh7_OcmVU7C0IX89hE28QD8s-9JRHyvCyGg2_C6KUIBzNipmNK3afptsG1yWSC7IZYTzUTkiMLXVptn88q7nCtmPJv5B6jB3fv-asV18wx6WonacqqgiHFLkssXwveoqXol4qF_NS0)/Vision/71/cf_Display_Settings)</a></td>
</tr>
<tr>
<td>Settings</td>
<td>Use this drop-down list to select a pre-defined global theme for the display settings. This list includes the following: Pre-installed color themes that you can select to set the color across all controls. Global themes created and saved by your system administrator. When you display this dialog box, your current settings are loaded but this field does not have a value. In addition, if you select a saved setting and any of the display settings change, the value of this field is cleared. [<a href="https://help.deltek.com/Products/(F(MnOF9a2gno_QIzP4QZU-WB3HG81Dx5LKcH9iVMXG_KP2_Iy5FPLjxTh7_OcmVU7C0IX89hE28QD8s-9JRHyvCyGg2_C6KUIBzNipmNK3afptsG1yWSC7IZYTzUTkiMLXVptn88q7nCtmPJv5B6jB3fv-asV18wx6WonacqqgiHFLkssXwveoqXol4qF_NS0)/Vision/71/cf_Display_Set">https://help.deltek.com/Products/(F(MnOF9a2gno_QIzP4QZU-WB3HG81Dx5LKcH9iVMXG_KP2_Iy5FPLjxTh7_OcmVU7C0IX89hE28QD8s-9JRHyvCyGg2_C6KUIBzNipmNK3afptsG1yWSC7IZYTzUTkiMLXVptn88q7nCtmPJv5B6jB3fv-asV18wx6WonacqqgiHFLkssXwveoqXol4qF_NS0)/Vision/71/cf_Display_Set</a> - Display_Settings_Controls](<a href="https://help.deltek.com/Products/(F(MnOF9a2gno_QIzP4QZU-WB3HG81Dx5LKcH9iVMXG_KP2_Iy5FPLjxTh7_OcmVU7C0IX89hE28QD8s-9JRHyvCyGg2_C6KUIBzNipmNK3afptsG1yWSC7IZYTzUTkiMLXVptn88q7nCtmPJv5B6jB3fv-asV18wx6WonacqqgiHFLkssXwveoqXol4qF_NS0)/Vision/71/cf_Display_Set">https://help.deltek.com/Products/(F(MnOF9a2gno_QIzP4QZU-WB3HG81Dx5LKcH9iVMXG_KP2_Iy5FPLjxTh7_OcmVU7C0IX89hE28QD8s-9JRHyvCyGg2_C6KUIBzNipmNK3afptsG1yWSC7IZYTzUTkiMLXVptn88q7nCtmPJv5B6jB3fv-asV18wx6WonacqqgiHFLkssXwveoqXol4qF_NS0)/Vision/71/cf_Display_Set</a> - Display_Settings_Controls)</td>
</tr>
</tbody>
</table>

### Navigation Tree Design Form Fields

Use the Navigation Tree Design form to customize your Vision Navigation Tree.

**To open the Navigation Tree Design Form, complete the following:**

1. Right-click the space below the Vision Navigation Tree.
2. Click the Design button. The Navigation Tree Design form displays.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Menu ID</td>
<td>When you select a standard Vision menu item, this field displays the unique system ID for that item. You cannot change it. When you add a user-defined info center, Vision automatically generates a unique system ID for that item; you can change it if needed.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Menu Label</td>
<td>This field displays the label for the menu item. You can change this information. You may want to limit the length of the label, since if it's too long it will be truncated in the navigation tree.</td>
</tr>
<tr>
<td>User-Defined Node</td>
<td>When you select a menu item, a check in this field indicates that the item is user-defined.</td>
</tr>
<tr>
<td>Icon</td>
<td>Use this drop-down list to select an icon for the selected node. This list of icons is pre-defined and cannot be modified.</td>
</tr>
<tr>
<td>Action</td>
<td>When you add a user-defined menu item, this field allows you to indicate what type of menu item you want to add. Note that you cannot change the action for a system-defined menu item (or any of its action options, except for the Help Page field.) You can only select an action for a user-defined menu item. You have the following options:</td>
</tr>
<tr>
<td></td>
<td><strong>Parent</strong> — Use this option to designate that the item is a parent item only; its purpose is to contain other menu items and has no action of its own.</td>
</tr>
<tr>
<td></td>
<td><strong>Open Application</strong> — This option only applies to system-defined menu items. You cannot apply it to user-defined menu items. The action options for Open Application are read-only, except for the Help Page field. See below for descriptions.</td>
</tr>
<tr>
<td></td>
<td><strong>HTTP</strong> — Use this option to add an http address. For example, you can add an intranet site to the navigation tree. If you select this action, complete the HTTP options described below.</td>
</tr>
</tbody>
</table>
### Field | Description
--- | ---
**File** | Use this option to add an external file or document that you want all employees to be able to access. For example, you can add an employees’ handbook. If you select this action, complete the **File** option described below.

**Web Outlook** | Use this option to add the Web Outlook application to your navigation tree. If you select this action, complete the **Web Outlook** options described below.

**Report** | Use this option to add a favorite report to your navigation tree. If you select this action, complete the **Report** options described below. [Link](https://help.deltek.com/Products/(F(bIV4sYLRL8jSVl365EBR5-GfkR2Ed4Zrr3Nw3hDjQvZ8kmOaY4vLQvqm7K2xUSR-MmOYV28bqdxuIK09uc3fZ7Yxd8apm0TtcZOzVSxftUWw-YKfFIPXtooJUNoBTjz6iarnjV6H-qHodBGp9DeNjDHOB_k5HAQeM5qng9PjsNCqNPriqghoWlgzm-1wRp0))/Vision/71/cf_nav_tree_de - Top)

### Action Options
These options change depending on which action you select from or displays in the **Action** field.

**For Open Application**
If Open Application displays in the **Action** field, these action options display:

- **Web Address** | This field displays the Web address for the page.
- **Arguments** | This field displays any argument parameters.
- **Open Options** | This field indicates whether the page opens in the current window or in a new window.
- **Help Page** | This field displays the default Vision Help topic associated with this page. You can change this setting.[Link](https://help.deltek.com/Products/(F(bIV4sYLRL8jSVl365EBR5-GfkR2Ed4Zrr3Nw3hDjQvZ8kmOaY4vLQvqm7K2xUSR-MmOYV28bqdxuIK09uc3fZ7Yxd8apm0TtcZOzVSxftUWw-YKfFIPXtooJUNoBTjz6iarnjV6H-qHodBGp9DeNjDHOB_k5HAQeM5qng9PjsNCqNPriqghoWlgzm-1wRp0))/Vision/71/cf_nav_tree_de - Top)

**For HTTP**
If you selected HTTP in the **Action** field, complete the following options:

- **Web Address** | Enter the Web address for the page.
- **Arguments** | Enter argument parameters. (This field is not currently used.)
- **Open Options** | Select whether you want the page to open in the current window or a new window.[Link](https://help.deltek.com/Products/(F(bIV4sYLRL8jSVl365EBR5-GfkR2Ed4Zrr3Nw3hDjQvZ8kmOaY4vLQvqm7K2xUSR-MmOYV28bqdxuIK09uc3fZ7Yxd8apm0TtcZOzVSxftUWw-YKfFIPXtooJUNoBTjz6iarnjV6H-qHodBGp9DeNjDHOB_k5HAQeM5qng9PjsNCqNPriqghoWlgzm-1wRp0))/Vision/71/cf_nav_tree_de - Top)

**For File**
If you selected File in the **Action** field, complete the following option:

- **File** | Click ![file_icon](image) to search for and select a file. Use a network share file as...
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| For Web Outlook               | If you selected Web Outlook in the **Action** field, complete the following options:  
  - **Web Address** — Select the URL address for Web Outlook.  
  - **Outlook Folder** — Select the Outlook folder you want to display as the default, such as Inbox, Calendar, or Contacts.  
  - **Users** — Enter an Outlook ID to pass to login. Enter `[USERNAME]` to pass the Vision ID as the Outlook ID. If you leave the field blank, the login opens with no name filled.                                                                                                                             |
| For Report                    | If you selected Report in the **Action** field, complete the following options:  
  - **Report Favorite** — Select a report from the available list of reports.  
  - **Always Rebuild Report** — Select this option if you want Vision to recalculate the report each time it is selected. Otherwise, Vision retrieves the report as is.                                                                                                           |
Dashparts

Your Dashboard content is easily managed because it is divided into individual sections — or blocks — on your Dashboard, called dashparts.

Dashparts provide access to specific records, Web links, reports, activities, and applications. You can access any dashpart without affecting your other dashparts.

In addition to the standard dashpart types on your Dashboard, you can customize multiple system and Web dashparts. There is also a Vision Tip of the Day.

You can also configure your Dashboard to display only those dashparts used in your role (such as Project Management or Accounting, for example), and then arrange them on the screen to suit your preference. You can also choose to display your dashparts as links using a flat style.

Create a Report Web Dashpart

In the Add Web Dashpart dialog, you can select report favorites and view them within a Web dashpart.

To create a Report Web dashpart, complete the following steps:

1. Create a favorite report.
3. Enter the name of your dashpart in the Web Part Name field. The name you enter in this field is the name that appears when the dashpart is added to the Dashboard.
4. Select Report from the Address Type field.
5. In the Report Favorite field, select a report favorite from the drop down list. Each report favorite also displays the corresponding report type, such as Visualization, Employees, Projects, or Performance Management. Vision automatically uses the report favorite name as the Web Part Name, but you can modify it.
6. Select the Hide Toolbar option to hide the Reporting toolbar on the web dashpart. This is useful for providing extra space on reports that contain graphs.
7. Select the Always Rebuild Report option if you want the report to always be rerun each time the Dashboard is refreshed. You must check this box if you want the dashpart added to the Dashboard.
   If you do not check the Always Rebuild Report checkbox, the dashpart will display the report as it was rendered the last time it was run. You must rerun the report in the Reports application before loading the Dashboard.
   Clicking the Refresh icon will force the report to be rebuilt, even if the Always Rebuild Report checkbox was not selected.
8. Select your access options. This is determined in role security (please see your system administrator regarding access rights).
9. Select Personal if the Web dashpart you are creating does not have any role security applied to it.
10. Select Access to all roles (if your role permits this option) for full access to all available roles.
11. Click OK.
Web Part Name Field

In the **Web Part Name** field, the Web part name will default to the name of the report favorite. However, you can modify the name after selecting a report favorite.

Web Dashpart Name Drop-down List

You can do the following to this Web dashpart by clicking on the name of the Web dashpart:

- Configure a Web dashpart
- Print a Web dashpart
- Hide a Web dashpart
- Delete a Web dashpart
- Open a Web dashpart in a new window
- Change the color of a Web dashpart

These options are based on security settings.
Login - Password and User ID Reminder

The Vision login dialog includes a Password and User ID reminder option. Select this option to receive a reminder of your Vision Password and/or User ID in the event that they are forgotten or have been disabled.

To use the Password and User ID reminder, complete the following:

1. Open the Deltek Vision login screen. The **Forgot your password or User ID?** option displays in the following conditions:
   - You are not using Windows Authentication.
   - The Vision email settings are configured.
2. Click **Forgot your password or User ID?** The Account Maintenance dialog box displays.
3. Select one or both options to reset:
   - **Forgot Password for** — Select this option to reset your Vision Password. The User ID from the Login screen displays and one of the following occurs:
     - If there is a valid User ID and associated email address, you will receive an email with a temporary password that will allow you to access your account. Follow the directions in this email to reset your password the next time that you log in.
     - If there is not a valid User ID, an error message displays stating that you cannot reset the password. Click **OK** to return to the Deltek Vision login screen.
   - **Forgot User ID** — Select this option to receive a reminder for your assigned User ID. When you select this option, the following occurs:
     - The **Email Address** field is activated. Enter the email address that is associated with your User ID.
     - Vision checks to ensure the email address is valid.
     - If it is valid, you will receive an email with the associated User ID information. Follow the directions in this email and use the User ID the next time you log in.
     - If it is not valid, an error message displays stating that the email address is not valid.
4. Click **OK**.
Lookups

Project Lookup
The Project Lookup allows you to display a list of some or all of the project records in your Project Info Center. Use the Project Lookup to search for and select the project records you want to open.

To access the Project Lookup, click in the Find field of any project record. You can also access the Project Lookup in data fields that require entry of a project name.
You can also use the Quick Find or Info Center Search tool feature to search for a record.

Advanced Lookup
Use the Advanced lookup to enter additional criteria that limit the data retrieved by the search. You can also perform Info Center queries based on a field in another Info Center.

Before proceeding, please review the Lookup list options.

To search using the Advanced lookup, complete the following steps:

1. Click to display the lookup list.
2. Select Advanced from the Display enter drop-down list. The Advanced search form displays.
3. From the drop-down list for the Search Type field, select the search type, such as Client Number or Employee Name. The drop-down arrow appears when you click anywhere in the Search Type field.
4. From the drop-down list for Search Field, select the name of the field that you want to search. Note that Memo type fields will also search the relevant HTML and include HTML code within the search results.
5. Click anywhere in the Operator field to display a drop-down list of comparative operators and select the one you want to use. For an Advanced search, you can implement searches such as "Is Me" and "Is Not Me", and "Is Mine" and "Is Not Mine".
6. Click inside the Search List field to display , then click on that icon to display a dialog box that corresponds to your Search Type selection.
7. On the Search List dialog box, highlight the records you want to display and then click Select.
8. Select one of the logical operators, AND or OR, using the drop-down list for the Cond text grid. This displays when you click anywhere in the Cond field.
9. Optional. Parenthesis can be used to group multiple levels of expressions for a given search. To use parenthesis, you must manually enter parenthesis in the left and right parenthesis grid columns. If the number of parenthesis on the left does not match the number on the right, you are prompted to fix the expression prior to searching, applying, or saving saved searches.
10. Optional. For a Project lookup, you can use the Project Level drop-down list to specify the WBS level to search. If you select Any Level, Vision searches all WBS levels.
11. Use the Search Criteria grid drop-down options to print grid information or export data to Excel.

12. Use the Move Up and Move Down buttons to arrange the order of your search criteria.

13. Use the Insert, Copy, and Delete buttons to modify your search criteria as needed.

14. Optional — select Display Search Text. If this option is selected, the search results grid is replaced with a text box containing a readable, color coded, indented version of the current Advanced search. This display allows you to see the entire Advanced search and how nested levels of the search (based on parenthesis) relate to each other. This check box is automatically cleared the next time you click the Search button.

15. Select Active Only to display only those records whose status is currently Active.

16. Select Pending Accounting Review to display only those records that are pending review.

17. Click Search. A list of all records matching your search criteria appears.

18. For an Advanced search, you can use the Organize button to use the criteria for future searches.

19. Click Select All to display all records, or highlight only those records you wish to display by pressing the Ctrl and Shift keys at the same time and then clicking Select. The first record that matches your criteria appears.

20. Use the left arrow and right arrow buttons to navigate through the records you selected.

Get Total Rows Function
Select Get Total Rows: to display the row count in a completed search. This function is available when the Use Lookup Limit option is selected in General System Settings.

Displaying Records
- Click the Next X Rows >> to view the next group of rows (X represents the number you choose in the General System Settings).
- Click the << Previous X Rows to view previous rows (X represents the number you choose in the General System Settings).

This function is available when the Use Lookup Limit option is selected in General System Settings.

Clear Button
Click the Clear button before starting a new Advanced search so that information from the previous search is not included in the new search.

Sub Tables
Sub tables corresponding to certain Search Types are displayed in the Sub Table field. You can use this information to manually order sub tables together so that they will be combined in a single EXISTS clause. When searches of like sub tables are not entered sequentially in the Advanced grid, then a separate EXISTS clause will be created for each search type.
Expense Report Configuration

Use the Setup tab to select global processing options for Expense Report users within a company, set standard expense report displays, and enter company paid default and distance reimbursement information.

Global Options

<table>
<thead>
<tr>
<th>Allow staff users to resubmit expense reports</th>
<th>Select this option to allow staff users to change submitted expense reports and resubmit them. If you do not select this option, staff users cannot change their expense reports after they submit them. Resubmit expense reports is available only to users whose Administration level is set to Staff. Group and/or System level users can resubmit their own expense reports if the appropriate options are selected on the Expense tab of the Employee Info Center.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow users to specify applied advance amounts</td>
<td>Select this option to allow users to enter applied advance amounts on their expense reports. By entering applied advance amounts, users can indicate that they received an advance prior to submitting an expense report. The amount of the advance is subtracted from the total expense amount on the expense report to determine the actual reimbursement due to the employee.</td>
</tr>
<tr>
<td>Require users to enter categories on expense reports</td>
<td>Select this option to require users to associate each expense on an expense report with an expense category. Expense categories allow you to standardize the account that is debited for specific types of expenses. When a user associates an expense with a category, the account specified for the category is automatically entered on the user’s expense report.</td>
</tr>
<tr>
<td>Require expense reports to be approved before posting</td>
<td>Select this option to require that submitted expense reports be approved before being posted to your Vision database. If you select this option, expense reports must have a status of Approved to be posted. Only users with Group, Company, or System access to the Expense Report application can approve expense reports. You establish user access and approval rights for the Expense Report application on the Expense tab of the Employee Info Center. If you select this option, a designated Group, Company, or System Administrator must approve expense reports for each employee at your firm before the expense reports are posted. If you want your principals, project managers, or supervisors to approve individual expense report line entries prior to posting, use the Expense Report Line Item Approval feature. These two approval options function independently of each other. You can require: • Expense report approval only. • Line item approval only. • Both expense report and line item approval. • No approval. If you do not require either level of approval, you can post expense reports with a status of Submitted. If you select this option, you can set up an Expense Report Approval alert to...</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| **Require electronic signature when submitting expense reports** | Select this option to require users to enter a password when they submit their expense reports. If you select this option, note the following:  
- Be sure that passwords are established in Users and Passwords Security Configuration.  
- From the Miscellaneous tab of Company Expense Report Configuration, you can enter a message that displays when employees submit expense reports.  
If you do not select this option, users can submit their expense reports without entering a password. |
| **Treat inactive projects as dormant**        | Select this option to prevent users from entering **Inactive** projects on their expense reports. Normally, Vision warns users when they enter a project with a status of **Inactive**, but still processes the transaction. When you select this option, Vision does not allow users to enter **Inactive** projects on expense reports.  
This setting does not affect the use of inactive projects with other types of transactions (such as Billing or Accounts Receivable). |
| **Display line number in expense report**    | Select this option for the **Line** column to display in the Expenses grid on the expense report. This column displays the sequence number of the expense line, which is useful for reference purposes. For example, if line 3 if for a taxi receipt, then you can write 3 on the physical paper copy of the taxi receipt to keep tabs on the expense.  
The lines in the Expenses grid are numbered sequentially within the **Line** column. However, if you insert a line between existing lines (for example, between 1 and 2, then the new line becomes 3 and the order is 1, 3, 2).  
Note: If you use the default column order, the Line column is inserted on the left side of the grid. If you have changed the column order, the Line column is inserted on the right side of the grid. |
| **Show Project**                             | Use the drop-down list in this field to select a display option for project data. The option you select determines how project data is entered and displayed on the Expense Report form.  
- Select **Number** to display the **Project** field. This field accepts and displays project numbers only.  
- Select **Name** to display the **Project Name** field. This field accepts and displays project names only.  
- Select **Both** to display both the **Project** and the **Project Name** fields. The **Project Name** field displays as a read-only field. Users must enter a project number in the **Project** field. Vision automatically enters the project name in the **Project Name** field. |
| **Show Phase**                               | Use the drop-down list in this field to select a display option for phase data. The option you select determines how phase data is entered and displayed on the Expense Report form.  
- Select **Number** to display the **Phase** field. This field accepts and displays phase numbers only.  
- Select **Name** to display the **Phase Name** field. This field accepts and displays phase names only.  
- Select **Both** to display both the **Phase** and the **Phase Name** fields. |
The Phase Name field displays as a read-only field. Users must enter a phase number in the Phase field; Vision automatically enters the phase name in the Phase Name field.

**Show Task**

Use the drop-down list in this field to select a display option for task data. The option you select determines how task data is entered and displayed on the Expense Report form.

- Select Number to display the Task field. This field accepts and displays task numbers only.
- Select Name to display the Task Name field. This field accepts and displays task names only.
- Select Both to display both the Task and the Task Name fields. The Task Name field displays as a read-only field. Users must enter a task number in the Task field; Vision automatically enters the task name in the Task Name field.

**Show Account**

Use the drop-down list in this field to select a display option for account data. The option you select determines how account data is entered and displayed on the Expense Report form.

- Select Number to display the Account field. This field accepts and displays account numbers only.
- Select Name to display the Account Name field. This field accepts and displays account names only.
- Select Both to display both the Account and the Account Name fields. The Account Name field displays as a read-only field. Users must enter an account number in the Account field; Vision automatically enters the account name in the Account Name field.
- Select None if you do not want to display either the Account or Account Name field. If you select this option, users are not required to enter accounts when completing expense reports.

**Company Paid Default Information**

Select this option to allow users to enter company paid items on their expense reports. A company paid item is any expense for which your company sends payment directly to a vendor instead of reimbursing the employee who incurred the expense. The expense is paid through Accounts Payable, not through Employee Expense Repayments.

For example, an airline may bill your company directly for a ticket purchased by one of your employees. In this case, your company would pay the airline directly for the cost of the ticket, and not reimburse the employee for this expense. However, the employee would include the cost of the airline ticket on an expense report to provide an audit trail for the expense.

If you select this option:

- The Project, Phase, Task, and Account fields on the Setup tab are enabled. Use these fields to enter the project, phase, task, and/or account to credit when processing company paid expenses.
- A Paid column appears on each expense report form. Users select the Paid option to indicate that an expense is company paid. The amount of the expense is deducted from the amount reimbursed to the employee.

For expenses that are not "company paid" items, Vision credits the project, phase, task, and account entered in the Employee Expense Credit fields on the Posting tab of Accounting Company Settings Configuration.
## Expense Report Configuration

| **Project** | Enter the default project that will receive the credit when users enter company paid expense items on their expense reports. Enter a project name directly in this field, use the Quick Find feature, or click ![Go to Project] in the **Project** field to use the Project Lookup. |
| **Phase** | Enter the default phase that will receive the credit when users enter company paid expense items on their expense reports. Enter a phase number directly in this field, use the Quick Find feature, or click ![Go to Phase] in the **Phase** field to use the Phase/Task Lookup. |
| **Task** | Enter the default task that will receive the credit when users enter company paid expense items on their expense reports. Enter a task number directly in this field, use the Quick Find feature, or click ![Go to Task] in the **Task** field to use the Phase/Task Lookup. |
| **Account** | Enter the default account that will receive the credit when users enter company paid expense items on their expense reports. Enter an account number directly in this field, use the Quick Find feature, or click ![Go to Account] in the **Account** field to use the Account Lookup. |
| **Distance Reimbursement Default** | Use the two **Distance Reimbursement Default** fields to enter the amount you will reimburse employees for each mile or kilometer of travel.  
- In the first field, enter a monetary amount.  
- In the second field, use the drop-down list to select a reimbursement unit—**Kilometer** or **Mile**. |
| **Disallow user to edit amount per mile on expense report** | Select this option if you do not want users to edit the reimbursement amount (per mile/kilometer) on their expense reports. |
# Project Info Center Toolbar

**Project Info Center Toolbar**

Use the Project Info Center toolbar to access management functions for project records. The buttons that display on the toolbar depend on the security access rights assigned to your role by your system administrator.

<table>
<thead>
<tr>
<th>Toolbar Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Save</strong> <img src="image" alt="Save" /></td>
<td>Click <img src="image" alt="Save" /> to save entries to the current project record.</td>
</tr>
<tr>
<td><strong>New</strong> <img src="image" alt="New" /></td>
<td>There are several options available from the New toolbar button:</td>
</tr>
<tr>
<td><img src="image" alt="New" /> <img src="image" alt="New Project" /></td>
<td>Click <img src="image" alt="New Project" /> to open a blank project record. Use the blank record to create a new project record.</td>
</tr>
<tr>
<td><img src="image" alt="New" /> <img src="image" alt="New Phase" /></td>
<td>Click <img src="image" alt="New Phase" /> to add a new phase to the current project record.</td>
</tr>
<tr>
<td><img src="image" alt="New" /> <img src="image" alt="New Task" /></td>
<td>Click <img src="image" alt="New Task" /> to add a new task to the current project record.</td>
</tr>
<tr>
<td><img src="image" alt="New" /> <img src="image" alt="Copy Current Project" /></td>
<td>Click <img src="image" alt="Copy Current Project" /> to copy the current project record to a new record. You can then edit the copied record to create a new project record. This option displays when you have the record open at the project level.</td>
</tr>
<tr>
<td><img src="image" alt="New" /> <img src="image" alt="Copy Current Phase" /></td>
<td>Click <img src="image" alt="Copy Current Phase" /> to copy the current phase. You can then edit the copied phase to create a new phase for the project. This option displays when you have the record open at the phase level.</td>
</tr>
<tr>
<td><img src="image" alt="New" /> <img src="image" alt="Copy Current Task" /></td>
<td>Click <img src="image" alt="Copy Current Task" /> to copy the current task. You can then edit the copied task to create a new task for the project. This option displays when you have the record open at the task level.</td>
</tr>
<tr>
<td><img src="image" alt="New" /> <img src="image" alt="Create Project from" /></td>
<td>Click <img src="image" alt="Create Project from" /> to open the Create Project from dialog and create a new project from an Existing Project, a Project Template, or an Opportunity.</td>
</tr>
<tr>
<td><img src="image" alt="New" /> <img src="image" alt="Create Phase from" /></td>
<td>Click <img src="image" alt="Create Phase from" /> to open the Create Phase from dialog and create a new phase from an Existing Project or a Project Template.</td>
</tr>
<tr>
<td><img src="image" alt="New" /> <img src="image" alt="Create Task from" /></td>
<td>Click <img src="image" alt="Create Task from" /> to open the Create Task from dialog and create a new task from an Existing Project or a Project Template.</td>
</tr>
<tr>
<td><img src="image" alt="New" /> <img src="image" alt="Create Project from a Plan" /></td>
<td>Click <img src="image" alt="Create Project from a Plan" /> to create a new project based on an existing project plan.</td>
</tr>
</tbody>
</table>

**Delete Record** ![Delete](image) | Click ![Delete](image) to delete the current project, phase, or task records from...
| **Print**  | There are several options available from the Print toolbar button:  
|           | - Click » Print Current Project to print the current project record.  
|           | - Click » Print Active Group to print all project records currently active in the Project Info Center.  
|           | - Click » Select Project to Print to select the project records you want to print.  |
| **Billing Terms**  | Click Billing Terms to display billing terms for the current project record. When you click this option, Vision opens the Billing Terms Setup form in a dialog window.  |
| **Project Review**  | Click Project Review to display financial data for the current project record. When you click this option, Vision opens the Project Review form in a dialog window.  |
| **Merge**  | There are several options available from the Merge toolbar button:  
|           | - Click » Merge Current Project to merge data from the current project record.  
|           | - Click » Merge Active Group to merge data from all project records currently active in the Project Info Center.  
|           | - Click » Select Project to Merge to open the Project Lookup and select the records you want to include in the merge.  |
| **Email**  | Click » Email Template to open the Send Email dialog and select a template to use for the email.  |
| **Photo**  | There are two options available from the Photo toolbar button:  
|           | - Click » Update to open the Photo Upload dialog box and add a photo to a project record.  
|           | - Click » Clear remove the current photo from a project record.  |
| **View**  | Use the View toolbar button to select the type of view, Detail or List, for the Project Info Center.  
|           | - Click Detail View to display the tabs within the info center.  
|           | - Click List View to display the info center records in a grid format. Use this view to quickly locate information within the info center.  |
| **Help**  | Click Help to view help for the Info Center.  |

7.1 Online Help Updates
General Tab of Project Info Center

Use the General tab of the Project Info Center to enter, edit, or review information about a project including the project name and number, the name of the organization in your company working on the project, primary client and contact names, project manager, principal and supervisor names, project type and status, and user record access rights.

Each project record in the Project Info Center may have an associated Work Breakdown Structure (WBS), consisting of various phases or tasks. Before entering WBS information for a project, you must enter and save the project's general information. After creating the project record, you can enter as many phases and tasks as needed.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Project** | Enter a unique project identification number. If you attempt to enter an existing project number in this field, Vision displays a dialog box to inform you that the number already exists in your database. When you close the dialog box, Vision clears the number you entered in this field. If Vision uses the auto numbering feature, you cannot enter a number in this field. Instead, **[AUTONUMBER]** displays in this field when you save the form. For a new project, after you save the project number, you can also enter the project's phase (second field). After saving the project number and phase, you can then enter the project's task (third field). The project number, phase, and task correlate with the Work Breakdown Structure (WBS). For Projects that have a defined multi-level WBS, a Phase/Task icon displays next to the Project Name. Click the icon to view the WBS tree structure. Note the following about project numbers:
  - The **Project** field is active only when you click **New** to add a new project record to your database. You cannot use this field to change a project number after you have created a project record.
  - You establish the length and format of your project numbers when you install Vision. If you need to change the length or format of your project numbers after installing Vision, you must use the Project Number Conversion utility. [http://hq1apprd44vs/Vision70/Help/en-us/pro_General_Tab_of_Project_Info_Center.htm](http://hq1apprd44vs/Vision70/Help/en-us/pro_General_Tab_of_Project_Info_Center.htm) - Top of Page

| **Phase** | Use this field to create a Work Breakdown Structure (WBS) for the new project. After you enter and save a project record, you can enter a phase that is associated with the project. Each project may have multiple phases. The phase number is the second level of the Work Breakdown Structure. WBS Level Two values can be a maximum of seven characters in length. This includes one user-defined delimiter. If you attempt to enter a phase number that already exists in the project record, Vision displays a dialog box to inform you that the number already exists. When you close the dialog box, Vision clears the number you entered in this field. **http://hq1apprd44vs/Vision70/Help/en-us/pro_General_Tab_of_Project_Info_Center.htm** - Top of Page |

| **Task** | Use this field to create a Work Breakdown Structure (WBS) for the new project. To enter a task number, you must have first entered a phase number. After you enter and save a project record, you can enter a task that is associated with a phase of the project. Each phase of the project may have multiple associated tasks. The task number is the third level of the Work Breakdown Structure. WBS Level Three values can be a maximum of seven characters in length. This includes one user- |
If you attempt to enter a task number that already exists for the phase, Vision displays a dialog box to inform you that the number already exists. When you close the dialog box, Vision clears the number you entered in this field. [http://hq1apprd44vs/Vision70/Help/en-us/pro_General_Tab_of_Project_Info_Center.htm - Top of Page]

### Opportunity

Enter the name of the opportunity associated with the project.

You can enter an opportunity name directly in this field, use the Quick Find feature to select an opportunity from your database, or click **Find** and use the Opportunity Lookup.

After you enter an opportunity in this field, you can click the opportunity name to open the Opportunity Info Center record in the current browser window. Or, right-click the name and then click on the **Open in new window** pop-up option to open the Opportunity Info Center record in a new browser window.

When you enter an opportunity in this field in a project record, the associated project's number is entered in the **Project** field on the General tab of the opportunity record.


### Short Name

Enter a short name for the project. Use this field if the project name is too long to fully display on project reports and invoices.

When you enter the project’s name in this field and then move to the next field, Vision searches your database to look for duplicate records. If Vision detects possible duplicate records, the Potential Duplicate Records Found dialog displays. The dialog box lists existing project records that match, or closely match, the project name you want to add. Review the list to ensure the record you are adding does not already exist in your database. [http://hq1apprd44vs/Vision70/Help/en-us/pro_General_Tab_of_Project_Info_Center.htm - Top of Page]

### Promotional Project

This field is enabled for regular projects only.

Enter the name or number of the promotional project associated with the project.

You can enter a promotional project name or number directly in this field, use the Quick Find feature to select a promotional project from your database, or click **Find** and use the Project Lookup.

After you enter a promotional project, you can click the promotional project number to open the Project Info Center record in the current browser window. Or, right-click the number and then click the **Open in new window** option to open the Project Info Center record in a new browser window.


### Long Name

Enter the full name of the project. If you do not enter a Long Name, this field defaults to the name entered in the **Short Name** field. [http://hq1apprd44vs/Vision70/Help/en-us/pro_General_Tab_of_Project_Info_Center.htm - Top of Page]

### Project Plan

Enter the name of the plan associated with the project.
You can enter a plan name directly in this field, use the Quick Find feature to select a plan from your database, or click **Find** and use the Plan Lookup.

After you enter a plan, you can click the plan name to open the Project Planning record in the current browser window. Or, right-click the name and then click the **Open in new window** option to open the Project Planning record in a new browser window.

If you create a new project record from a project plan, Vision enters the plan name in this field. [Link](http://hq1apprd44vs/Vision70/Help/en-us/pro_General_Tab_of_Project_Info_Center.htm - Top of Page)

### Organization

Enter the name of the organization in your firm that is responsible for completing the project. Organizations are discrete business units within your company.

You can enter an organization name directly in this field, use the Quick Find feature to select an organization from your database, or click **Find** to use the Organization Lookup.

**Multicompany**

The organization code you specify here indicates which company "owns" the project, phase, or task record.

The active company determines which organizations are available for the Organization lookup dialog box. [Link](http://hq1apprd44vs/Vision70/Help/en-us/pro_General_Tab_of_Project_Info_Center.htm - Top of Page)

### Federal Project

Select this option if the project is being completed for an agency or branch of the federal government. [Link](http://hq1apprd44vs/Vision70/Help/en-us/pro_General_Tab_of_Project_Info_Center.htm - Top of Page)

### Referable

Select this option if the project can be used as a reference. [Link](http://hq1apprd44vs/Vision70/Help/en-us/pro_General_Tab_of_Project_Info_Center.htm - Top of Page)

### Primary Client

Enter the name of the primary client associated with the project.

You can enter a client name directly in this field, use the Quick Find feature to select a client from your database, or click **Find** to use the Client Lookup.

If the client record you want to enter in this field does not yet exist in your database, click **New** to create a new client record.

When you click **New**, Vision opens a blank Client Info Center record in a separate browser window. Enter the client information in the blank record to create a new record, as needed. When you save the new record, Vision inserts the client name in the **Primary Client** field.

When you enter a client name in the **Primary Client** field:

- Vision creates a hyperlink between the client name and the corresponding Client Info Center record. You can then click the client name in this field to open the Client Info Center record.
- Vision adds the client’s name and related information to the Clients grid on the Clients/Contacts tab of the Project Info Center record.
- Vision adds the project’s name and related information to the Projects grid in the specified Client Info Center record.
<table>
<thead>
<tr>
<th><strong>Confidential</strong></th>
<th><strong>Alias</strong></th>
<th><strong>Client Address</strong></th>
<th><strong>Primary Contact</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>When you use Vision Proposals, select this option to keep the <strong>Primary Client’s</strong> and <strong>Owner’s</strong> names confidential and to exclude their names from all proposals. When you include the project in a proposal, an alias that you create will be substituted for the client or owner name. If you select this option, the <strong>Alias</strong> field displays on the General tab. Use this field to enter the name you want to substitute for the client’s and owner’s actual name.</td>
<td>This field displays when you select the <strong>Confidential</strong> option. Enter the name you want to substitute for the <strong>Primary Client’s</strong> or <strong>Owner’s</strong> actual name when you include this project in a proposal.</td>
<td>When you enter a client name in the <strong>Primary Client</strong> field on the General tab, Vision enters the primary address associated with that client record in the <strong>Client Address</strong> field. However, you can enter a different client address in this field. This address displays on client reports. The actual address does not display in this field. When you enter a client address in the Client Info Center, you must also enter a description for the address and you must designate one address as the primary address. It is the description for the primary address that displays in the <strong>Client Address</strong> field on the General tab.</td>
<td>Enter the name of the primary contact associated with the project. You can enter a contact name directly in this field, use the Quick Find feature to select a contact from your database, or click <strong>Find</strong> to use the Contact Lookup. If no contact record exists, you must add a new record in the Contact Info Center before you enter a name in this field. When you enter a contact name in this field:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Vision creates a hyperlink between the contact name and the corresponding Contact Info Center record. You can then click the name in this field to open the Contact Info Center record in the current browser window. Or, right-click the name and then click the <strong>Open in new window</strong> option to open the Contact Info Center record in a new browser window. • Vision adds the contact’s name and related information to the Contacts grid on the Clients/Contacts tab of the Opportunity Info Center record. • Vision adds the opportunity’s name and related information to the Opportunities grid in the specified Contact Info Center record.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>To edit the contact name, right-click the name and click <strong>Edit</strong>. This temporarily disables the hyperlink feature and allows you to edit the information in this field. <strong><a href="http://hq1apprd44vs/Vision70/Help/en-us/pro_General_Tab_of_Project_Info_Center.htm">http://hq1apprd44vs/Vision70/Help/en-us/pro_General_Tab_of_Project_Info_Center.htm</a> - Top of Page</strong></td>
</tr>
<tr>
<td><strong>Principal</strong></td>
<td>Enter the name of the employee who is the Principal for the project. You can enter a name directly in this field, use the Quick Find feature to select an employee from your database, or click <strong>Find</strong> to use the Employee Lookup. If no employee record exists, you must add a new record in the Employee Info Center before you can enter a name in this field. When you enter an employee name in this field:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Vision creates a hyperlink between the employee name and the corresponding Employee Info Center record. You can then click the name in this field to open the Employee Info Center record in the current browser window. Or, right-click the name and then click the <strong>Open in new window</strong> option to open the Employee Info Center record in a new browser window.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Vision adds the employee's name and related information to the Employees grid on the Team tab of the Project Info Center record.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Vision adds the project's name and related information to the Projects grid on the Projects tab of the specified Employee Info Center record.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Project Manager</strong></td>
<td>Enter the name of the employee who is the Project Manager for the project. You can enter a name directly in this field, use the Quick Find feature to select an employee from your database, or click <strong>Find</strong> to use the Employee Lookup. If no employee record exists, you must add a new record in the Employee Info Center before you can enter a name in this field. When you enter an employee name in this field:</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Vision creates a hyperlink between the employee name and the corresponding Employee Info Center record. You can then click the name in this field to open the Employee Info Center record in the current browser window. Or, right-click the name and then click the <strong>Open in new window</strong> option to open the Employee Info Center record in a new browser window.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Vision adds the employee's name and related information to the Employees grid on the Team tab of the Project Info Center record.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Vision adds the project's name and related information to the Projects grid on the Projects tab of the specified Employee Info Center record.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

To edit the Principal name, right-click the name and click **Edit**. This temporarily disables the hyperlink feature and allows you to edit the information in this field. Note the following:

- If you remove an employee from the **Principal** field of a project record, the employee is removed from the Employees grid on the Team tab of the Project Info Center record only if the employee's **Team Status** is **Proposed**. If the employee's **Team Status** is **Active**, the employee's name remains in the grid, but the **Role** field is cleared.
- If you remove an employee from the **Principal** field of a project record, the project is removed from the Projects grid on the Projects tab of the associated Employee Info Center record only if the employee's **Team Status** is **Proposed**. If the employee's **Team Status** is **Active**, the project's name remains in the grid, but the **Role** field is cleared.
- If you remove an employee (with role type **Principal**) from the Employees grid on the Team tab of the Project Info Center record, and that employee is also entered in the **Principal** field on the General tab of the Project Info Center record, the employee is also removed from the **Principal** field.
- Vision does not update the **Principal** field when you change an employee's role on either the Team tab of the Project Info Center record or on the Project tab of the Employee Info Center record. When you make a change on either of those tabs, you must manually change your entry in the **Principal** field, as needed. [http://hq1apprd44vs/Vision70/Help/en-us/pro_General_Tab_of_Project_Info_Center.htm](http://hq1apprd44vs/Vision70/Help/en-us/pro_General_Tab_of_Project_Info_Center.htm) - Top of Page
window. Or, right-click the name and then click the **Open in new window** option to open the Employee Info Center record in a new browser window.

- Vision adds the employee's name and related information to the Employees grid on the Team tab of the Project Info Center record.

- Vision adds the project's name and related information to the Projects grid on the Projects tab of the specified Employee Info Center record.

To edit the Project Manager name, right-click the name and click the **Edit** pop-up option. This temporarily disables the hyperlink feature and allows you to edit the information in this field.

Note the following:

- If you remove an employee from the **Project Manager** field of a project record, the employee is removed from the Employees grid on the Team tab of the Project Info Center record only if the employee's **Team Status** is **Proposed**. If the employee's **Team Status** is **Active**, the employee's name remains in the grid, but the **Role** field is cleared.

- If you remove an employee from the **Project Manager** field of a project record, the project is removed from the Projects grid on the Projects tab of the associated Employee Info Center record only if the employee's **Team Status** is **Proposed**. If the employee's **Team Status** is **Active**, the project's name remains in the grid, but the **Role** field is cleared.

- If you remove an employee (with role type **Project Manager**) from the Employees grid on the Team tab of the Project Info Center record, and that employee is also entered in the **Project Manager** field on the General tab of the Project Info Center record, the employee is also removed from the **Project Manager** field.

- Vision does not update the **Project Manager** field when you change an employee's role on either the Team tab of the Project Info Center record or on the Project tab of the Employee Info Center record. When you make a change on either of those tabs, you must manually change your entry in the **Project Manager** field, as needed.

---

**Supervisor**

Enter the name of the employee who is the Supervisor for the project.

You can enter a name directly in this field, use the Quick Find feature to select an employee from your database, or click **Find** to use the Employee Lookup.

If no employee record exists, you must add a new record in the Employee Info Center before entering a name in this field.

When you enter an employee name in this field:

- Vision creates a hyperlink between the employee name and the corresponding Employee Info Center record. You can then click the name in this field to open the Employee Info Center record in the current browser window. Or, right-click the name and then click the **Open in new window** option to open the Employee Info Center record in a new browser window.

- Vision adds the employee's name and related information to the Employees grid on the Team tab of the Project Info Center record.

- Vision adds the project's name and related information to the Projects grid on the Projects tab of the specified Employee Info Center record.

To edit the Supervisor name, right-click the name and click the **Edit** pop-up option. This temporarily disables the hyperlink feature and allows you to edit the information in this field.

Note the following:
• If you remove an employee from the Supervisor field of a project record, the employee is removed from the Employees grid on the Team tab of the Project Info Center record only if the employee's Team Status is Proposed. If the employee's Team Status is Active, the employee's name remains in the grid, but the Role field is cleared.

• If you remove an employee from the Supervisor field of a project record, the project is removed from the Projects grid on the Projects tab of the associated Employee Info Center record only if the employee's Team Status is Proposed. If the employee's Team Status is Active, the project's name remains in the grid, but the Role field is cleared.

• If you remove an employee (with role type Supervisor) from the Employees grid on the Team tab of the Project Info Center record, and that employee is also entered in the Supervisor field on the General tab of the Project Info Center record, the employee is also removed from the Supervisor field.

• Vision does not update the Supervisor field when you change an employee's role on either the Team tab of the Project Info Center record or on the Project tab of the Employee Info Center record. When you make a change on either of those tabs, you must manually change your entry in the Supervisor field, as needed.  

Project Type
Use this drop-down list to select the project type.

The project type is different from the project’s charge type, which indicates whether the project is a regular, overhead, or promotional project. You enter a project’s charge type on the Accounting Tab of the Project Info Center.

You use the Project Type Code Table in Code Table Configuration to define project types. Contact your system administrator to add values to this list.  

Responsibility
Use this drop-down list to select your company's level of responsibility on this project.

You use the Project Responsibility Code Table in Code Table Configuration to define project responsibility options. Contact your system administrator to add values to this list.

Status
Use this drop-down list to select the project’s status. A project’s status determines the validity of certain project-related transactions in Vision.

Your status options are:

- **Active** — You can use the project in any transaction that requires a project number.
- **Inactive** — Visions displays a warning if you try to use the project in any transaction that requires a project number. You must choose to proceed with the transaction after you receive the warning.
- **Dormant** — Vision prevents you from using the project number in any transaction that requires a project number, except for receipt, invoice, and historical data entry, and bill processing. Vision displays a warning when you process receipts, invoices, historical data, and bills, but you can complete the transaction.
- **Purged** — Vision does not allow any transaction activity on the project.
### Project Currency

**Multicurrency, only.**

If you use Vision Multicurrency, select the currency in which the project is managed; this can differ from the functional currency of the project’s home company.

The project currency is the currency in which a project is managed. The project currency is used for all project reporting and project planning. When labor or expense charges are made to the project, the charges are recorded in the project currency (as well as all other appropriate currencies).


### Billing Currency

**Multicurrency, only.**

If you use Vision Multicurrency, select the currency in which the project is managed; this can differ from the functional currency of the project’s home company.

The billing currency is the currency used to generate invoices and billing reports for a project and all its phases and tasks. The project and billing currencies do not need to be the same. You can plan and manage a project in one currency and invoice the client in another.


### Available to CRM users

This option displays if you use both Vision CRM and Vision Accounting. Select this option to allow CRM users to open and review the project record.

Vision selects this option by default when you add a new project record. You can select or clear this option at any time. [http://hq1apprd44vs/Vision70/Help/en-us/pro_General_Tab_of_Project_Info_Center.htm - Top of Page](http://hq1apprd44vs/Vision70/Help/en-us/pro_General_Tab_of_Project_Info_Center.htm - Top of Page)

### Available to Accounting users

This option displays if you use both Vision CRM and Vision Accounting. Select this option to allow Accounting users to open and review the project record.

Vision selects this option by default when you add a new project record. You can select this option at any time. However, you can clear this option only if the **Approved for use in processing** option is not selected.

If this option is selected when you save a new project record, Vision prompts you to enter required information on the Project Info Center Accounting tab. You must enter the required information before you can save the record. [http://hq1apprd44vs/Vision70/Help/en-us/pro_General_Tab_of_Project_Info_Center.htm - Top of Page](http://hq1apprd44vs/Vision70/Help/en-us/pro_General_Tab_of_Project_Info_Center.htm - Top of Page)

### Approved for use in processing

This option displays if you use Vision Accounting or Vision Project Control. Select this option if the project record is approved for use when processing accounting transactions.

Vision selects this option by default when an Accounting user adds a new project record. It is disabled for all other users. If you are an Accounting user, you can select this option at any time. However, you can clear this option only if the project record has not been used in any accounting transactions.

If this option is selected when you save a new project record, Vision prompts you to enter required information on the Project Info Center Accounting tab. You must enter the required information before you can save the record. [http://hq1apprd44vs/Vision70/Help/en-us/pro_General_Tab_of_Project_Info_Center.htm - Top of Page](http://hq1apprd44vs/Vision70/Help/en-us/pro_General_Tab_of_Project_Info_Center.htm - Top of Page)
## Memo
Enter additional notes about the project.

You can enter text directly in this field or click **Edit** to use the Vision Text Editor to enter text. [http://hq1apprd44vs/Vision70/Help/en-us/pro_General_Tab_of_Project_Info_Center.htm](http://hq1apprd44vs/Vision70/Help/en-us/pro_General_Tab_of_Project_Info_Center.htm) - Top of Page

## Kona Space
If you are using the Kona application, you can associate a Kona space with the selected project.

Use the drop-down list to select a Kona space for the project. The Kona space’s image displays. You can select the space to open Kona directly from within Vision.
Opportunity Info Center Toolbar

Use the Opportunity Info Center toolbar to access management functions for opportunity records. The buttons that display on the toolbar may vary, depending on the security access rights assigned to your role by your system administrator.

Refer to the table below for a description of the Opportunity Info Center toolbar buttons.

<table>
<thead>
<tr>
<th>Toolbar Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Save</strong> ![Save icon]</td>
<td>Click ![Save icon] to save entries to the current opportunity record.</td>
</tr>
<tr>
<td><strong>New</strong> ![New icon]</td>
<td>There are several options available from the <strong>New</strong> toolbar button:</td>
</tr>
<tr>
<td></td>
<td>• Click ![New icon] <strong>New Opportunity</strong> to open a blank opportunity record. Use the blank record to create a new opportunity record.</td>
</tr>
<tr>
<td></td>
<td>• Click ![New icon] <strong>Copy Current Opportunity</strong> to copy the current opportunity record to a new record. You can then edit the copied record to create a new opportunity record.</td>
</tr>
<tr>
<td></td>
<td>• Click ![New icon] <strong>Select Opportunity to Copy</strong> to open the Opportunity Lookup and select an opportunity record to copy. You can then edit the copied record to create a new opportunity record.</td>
</tr>
<tr>
<td><strong>Delete Opportunity</strong> ![Delete icon]</td>
<td>Click ![Delete icon] to delete the current opportunity record from your Vision database.</td>
</tr>
<tr>
<td><strong>Print</strong> ![Print icon]</td>
<td>There are several options available from the <strong>Print</strong> toolbar button:</td>
</tr>
<tr>
<td></td>
<td>• Click ![Print icon] <strong>Print Current Opportunity</strong> to print the current opportunity record.</td>
</tr>
<tr>
<td></td>
<td>• Click ![Print icon] <strong>Print Active Group</strong> to print all opportunity records currently active in the Opportunity Info Center.</td>
</tr>
<tr>
<td></td>
<td>• Click ![Print icon] <strong>Select Opportunity to Print</strong> to select the opportunity records you want to print.</td>
</tr>
<tr>
<td><strong>Merge</strong> ![Merge icon]</td>
<td>There are several options available from the <strong>Merge</strong> toolbar button:</td>
</tr>
<tr>
<td></td>
<td>• Click ![Merge icon] <strong>Merge Current Opportunity</strong> to merge data from the current opportunity record.</td>
</tr>
<tr>
<td></td>
<td>• Click ![Merge icon] <strong>Merge Active Group</strong> to merge data from all opportunity records currently active in the Opportunity Info Center.</td>
</tr>
</tbody>
</table>
| | • Click ![Merge icon] **Select Opportunity to Merge** to open the Opportunity Lookup and select the records you want to include in the
merge.

| Email | Click **Email** » **Email Template** to open the Send Email dialog and select a template to use for the email. |
| Photo | There are two options available from the **Photo** toolbar button: |
|       | • Click **Update** to open the Photo Upload dialog box and add a photo to an opportunity record. |
|       | • Click **Clear** remove the current photo from an opportunity record. |
| View  | Use the **View** toolbar button to select the type of view, **Detail** or **List**, for the Opportunity Info Center. |
|       | • Click **Detail View** to display the tabs within the info center. |
|       | • Click **List View** to display the info center records in a grid format. Use this view to quickly locate information within the info center. Note that if the Allocation Method on the Estimated Revenue tab is set to **Specific Date**, the **Revenue** column in the grid view is non-editable. |
| Help  | Click **Help** to view help for the Info Center. |

**General Tab of Opportunity Info Center**

Use the General tab of Opportunity Info Center to enter, edit, or review information about an opportunity. This can include the opportunity name, number, description, status, type, source, revenue and probability figures, open and close dates, and an associated client, contact, or organization name.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Enter the opportunity number. If Vision uses auto numbering, you cannot enter a number in this field unless you allow overrides. Instead, [AUTONUMBER] displays in this field when you save the form. When you enter the opportunity number in this field, Vision searches your database to look for duplicate records. If Vision detects a possible duplicate record, the Potential Duplicate Records Found dialog box displays. The dialog box displays the name and number of the existing opportunity record that exactly matches the opportunity number you want to add. Review the existing record to ensure the record you want to add does not already exist in your database. <a href="http://camqasvr08wsx64/vision/Help/en-US/opp_General_Tab_of_Opportunity_Info_Center.htm">http://camqasvr08wsx64/vision/Help/en-US/opp_General_Tab_of_Opportunity_Info_Center.htm - General Tab of Opportunity Info Center</a></td>
</tr>
<tr>
<td>Name</td>
<td>Enter the name of the opportunity. The name you enter in this field displays on proposals, reports, and marketing materials. When you enter the opportunity name in this field, Vision searches your database to look for duplicate records. If Vision detects possible duplicate records, the Potential Duplicate Records Found dialog box displays. The dialog box contains a list of existing opportunity records that closely match the opportunity name you want to add. Review the list to ensure the record you are adding does not already exist in your database. <a href="http://camqasvr08wsx64/vision/Help/en-US/opp_General_Tab_of_Opportunity_Info_Center.htm">http://camqasvr08wsx64/vision/Help/en-US/opp_General_Tab_of_Opportunity_Info_Center.htm - General Tab of Opportunity Info Center</a></td>
</tr>
<tr>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>-------------</td>
<td></td>
</tr>
<tr>
<td><strong>Click</strong> ![Edit](<a href="http://camqasvr08wsx64/vision/Help/en-US/opp_General_Tab_of_Opportunity_Info_Center.htm">http://camqasvr08wsx64/vision/Help/en-US/opp_General_Tab_of_Opportunity_Info_Center.htm</a> - General Tab of Opportunity Info Center) to access the Text Editor and enter a brief description of the opportunity. <strong><a href="http://camqasvr08wsx64/vision/Help/en-US/opp_General_Tab_of_Opportunity_Info_Center.htm">http://camqasvr08wsx64/vision/Help/en-US/opp_General_Tab_of_Opportunity_Info_Center.htm</a> - General Tab of Opportunity Info Center</strong></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Promotional Project</th>
</tr>
</thead>
</table>
| If the opportunity is now a proposal and you created a promotional project record to track and bill charges for proposal generation, the promotional project number displays in this field.  
If you create a new promotional project but do not use the Create Promotional Project from Opportunity option, you can complete one of the following:  
- Enter a name directly in this field.  
- Use the Quick Find feature to select a record from your database.  
- Click ![Find](http://camqasvr08wsx64/vision/Help/en-US/opp_General_Tab_of_Opportunity_Info_Center.htm - General Tab of Opportunity Info Center) to use the Project Lookup.  
After you enter a promotional project, click the promotional project number to open the Project Info Center record in the current browser window. Or, right-click the number and then click the **Open in new window** option to open the Project Info Center record in a new browser window. **http://camqasvr08wsx64/vision/Help/en-US/opp_General_Tab_of_Opportunity_Info_Center.htm - General Tab of Opportunity Info Center** |

<table>
<thead>
<tr>
<th>Regular Project</th>
</tr>
</thead>
</table>
| If you award the opportunity and you create a project record from the opportunity record, the project number displays in this field.  
If you create a new project but do not use the Create Project from Opportunity option, you can complete one of the following:  
- Enter a name directly in this field.  
- Use the Quick Find feature to select a record from your database.  
- Click ![Find](http://camqasvr08wsx64/vision/Help/en-US/opp_General_Tab_of_Opportunity_Info_Center.htm - General Tab of Opportunity Info Center) and use the Project Info Center.  
After you enter a project in this field, you can click on the project number to open the Project Info Center record in the current browser window. Or, right-click on the number and then click the **Open in new window** option to open the Project Info Center record in a new browser window. **http://camqasvr08wsx64/vision/Help/en-US/opp_General_Tab_of_Opportunity_Info_Center.htm - General Tab of Opportunity Info Center** |

<table>
<thead>
<tr>
<th>Project Plan</th>
</tr>
</thead>
</table>
| Enter the name of the project plan related to the opportunity. You can complete one of the following to enter the plan name:  
- Enter a name directly in this field.  
- Use the Quick Find feature to select a record from your database.  

<table>
<thead>
<tr>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use this drop-down list to select a status for the opportunity. <strong><a href="http://camqasvr08wsx64/vision/Help/en-US/opp_General_Tab_of_Opportunity_Info_Center.htm">http://camqasvr08wsx64/vision/Help/en-US/opp_General_Tab_of_Opportunity_Info_Center.htm</a> - General Tab of Opportunity Info Center</strong></td>
</tr>
</tbody>
</table>
| Organization | Enter the name of the organization in your firm that is responsible for pursuing the opportunity. Organizations are discrete business units within your company. Complete one of the following to enter an organization name:  
- Enter a name directly in this field.  
- Use the Quick Find feature to select a record from your database.  
- Click Find to use the Organization Lookup. |
|-------------|--------------------------------------------------------------------------------------------------|
| Primary Client | Enter the name of the primary client associated with the opportunity. Complete one of the following to enter a client name:  
- Enter a name directly in this field.  
- Use the Quick Find feature to select a record from your database.  
- Click Find to use the Client Lookup.  
- If the client record does not exist in your database, click New to create a new client record. Vision opens a blank Client Info Center record in a separate browser window. Enter the client information in the blank record to create a new record. When you save the new record, Vision inserts the client name in the Primary Client field. When you enter a client name in the Primary Client field:  
- Vision creates a hyperlink between the client name and the corresponding Client Info Center record. You can click the client name in this field to open the Client Info Center record.  
- Vision adds the client's name and related information to the Clients grid on the Clients/Contacts tab of the Opportunity Info Center record.  
- Vision adds the opportunity's name and related information to the Opportunities grid in the specified Client Info Center record. |
| Primary Contact | Enter the name of the primary contact associated with the opportunity. Complete one of the following to enter a contact name:  
- Enter a name directly in this field.  
- Use the Quick Find feature to select a record from your database.  
- Click Find to use the Contact Lookup.  
- If the contact record you want to enter in this field does not yet exist in your database, click New to create a new contact record. When you click New, Vision opens a blank Contact Info Center record in a separate browser window. Enter the contact information in the blank record to create a new record, as needed. When you save the new record, Vision inserts the contact name in the Primary Contact field. |
Name the **Primary Contact** field.

When you enter a contact name in the **Primary Contact** field:

- Vision creates a hyperlink between the contact name and the corresponding Contact Info Center record. You can then click the contact name in this field to open the Contact Info Center record.

- Vision adds the contact's name and related information to the Contacts grid on the Clients/Contacts tab of the Opportunity Info Center record.

- Vision adds the opportunity's name and related information to the Opportunities grid in the specified Contact Info Center record.


| Stage       | Use the drop-down list in this field to select a stage for the opportunity. 
You can configure Vision to alert applicable staff members at your firm when the status of an opportunity changes. 
You use the Opportunity Stage Code Table in Code Table Configuration to define opportunity stage options. Contact your system administrator to add values to this list. [http://camqasvr08wsx64/vision/Help/en-US/opp_General_Tab_of_Opportunity_Info_Center.htm - General Tab of Opportunity Info Center](http://camqasvr08wsx64/vision/Help/en-US/opp_General_Tab_of_Opportunity_Info_Center.htm) |
|-------------|-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------|
| Type        | Use the drop-down list in this field to select a type by which to classify the opportunity. 
You use the Opportunity Type Code Table in Code Table Configuration to define opportunity type options. Contact your system administrator to add values to this list. [http://camqasvr08wsx64/vision/Help/en-US/opp_General_Tab_of_Opportunity_Info_Center.htm - General Tab of Opportunity Info Center](http://camqasvr08wsx64/vision/Help/en-US/opp_General_Tab_of_Opportunity_Info_Center.htm) |
| Source      | Use the drop-down list in this field to select the source of the opportunity. Your sources may include client referrals, consultant jobs, and marketing campaigns, among others. 
You use the Opportunity Source Code Table in Code Table Configuration to define opportunity source options. Contact your system administrator to add values to this list. [http://camqasvr08wsx64/vision/Help/en-US/opp_General_Tab_of_Opportunity_Info_Center.htm - General Tab of Opportunity Info Center](http://camqasvr08wsx64/vision/Help/en-US/opp_General_Tab_of_Opportunity_Info_Center.htm) |
| Principal-in-Charge | Enter the name of the employee who is the Principal for the opportunity. 
Complete one of the following to enter an employee name: 
- Enter a name directly in this field. 
- Use the Quick Find feature to select a record from your database. 
- Click Find to use the Employee Lookup. 
If no employee record exists, you must add a new record in the Employee Info Center before you enter a name in this field. 
When you enter an employee name in this field: 
- Vision creates a hyperlink between the employee name and the corresponding Employee Info Center record. You can then click the name in this field to open the Employee Info Center record in the current browser window. Or, right-click the name and then click the Open in new window option to open the Employee Info Center record in a new browser window. |
• Vision adds the employee's name and related information to the Employees grid on the Team tab of the Opportunity Info Center record.

• Vision adds the opportunity's name and related information to the Opportunities grid on the CRM Info tab of the specified Employee Info Center record.

To edit the Principal name, right-click the name and click **Edit**. This disables the hyperlink feature and allows you to edit the information in this field.

Note the following:

• If you remove an employee from the Principal field of an opportunity record, the employee still displays in the Employees grid on the Team tab of the Opportunity Info Center record, but the Role field is cleared.

• If you remove an employee from the Principal field of an opportunity record, the opportunity still displays in the Opportunities grid on the CRM Info tab of the associated Employee Info Center record, but the Role field is cleared.

• If you remove an employee with role type Principal from the Employees grid on the Team tab of the Opportunity Info Center record, and that employee is also entered in the Principal field on the General tab of the Opportunity Info Center record, the employee is also removed from the Principal field.

• Vision does not update the Principal field when you change an employee's role on either the Team tab of the Opportunity Info Center record or on the CRM Info tab of the Employee Info Center record. When you make a change on either of those tabs, you must manually change your entry in the Principal field. [http://camqasvr08wsx64/vision/Help/en-US/opp_General_Tab_of_Opportunity_Info_Center.htm - General Tab of Opportunity Info Center](http://camqasvr08wsx64/vision/Help/en-US/opp_General_Tab_of_Opportunity_Info_Center.htm)

Project Manager

Enter the name of the employee who is the Project Manager for the opportunity.

Complete one of the following to enter an employee name:

• Enter a name directly in this field.

• Use the Quick Find feature to select a record from your database.

• Click **Find** to use the Employee Lookup.

If no employee record exists, you must add a new record in the Employee Info Center before you can enter a name in this field.

When you enter an employee name in this field:

• Vision creates a hyperlink between the employee name and the corresponding Employee Info Center record. You can click the name in this field to open the Employee Info Center record in the current browser window. Or, right-click the name and then click the Open in new window option to open the Employee Info Center record in a new browser window.

• Vision adds the employee's name and related information to the Employees grid on the Team tab of the Opportunity Info Center record.

• Vision adds the project's name and related information to the Opportunities grid on the CRM Info tab of the specified Employee Info Center record.

To edit the Project Manager name, right-click the name and click **Edit**. This disables the hyperlink feature so you can edit the information in this field.

Note the following:

• If you remove an employee from the Project Manager field of an opportunity record, the employee still displays in the Employees grid on the Team tab of
<table>
<thead>
<tr>
<th>Supervisor</th>
<th>Enter the name of the employee who is the Supervisor for the opportunity.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Complete one of the following to enter a client name:</td>
</tr>
<tr>
<td></td>
<td>• Enter a name directly in this field.</td>
</tr>
<tr>
<td></td>
<td>• Use the Quick Find feature to select a record from your database.</td>
</tr>
<tr>
<td></td>
<td>• Click <img src="#" alt="Find" /> to use the Employee Lookup.</td>
</tr>
<tr>
<td></td>
<td>If no employee record exists, you must add a new record in the Employee Info Center before you can enter a name in this field.</td>
</tr>
<tr>
<td></td>
<td>When you enter an employee name in this field:</td>
</tr>
<tr>
<td></td>
<td>• Vision creates a hyperlink between the employee name and the corresponding Employee Info Center record. You can click the name in this field to open the Employee Info Center record in the current browser window. Or, right-click the name and then click the <strong>Open in new window</strong> option to open the Employee Info Center record in a new browser window.</td>
</tr>
<tr>
<td></td>
<td>• Vision adds the employee's name and related information to the Employees grid on the Team tab of the Opportunity Info Center record.</td>
</tr>
<tr>
<td></td>
<td>• Vision adds the project's name and related information to the Opportunities grid on the CRM Info tab of the specified Employee Info Center record.</td>
</tr>
<tr>
<td></td>
<td>To edit the Supervisor name, right-click the name and click <img src="#" alt="Edit" />. This temporarily disables the hyperlink feature and allows you to edit the information in this field.</td>
</tr>
<tr>
<td></td>
<td>Note the following:</td>
</tr>
<tr>
<td></td>
<td>• If you remove an employee from the <strong>Supervisor</strong> field of an opportunity record, the employee still displays in the Employees grid on the Team tab of the Opportunity Info Center record, but the <strong>Role</strong> field is cleared.</td>
</tr>
<tr>
<td></td>
<td>• If you remove an employee from the <strong>Supervisor</strong> field of an opportunity record, the opportunity still displays in the Opportunities grid on the CRM Info tab of the associated Employee Info Center record, but the <strong>Role</strong> field is cleared.</td>
</tr>
<tr>
<td></td>
<td>• If you remove an employee with role type <strong>Supervisor</strong> from the Employees grid on the Team tab of the Opportunity Info Center record, and that employee is also entered in the <strong>Supervisor</strong> field on the General tab of the Opportunity Info Center record, the employee is also removed from the <strong>Supervisor</strong> field.</td>
</tr>
</tbody>
</table>
- Vision does not update the **Supervisor** field when you change an employee's role on either the Team tab of the Opportunity Info Center record or on the CRM Info tab of the Employee Info Center record. When you make a change on either of those tabs, you must manually change your entry in the **Supervisor** field, as needed. [http://camgasvr08wsx64/vision/Help/en-US/opp_General_Tab_of_Opportunity_Info_Center.htm - General Tab of Opportunity Info Center](http://camgasvr08wsx64/vision/Help/en-US/opp_General_Tab_of_Opportunity_Info_Center.htm)

**BVS**

This option displays for Vision CRM users who have set up the Business Value Selling (BVS) Interface in **Configuration » General » Opportunity Settings** to help qualify opportunities.

After you enter a new opportunity record and select a **Stage**, click the **BVS Sales Process** link to access the BVS application. Enter additional information in BVS, and save and close the application. BVS updates the necessary information within the Vision opportunity record. [http://camgasvr08wsx64/vision/Help/en-US/opp_General_Tab_of_Opportunity_Info_Center.htm - General Tab of Opportunity Info Center](http://camgasvr08wsx64/vision/Help/en-US/opp_General_Tab_of_Opportunity_Info_Center.htm)

**Date Opened**

Click ![Calendar](http://camgasvr08wsx64/vision/Help/en-US/opp_General_Tab_of_Opportunity_Info_Center.htm) to select the date on which you identified the opportunity and began pursuing the job. Vision enters your selection in the **Date Opened** field. [http://camgasvr08wsx64/vision/Help/en-US/opp_General_Tab_of_Opportunity_Info_Center.htm - General Tab of Opportunity Info Center](http://camgasvr08wsx64/vision/Help/en-US/opp_General_Tab_of_Opportunity_Info_Center.htm)

**Date Closed**


**Days Open**

Vision displays the number of days the opportunity has been open. This value is based on the date entered in the **Date Opened** field and either today's date or the date entered in the **Date Closed** field. [http://camgasvr08wsx64/vision/Help/en-US/opp_General_Tab_of_Opportunity_Info_Center.htm - General Tab of Opportunity Info Center](http://camgasvr08wsx64/vision/Help/en-US/opp_General_Tab_of_Opportunity_Info_Center.htm)

**Revenue**

Enter a number representing the estimated monetary amount of revenue you expect to earn, if the opportunity results in an awarded project.


**Probability**

Use the drop-down list to select a number that represents the probability that the opportunity will become a project. For example, if the probability that the opportunity will become a project is 80%, enter **80** in this field.

If there is a description associated with the probability number you enter in this field, the description displays to the right of the field. For example, an 80% probability may have a description such as: **Submit Proposal**.

You define probability options and their descriptions using the Opportunity Probability Code Table in Code Table Configuration. Contact your system administrator to add values to this list.

If you use Vision Planning, this field determines the availability of resources for work on any plan linked to the opportunity. To ensure that anyone checking for resource availability has up-to-date information, you must change the probability setting in this
### Weighted Revenue

Vision calculates this value (weighted revenue) using the information you enter in the Revenue and Probability fields. Vision determines the value as follows:

**Revenue X Probability = Weighted Revenue**

If you clear the Probability field, the weighted revenue value defaults to 0 (zero).

### Estimated Start

Enter the date you expect to begin the job associated with the opportunity.

You can enter a date directly in this field or click Calendar and select a date from the drop-down list calendar.

### Estimated Completion

Enter the date you expect to complete the job associated with the opportunity.

You can enter a date directly in this field or click Calendar and select a date from the drop-down list calendar.

### Currency

Multicurrency, only.

Use this drop-down list to select a currency code for this opportunity record.

This field displays if you use Vision Multicurrency. It is required.

### Kona Space

If you are using the Kona application, you can associate a Kona space with the selected opportunity.

Use the drop-down list to select a Kona space for the opportunity. The Kona space’s image displays. You can select the space to open Kona directly from within Vision.
Project Info Center List View—Populated with Phase and Task Records

Info Center Views
The List View and Detail View toolbar buttons display on the toolbar in some Info Center. Click these buttons on the form toolbar to switch back and forth between the views:

- **Detail View**
  This is the default view that displays when you open an Info Center. All fields for the Info Center records are displayed on tabs on the Info Center form. The Detail View is the format that is described within help topics in the Vision Online Help System.

- **List View**
  In this view, fields for an Info Center record are displayed in columns in a grid rather than on separate tabs. In the grid, you can display one or more Info Center records at a time. You can add, remove, or change the order of the columns in the grid by clicking the Select Fields option on the Info Center grid toolbar.

  The List view allows you to quickly locate and evaluate Info Center data. For example, to locate an opportunity that is associated with a particular client, but you do not remember specific details, use the List View to filter the opportunity records by client. Then review the list to locate the desired record.

  The Info Center records that you select using the Standard Lookup or the Advanced Lookup in the Search field on the Info Center form display in the grid in the List View.

  In the Project Info Center only, there is an additional field on the Advanced Lookup dialog box—the Display field—that allows you to see a hierarchical view of all work breakdown structure (WBS) levels (project, phase, and task) for a project in the List View or Detail View.

Populate the List View or Detail View in the Project Info Center with Phase and Task Records
Use the Advanced Project Lookup dialog box to populate the List View or Detail View of the Project Info Center with project, phase, or task (work breakdown structure (WBS) 1, 2, or 3) records.

**To populate the List View or Detail View in the Project Info Center with phase and/or task records, complete the following steps:**

1. From the Vision Navigation menu, click **Info Center » Project**.
2. On the Info Center form, click the **Search** field icon.
3. On the Project Lookup dialog box, select **Advanced** in the drop-down list in the Display Type field.
4. In the Search Criteria grid, insert the criteria for the projects, phases, or tasks that you want to find.
5. In the drop-down list in the Display field, select one of the following options to determine how the records will display in the Project grid in the List View or for the Navigation buttons in the Detail View:
Project Info Center List View—Populated with Phase and Task Records

- **Project**
  Each row in the List View grid (or record that is accessible using the Navigation button in the Detail View) is a project that either:
  - Matches your search criteria.
  - Owns a phase or task that matches your selection criteria.

- **Phase**
  Each row in the List View grid (or record that is accessible using the Navigation button in the Detail view) is a phase that:
  - Belongs to the project that matches your search criteria.
  - Matches your search criteria.
  - Owns a task which matches your search criteria.

- **Tasks**
  Each row in the List View grid (or record that is accessible using the Navigation button in the Detail view) is a task that either:
  - Belongs to a project or phase that matches your selection criteria.
  - Matches your search criteria.

- **All Matches** — The List View displays a row for each project and a row for each lower WBS level (each phase and task) that matches the search criteria. Likewise, the records that are accessible using the Navigation button in the Detail View include project records and all lower WBS levels that match the selection criteria.

6. Click the **Search** button.

   The results of the search display in the grid in the lower portion of the Advanced Project Lookup dialog box.

7. Complete one of the following:
   - Click the **Select All** button to select all the records in the search results grid to display in the Project Info Center List View or Detail View.
   - Click one or more records in the search results grid and then click the **Select** button to select only some of the records to display in the Project Info Center List View or Detail View.

   To select multiple records in the list, press and hold the CTRL key and then click the appropriate records in the search results grid.

   To select multiple records in the grid that are listed beside each other, click the first record and then press the SHIFT key while you click the last record. All records in between the first and last record that you clicked are selected.

   After you click the **Select All** or **Select** buttons, you are returned to the List View or the Detail View (whichever you had selected on the Project Info Center form).

The **Project** grid in the List View is populated with the items that you selected on the Advanced Project Lookup dialog box. The records in the grid are sorted by WBS number, not name.

For the Detail View, the **Navigation** buttons (left-arrow and right-arrow) to the left of the **Search** field at the top of the Project Info Center form are populated with the projects, phases, or tasks that you selected on the Advanced Project Lookup dialog box. This allows you to easily scroll through the multiple records from the advanced lookup results.
Add, Remove, or Change the Order of Columns in an Info Center List View

In Info Centers that have a List View, you can add, remove, or change the order of the columns in the List View grid.

To customize the Info Center grid in the List View, complete the following steps:

1. Open an Info Center.
2. Click  List View  on the Info Center toolbar.
3. On the toolbar of the Info Center grid, click the Select Fields option.
4. In the Tab field drop-down list on the Select Fields dialog box, select the Info Center tab from which you want to select columns (fields) to add to the grid.
   The drop-down list displays all Info Center tabs for which you have security access. What you enter in this field determines the list of fields that display in the Available Fields section.
   The Select All option in the Tab drop-down list allows you to display fields from all tabs in the Available Fields section.
5. Complete any of the following actions on the Select Fields dialog box:
   - To add fields to the grid, select the fields in the Available Fields list that you want to display on the grid and click Add.
   - To remove fields that display on the grid, select the fields in the Selected Fields list and click Remove.
   - To change the display order of fields in the grid, in the Selected Fields box, click the field that you want to move and then click the Up or Down buttons. Continue this process until the selected fields are in the correct order.
   Another way to change the order of the fields in the grid is to drag and drop columns directly in the grid in the List View screen. Click a column header, drag the columns to the desired location, and drop the column. Changes that you make on the grid are not reflected in the Selected Fields list. You must reorder the Selected Fields list to maintain the changed display order.
6. Click OK to return to the List View.
Project Info Center Toolbar

Use the Project Info Center toolbar to work with project records.

Location

To display the toolbar, complete the following step:

1. From the Vision Navigation menu, click Info Center » Projects.

Contents

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>![Save]</td>
<td>Click this option to save your work.</td>
</tr>
<tr>
<td>![New]</td>
<td>After you click this option, select one of the following:</td>
</tr>
<tr>
<td>![New Project]</td>
<td>Select <strong>New Project</strong> to open a blank project record. Use the blank record to create a new project record.</td>
</tr>
<tr>
<td>![New Phase]</td>
<td>Select <strong>New Phase</strong> to add a new phase to the current project record.</td>
</tr>
<tr>
<td>![New Task]</td>
<td>Select <strong>New Task</strong> to add a new task to the current project record.</td>
</tr>
<tr>
<td>![Copy Current Project]</td>
<td>Select <strong>Copy Current Project</strong> to copy the current project record to a new record. You can then edit the copied record to create a new project record. This option displays when you have the record open at the project level.</td>
</tr>
<tr>
<td>![Copy Current Phase]</td>
<td>Select <strong>Copy Current Phase</strong> to copy the current phase. You can then edit the copied phase to create a new phase for the project. This option displays when you have the record open at the phase level.</td>
</tr>
<tr>
<td>![Copy Current Task]</td>
<td>Select <strong>Copy Current Task</strong> to copy the current task. You can then edit the copied task to create a new task for the project. This option displays when you have the record open at the task level.</td>
</tr>
<tr>
<td>![Create Project from]</td>
<td>Select <strong>Create Project from</strong> to open the Create Project from dialog box and create a new project from an existing project, project template, or opportunity.</td>
</tr>
<tr>
<td>![Create Phase from]</td>
<td>Select <strong>Create Phase from</strong> to open the Create Phase from dialog box and create a new phase from an existing project or project template.</td>
</tr>
<tr>
<td>![Create Task from]</td>
<td>Select <strong>Create Task from</strong> to open the Create Task from dialog box and create a new task from an existing project or project template.</td>
</tr>
<tr>
<td>![Create Project from a Plan]</td>
<td>Select <strong>Create Project from a Plan</strong> to create a new project based on an existing project plan.</td>
</tr>
<tr>
<td><strong>Delete</strong></td>
<td>Click this option to delete a record.</td>
</tr>
<tr>
<td><strong>Print</strong></td>
<td>After you click this option, select one of the following:</td>
</tr>
<tr>
<td></td>
<td>• Select <strong>Print Current Project</strong> to print the current project record.</td>
</tr>
<tr>
<td></td>
<td>• Select <strong>Print Active Group</strong> to print all project records currently active in the Project Info Center.</td>
</tr>
<tr>
<td></td>
<td>• Select <strong>Select Project to Print</strong> to select the project records that you want to print.</td>
</tr>
<tr>
<td><strong>Billing Terms</strong></td>
<td>Click this option to display billing terms for the current project record. When you click this option, Vision opens the Billing Terms Setup form in a new window.</td>
</tr>
<tr>
<td><strong>Project Review</strong></td>
<td>Click this option to display financial data for the current project record. When you click this option, Vision opens the Project Review form in a new window.</td>
</tr>
<tr>
<td><strong>Merge</strong></td>
<td>After you click this option, select one of the following:</td>
</tr>
<tr>
<td></td>
<td>• Select <strong>Merge Current Project</strong> to merge data from the current project record.</td>
</tr>
<tr>
<td></td>
<td>• Select <strong>Merge Active Group</strong> to merge data from all project records currently active in the Project Info Center.</td>
</tr>
<tr>
<td></td>
<td>• Select <strong>Select Project to Merge</strong> to open the Project Lookup and select the records that you want to include in the merge.</td>
</tr>
<tr>
<td><strong>Email</strong></td>
<td>After you click this option, select <strong>Email Template</strong> to open the Send Email dialog box and select a template to use for the email message.</td>
</tr>
<tr>
<td><strong>List View</strong></td>
<td>When you are in the detail view (project information displays on tabs in the Project Info Center), click the <strong>List View</strong> option to display the project information in a grid format.</td>
</tr>
<tr>
<td><strong>Detail View</strong></td>
<td>When you are in the list view (project information displays in a grid), click the <strong>Detail View</strong> option to display project information on tabs.</td>
</tr>
<tr>
<td><strong>Help</strong></td>
<td>Click this option to display the online help.</td>
</tr>
</tbody>
</table>
Adobe InDesign Merge Templates

Merge Templates Overview

Merge templates contain merge codes that determine the Vision Info Center data to be retrieved when you produce merged documents. Merge templates also contain the formatting for merged documents. You use the Merge feature in Vision Info Centers and Custom Proposals to select one or more Info Center records and a merge template to produce a merged document.

For example, you could create a simple list from the Employee Info Center that contains an employee’s name and hire date.

In Custom Proposals, you can integrate your proposal text into any format desired. For example, you could create employee resumes with a merge template based on information from the Employee Info Center.

Summary of How Merge Templates and the Merge Process Work

1. You create your own merge templates with Microsoft Word (.rtf files) or Adobe InDesign (.indt files). InDesign gives you more flexibility with formatting and structuring merged document. Each merge template applies for a specific Info Center in Vision.

2. In Vision Configuration » General » Merge Templates, you add the merge template files to Vision.
   - For merge templates that are created in Word: You create the .rtf merge template file in Word before you add the file’s contents to Vision.
   - For merge templates that are created in InDesign: You create the .indt merge template file in InDesign from within Vision at the same time that you add the merge template to Vision.

3. A system administrator can assign specific merge templates to each security role, so that users have access to only the templates they need to use.

4. To generate a merged document:
   - In an Info Center — Click Merge on an Info Center toolbar to select one or more Info Center records (such as one or more employees), and then select the merge template.
   - Custom Proposals — Click Sections on the Custom Proposals form toolbar to select a merge template for different sections of the proposal. Then click Merge on the Custom Proposals toolbar to generate the merged document.

You can create merge templates and produce merged documents for all the Info Centers except the Accounts, Units, and user-defined Info Centers.
Prerequisites for Creating Vision Merge Templates with Adobe InDesign

Before you can use Adobe InDesign to create Vision merge templates and generate merged documents you must complete certain prerequisites.

Prerequisites include the following:

- You must have InDesign installed on your workstation.
- InDesign versions CS5.5 (7.5) and later are supported for Vision.
  
  If you use InDesign CS6, you must install InDesign on the same drive as your Windows Users directory on your workstation. If they are not located in the same directory, you cannot create or edit Vision InDesign templates. You will receive a message that InDesign has never been run as an administrator, and InDesign will not open. For more information on this issue, see the following Adobe link: [http://forums.adobe.com/message/4941732](http://forums.adobe.com/message/4941732). This issue does not occur with InDesign CS5.5.
- InDesign must be included in the Windows registry on your workstation in order for it to work with Vision.
  
  If you have Windows 7, InDesign may not generate the registry entry automatically when you launch InDesign for the first time. See the “Create the Adobe InDesign Registry Entry” help topic for instructions.
- A system administrator must enable FILESTREAM because InDesign merge templates are uploaded and saved to Vision using FILESTREAM. See the Deltek Vision Advanced Technical Installation Guide for instructions.

Create the Adobe InDesign Registry Entry

If you have Windows 7, InDesign may not generate the registry entry automatically when you launch InDesign for the first time. You must have administrator rights on your workstation to complete the procedure. See your system administrator if you need help with this.

To create the InDesign registry entry, complete the following steps:

1. On your workstation, open Windows Start » All Programs, and navigate to the Adobe InDesign application.
2. Right-click the Adobe InDesign application and select Run as administrator from the shortcut menu.

   This updates your Windows registry.

You perform this step only once on a workstation. You need to repeat this step only if you upgrade InDesign to another version. You do not have to run InDesign with administrator rights after the registry entry is made.
Adobe InDesign Merge Templates

You will receive the message: “Vision has not been configured for Adobe InDesign merge templates. Please see your administrator.” if Microsoft SQL Server FILESTREAM has not been enabled and configured for Vision.

FILESTREAM must be enabled and configured before you can use Adobe InDesign to create or import merge templates for Vision or before you can use InDesign merge template in Vision Info Centers or Custom Proposals. For instructions on how to enable and configure FILESTREAM, see the Vision Advanced Technical Administration Guide.

Adobe InDesign Sample Merge Templates

You can download sample Adobe InDesign merge templates from the Deltek Customer Care Connect site. See Knowledge Base article # 73879.

Use these samples to:

- See what InDesign templates looks like as you learn how to create InDesign merge templates.
- Create your own InDesign merge templates.

On the Merge Templates form in Vision Configuration » General » Merge Templates, click the Add » Import Adobe InDesign Template toolbar option to import sample merge templates into Vision. Then you can modify and save the InDesign merge template file with a new name.

Create a Vision Merge Template with Adobe InDesign

You can create a Vision merge template with Adobe InDesign. InDesign gives you more flexibility with formatting and structuring your merged document.

You create a merge template with InDesign when InDesign is launched automatically from within Vision Merge Templates Configuration. In the same step that you add the merge template to the Vision database, you also create the merge template. This allows the Vision database tables and fields to be available within InDesign. You cannot create merge templates directly in InDesign without going through Vision Merge Templates Configuration.

Prerequisites: See the “Prerequisites for Creating Vision Merge Templates with Adobe InDesign” help topic.

To create a Vision merge template with Adobe InDesign, complete the following steps:

1. From the Vision Navigation menu, click Configuration » General » Merge Templates.
2. In the Info Center Area field on the Merge Templates form, select the appropriate Info Center for the template.
3. On the Merge Templates grid toolbar, click Add, and from the drop-down list, select Create Adobe InDesign Template.
4. On the Add Merge Template dialog box, enter a description for the template in the Description field, and click OK.

The description will also be used as the name for the InDesign .indt file that is created for the merge template. When you click OK, Adobe InDesign opens, and the Vision Merge Code dialog box is minimized on your Windows taskbar.
5. On the Merge Codes dialog box, select a Vision table and field (merge code) that you want to add to the merge template.

   From the drop-down lists, you can select only the Vision database tables and fields for the Info Center that you selected on the Merge Templates form.

6. Optional. If the field that you select can be formatted, enter formatting for it in the Format field.

   You can see how the formatting looks in the Example section below the Format field.

7. Click Insert on the InDesign Merge Codes dialog box.

   The Vision field and its formatting are entered into the active InDesign text frame.

   To add merge codes for grid fields, graphics, and other items, see the following topics:
   - Insert Merge Codes for Vision Grids in an Adobe InDesign Merge Template
   - Insert Merge Codes for a Graphic in an Adobe InDesign Merge Template
   - Insert Merge Codes for Project Descriptions in an Adobe InDesign Merge Template

8. Continue to add more Vision fields to the InDesign file using the InDesign Merge Codes dialog box.

9. When you finish adding Vision fields to the InDesign file, click Save and Close on in the InDesign Merge Codes dialog box.

   This saves the merge template to Vision, closes InDesign, and returns you to the Vision Merge Templates form.

   If you save the file in InDesign using File » Save or File » Save As, the .indt file is not saved to Vision. It is saved to a location that you choose on your workstation or a network drive.

   After you save the .indt file to Vision, a new row for the template is added to the Vision Merge Template form. The file name that displays in the Template File Name field is based on the description that you entered for the merge file on the Add Merge Template dialog box.

   When you click the Cancel button on the InDesign Merge Codes dialog box, it cancels all changes made to the template since the last save, closes the InDesign, and returns you to the Merge Templates form. If the template file has not been saved previously, the template file is not saved.

Merge Templates Form

Use this form to manage the merge templates that you use to create merged documents in Vision Custom Proposals and Info Centers.

The merge templates that you add here display in:

- **Roles Security Configuration** — On the Access Rights tab, select MergeTemplates in the Functional Area field. After you select an Info Center, the merge templates display in the Available Templates box, and you can move them to the Templates for this Role box.

- **An Info Center** — Click Merge on an Info Center toolbar to open the Merging dialog box where you select a merge template and generate the merged document.
Custom Proposals — Click **Sections** on the Custom Proposals form toolbar to open the Configure Section(s) dialog box where you select a merge template for different sections of the proposal.

**Location**

To display the form, complete the following step:

1. From the Vision Navigation menu, click **Configuration » General » Merge Templates**.

**Contents**

**Fields**

<table>
<thead>
<tr>
<th><strong>Info Center Area</strong></th>
<th>Click the down-arrow, and from the drop-down list, select the Info Center for the merge template that you want to view, add, update, export, copy, or delete.</th>
</tr>
</thead>
</table>

**Merge Templates Grid**

Each row in the grid displays a merge template that has been added for the Info Center that you entered in the **Info Center Area** field.

<table>
<thead>
<tr>
<th><strong>Merge Templates Drop-down</strong></th>
<th>The Vision grids contain a drop-down list that displays a combination of the following options:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Print grid information</td>
</tr>
<tr>
<td></td>
<td>Export grid data to Excel</td>
</tr>
<tr>
<td></td>
<td>Enable Grouping</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Add</strong></th>
<th>Click this toolbar icon, and from the drop-down list, select one of the following options to add, create, or import a merge template into Vision:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• <strong>Microsoft Word Template</strong> — Use this option to add a merge template that has been created using Microsoft Word (an .rtf file). You must create merge templates in Word, before you add the file to Vision. When you add the file to Vision, the contents of the .rtf file are copied into Vision.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Create Adobe InDesign Template</strong> — Use this option to create a new merge template using InDesign. The InDesign software will open from within Vision, and you create the merge template (an .indt file). When you save the InDesign file, it is saved in Vision using SQL FILESTREAM capabilities.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Import Adobe InDesign Template</strong> — Use this option to import an existing merge template that you created directly in InDesign (not from within Vision).</td>
</tr>
<tr>
<td></td>
<td>When you select any of these options, the Add Merge Templates dialog box opens, and you enter information for the merge template you are adding, creating, or importing.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Update</strong></th>
<th>Click this toolbar icon to apply or make modifications to merge templates that have previously been added to Vision. This works differently for Microsoft Word and Adobe InDesign merge templates.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Microsoft Word merge templates:</strong></td>
</tr>
<tr>
<td></td>
<td>First, you must make modifications to the original .rtf file or a new .rtf file in Word</td>
</tr>
</tbody>
</table>
(outside of Vision). Then in the **Merge Templates** grid on the Merge Templates form, select the Word merge template that you want to modify. Click the **Update** icon to copy the contents of the modified or new Word .rtf file into the existing merge template in Vision.

**Adobe InDesign merge templates:**

In the **Merge Templates** grid on the Merge Templates form, select the InDesign merge template that you want to modify. Then click **Update** to open Adobe InDesign and modify a merge template directly in the InDesign software.

For more specific information about the update process for both Word and InDesign merge templates, see the "Update Merge Templates" topic.

| **Export** | This toolbar icon applies only for merge templates that are created with Microsoft Word. The icon is disabled when you select an Adobe InDesign merge template. After you select an .rtf merge template in the **Merge Templates** grid, click this icon to save a copy of the .rtf merge template file outside of Vision on your local machine or a network drive. For more specific information about the update process for Word merge templates, see the "Export Merge Templates" topic. |
| **Copy** | This toolbar icon applies for merge templates that are created with either Microsoft Word or Adobe InDesign. Click this icon to copy a selected merge template to create a new one. A new row is inserted in the grid for the new merge template. For more specific information about the copy process, see the "Copy Merge Templates" topic. |
| **Delete** | Click this toolbar icon to delete a selected merge template from Vision. Ensure that you no longer need a template before you delete it because the deletion cannot be undone. After a template is deleted, it is no longer accessible in the Merge Templates functional area on the Access Rights tab of Role Security. It is no longer accessible in the Info Centers or Custom Proposals. |
| **Description** | This column displays the description of the merge template that you entered on the Add Merge Template dialog box when you initially add the template to Vision. This column also reflects any changes you make to the description on the Update Merge Template dialog box if you updated the merge template. You can modify the description directly in this field. To save changes, click **Save** on the Merge Template form toolbar. When you use **Copy** to copy an existing merge template to create a new template, after you enter a description for the new (copied) template and move away from the **Description** field in the **Merge Templates** grid, the description is used to rename the file in the **Template File Name** column. |
| **Template File Name** | This column displays the name of the Microsoft Word .rtf or Adobe InDesign .indt file that is used to create the merge template in Vision. |
For Microsoft Word merge templates:
This column displays the .rtf file that you selected in the Merge Template field on either the Add Merge Template dialog box when you initially add a Word merge template to Vision or on the Update Merge Template dialog box if you update a merge template in Vision.

For Adobe InDesign merge templates:
This column displays the name of the InDesign .indt file, which is based on the description that you entered in the Description field on the Add Merge Template dialog box when you initially created and added the InDesign merge template in Vision.

When you use Copy to copy an existing merge template to create a new template, the Template File Name column initially fills with the file name of the merge template you are copying. After you enter a description for the new (copied) merge template in the grid on the Merge Templates form and move away from the Description column, the description is used to rename the file in the Template File Name column.

<table>
<thead>
<tr>
<th>Type</th>
<th>This column displays the merge template file type. The software that you use to create the merge template and the file extension are listed in this field. The types are:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Microsoft Word (.rtf)</td>
</tr>
<tr>
<td></td>
<td>• Adobe InDesign (.indt)</td>
</tr>
</tbody>
</table>

Toolbar of Merge Templates Form
Use these toolbar items to save entries on the Merge Templates form and open the online Help for the form.

| ![Save Icon] | Click this option to save any changes that you make to the description of a template in the Description column in the Merge Templates grid. |
| ![Help Icon] | Click this option to display the online Help for the Merge Templates form. |

Merge Codes Dialog Box
Use this dialog box to add merge codes to the merge template that you are creating in Adobe InDesign within Vision.

The merge codes identify the Vision database fields and any additional text that you want to include on a merged document.

On this dialog box, you also select the formatting for Vision fields that can be formatted.

This dialog box applies when you add a new InDesign merge template or update an existing InDesign merge template.

When you turn on hyphenation in an InDesign merge template, it is possible for merge codes to become hyphenated, especially if you use a large font size in the merge template. A hyphenated merge code will not work properly. The solution is to turn off hyphenation or reduce the font size of the merge code.
Location

To display the dialog box, complete the following steps:

1. From the Vision Navigation menu, click **Configuration » General » Merge Templates**.
2. On the Merge Templates form, enter an Info Center area for the new merge template that you are adding.
3. Click **Add** on the **Merge Templates** grid toolbar.
4. On the Add Merge Template dialog box, select the **Adobe InDesign** option.
5. In the **Description** field, enter a description for the merge template.
6. Click **OK**.

Contents

Fields

| Table        | From the drop-down list, select the Info Center database table that contains the field (merge code) that you want to add to the merge template. The drop-down list contains only the table options for the Info Center that you selected on the Merge Templates form. The entry that you make in this field determines which fields display in the drop-down list in the **Field** field. The items in the drop-down list include:

- **<Info Center name>** — For example, you see **Employees** in the drop-down list when you create a merge template for the Employees Info Center, **Projects** in the drop-down list when you create a merge template for the Projects Info Center, and so on. These options allow you to select fields from an Info Center, but not the fields that are contained in associated grids on Info Center tabs.

- **<Associated grid name>** — Select an associated grid to add grid fields from an associated grid (on an Info Center tab) to a merge template.

Examples of the associated grids that display in the **Table** drop-down list are **Associated Projects**, **Associated Clients**, **Associated Employees**, and so on. For example, the Employees Info Center has an associated **Projects** grid on the Projects tab that associates an employee with projects (another Info Center record). So **Associated Projects** displays in the **Table** drop-down list when you create a merge template for the Employee Info Center. Another example: **Associated Clients** displays in the **Table** drop-down list when you create a merge template for the Project Info Center. The associated **Clients** grid displays on the Clients/Contacts tab in the Project Info Center.

- **Non-associated grids** — Select this option to add grid fields from a non-associated grid (on an Info Center tab) to the merge template.

For example, the Employees Info Center has a **Resumes** grid on the Resumes tab. The resumes apply to an employee, but the resumes are not records from another Info Center. The **Resumes** grid displays in the **Table** drop-down list as **Resumes**.

Other non-associated grid items that display in the **Table** field are **Descriptions** and **Awards**. These are grids on the Background tab in the Project Info Center.

- **Firm Setup - Proposals** — This displays in the **Table** field drop-down list
when you create a merge template for an Employee, Opportunity, or Project Info Center. When you select Firm Setup - Proposals, the drop-down list in the Field field displays all the fields listed on the General tab of the Firm Setup - Proposals form in Configuration » Organization » Firm Setup - Proposals.

Service Estimate Tables

The following tables display in the Table field when you create a merge template for the Opportunity Info Center if the Enable Service Estimate check box is selected on the Service Estimate tab in Configuration » Opportunities:

- Service Estimate Consultants
- Service Estimate Expense
- Service Estimate Labor
- Service Estimate Unit

Activity Grids

Activity grids from all Info Centers are not included in the Table field drop-down list.

| Field | From the drop-down list, select a Vision field (merge code) to add to merge template. You can select only one field at a time. The drop-down list contains only:
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• The fields for the Info Center table that you entered in the Table field.</td>
</tr>
<tr>
<td></td>
<td>• The Lookup fields that you have access to per the Lookup functional area settings for your role security in Vision Configuration » Security » Roles » Access Rights tab.</td>
</tr>
<tr>
<td></td>
<td>When users generate a merged document and they do not have at least read only record access rights to a field that is included in a merge template, they will see the merge code (Vision field name) displayed in the merged document instead of the Vision data.</td>
</tr>
</tbody>
</table>

Field Names and Labels

The Vision field names in the drop-down list are based on the field labels that are entered in Vision in Configuration » General » Lookup/Report Labels or in Configuration » General » User Defined Components for grids.

If a field label is changed in Vision Configuration after an InDesign merge template has been created and saved, the correct data will display on a merged document that is generated from the merge template. However, the new field label will not display on a merged document until you update the merge template and replace the merge code (Vision field).

If you make a change to a field label in Vision Screen Designer, you must make the same change in the in Configuration » General » Lookup/Report Labels, or the label change will not be displayed in the Field field.

Grid Fields

When you select an associated or non-associated grid in the Table field, the drop-down list in the Field field includes fields from the grid. For associated grids, it also includes fields from the associated Info Center Lookup. See the Table field description for more information about associated and non-associated grids.

Current User and Current User Title

Current User and Current User Title display in the Field drop-down list when you select an Info Center’s name (for example Project for the Project Info Center).
in the Table field. Select these fields to add your Vision user name and title (first and last names and title from the Employee Info Center) to a merged document.

**Proposal Description**

When you select Projects in the Table field, the drop-down list in the Field field includes a Proposal Description merge code. This merge code allows you to insert project descriptions into a section of a Vision custom proposal. The project descriptions are from the Descriptions grid on the Background tab in the Project Info Center.

The Proposal Description merge code appears as the following in the merge template:

```
[Proposal Description|{BlockText}]
```

After you create the merge template and insert the Proposal Description merge code, you must add projects and their descriptions on the project section tab in Custom Proposals. When you merge the template in Custom Proposals, the project description text appears in place of the Proposal Description merge code.

For more information, see the following topics:
- Insert Merge Codes for Project Descriptions in an Adobe InDesign Merge Template
- Add a Project Description to a Custom Proposal Section

**Proposal Graphic**

When you select one of the following tables in the Table field, the drop-down list in the Field field includes a Proposal Graphic merge code:

- Clients
- Employees
- Opportunities
- Projects
- Text Libraries
- Vendors

Select this merge code to insert an empty graphic frames into the merge template. This is a placeholder that allows you to insert a graphics file in Vision Custom Proposals to a section of a custom proposal.

For more information, see the “Insert Merge Codes for a Graphic in an Adobe InDesign Merge Template” help topic.

**Proposal Resume**

When you select Employees in the Table field, the drop-down list in the Field field includes a Proposal Resume merge code. This merge code allows you to insert resume text into a section of a Vision custom proposal. The resume text is from the Resume grid on the Resumes tab of the Employee Info Center.

The Proposal Resume merge code appears as the following in the merge template:

```
[Proposal Resume|{BlockText}]
```

After you create the merge template and insert the Proposal Resume merge code, you must add employees and build their resumes on the employee section tab in Custom Proposals.

When you merge the template in Custom Proposals, the resume text appears in place of
the **Proposal Resume** merge code.

In Custom Proposals, if you have added projects to a resume by using the **Resume by Query w/ Project Restriction** option or the **Resume by Query w/o Project Restriction** option, these projects are included in the resume text on a merged document.

For more information, see the following topics:

- Insert Merge Codes for Resume Text in an Adobe InDesign Merge Template
- Add Resume Text to a Custom Proposal Section

### Proposal Section

**Proposal Section** displays in the **Field** drop-down list when you select an Info Center’s name (for example **Project** for the Project Info Center) in the **Table** field. This field applies only when you create a merge template for a custom proposal. Select this field to display the custom proposal section name on a merged document.

### Contact Address Fields

Contact address fields apply for merge templates that you create for the Contact Info Center.

To add a contact’s **Other/Home Address** from the General tab of the Contact Info Center to a merged document: Select **Contact** in the **Table** field. Then select address fields (such as **Address Line 1**, **City**, and so on) in the **Field** field.

To add a contact’s **Mailing Address** from the General tab of the Contact Info Center to a merged document: Select **Mailing Address** in the **Table** field. Then select address fields (such as **Address Line 1**, **City**, and so on) in the **Field** field. The **Insert Begin/End Code** button is not enabled when you select the **Mailing Address** table; Begin and end codes are not needed for this table.

### Total Years of Experience

**Total Years of Experience** displays in the **Field** drop-down list when you create a merge template for the Employee Info Center and you select **Employee** in the **Table** field. In a merged document, the **Total Years of Experience** displays the sum of the following fields from the General tab of the Employee Info Center for an employee:

- **Hire Date** through today
- **Prior Years with This Firm**
- **Years with Other Firms**

### Options section:

| **Select Specific** | When you select certain tables in the **Table** field, this field is enabled. The field name varies, based on the table that you select. For example, **Select Specific Role** displays for the **Associated Employees** table, **Select Specific Relationship** displays for the **Associated Clients** table, and so on.

In the **Select Specific** field, select an option that will determine whether the associated grid field that you entered in the **Field** field will display in a merged document for all the records (rows) in the associated grid or for only some of the specific records in the grid. |
Example
For a merge template for the Project Info Center, you select Associated Employees in the Table field and Employee Last Name in the Field field on the Merge Codes dialog box.

- If you select All in the Select Specific Role field: The last name for all employees who are entered in the associated Employees grid on the Team tab in the Project Info Center are included in the merged document.

- If you select Principal (a specific role) in the Select Specific Role field: Only employees who are designated as principals for a project (they have Principal entered in the Role column in the associated Employees grid on the Team tab in the Project Info Center) are included in the merged document.

Items in the Drop-Down List
The drop-down list in this field displays different options based on the associated grid that you selected in the Table field.

In addition to specific values, other possible options in the drop-down list are:

- **All** — All association grid records are included in the merge template. For some associated grids, All is the only option available, and you cannot change it.

- **Billing** — This option displays in the drop-down list when you create a merge template for the Client Info Center, and you select Addresses in the Table field. The billing address is included in the merge template.

- **Primary** — This option displays in the drop-down list when you create a merge template for the Client or Vendor Info Center, and you select Addresses in the Table field. The primary address is included in the merge template. This is the address that has the Primary check box selected for a client on the General tab of the Client Info Center.

- **Proposal Contacts** — This option retrieves contacts that are entered for a custom proposal in a Client Info Center section tab in Proposals » Custom Proposals (open the tab and click Contacts on the grid toolbar). This option displays in the drop-down list only when you create a merge template for the Client Info Center, and you select Associated Contacts in the Table field. Proposal Contacts applies only for merge templates that you create specifically for Clients Info Center sections of a custom proposal. If you add this merge code to a merge template that you use in the Client Info Center (instead of Custom Proposals), the merge codes are displayed instead of any actual contact when you generate a merged document.

- **Proposal Team** — This option retrieves employees who are entered as team members in a Project Info Center section tab for a custom proposal in Proposals » Custom Proposals (open the tab and click Team on the grid toolbar). This option displays in the drop-down list only when you create a merge template for the Project Info Center, and you select Associated Employees in the Table field. Proposal Team applies only for merge templates that you create specifically for Project Info Center sections of a custom proposal. If you add this merge code to a merge template that you use in the Project Info Center (instead of Custom Proposals), the merge codes are displayed instead of any actual team member when you generate a merged document.
<table>
<thead>
<tr>
<th>Address Fields for Associated Clients or Associated Vendors</th>
</tr>
</thead>
<tbody>
<tr>
<td>When you create a merge template for the Project, Employee, or Opportunity Info Center, and you select either <strong>Associated Clients</strong> or <strong>Associated Vendors</strong> in the <strong>Table</strong> field and <strong>Address</strong> in the <strong>Field</strong> field, after you click the <strong>Insert</strong> button on the Merge Codes dialog box, the <strong>Client Address</strong> or <strong>Vendor Address</strong> dialog box displays. This allows you to select the appropriate address for the associated client or vendor because they can have multiple addresses entered for them. You can also select which parts of the address (line 1, city, country, and so on) to include in the merge template.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Preceding text and Succeeding text</th>
</tr>
</thead>
<tbody>
<tr>
<td>You can add spaces, comma, or other text before or after fields directly in the InDesign active text frame when you create a merge template.</td>
</tr>
<tr>
<td>Examples: You add a space between a first name and a last name. You add a comma between the city and state in an address. You add the title “Total Cost” before a total cost field.</td>
</tr>
<tr>
<td>However, if you want the separators or text to not display if no data exists for a record, then instead of adding separators and text in the active text frame, enter them in the <strong>Preceding</strong> text and <strong>Succeeding</strong> text fields.</td>
</tr>
<tr>
<td>After you select a field in the <strong>Field</strong> field, in the <strong>Preceding text</strong> field enter the text (or space) that you want to appear before the field. In the <strong>Succeeding text</strong> field, enter the text (or space) that you want to appear after the field.</td>
</tr>
<tr>
<td>Example: You add an employee’s first, middle, and last names to a merge template. You enter a space in the <strong>Succeeding text</strong> field for both the <strong>Employee First Name</strong> and the <strong>Employee Middle Name</strong> fields. This adds a space between the first and middle name and a space between the middle and last name. For employees who have no middle name, their first and last name displays correctly with only one space between. If, instead of using the <strong>Preceding text</strong> and <strong>Succeeding text</strong> fields to enter the space separators, you entered the spaces directly in the InDesign active text frame between the first, middle, and last names, then the employees with no middle name would have two spaces between their first and last name, instead of one space.</td>
</tr>
<tr>
<td>You cannot use the following characters in the <strong>Preceding text</strong> and <strong>Succeeding text</strong> fields: [ ]</td>
</tr>
<tr>
<td>You cannot use a hard return (press the ENTER key on your keyboard) in these fields.</td>
</tr>
<tr>
<td>The <strong>Preceding text</strong> and <strong>Succeeding text</strong> fields are not enabled for memo fields.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Format section:</th>
</tr>
</thead>
<tbody>
<tr>
<td>The formatting options that display in this section are different, depending on the specific field or type of field that you select from the <strong>Field</strong> field drop-down list. The formatting options affects how the specific fields display in merged documents that are produced by the InDesign merge template that you are creating.</td>
</tr>
<tr>
<td>In the field description list that follows, the fields are grouped together by the specific field or the type of field that you enter in the <strong>Field</strong> field:</td>
</tr>
</tbody>
</table>
| • Proposal Graphic (an individual field)  
  • Currency or Number fields  
  • Currency Fields only  
  • Date fields |
| **No format options available for this field** |
| If you select a field that has no formatting options for it, then "**No format options available for this field**" displays in the **Format** section. |
| An example of a field that cannot be formatted is the **Project Manager Name** field. Fields such as number, date, and currency fields can be formatted. |
| **Vision Memo Fields** |
If you select a Vision memo field, then "No format options available for this field" displays in the Format section. For more information about the formatting that carries over to an InDesign merged document from Vision memo fields, see the "Vision Memo Fields and InDesign Merge Templates" help topic.

### Proposal Graphics
When you select Proposal Graphic from the Field drop-down list, the following Graphic Number field displays. You use the Proposal Graphic merge code to add graphics frames to a merge template. Then in Vision Custom Proposals, you can insert one or more graphic into a custom proposal section that uses the merge template.

| Graphic Number | After you select Proposal Graphic in the Field field, place your mouse pointer in the InDesign active text frame where you want to insert the graphic frame. Return to the Merge Codes dialog box, and enter the number of the graphic in the Graphic Number field. If this is the first graphic you are inserting, enter 1; if it is the second graphic you are inserting, enter 2, and so on.

Because you can have multiple graphics in a merge template, numbers are used to identify the different graphics in a merged document. For merge templates with multiple graphic merge codes, when you insert the graphic files in Custom Proposals, the first graphic file that you insert will be placed where the graphic 1 merge codes is located; the second graphic file that you insert will be placed where graphic 2 merge code is located; and so on.

After you enter a number in the Graphic Number field, click the Insert button to insert the merge code with an empty graphic frame into the InDesign active text frame.

For more information about inserting graphics, see the “Insert Merge Codes for a Graphic in an Adobe InDesign Merge Template” help topic. |

### Currency or Number Fields
The following fields display when you select a currency or number field from the Field drop-down list:

| Type | This displays the type of field (Currency or Number) that you entered in the Field field. |
| Use Regional Settings | This check box is selected by default. When it is selected, Microsoft Windows regional settings from the workstation of the user who generates a merged document will be used to format the currency or number field on the merged document.

When you select this check box, only some of the fields in this section are enabled for entry.

When you do not select this check box, all of the remaining settings in this section are enabled for entry. |
| Decimal Places | From the drop-down list, select the number of decimal places to use.

Options are 0, 1, 2, 3, 4, 5, 6, 7, 8, and 9.

When you select 0, no decimal symbol is displayed. |
| Decimal Symbol | From the drop-down list select the decimal symbol to use.

Options are comma and period:

• ,

• .

This field is enabled only when you do not select the Use Regional Settings check box. |
| Display Digit | Select this check box if you want a symbol, such as the comma, to be used as a
### Grouping Symbol

Thousands separator. This may make large numbers easier to read. You select the separator symbol to use in the next field—**Digit Grouping Symbol**.

Example that uses a comma as the digit grouping symbol (with two decimal places that use a period symbol):

- **Display Digit Grouping Symbol** check box is not selected: 2000000.00
- **Display Digit Grouping Symbol** check box is selected: 2,000,000.00

### Digit Grouping Symbol

From the drop-down list, select a symbol to use as a thousands separator.

Options are comma, period, or space:

- ,
- .
- (Space)

This field is enabled only when you do not select the **Use Regional Settings** check box, and you selected the **Display Digit Grouping Symbol** check box.

### Zero Number

From the drop-down list, select how you want a zero to display.

The options are:

- 0
- *Do Not Display* (it displays nothing)

If you have preceding or succeeding text next to a zero amount and you have selected *Do Not Display*, the preceding and succeeding text will also not display on a merged document. See the previous Field Options section for information about preceding and succeeding text.

### Currency Fields Only

The following fields display only when you select a currency field in the **Field** drop-down list:

#### Display Currency Symbol

Select this check box if you want the currency symbol to display.

This field applies if you use the Vision Multicurrency feature.

#### Symbol Location

This field is enabled when you select the **Display Currency Symbol** check box. From the drop-down list select whether you want the currency symbol placed to the left or right of the currency amount.

The symbols used are the symbols that you set up in Vision Configuration » General » Currencies.

#### Sample

This displays a sample of how the currency or number will display on a merged document, based on the settings that you selected in the **Format** section.

If you selected the **Use Regional Settings** check box, **Sample** displays a field’s format using your workstation’s regional settings, which may be different from the regional settings of another user who generates a merged document using the merge template.

### Date Fields

The following fields display when you select a date field in the **Field** drop-down list:

#### Type

From the drop-down list, select how you want the date to display in merged documents.

The options are:

- **Short Date** — Example: 10/23/13
- **Medium Date** — Example: October 23, 2013
**Long Date** — Example: Wednesday, October 23, 2013

| **Use Regional Settings** | This check box is selected by default. When it is selected, Microsoft Windows regional settings from the workstation of the user who generates a merged document will be used to format the date field on the merged document. When you select this check box, the **Date Separator** and the **Date Order** fields in this section are not enabled. When you do not select this check box, all the remaining fields in this section are enabled. |
| **Date Separator** | From the drop-down list, select the symbol to use to separate the month, day, and year in a date. Options are forward slash, hyphen, and period:  
- /  
- -  
- .  
Example using the hyphen symbol: 3-6-2013  
This field is enabled only when you select **Short Date** in the **Type** field, and you do not select the **Use Regional Settings** check box. |
| **Date Order** | From the drop-down list, select the order in which the month, day, and year will display for a date. Options are:  
- Month Day Year — Example: 3/27/2013  
- Day Month Year — Example: 27/3/2013  
- Year Month Day — Example: 2013/3/27  
This field is enabled only when you do not select the **Use Regional Settings** check box. |
| **Display Day** | Select one or more of these check boxes to display one, two, or all of the components that make up a date. For example, if a date field is a short date, when you select the **Display Month** and **Display Year** check boxes, September 5, 2013 displays as 9/13. When you select the **Display Day**, **Display Month**, and **Display Year** check boxes, September 5, 2013 displays as 9/5/13. |
| **Display Month** |  |
| **Display Year** |  |
| **Display Four Digit Year** | Select this check box to have the year display with all four digits, such as 2013 (instead of 13). This check box is enabled only when you select the **Display Year** check box. |
| **Display Leading Zeros** | Select this check box if you want a leading zero to display before a single-digit day or month. Example: With this check box selected, you will see August 9, 2013 displayed as 08/09/2013 instead of 8/9/2013. When you select only the **Display Day** or only the **Display Month** check box, the **Display Leading Zeros** check box is selected automatically, and you cannot change it. |
| **Sample** | This displays a sample of how dates will display on a merged document, based on the settings that you selected in the **Format** section. If you selected the **Use Regional Settings** check box, **Sample** displays a field’s format using your workstation’s regional settings, which may be different from the regional settings of another user who generates a merged document using the |
merge template.

**Buttons:**

<table>
<thead>
<tr>
<th>Insert Begin/End Codes</th>
</tr>
</thead>
</table>
| This button is enabled only after you select an associated or non-associated grid in the **Table** field. See the description for the **Table** field for more information about grids.  

Associated grid and non-associated fields (merge codes) that you add to a merge template must be placed between a [Begin] code and an [End] code.  

**Example:**  

[Begin]  

[grid field merge code] [another grid field merge code]  

[End]  

After you select an associated or non-associated grid in the **Table** field, click the **Insert Begin/End Codes** button to insert a [Begin] code and an [End] code into the active text frame in InDesign. Put your cursor between the [Begin] and [End] codes. Then, select a grid field in the **Field** field in the Merge Codes dialog box, and click the **Insert** button. The grid field is inserted between the [Begin] and [End] codes in the InDesign active text frame.  

Add multiple grid fields from the same grid between the [Begin] and [End] codes.  

Because grids can include many rows of data for multiple records, it is possible for the merged data to exceed the space allotted in an InDesign text frame. When this happens, you can manually adjust the text in the merged document. However, you can automatically allow larger quantities of text to flow onto the next page of a merged document by creating a second page with another text frame and link the two when you create the merge template.  

Regular fields (non-grid fields) do not require [Begin] and [End] codes.

<table>
<thead>
<tr>
<th>Insert</th>
</tr>
</thead>
</table>
| This button is enabled only after you select a table in the **Table** field and a field in the **Field** field.  

After you select a table and field to add to a merge template and you complete the fields on this dialog box, click the **Insert** button. This inserts the field (merge code) into the active text frame in InDesign.  

When you select **Proposal Graphic** in the **Field** field, you must put your mouse pointer in the InDesign active text frame in the location where you want to insert the graphic frame, enter a number in the **Graphic Number** field in the **Format** section on the Merge Codes dialog box, and then click **Insert**. For more information about inserting graphics, see the "Insert Merge Codes for a Graphic in an Adobe InDesign Merge Template" help topic.  

For more information about how the **Insert** and the **Insert Begin/End Codes** buttons work together when you select an associated or non-associated grid in the **Table** field, see the description above for the **Insert Begin/End Codes** button. |

<table>
<thead>
<tr>
<th>Save</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click this button to save the changes that you made to the merge template. The InDesign merge template .indt file is saved in Vision using SQL FILESTREAM capabilities.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Save and Close</th>
</tr>
</thead>
</table>
| When you finish adding Vision fields to the InDesign file, click the **Save and Close** button to save the merge template to Vision, close InDesign, and return to the Vision Merge Templates form.  

The InDesign merge template .indt file is saved in Vision using SQL FILESTREAM capabilities. After you save the merge template, you can access it again using the **Update** icon on the **Merge Templates** grid toolbar on the Merge Templates form.  

You cannot access the file directly in the InDesign software. |
Client Address Dialog Box

Use this dialog box to select which client address and which parts of the address from the associated Client grid to insert into a merge template that you are creating for the Project, Employee, or Opportunity Info Center.

This applies only for merge templates that you create with Adobe InDesign.

**Location**

To display the dialog box, complete the following steps:

1. From the Vision Navigation menu, click Configuration » General » Merge Templates.
2. When you add a new or update an existing merge template for the Project, Employee, or Opportunity Info Center, the Client Address dialog box opens when you click the Insert button on the Merge Codes dialog box, after you make the following entries on the Merge Codes dialog box:
   - Associated Clients in the Table field.
   - Address in the Field field.

**Contents**

<table>
<thead>
<tr>
<th>Address Type</th>
<th>From the drop-down list, select which address for the associated client to add to the merge template. Options are:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assigned</td>
<td>This is the address that is assigned in the Address Description column in the associated Client grid on the Clients/Contacts tab in the Project or Opportunity (whichever Info Center you are creating the merge template for). This option does not apply for a merge template for the Employee Info Center.</td>
</tr>
<tr>
<td>Primary</td>
<td>This is the address that has the Primary check box selected for a client on the General tab of the Client Info Center.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Fields list</th>
<th>In the Fields list, click an address part field (such as Address Line 1, City, Country, and so on) to add it to the merge template, and then click the Insert button. Repeat these steps to add all the desired address fields to the merge template.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text box</td>
<td>This text box below the Field list displays the merge codes for the address fields from the Fields list that you added to the merge template. For example, if you insert Address Line 1, City, State/Province Name, and Zip/Postcode, it displays as the following in the text box:</td>
</tr>
<tr>
<td></td>
<td>[Address Line 1]{Address1}#A#</td>
</tr>
<tr>
<td></td>
<td>[City]{City}#A#</td>
</tr>
<tr>
<td></td>
<td>[State/Province Name]{StateName}#A#</td>
</tr>
<tr>
<td></td>
<td>[Zip/Postcode]{Zip}#A#</td>
</tr>
</tbody>
</table>
Each address field will display on a separate line in a merged document. In the text box, you can manually add a comma or space between each address field if you want all the address fields to display on one line with a comma or space between each field (instead of each address field on a separate line) in a merged document.

You can also manually add other text into the text box, as well.

### Insert Address

When you finish selecting address fields for the merge template, click this button to insert all the address merge codes into the merge template.

### Cancel

Click this button to close the Client Address dialog box and unsaved changes will be lost. You are returned to the Merge Codes dialog box.

---

## Vendor Address Dialog Box

Use this dialog box to select which vendor address and which parts of the address from the associated Vendor grid to insert into a merge template that you are creating for the Project or Opportunity Info Center.

This applies only for merge templates that you create with Adobe InDesign.

### Location

To display the dialog box, complete the following steps:

1. From the Vision Navigation menu, click Configuration » General » Merge Templates.
2. When you add a new or update an existing merge template for the Project or Opportunity Info Center, the Vendor Address dialog box opens when you click the Insert button on the Merge Codes dialog box, after you make the following entries on the Merge Codes dialog box:
   - Associated Vendors in the Table field.
   - Address in the Field field.

### Contents

<table>
<thead>
<tr>
<th><strong>Address Type</strong></th>
<th>From the drop-down list, select which address for the associated vendor to add to the merge template.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Options are:</td>
</tr>
<tr>
<td></td>
<td>• Assigned — This is the address that is assigned in the Address Description column in the associated Vendor grid on the Team tab in the Project Info Center or on the Team tab in the Opportunity Center (whichever Info Center you are creating the merge template for).</td>
</tr>
<tr>
<td></td>
<td>• Primary — This is the address that has the Primary check box selected for the vendor on the General tab of the Vendor Info Center.</td>
</tr>
<tr>
<td><strong>Fields list</strong></td>
<td>In the Fields list, click an address part field (such as Address Line 1, City, Country, and so on) to add it to the merge template, and then click the Insert button. Repeat these steps to add all the desired address fields to the merge template.</td>
</tr>
<tr>
<td><strong>Insert button</strong></td>
<td>This text box below the Field list displays the merge codes for the address fields from the Fields list that you added to the merge template.</td>
</tr>
<tr>
<td><strong>Text box</strong></td>
<td>For example, if you insert Address Line 1, City, State/Province Name, and</td>
</tr>
</tbody>
</table>
Zip/Postcode, it displays as the following in the text box:

[Address Line 1]{Address1}#A#
[City]{City}#A#
[State/Province Name]{StateName}#A#
[Zip/Postcode]{Zip}#A#

Each address field will display on a separate line in a merged document.

In the text box, you can manually add a comma or space between each address field if you want all the address fields to display on one line with a comma or space between each field (instead of each address field on a separate line) in a merged document.

You can also manually add other text into the text box, as well.

### Insert Address
When you finish selecting address fields for the merge template, click this button to insert all the address merge codes into the merge template.

### Cancel
Click this button to close the Vendor Address dialog box and unsaved changes will be lost. You are returned to the Merge Codes dialog box.

---

**Vision Memo Fields and Adobe InDesign Merge Templates**

A Vision memo field is a field that has a text box in which you can type a larger amount of text, and then format it in the Vision Text Editor dialog box.

Examples of Vision memo fields:

- **Memo** field on the General tab in the Project Info Center
- **Notes** field on the General tab in the Client Info Center

### Formatting that Is Controlled by the Vision Text Editor

When you create an Adobe InDesign merge template in Vision **Configuration » General » Merge Templates** and you select a Vision memo field in the **Field** drop-down list on the Merge Code dialog box, the **Format** section on the Merge Code dialog box says “No format options available for this field.”

The following text formatting that you apply directly for the Vision memo field in the Vision Text Editor dialog box carries through and displays on InDesign merged document.

- Bolding
- Bullets
- Indentation
- Italics
- Numbering
- Underlining

### Formatting that You Can Control from within InDesign

You can control the following formatting attributes from within InDesign when you create a merge template:

- Case (if small, caps should be used)
- Color
- Columns
- Drop caps
- Font face (family)
- Font size
- Hyphenation
- Justification
- Keep Options
- Kerning (adjusting the spacing between characters)
- Leading
- Space before or after a paragraph

When you apply this formatting in InDesign, it overrides the formatting from the Vision memo field.

**Paragraph Styles Applied in InDesign**

In InDesign, when you apply a paragraph style to a Vision memo field merge code, then certain attributes, such as bullets and numbering, will be stripped from the memo field in a merged document. When you do not apply a paragraph style to a Vision memo field merge code, then the paragraph style of the merge text will be “basic paragraph.” This means that the attributes from the Vision Text Editor, such as bullets and numbering will be retained and displayed in a merged document.

**Text Quantity**

Vision memo fields can include a large amount of text, so it is possible for the merged data to exceed the allotted space in an InDesign text frame in a merged document. If this happens, you can manually adjust the text in the merged InDesign document. However, to automatically allow larger quantities of memo field text to flow onto the next page of a merged document, you can create a second page with another text frame and link the two when you create the merge template.

**Insert Merge Codes for Vision Grids in an Adobe InDesign Merge Template**

You can insert merge codes for grid fields from associated or non-associated grids in an Adobe InDesign merge template.

**To insert a grid field in an InDesign merge template, complete the following steps:**

1. When you are creating or editing an InDesign merge template in Vision, on the Merge Codes dialog box in Vision, select an associated or non-associated grid table from the drop-down list in the **Table** field.

   If you need more instructions on how to create a merge template and open the Merge Codes dialog box, see the "Create a Vision Merge Template with Adobe InDesign" help topic or the "Edit a Vision Merge Template with Adobe InDesign" topic.

2. Click the **Insert Begin/End Codes** button to insert a [Begin] code and an [End] code into the active text frame in InDesign.
Example of what this looks like in InDesign:

```markdown
[Begin]
[End]
```

3. In the InDesign active text frame, place your mouse pointer in between the begin and end codes.

4. Return to the Merge Codes dialog box, and from the Field field drop-down list, select the grid field to insert between the begin and end codes in the merge template.

5. Click the Insert button to insert the grid field into the InDesign active text frame between the begin and end codes.

Example of what this looks like in InDesign (the Company Name field was selected in the Field field):

```markdown
[Begin]
[Company Name|OrgCode1Name||Projects|All]
[End]
```

6. To add other grid fields from the same grid to the merge template, add these fields within the same begin and end codes by repeating steps 3–5.

Do not mix grid fields from different grids between one set of begin and end codes. You must use separate begin and end codes for different grid templates.

Because grids can include many rows of data for multiple records, it is possible for the merged data to exceed the space allotted in an InDesign text frame. When this happens, you can manually adjust the text in the merged document. However, you can automatically allow larger quantities of text to flow onto the next page of a merged document by creating a second page with another text frame and link the two when you create the merge template.

**Insert Merge Codes that Display the Contents of an Associated Grid Field for Only Certain Records in the Grid**

When you create a merge template in Adobe InDesign, you can insert merge codes that will display the contents of an associated grid field only for certain records (rows) in the grid. This applies for merge templates that you create for the Project, Client, Employee, or Opportunity Info Center.

For example, you might want the last name of only the employees who are designated as principals for the project to be included in a merge template for the Project Info Center. These employees have Principal entered in the Role column in the associated Employee grid (on the Team tab) of the Project Info Center.

To insert a merge code that displays the contents of an associated grid field for only certain records in the grid, complete the following steps:

1. When you are creating or editing an InDesign merge template for a Project, Client, Employee, or Opportunity Info Center, on the Merge Codes dialog box in Vision, select an associated grid table from the drop-down list in the Table field.

   If you need more instructions on how to create a merge template and open the Merge Codes dialog box, see the “Create a Vision Merge Template with Adobe InDesign” help topic or the “Edit a Vision Merge Template with Adobe InDesign” topic.
2. Click the **Insert Begin/End Codes** button to insert a [Begin] code and an [End] code into the active text frame in InDesign.

   Example of what this looks like in the active text frame in InDesign:

   \[\text{[Begin]}\]
   \[\text{[End]}\]

3. In the InDesign active text frame, place your mouse pointer in between the begin and end codes.

4. Return to the Merge Codes dialog box, and from the **Field** field drop-down list, select the associated grid field to insert between the begin and end codes in the merge template.

5. In the **Select Specific** field in the **Options** section, select the records for which you want the associated grid field that is entered in the **Field** field to display in the merge template.

6. Click the **Insert** button to insert the grid field into the InDesign active text frame between the begin and end codes.

   Example of what this looks like in InDesign (**Associated Employees** is selected in the **Table** field; **Employee Role** is selected in the **Field** field; and **Principal** is selected in the **Select Specific Role** field):

   \[\text{[Begin]}\]
   \[\text{[Employee Role|employeeRole||Employees|sysPR]}\]
   \[\text{[End]}\]

7. On the Merge Code dialog box, click **Save**.

---

**Insert Vision Data into a Table in an Adobe InDesign Merge Template**

When you create a merge template in Adobe InDesign, you can add Vision data in a table format. The following instructions assume that you already know the general steps to create an InDesign merge template in Vision that are outlined in the “Create a Vision Merge Template with Adobe InDesign” or the “Edit a Vision Merge Template with Adobe InDesign” topic.

**To add Vision fields to a table in an InDesign Merge Template, complete the following steps:**

1. When you are creating or updating an InDesign merge template in Vision **Configuration > General > Merge Templates**, in the InDesign active text frame, place your mouse pointer where you want to insert a table.

2. If you are creating a table that will contain only Vision standard fields that are not fields from a Vision grid (either an associated or non-associated grid): On the toolbar in the InDesign active text frame, click **Table > Insert Table**.

   Grid fields are columns in a Vision grid. An example is the **Start Date** in the **Projects** grid on the Project tab in the Employee Info Center.
3. If you are creating a table that will contain Vision grid fields (associated or non-associated grids) or a mix of standard and grid fields:
   
   a. In the Table field on the Vision Merge Code dialog box, select the Vision associated or non-associated table from which you want to add fields to a table in the InDesign active text frame. Then click the Insert Begin/End Code button.

   This inserts a begin code and an end code ([Begin] and [End]) in the InDesign active text frame where you had your mouse pointer.

   When you add Vision grid fields to a table format, the table must be inserted between a begin and end code. If a table does not contain grid fields, it does not require a begin and end code.

   b. Place your mouse pointer between the begin and the end code, and then click Table » Insert Table on the InDesign toolbar.

4. On the Insert Table dialog box, enter the table dimensions (number of rows, columns, header rows, and footer rows) and table style. Then click OK.

5. In the table that displays in the active text frame, if you entered header and footer rows, enter header and footer text in the first and last rows.

6. Click your mouse pointer in a cell of a data row, and then on the Vision Merge Code dialog box, select the field in the Field field that you want to insert in the cell, and click the Insert button.

   If you have not already selected a Vision database table in the Table field, you must select a table before you can select a field in the Field field.

   The field is inserted into the table in the InDesign active text frame.

7. Repeat step 6 to continue adding Vision fields to each cell in a data row of the table in the InDesign active text frame.

   You can insert more than one Vision field in one cell in the table. For example, you can insert an employee’s first name and last name fields in one table cell.

   You can insert both standard Vision fields and grid fields into one table as long as the table is between a begin and end code.

8. When you finish adding fields to the table cells, save the merge template file.

**Import an Adobe InDesign Merge Template into Vision**

You can import an existing Adobe InDesign merge template into Vision in Merge Templates Configuration.

This is an alternative to creating a new InDesign merge template from scratch in Vision Merge Templates Configuration. For example, you may want to import a sample InDesign merge template from the Deltek Customer Care Connect site (see Knowledge Base article # 73879 at the Deltek Customer Care Connect site to download the sample merge templates).

To import an existing InDesign merge template into Vision, complete the following steps:
1. From the Vision Navigation menu, click Configuration » General » Merge Templates.

2. On the Merge Templates form, select the Info Center for the merge template in the dropdown list in the Info Center Area field.

3. On the Merge Templates form, click Add on the Merge Templates grid toolbar, and from the drop-down list, select Import Adobe InDesign Template.

4. On the Add Merge Template dialog box, enter a description for the merge template in the Description field.

5. Click the Browse button, and in the Please Select an InDesign File dialog box, navigate to and select the .indt merge template file to import into Vision.

You can also select an InDesign .indd file. When it is imported into Vision, it is saved as an .indt file within Vision.

6. Click OK to return to the Merge Templates form.

The contents of the InDesign .indt file are copied and saved in Vision. The name of the .indt file in Vision is based on the description that you entered in the Description field on the Add Merge Template dialog box.

You are returned to the Merge Templates form where a new row for the template has been added to the Merge Templates grid. The Description and Template File Name columns prefill with the entries on the Add Merge Template dialog box.

Update Merge Templates

Use the Update process in Merge Templates Configuration to apply or make modifications to merge templates that have previously been added to Vision.

The Update process works differently for each merge template file type:

- For Microsoft Word .rtf template files: In Word, you make modifications to an .rtf merge template (to the original .rtf file that you added as a Vision merge template or in a new .rtf file). Then use the Update process to copy the revised content in the .rtf file into the merge template in Vision.

You can use the Export process in Merge Templates Configuration when you need to modify a Word .rtf merge template file that has been previously added to Vision, and a copy of the .rtf file is not immediately available on your network or local drive. When you export, an .rtf file is created using the contents of the merge template that was added to Vision. You save the exported .rtf file to the desired location on your workstation or network drive, and modify it in Word. Then use the Update process to copy the updated content in the exported .rtf file back into the existing merge template in Vision.

- For Adobe InDesign .indt template files: Use the Update process to directly modify the template's contents file in InDesign within Vision.

To update an existing Word or InDesign merge template, complete the following steps:

1. From the Vision Navigation menu, click Configuration » General » Merge Templates.

2. In the Info Center Area field on the Merge Templates form, select the Info Center for the template that you want to update.
3. In the **Merge Templates** grid, select the merge template to update.

4. Click ✉️ **Update** on the grid toolbar.

5. The remaining steps are different for each type of merge template file:
   - For Microsoft Word .rtf template files, the Update Merge Template dialog box displays.
     a. On the Update Merge Template dialog box, click the **Browse** button beside the **Merge Template** field.
     b. On the Open dialog box, navigate to and select the .rtf file that contains the modified or new content for the merge template, and then click **OK**.
     c. On the Update Merge Template dialog box, click **OK**.
       The contents of the Word .rtf file are copied into the merge template in Vision, and you are returned to the Merge Templates form.
   - For Adobe InDesign .indt template files, Adobe InDesign opens.
     a. In InDesign, make changes to the merge template file.
     b. Save and close the merge template from the Merge Codes dialog box in InDesign.
       The InDesign .indt file is saved in Vision, and you are returned to the Merge Templates form. If you save the .indt file in InDesign using **File » Save** or **File » Save As**, the .indt file is not saved to Vision. It is saved to a location that you choose on your workstation or a network drive.

### Export Merge Templates

When you export a Microsoft Word merge template file from Vision, it saves a copy of the .rtf file outside of Vision on your local machine or a network drive.

The **Export** option in Merge Templates Configuration applies only for merge templates that are created with Microsoft Word (.rtf files). You cannot export Adobe InDesign .indt files.

You can use the Export option when you need to modify an .rtf merge template file that has been previously added to Vision, and a copy of the .rtf file is not immediately available on your network or local drive. After you export the .rtf file, you can modify the exported copy in Word. Then use the Update option in Vision Merge Templates Configuration to copy the contents of the updated .rtf file back into the existing merge template in Vision. If you already have a copy of an .rtf file that has been added to Vision, you do not need to export the file from Vision before you modify it.

**To export a merge template file, complete the following steps:**

1. From the Vision Navigation menu, click Configuration » General » Merge Templates.

2. In the **Info Center Area** field on the Merge Templates form, select the Info Center that you want to export.

3. In the Merge Templates grid, select the Word merge template that you want to export.

4. Click ✉️ **Export**.

5. On the File Download dialog box, specify whether you want to open or save the file.
When you click **Save** on the File Download dialog box, the Save As dialog box opens, and you enter the location in which to save the file. When you click **Save**, an .rtf file for the template downloads to the folder that you selected.

When you click **Open** on the File Download dialog box, the file display on the screen in Word. You can make edits and save the file.

---

When you make changes to an exported .rtf file in Word and save the changes, the changes are not automatically saved in the Vision database. To save the changes to the Vision database, you must also update the merge template in Vision using the **Update** option in Merge Templates Configuration. This copies the contents of the .rtf file back into the existing merge template in Vision.

You are returned to the Merge Templates form.

### Copy Merge Templates

You can copy an existing merge template in Vision to create a new merge template. This applies for both Microsoft Word and Adobe InDesign merge templates.

**To copy an existing merge template, complete the following steps:**

1. From the Vision Navigation menu, click **Configuration » General » Merge Templates**.
2. In the **Info Center Area** field on the Merge Templates form, select the Info Center for the template that you want to copy.
3. In the Merge Template grid, select (click) the merge template to copy.
4. Click **Copy** on the grid toolbar.
   
   A new row is inserted in the grid, and the **Template File Name** and **Type** columns prefill with the information from the template that you copied.
5. In the **Description** column, enter a description for the new merge template.
   
   When you move away from this field, the description is used to rename the file in the **Template File Name** column.
6. Click **Save** on the Merge Templates form toolbar.

### Delete Merge Templates

You can delete a Microsoft Word or Adobe InDesign merge template from the Vision database. Ensure that you no longer need a template before you delete it because the deletion cannot be undone. You cannot delete system default or sample templates.

After a template is deleted, it is no longer accessible in the Merge Templates functional area on the Access Rights tab of Role Security. It is no longer accessible in the Info Centers or Custom Proposals.

**To delete a merge template from Vision, complete the following steps:**

1. From the Vision Navigation menu, click **Configuration » General » Merge Templates**.
2. In the **Info Center Area** field on the Merge Templates form, select the Info Center for the template that you want to delete.
3. In the Merge Templates grid, select the template to delete.
4. On the grid toolbar, click Delete.
5. On the dialog box that says "The merge template that you selected will be permanently deleted, and all references to it will be lost. Do you want to continue?" click Yes.

Assign Merge Templates to a Security Role

A system administrator can assign specific merge templates to each security role, so users have access to only the templates that they need to use. All users have access to 254/255 merge templates, regardless of their security roles.

To assign merge templates to a security role, complete the following steps:

2. In the Search field on the Roles form, select the security role for which you want to assign merge templates.
3. Open the Access Rights tab, and from the drop-down list in the Functional Area field, select MergeTemplates.
4. In the drop-down list in the Info Center field, select the Info Center for the merge templates that you want to assign to the security role.
5. In the Available Templates pane, click a merge template name, and then click the Add -> button to make the template accessible to the security role.
   The template name now displays in the Templates for this Role pane.
6. Repeat step 5 to add other templates for the security role.
7. When you finish adding merge templates for a role, click Save.

Add Merge Template Dialog Box

Use this dialog box to add a Microsoft Word merge template, create an Adobe InDesign merge template, or import an existing InDesign merge template into Vision.

Location

To display the dialog box, complete the following steps:

1. From the Vision Navigation menu, click Configuration » General » Merge Templates.
2. On the Merge Templates grid toolbar on the Merge Templates form, click Add, and then select any of the options (Microsoft Word Template, Create Adobe InDesign Template, or Import Adobe InDesign Template) in the drop-down list.

Contents

<table>
<thead>
<tr>
<th>Info Center Area</th>
<th>This field displays the Info Center that you selected on the Merge Template form. This is the Info Center for which you are adding, creating, or importing the merge template.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Enter a description for the new template. The description displays in the Description field in the Merge Templates grid on the</td>
</tr>
</tbody>
</table>
Merge Templates form.

If you are creating an Adobe InDesign merge template, the description that you enter in the **Description** field is also used for the .indt file name that is prefilled in the **Template File Name** field on the Merge Templates form.

<table>
<thead>
<tr>
<th>Merge Template and Browse</th>
</tr>
</thead>
<tbody>
<tr>
<td>This field and button apply only if you are adding a Word merge template or importing an existing InDesign merge template. These are not enabled when you are creating an InDesign merge template within Vision.</td>
</tr>
<tr>
<td>Click the <strong>Browse</strong> button and in the Open dialog box, navigate to and select the Word or InDesign merge template file. The Word file must be an .rtf file. The InDesign file must be an .indt file. The file that you select displays in the <strong>Merge Template</strong> field.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>OK</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>When you add a Word merge template:</strong></td>
</tr>
<tr>
<td>After you enter a description and select a Word file, click <strong>OK</strong>. The contents of the Word .rtf file are copied and saved in Vision. You are returned to the Merge Templates form where a new row for the template has been added to the <strong>Merge Templates</strong> grid. The <strong>Description</strong> and <strong>Template File Name</strong> columns prefill with the entries from the Add Merge Template dialog box.</td>
</tr>
<tr>
<td><strong>When you create an InDesign merge template:</strong></td>
</tr>
<tr>
<td>After you enter a description, click <strong>OK</strong>. Adobe InDesign is launched automatically if you have InDesign installed. In InDesign, create a Vision merge template. For more information, see the Create a Vision Merge Template with Adobe InDesign help topic.</td>
</tr>
<tr>
<td><strong>When you import an InDesign merge template:</strong></td>
</tr>
<tr>
<td>After you enter a description and select an InDesign file, click <strong>OK</strong>. The contents of the InDesign .indt file are copied and saved in Vision using SQL FILESTREAM capabilities. You are returned to the Merge Templates form where a new row for the template has been added to the <strong>Merge Templates</strong> grid. The <strong>Description</strong> and <strong>Template File Name</strong> columns prefill with the entries on the Add Merge Template dialog box.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Cancel</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click <strong>Cancel</strong> to discard entries that you made on the Add Merge Template dialog box since the last save, and return to the Merge Templates form.</td>
</tr>
</tbody>
</table>

### Update Merge Template Dialog Box

Use the Update Merge Template dialog box to apply modifications to Microsoft Word merge templates that have previously been added to Vision. You make the modifications to the Word .rtf outside of Vision before you use the **Update** option in Vision.

This dialog box does not apply for Adobe InDesign merge template files.

### Location

**To display the dialog box, complete the following steps:**

1. From the Vision Navigation menu, click **Configuration » General » Merge Templates**.
2. In the **Info Center Area** field on the Merge Templates form, select the Info Center for the Word merge template that you are updating in Vision.
3. In the **Merge template** grid, select the Word .rtf merge template that contains the revisions that you want to apply to the existing merge template.

4. Click **Update** on the grid toolbar.

### Contents

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Info Center Area</strong></td>
<td>This field displays the Info Center area that you selected on the Merge Template form.</td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>This field displays the merge template’s description, which you can change as needed. (You can also change the description directly on the Merge Templates form.)</td>
</tr>
<tr>
<td><strong>Merge Template and Browse</strong></td>
<td>Click the <strong>Browse</strong> button to the right of the <strong>Merge Template</strong> field to navigate to the .rtf file that contains the revisions that you want to apply to the existing merge template in Vision.</td>
</tr>
<tr>
<td><strong>OK</strong></td>
<td>Click <strong>OK</strong> to save the entries that you made on this dialog box. The contents of the Word .rtf file are copied into the merge template in Vision, and you are returned to the Merge Templates form.</td>
</tr>
<tr>
<td><strong>Cancel</strong></td>
<td>Click <strong>Cancel</strong> to discard the entries that you made on this dialog box since the last save. You are returned to the Merge Templates form.</td>
</tr>
</tbody>
</table>

### Add Microsoft Word Merge Templates to Vision

Add a merge template that you created with Microsoft Word to Vision, so that you can generate merged documents with it in Vision Info Centers and Custom Proposals.

When you add a merge template to Vision that is created in Microsoft Word:

- You must create the merge template .rtf file in Word first before you add it to Vision.
- The contents of the .rtf file are copied into Vision.

**To add a new merge template created with Word to Vision, complete the following steps:**

1. From the Vision Navigation menu, click **Configuration » General » Merge Templates**.
2. On the Merge Templates form, select the appropriate Info Center for the template in the **Info Center Area** field.
3. On the **Merge Templates** grid, click **Add**, and then select **Microsoft Word Template**.
4. On the Add Merge Template dialog box, enter a description for the merge template in the **Description** field.
5. In the **Merge Template** field, navigate to and select the .rtf file that contains the contents for the merge template.
6. Click **OK**.

The contents of the Word .rtf file are copied and saved in Vision. You are returned to the Merge Templates form where a new row for the template is added to the **Merge**
Templates grid. The Description and Template File Name columns in the grid prefill with the entries that you made on the the Add Merge Template dialog box.

**Merge Info Center Records to Create a Document Using a Microsoft Word Merge Template**

Use the merge feature to create a document that contains data from one or more records from an Info Center.

To create the merged document, you select:

- Specific Info Center records, such as which employees, to include in the document.
- The merge template to use. This determines the data from the Info Center records to include in the document and the document's formatting.

The merge feature is available if the Vision CRM module is activated.

**Prerequisites:**

- Before you can create a merged document, you must create a merge template and then add the template to the appropriate Info Center in Configuration » General » Merge Templates.
- The CRM check box in the Type of Role section on the General tab in Roles Security Configuration must be selected for your security role.

**To create a merged document in an Info Center using a Microsoft Word merge template, complete the following steps:**

1. From the Vision Navigation menu, click Info Center and open the Info Center that contains data that you want to include in the merged document.

2. On the Info Center form, use the Search field to open a record that you want to include in the merged document.

   In the record Lookup in this field, you can select all the records you want to include if you want to merge multiple records in one document. You can also select the specific records to merge in the next steps.

3. On the form toolbar, click Merge, and select one of the following actions:

   - Select **Merge Current <Record>** to merge data from the current record that is displayed on the Info Center form.
   - Select **Merge Active Group** to merge data from all the Info Center records that are currently active. These are the multiple Info Center records that you selected in the Lookup dialog box from the Search field on the Info Center form.
   - Select **Select <Record> to Merge** to select the specific records that you want to include in the document.

4. On the Merging dialog box, complete the following actions:

   a. Click the down-arrow in the field to the left of the Add Favorite button to select a different group of merge templates to display in the Merge Templates grid.
b. To select a merge template for the document, click the row in the **Merger Templates** grid that displays the appropriate merge template name.

c. If you did not select the records for the merge from the Lookup in the **Search** field on the Info Center form, click the **Selection** field in the grid. Then click **Find** to open the Lookup dialog box and choose a different record or multiple records to include in the merge document.

d. Optional. To create an activity for the merge, select the **Create Activity** check box. The merge activity will be added to the **Activities** grid of all records included in the merge document.

e. Click **Merge**.

5. On the Merged Document dialog box, enter a file name for the merged document in the **Merged Document Name** field, and click **OK**.

6. On the File Download dialog box complete one of the following actions:

   - Click **Save** to open a standard Windows Save As dialog box to save the merged document to the desired location. After the file is saved, you are returned to the Merging dialog box.

   - Click **Open** to open and view the merged document in Microsoft Word. You can save the file from within Word to a desired location. When you close the document, you are returned to the Merging dialog box.

7. If you selected the **Create Activity** check box on the Merging dialog box, complete the fields in the Activities dialog box that displays.

   Notice that the activity **Type** field prefills with **Merge**.

8. Click **OK**. The merge is added to the **Activities** grid on the Activities tab of each record that is included in the merge.

9. When you are finished creating merged documents, click **Close** on the Merging dialog box.

### Merge Info Center Records to Create a Document Using an Adobe InDesign Merge Template

Use the Merge feature to create a document that contains data from one or more records from an Info Center.

To create a merged document, you select:

- Specific Info Center records, such as which employees, to include in the document.
- The merge template to use. This determines the data from the Info Center records to include in the document and the document’s formatting.

The Merge feature is available if you use Vision CRM.

### Prerequisites

- Before you can create a merged document, you must create a merge template and then add the template to the appropriate Info Center in **Configuration » General » Merge Templates**.

- Before you can create a merged document using a merge template created with Adobe InDesign, you must have Adobe InDesign installed. You must also run InDesign as an
To create a merged document in an Info Center using an InDesign merge template, complete the following steps:

1. From the Vision Navigation menu, click **Info Center** and open the Info Center that contains data that you want to include in the merged document.

2. On the Info Center form, use the **Search** field to open a record that you want to include in the merged document.

   In the record Lookup in this field, you can select all the records that you want to include in the merged document if you plan to include multiple records in the document. You can also select the specific records in the next steps.

3. On the form toolbar, click **Merge**, and select one of the following actions:

   - Select **Merge Current <Record>** to merge data from the current record that is displayed on the Info Center form.

   - Select **Merge Active Group** to merge data from all the Info Center records that are currently active. These are the multiple Info Center records that you selected in the Lookup dialog box from the **Search** field on the Info Center form.

   - Select **Select <Record> to Merge** to select the specific records that you want to include in the document.

4. On the Merging dialog box, complete the following actions:

   a. Click the down-arrow in the field to the left of the **Add Favorite** button to select a different group of merge templates to display in the **Merge Templates** grid.

   b. To select a merge template for the document, click the row in the **Merger Templates** grid that displays the appropriate merge template name.

   c. If you did not select the records for the merge from the Lookup in the **Search** field on the Info Center form, click the **Selection** field in the grid. Then click **Find** to open the Lookup dialog box and choose a different record or multiple records to include in the merge document.

   d. Optional. To create an activity for the merge, select the **Create Activity** check box. The merge activity is added to the **Activities** grid of all records included in the merged document.

   e. Click **Merge**.

5. You receive a message that says **Please wait while Adobe InDesign merges the selected <Info Center records>**. When the merge process completes, InDesign opens and displays the merged document.

   In InDesign, you see that the name assigned to the file is based on what was entered in the **Merge Template Description** field on the Vision Merging dialog box.

6. In InDesign, you can do whatever you need to do to the document. You can print it, make changes to it, email it, save it, and so on.
7. When you finish, close InDesign and you are returned to the Vision Merging dialog box.

On the Merging dialog box, if you merge again using the same InDesign merge template without first closing the open InDesign output file, when Vision produces the new merged document in InDesign, the file name assigned is the same as the name previously used, but it is appended to include incremented numbers.

8. If you selected the Create Activity check box on the Merging dialog box, complete the fields in the Activities dialog box that displays.

Notice that the activity Type field prefills with Merge.

9. Click OK.

The merge is added to the Activities grid on the Activities tab of each record that is included in the merge.

10. When you are finished creating merged documents, click Close on the Merging dialog box.

**Merging Dialog Box**

Use the Merging dialog box to select a merge template, specify records to merge, and run the merge process to produce a merged document.

**Location**

**To display the Merging dialog box, complete the following steps:**

1. From the Vision Navigation menu, click Info Center, and then click the Info Center from which you want to create a merged document.

2. On the Info Center form, select the Info Center records to merge in the Search field.

3. On the Info Center form toolbar, click Merge and select one of the following:
   - Merge Current <Record>
   - Merge Active Group
   - Select <Record> to Merge

**Contents**

**Fields**

<table>
<thead>
<tr>
<th>Display</th>
<th>Click the down arrow in this field, and from the drop-down list select the group of merge templates that you want to display on the Merging dialog box.</th>
</tr>
</thead>
</table>
| Options | **All Merge Templates**  
**Favorite Merge Templates**  
**Microsoft Word (.rtf) Templates**  
**Adobe InDesign (.indt) Templates** |

| Add Favorite | Click this button to create a favorite template. |
Delete Favorite | Click this option to delete a favorite report from the grid. This button displays only when you select Favorite Merge Templates from the drop-down list in the display field.

Info Center | This prefills with the Info Center that you currently have open. If you want to create a merged document using a different Info Center, click the down arrow in this field and select a different Info Center.
If you select a different Info Center, you must select one or more new records from that Info Center in the Selection column in the Merge Templates grid.

Merge Templates Grid

| Merge Templates Drop-down in the toolbar | The Vision grids contain a drop-down list that displays a combination of the following options:
  - Print
  - Export to Excel
  - Enable Grouping |

| Merge Template Description | This column displays the name of the merge template. The merge templates are added to Vision in Configuration » General » Merge Templates.
To select a merge template to use for the merged document, click the row in the grid that displays the appropriate merge template name. |

| Selection | This field prefills based on which the merge option you select after you click the Merge icon on the Info Center form toolbar.
  - If you selected Merge Current <Record>, the name of the current record that is displayed on the Info Center form displays in this field.
  - If you selected Merge Active Group, <based on navigation group> displays in this field. This represents the multiple records that you selected using the Lookup in the Search field on the Info Center form.
  - If you selected Select <Record> to Merge, this field is blank. Click the field, and then click Find to display a Lookup. Use the Lookup to select the records that you want to include in the merged document. After you select a record, <record selected> displays in this field. Regardless of what prefills in this field, you can click this field, and then click Find to open the Lookup and select one or more records for the merge. After you make selections, <record selected> displays in this field. |

| Type | This column displays the merge template file type. The software that was used to create the merge template and merge template file extension are listed in this field.
  - Microsoft Word (.rtf)
  - Adobe InDesign (.indt) |

Fields and Buttons

| Refresh | Click this button to undo any changes you made in the Merge Templates grid on this dialog box. Any entries that you made to the Selection column are reversed. The merge template description that you clicked (selected) is unselected, and the |
focus moves to the first merge template description in the grid.

| Create Activity | Select this check box to automatically create an activity for the merge. When you select this option, after the merged document is created, the Activities dialog box displays. When you click OK on the dialog box, the merge activity is added to the Activities grid of all records included in the merge. This option does not display when you are merging vendor or text library records. |
| Merge | Click this button to merge records using the selected template to create a document. |
| Close | Click this button to close the Merging dialog box without creating any merge documents. |
| Help | Click this button to display online help for the Merging dialog box. |

**Merged Document Dialog Box**

Use this dialog box to enter a file name for the document that is produced by the merge process when you use a merge template created in Microsoft Word.

**Location**

To display the Merged Document dialog box, complete the following step:

1. From the Vision Navigation menu, click **Info Center**, and then select the Info Center from which you want to create a merged document.
2. On the Info Center form, use the **Search** field to open a record that you want to include in the merged document.
3. On the Info Center toolbar, click **Merge**, and select one of the following to open the Merging dialog box:
   - **Merge Current <Record>**
   - **Merge Active Group**
   - **Select <Record> to Merge**
4. On the Merging dialog box, click the **Merge** button.

**Contents**

| Merged Document Name | Enter a file name for your merged document. |
OK | Click OK to open the File Download dialog box. On this dialog box, you select whether to save or open the merged document in Word.

Help | Click this button to open the online Help topic for this dialog box.

File Download Dialog Box
Use this dialog box to open or save a merged document that is generated from an Info Center using a merge template created with Microsoft Word.
This does not apply to merged documents that are created with a merge template created with Adobe InDesign.

Location
To display the Merged Document dialog box, complete the following step:
1. Click the OK button on the Merged Document dialog box.

Contents
Open | Click this button to open the merged document in Word (as an .rtf file).
In Word, you can edit it, save it, email it, and so on. When you close the file, you are returned to the Vision Merging dialog box.

Save | Click this button to save the merged document as an .rtf file to a desired location without opening the file.
The standard Windows Save As dialog box displays. The name that you in the Merged Document Name field on the Merged Document dialog box prefills in the File name field. When you click Save on this dialog box, the .rtf file is saved, and you are returned to the Merging dialog box.

Cancel | Click this button return to the Merging dialog box without opening or saving the merged document.

Custom Proposals Overview
Use Vision Custom Proposals to create proposals for a private firm or for a government or other public entity if the SF254, SF255, and SF330 proposals are not applicable. Custom Proposals can contain data from any of the Vision Info Centers except the Account and Unit Info Centers. These Info Centers are part of the Vision Accounting module and are not available in Vision Proposals. You search the Info Center for applicable employee, project, consultant, text, graphics, and client reference records to insert into private and public sector proposals. The select data selected for proposals can then be tailored to meet your clients’ specifications.

Overview of the Custom Proposals Process:
1. You create and add merge templates for custom proposals to Vision (in Microsoft Word and in Vision Configuration » General » Merge Templates).
   Merge templates contain merge codes that retrieve data from an Info Center. The templates also contain your company's styles for proposals: page layouts, font settings, graphics locations, and other details.

2. You create custom proposal sections and add records to a custom proposal (in Proposals » Custom).
3. You merge the proposal to generate a custom proposal document (in **Proposals » Custom**).

The Custom Proposals application is installed with a set of sample merge templates—.rtf files created with Microsoft Word—that you can modify. You can also create Word merge templates from scratch. In addition, you can create merge templates with Adobe InDesign (.indt files).

You can re-use merge templates to make different proposals. You can create different merge templates for different clients or different groups of proposals. You can also use Custom Proposals to make templates for mail merge documents or simple reports.

**Custom Proposals Graphics and Adobe InDesign Merge Templates**

You can add graphics to a Vision custom proposal that uses a merge template created with Adobe InDesign.

**Summary of the Process**

<table>
<thead>
<tr>
<th>Step #</th>
<th>Step</th>
<th>Where to Perform This</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Link the actual graphics file to a Vision Info Center record.</td>
<td>In the grid on the Files tab in a Vision Info Center.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>In the grid, you must also select the check box in the <strong>Graphic</strong> column.</td>
</tr>
<tr>
<td>2</td>
<td>Create a merge template for a section of a custom proposal using Adobe InDesign.</td>
<td>In Vision <strong>Configuration » General » Merge Templates</strong>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>You use the <strong>Proposal Graphic</strong> merge code as a placeholder for graphic files.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>This merge code inserts an empty graphics frame into the merge template.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>You can insert one or more graphic merge codes.</td>
</tr>
<tr>
<td>3</td>
<td>Assign an InDesign merge template that contains graphics merge codes to a section of a custom proposal.</td>
<td>In <strong>Proposals » Custom</strong>, use the <strong>Sections</strong> toolbar option on the Custom Proposals form.</td>
</tr>
<tr>
<td>4</td>
<td>Insert the graphics files into the custom proposal section (merge template).</td>
<td>In <strong>Proposals » Custom</strong>: On the section tab on the Custom Proposals form, use the <strong>Graphics</strong> toolbar option.</td>
</tr>
<tr>
<td>5</td>
<td>Generate the custom proposal (merged document) that displays the graphic.</td>
<td>In <strong>Proposals » Custom</strong>: On the Custom Proposals form, use the <strong>Merge Proposal</strong> toolbar option.</td>
</tr>
</tbody>
</table>
Insert Merge Codes for a Graphic in an Adobe InDesign Merge Template

Use the Proposal Graphic merge code to add a graphics frame to an Adobe InDesign merge template. The graphics merge code is a placeholder that allows you to insert one or more graphic files in Vision Custom Proposals to a section of a custom proposal.

To insert a graphics merge code in an InDesign merge template, complete the following steps:

1. When you are creating or editing an InDesign merge template in Vision, on the Merge Codes dialog box in Vision, select Proposal Graphic from the drop-down list in the Field field.

   If you need more instructions on how to create a merge template and open the Merge Codes dialog box, see the “Create a Vision Merge Template with Adobe InDesign” help topic or the “Edit a Vision Merge Template with Adobe InDesign” topic.

2. In the InDesign active text frame, place your mouse pointer in the location where you want to insert the graphics merge code.

3. Return to the Merge Codes dialog box, and in the Format section, enter the number 1 in the Graphic Number field if this is the first graphic you are inserting into the template.

   Because you can have multiple graphics in a merge template, numbers are used to identify the different graphics in a merged document. For merge templates with multiple graphics merge codes, when you insert the graphic files in Custom Proposals, the first graphic that you insert will be placed where the graphic 1 merge codes is located; the second graphic file that you insert will be placed where graphic 2 merge code is located; and so on.

4. Click the Insert button to insert the proposal graphic merge code into the InDesign active text frame.

   In the InDesign active text frame, you now see an empty graphic frame inserted between the begin code [Proposal Graphic|[Graphic] 1] and the end code [][End Graphic]).

5. To add more graphic frames to the merge template, repeat steps 2–4, and enter the next number in the Graphic Number field.

After you add a graphic frame to the merge template, you can use any functionality in InDesign to change the frame properties and format the graphic in InDesign.

Some examples of the formatting that you can change:

- Size — The height and width of the graphic
- Resizing — Whether or not the graphic is resized to within the frame or merged as-is (so you may only see a piece of the graphic).
- Wrapping of other objects, such as text around the graphic.
- Stroke (Borders)
- Effects, such as drop-shadows
- Justification
- Transparency

After you create a merge template that contains graphics merge codes, in Vision Custom Proposals, you insert the merge template into a custom proposal section and then insert the graphic files into the custom proposal section.
Insert Merge Codes for Project Descriptions in an Adobe InDesign Merge Template

Use the Proposal Description merge code to insert project descriptions into a custom proposal. The descriptions come from the Description grid on the Background tab of the Project Info Center.

This applies if you are using an Adobe InDesign merge template for a custom proposal section in Vision Custom Proposals.

Prerequisites

In the Project Info Center, enter project descriptions in the Descriptions grid on the Background tab.

To insert a project description merge code in an Adobe InDesign merge template, complete the following steps:

1. Follow the steps in the “Create a Vision Merge Template with Adobe InDesign” help topic or the “Edit a Vision Merge Template with Adobe InDesign” topic to create or edit a merge template with InDesign.
2. Be sure you select Projects in the Info Center Area field on the Merge Templates form.
3. On the Merge Codes dialog box, select Projects in the Table field.
4. In the drop-down list in the Field field, select Proposal Description.
5. In the InDesign active text frame, place your mouse pointer in the location where you want to insert the Proposal Description merge code (project description text).
6. Return to the Merge Codes dialog box, and click the Insert button to insert the Project Description merge code into the InDesign active text frame.

In the InDesign active text frame, you now see the merge code: [Proposal Description|{BlockText}]

There is just one merge code (instead of both a beginning and end code).

This serves as a placeholder for the project description text that you add in Custom Proposals.

In Vision Custom Proposals, you must add projects and their description on the project section tab.

Add a Project Description to a Custom Proposal Section

After you enter a project description in the Project Info Center and create an Adobe InDesign merge template that contains the Proposal Description merge code in Merge Templates Configuration, add project descriptions to a project section in Custom Proposals.

This applies only if you are using an Adobe InDesign merge template for a custom proposal section in Vision Custom Proposals.

Prerequisites

1. In the Project Info Center, enter project descriptions in the Descriptions grid on the Background tab.
2. In Configuration » General » Merge Templates, create an Adobe InDesign merge template that contains the Proposal Description merge code.
To add a project description to a custom proposal section, complete the following steps:

1. From the Vision Navigation menu, click **Proposals » Custom**.
2. On the Custom Proposals form, click the **New** or **Open** toolbar option to create a new proposal or open an existing proposal.
3. If you have not yet created a proposal section for the Projects Info Center area, complete the following steps:
   a. On the Custom Proposals form, click the **Sections** toolbar option.
   b. On the Configure Sections dialog box, click **Insert**, and enter the row of information for the project section.
      
      Be sure to:
      - Select **Projects** from the drop-down list in the **Info Center Area** column.
      - Select the merge template that contains the **Proposal Description** merge code (that you created in Merge Templates Configuration) in the **Merge Template** field.
   c. Click **Close** to return to the Custom Proposals form.
4. On the Custom Proposals form, click the tab for the Project Info Center section of the custom proposal.
5. Click the **Add Records(s)** toolbar option to add projects to the custom proposal.
6. Select a project's row and then click the **Descriptions** toolbar option, and from the shortcut menu, select **Descriptions**.
7. In the Select Items dialog box, click the appropriate description in the **Available** pane on the left, and then click the **Right –>** button to move the description to the **Selected** pane on the right.
8. If there are multiple descriptions, repeat step 7 to add as many descriptions as you want.
   Use the **Up** and **Down** buttons to change the order of the descriptions if you select multiple descriptions.
9. Repeat steps 6–8 for all the projects that you added to the records grid on the section tab.
10. Click **OK** to return to the Custom Proposals form.
11. On the Custom Proposals form toolbar, click **Save**.
    Now you can use the **Merge Proposals** toolbar option to generate a proposal that includes the project descriptions that you just added.

**Insert Merge Codes for Resume Text in an Adobe InDesign Merge Template**

Use the **Proposal Resume** merge code to insert resume text into a custom proposal. The resume text comes from the Resumes tab in the Employee Info Center.

This applies only if you are using an Adobe InDesign merge template for a custom proposal section in Vision Custom Proposals.

**Prerequisites**

In the Employee Info Center, enter resume text in the **Resumes** grid on the Resumes tab.
To insert a resume text merge code in an Adobe InDesign merge template, complete the following steps:

1. Follow the steps in the "Create a Vision Merge Template with Adobe InDesign" help topic or the "Edit a Vision Merge Template with Adobe InDesign" topic to create or edit a merge template with InDesign.

2. Be sure to select Employees in the Info Center Area field on the Merge Templates form.

3. On the Merge Codes dialog box, select Employees in the Table field.

4. In the drop-down list in the Field field, select Proposal Resume.

5. In the InDesign active text frame, place your mouse pointer in the location where you want to insert the Proposal Resume merge code (resume text).

6. Return to the Merge Codes dialog box, and click the Insert button to insert the resume text merge code into the InDesign active text frame.

In the InDesign active text frame, you now see the merge code: 

```
[Proposal Resume|{BlockText}]
```

There is just one merge code (instead of both a beginning and end code).

This serves as a placeholder for the resume text that you add in Custom Proposals.

Postrequisite

In Vision Custom Proposals, you must add employees and build their resumes on the employees section tab.

Add Resume Text to a Custom Proposal Section

After you enter resume text in the Employee Info Center and create an Adobe InDesign merge template that contains the Proposal Resume merge code in Merge Templates Configuration, add the resume text to an employee section in Custom Proposals.

This applies only if you are using an Adobe InDesign merge template for a custom proposal section in Vision Custom Proposals.

Prerequisites

1. In the Employee Info Center, enter resume text in the Resumes grid on the Resumes tab.

2. In Configuration » General » Merge Templates, create an Adobe InDesign merge template that contains the Proposal Resume merge code.

To add resume text to a custom proposal section, complete the following steps:

1. From the Vision Navigation menu, click Proposals » Custom.

2. On the Custom Proposals form, click the New or Open toolbar option to create a new proposal or open an existing proposal.

3. If you have not yet created a proposal section for the Employees Info Center area, complete the following steps:
   a. On the Custom Proposals form, click the Sections toolbar option.
   b. On the Configure Sections dialog box, click Insert, and enter the row of information for the employee section.

   Be sure to:
- Select Employees from the drop-down list in the Info Center Area column.
- Select the merge template that contains the Proposal Resume merge code (that you created in Merge Templates Configuration) in the Merge Template field.

c. Click Close to return to the Custom Proposals form.

4. On the Custom Proposals form, click the tab for the Employees Info Center section of the custom proposal.

5. Click the Add Records(s) toolbar option to add employees to the custom proposal.

6. Select an employee’s row and then click the Build Resumes toolbar option, and from the shortcut menu, select one of the options (Resume by Category, Resume by Query w/Project Restriction, and so on) to add resume text.

7. In the Select Items dialog box, click the appropriate resume text in the Available pane on the left, and then click the Right –> button to move the resume text to the Selected pane on the right.

8. If there are multiple blocks of resume text, repeat step 7 to add as many blocks as you want.

Use the Up and Down buttons to change the order of the blocks of resume text.

9. Repeat steps 6–8 for all the employees that you added to the records grid on the section tab.

10. Click OK to return to the Custom Proposals form.

11. On the Custom Proposals form toolbar, click Save.

Now you can use the Merge Proposals toolbar option to generate a proposal that includes the resume text that you just added.

Custom Proposals Form

Use the Custom Proposals form to create or modify a custom proposal.

Toolbar of Custom Proposals Form

Use the toolbar options on the Custom Proposal form to create custom proposals and their sections and to generate a merged custom proposal document.

<table>
<thead>
<tr>
<th>Toolbar Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="#" alt="Save" /></td>
<td>Click this option to save the proposal.</td>
</tr>
<tr>
<td><img src="#" alt="New" /></td>
<td>Click this option and then select <img src="#" alt="New Proposal" /> or <img src="#" alt="Copy Current Proposal" />.</td>
</tr>
<tr>
<td><img src="#" alt="Delete" /></td>
<td>Click this option to delete the proposal that is currently open. <strong>Warning:</strong> Deleting a proposal removes it permanently from the Vision database. You cannot undo this action.</td>
</tr>
<tr>
<td><img src="#" alt="Open" /></td>
<td>Click this option and select a custom proposal to open from the Custom Proposal Lookup dialog box.</td>
</tr>
<tr>
<td><img src="#" alt="Sections" /></td>
<td>Click this option to open the Configure Sections dialog box and create the Info Center sections for a custom proposal. Each custom proposal section contains records from one Info Center. You can add one or more sections to a custom proposal.</td>
</tr>
</tbody>
</table>
After you create one or more sections and click **Close** on the Configure Sections dialog box, a tab for each section now displays on the Custom Proposal form.

**Create Proposal Log**
Click this option to display the Proposal log dialog box. On the Detail tab, enter information for the related opportunity. You can enter notes on the Notes tab.

**Merge Proposal**
Click this option and then select either:
- **Merge Current Section** — Select this option to merge only the section whose tab you have open on the Custom Proposal form.
- **Merge Multiple Section** — Select this option to open the Select Sections to Merge dialog box and select one or more sections of a custom proposal to merge.

**Help**
Click this option to display the online help for Custom Proposals.

### General Tab of the Custom Proposals Form
On this tab, enter basic information for the custom proposal that you are creating or modifying.

### Location

**To display the form, complete the following step:**
1. From the Vision Navigation menu, click **Proposals » Custom Proposals**.

### Contents

<table>
<thead>
<tr>
<th>Name</th>
<th>Enter the name of the new custom proposal.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Enter the number of the new custom proposal if your company gives numbers to its proposals.</td>
</tr>
<tr>
<td>Client</td>
<td>Open the Clients Lookup, and select the name of the client to whom you are sending the proposal.</td>
</tr>
<tr>
<td>Organization</td>
<td>Open the Organization Lookup, and select the organization in your company that is preparing the proposal.</td>
</tr>
<tr>
<td>Proposal Manager</td>
<td>Open the Employee Lookup and select the employee who has the primary responsibility to send this custom proposal.</td>
</tr>
<tr>
<td>Date Advertised</td>
<td>Specify the date when your organization received notice of the Request for Proposal.</td>
</tr>
<tr>
<td>Due Date</td>
<td>Specify the date by which the proposal must be sent, as specified in the Request for Proposal.</td>
</tr>
</tbody>
</table>
Configure Sections Dialog Box

Use this dialog box to create sections for a custom proposal. You can use any Info Center to create a section. For example, to add resumes to a proposal, add a section that uses the Employee Info Center. Employee’s resumes are stored in the Employee Info Center.

When you add a section, a new tab is created for it on the Custom Proposals form. The order of tabs determines the order of the data in the custom proposal.

Location

To display the dialog box, complete the following steps:

1. From the Vision Navigation menu, click Proposals » Custom Proposals.
2. On the toolbar, click Sections.

Contents

| Insert | Click this option on the grid toolbar to insert a section into the custom proposal. Enter information for the section in the blank row that is inserted into the grid. |
| Move Up | Select a row in the grid (section) that you want to move up in the grid. Then click the Move Up option on the grid toolbar to move the row up one position. The order of the sections in the grid determines the order of the tabs on the Custom Proposals form and the order of the sections that display in the merged custom proposal. |
| Move Down | Select a row in the grid (section) that you want to move down in the grid. Then click the Move Down option on the grid toolbar to move the row down one position. The order of the sections in the grid determines the order of the tabs on the Custom Proposals form and the order that the sections display in the merged custom proposal. |
| Delete | Select a row in the grid (section) that you want to delete, and then click this option to delete it from the custom proposal. |
| Section Name | Enter a name for the section's tab that will display on the Custom Proposal form. You can also select a name from the drop-down list. You can edit the section name at any time. |
| Description | Enter a description for the section. |
| InfoCenterArea | Select the Info Center for the section. Each section can have one Info Center. You can use the same Info Center for more than one section. |
| Merge Template | Click this field to display the Lookup icon. Then click the icon to open the Templates Lookup dialog box and select a template to use for the custom proposal section. You can select either a Microsoft Word (.rtf) or an Adobe InDesign (.indt) merge template. The Type column on the Templates Lookup dialog box indicates whether a merge template is a Word or InDesign file. |
| Merged Filename | When you merge one or multiple sections of a custom proposal, a file for the merged custom proposal is created. When you select a Microsoft Word merge template in the Merge Template field, enter the file name that you want to use for the merged document in the Merged FileName field. When you select an Adobe InDesign merge template in the Merge Template field, the Merged Filename field is not enabled. The name of the InDesign merge template will be used for the merged custom proposal file name. |
Select Sections to Merge Dialog Box

On this dialog box, select one or more sections to include in a custom proposal, and then merge to create the custom proposal document.

Click a section in the Sections list to select it. You can select multiple sections by using the CTRL or SHIFT keys on your keyboard.

<table>
<thead>
<tr>
<th>Select All</th>
<th>Click this button to select all the custom proposal sections in the Sections list on this dialog box to merge.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear All</td>
<td>Click this button to clear the custom proposal sections that you selected in the Sections list.</td>
</tr>
<tr>
<td>Sections List</td>
<td>This list displays all the custom proposal sections that you created for a custom proposal.</td>
</tr>
<tr>
<td>Merge as one document</td>
<td>This check box applies only for Adobe InDesign merge templates. Select this check box to merge all the custom proposal sections into one merged document. Clear this check box to merge each selected section into a separate document. For Microsoft Word merge templates, only one document is created whether or not you include one or multiple sections in the merged document.</td>
</tr>
<tr>
<td>Merge</td>
<td>Click this button to generate a merged document for the custom proposal sections that you selected.</td>
</tr>
<tr>
<td></td>
<td>If you generated the custom proposal with a Microsoft Word merge template, an .rtf file in Word displays on your screen.</td>
</tr>
<tr>
<td></td>
<td>If you generated the custom proposal with an Adobe InDesign merge template, an .indd file in InDesign displays on your screen.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Click this button to cancel the selection of custom proposal sections and return to the Custom Proposals form without merging any sections.</td>
</tr>
</tbody>
</table>

Add Info Center Sections to Custom Proposals

Each section that you add to a custom proposal contains records from one Info Center.

After you add these sections on the Configure Sections dialog box, a tab for each section displays on the Custom Proposals form. The order of the sections entered on the Configure Sections dialog box (and thus the order of the tabs on the Custom Proposals dialog box) determines the order of the information in the custom proposal.

To add an Info Center section, complete the following steps:

1. From the Vision Navigation menu, click Proposals » Custom Proposals.
2. On the Custom Proposals toolbar, click Sections » Configure Sections.
3. On the toolbar of the Configure Sections dialog box, click **Insert**.

4. In the blank row in the grid, enter a name and description for the section.

5. In the **InfoCenterArea** field, select the Info Center from which to retrieve information.

6. Click the **Merge Template** field to display the Lookup icon. Click the icon to open the Template Lookup dialog box and select a merge template to use for the section.

7. In the **Merged Filename** field:
   - If you selected a Microsoft Word merge template in the **Merge Template** field, enter the file name that you want to use for the merged proposal document in the **Merged FileName** field.
   - If you selected an Adobe InDesign merge template in the **Merge Template** field, the **Merged Filename** field is not enabled. The name of the InDesign merge template will be used for the merged proposal document file name.

8. On the Configure Sections dialog box, click **Close**.

   The section that you created is saved and now displays as a tab on the Custom Proposal form.

9. Open the section tab and click **Add Record(s)** on the grid toolbar.

10. On the Info Center Lookup dialog box, enter search criteria for the records that you want to find and include in the custom proposal section. Use the CTRL or SHIFT keys on your keyboard to select multiple records.

11. When you close the dialog box, the records display in the grid on the section tab.

12. Optional. If the section type supports graphics, select the record in the grid to which you want to add a graphic, click **Graphics** on the grid toolbar, and in the Graphics dialog box, click **Right->** to move a graphics file from the **Available** list to the **Selected** list.

13. Optional. On the section tab of a Client Info Center section, select a client record, click **Contacts** on the grid toolbar, and on the Contacts dialog box, click **Add** to add contacts whose data you want to merge with the selected client records.

14. Optional. On the section tab of an Employee Info Center section, click the **Build Resume** toolbar option to specify how to create a resume for the employee.

15. Optional. On the section tab of a Project Info Center section, click the **Team** toolbar option to add team members to the project record.

16. On a section tab, click **Reorder** on the grid toolbar to set the order of the rows (records) in the section.

17. On the Custom Proposals form, click **Save**.

### Merge a Custom Proposal that is Created with Microsoft Word

After you create sections and add records for your custom proposal, you merge the proposal to generate a custom proposal document.

These instructions apply for custom proposals that you create with merge templates that are created in Microsoft Word.

**To merge a custom proposal, complete the following steps:**

1. From the Vision Navigation menu, click **Proposals » Custom Proposals**.

2. On the Custom Proposals form, select a section tab other than the General tab.
3. Select a merge option:
   - **Merge Current Section** — Select this option to include only the section whose section tab you have open.
     On the File Download dialog box, click Open to open the merged document in Word, or click Save to open the Save As dialog box and save the merged document into a folder that you specify.
   - **Merge Multiple Sections** — Select this option to merge all sections of a custom proposal.
     a. On the Select Sections to Merge dialog box, select the sections to merge. You can select multiple sections by using the CTRL or SHIFT keys on your keyboard, or click Select All to select all sections.
     b. Select the Merge as one document check box if you want all sections to be merged into one document. If you do not select the check box, each section will be merged into a separated merged document.
     c. Click Merge to generate the custom proposal.
     d. On the File Download dialog box, click Open to open the merged document in Word, or click Save to open the Save As dialog box and save the merged document into a folder that you specify.
     e. If you chose not to merge all the sections as one document, after you save or open a merged document for one section, the Merge button’s label changes to Merge Next Page. Click the Merge Next Page button to merge the next section into a separate document. After you merge all sections, the caption reverts to Merge and the button becomes inactive.

Regardless of the File Type in the Save As dialog box, the merged document is an .rtf file type. To convert it to a Microsoft Word .docx file type: launch Microsoft Word, reopen the file from its saved location, and save it in Microsoft Word as a .docx file.

4. When you open a merged document Word, any graphic placeholder on its merge template is replaced with the path and filename of the graphic selected for the section.

   To expand the graphic into a frame, place the cursor at the beginning of the file document, and click either the Vision Graphic or the Vision Framed Graphic button in the Macro Toolbar.

   The Macro dialog box opens, with the following message:

   **Processing Complete. X Picture file(s) attached to your document.**

   “X” represents the number of graphic files merged.

5. Click Continue.

   The merged file document displays the graphic at the specified location.

6. Save the merged file in Microsoft Word.

   To print the completed proposal, open each merged file in Microsoft Word and print it.
Merge a Custom Proposal that is Created with Adobe InDesign

After you create sections and add records for your custom proposal, you merge the proposal to generate a custom proposal document.

These instructions apply for custom proposals that you create with merge templates that are created in Adobe InDesign.

To merge a custom proposal, complete the following steps:

1. From the Vision Navigation menu, click Proposals » Custom Proposals.
2. On the Custom Proposals form, select a section tab other than the General tab.
3. Select a merge option:
   - Merge Current Section — Select this option to include only the section whose section tab you have open.
     The custom merged proposal document opens directly in InDesign on your screen. You can save it as an .indd file.
   - Merge Multiple Sections — Select this option to include all sections in the merged custom proposal document.
     a. On the Select Sections to Merge dialog box, select the sections to merge. You can select multiple sections by using the CTRL or SHIFT keys on your keyboard, or click Select All to select all sections.
     b. Select the Merge as one document check box if you want all sections to be merged into one document. If you do not select the check box, each section will be merged into a separated merged document.
     c. Click Merge to generate the custom proposal.
     The custom merged proposal document opens directly in InDesign on your screen. You can save it as an .indd file.
     If you chose not to merge all the sections as one document, the documents for each section are created automatically one after the other. It may take several seconds for each one to merge and the multiple documents to display in InDesign on your screen.

Assign Merge Templates to a Security Role

A system administrator assigns access to specific merge templates for each security role. This allows users to generate only the merged documents that apply to them in each Info Center and in Custom Proposals.

All users have access to the SF254 proposals and SF255 proposals merge templates, regardless of their security roles.

This information applies for merge templates created with either Microsoft Word or Adobe InDesign.

To assign merge templates to a security role, complete the following steps:

2. In the Search field on the Roles form, select the security role for which you want to assign merge templates.
3. Open the Access Rights tab, and from the drop-down list in the Functional Area field, select MergeTemplates.

4. In the Info Center field drop-down list, select the Info Center for the merge templates that you want to assign to the security role.

5. In the Available Templates pane, click a merge template name, and then click the Add button to make the template accessible to the security role.

   The template name now displays in the Templates for this Role pane.

6. Repeat step 5 to add other templates for the security role.

7. When you finish adding merge templates for a role, click Save.

Security for Microsoft Word Merge Templates and Merged Documents

The following information applies for merge templates that you create with Microsoft Word.

Add a Merge Template in Vision Configuration

To add or update a Word merge template in Vision Configuration, you must have security access to Configuration » General » Merge Templates. This access is set up for a security role in Configuration » Security » Roles » General tab.

Generate Merged Documents in Info Centers and Custom Proposals

To generate merged documents in Info Centers and Proposals, your role security must give you access to the following:

- The Info Center and Custom Proposals applications — This access is set up in Configuration » Security » Roles » General tab.
- The individual merge template — This access is set up in Configuration » Security » Roles » Access Rights tab for the Merge Templates functional area.

When users generate a merged document and they do not have at least read only record-level access rights to a Vision field that is included in a merge template, they will see the merge code (Vision field name) displayed in the merged document instead of the actual Vision data. Record-level access rights are set up for a role in Configuration » Security » Roles » Record Access tab.

Security for Adobe InDesign Merge Templates and Merged Documents

The following security information applies only for merge templates that you create with Adobe InDesign.

Create a Merge Template in Vision Configuration

To create or update an InDesign merge template in Vision, you must have security access to Configuration » General » Merge Templates. This access is set up for your security role in Configuration » Security » Roles » General tab.

Merge Codes (Vision Fields)

When you create or update an InDesign merge template in Configuration » General » Merge Templates, you select Vision fields (merge codes) from the Field field in the Merge Code dialog box. The drop-down list in the Field field displays only the Vision fields for which you have at
least “read only” record-level access rights. These rights are set up for your security role in Configuration » Security » Roles » Record Access tab.

Generate Merged Documents in Info Centers and Custom Proposals

To generate merged documents in Info Centers and Proposals, your role security must give you access to the following:

- The Info Center and Custom Proposals applications — This access is set up in Configuration » Security » Roles » General tab.
- The individual merge template — This access is set up in Configuration » Security » Roles » Access Rights tab for the Merge Templates functional area.

When you generate a merged document and you do not have at least read only record-level access rights to a Vision field that is included in the merged document, you will see the merge code (Vision field name) displayed in the merged document instead of the actual Vision data. Record-level access rights are set up for a role in Configuration » Security » Roles » Record Access tab.
Analysis Cubes Configuration

Analysis Cubes Configuration Overview

The Analysis Cubes feature is part of the Vision Performance Management module. It provides you with a Vision project data cube and a general ledger data cube from which you can create custom Vision reports. Use Analysis Cubes Configuration to set up the feature.

To configure Analysis Cubes, complete the following general steps:

- Select which measures and dimensions populate the data cubes.
- Create key performance indicators (KPIs) for the data cubes.
- Create calculated measures for the data cubes.
- Set up currency exchange information for the data cubes (used for presentation currencies).

You can access Analysis Cubes Configuration in Vision only if you purchased and activated the Performance Management application. If you have not purchased Performance Management, you still have access to Analysis Cubes, but you do not have access to Analysis Cubes Configuration and the additional capabilities that it provides, or to the dimensions and measures that were added in the Vision 7.0 release. You have access to only the dimensions and measures available in prior releases.

Important Information

- When you configure Analysis Cubes for the first time or upgrade to a new version, you must follow the Analysis Cubes configuration instructions in the *Installation and Configuration Guide for Performance Management (Analysis Cubes)*. Completing the Analysis Cubes configuration within Vision is only one part of the overall Analysis Cubes configuration. You can download the PDF guide from the Deltek Customer Care Connect site.
- After you make the initial Analysis Cubes configuration selections in Vision Configuration, and anytime that you modify these settings, a system administrator must use the Vision Resource Kit to update the changes in the data cubes.
- If you remove dimensions and measures from the data cubes after they have populated the data cubes and you have reports that include these removed fields, the fields are automatically removed from custom reports after you refresh report data. You must rebuild the reports.
- If you activate the Performance Management edition of Vision Performance Management, the sample performance dashboards require that the Analysis Cubes include a specific set of dimensions, measures, and KPIs. If one of those required data items has been removed from the Analysis Cubes, you may receive errors when you try to publish or display the sample dashboards or your custom dashboards that are based on those sample dashboards.

If you receive an error when you publish or display a dashboard, and the message indicates that required data is missing from the Analysis Cubes, click [Restore Required Configuration](#) on the toolbar on the Analysis Cubes form (Configuration » General » Analysis Cubes) to restore all of the dimensions, measures, and KPIs that the performance dashboards need. You must also reprocess the Analysis Cubes to apply the updated configuration.
User-Defined Fields that You Want to Populate the Vision Data Cubes

You select user-defined fields to populate the Vision data cubes in Configuration » General » User Defined Tabs. This applies only if you purchased the Performance Management module.
Billing Invoice Approvals

Invoice Approvals Overview

Invoice Approvals is an optional feature that requires Billing invoices to be approved before they are accepted and posted.

This feature allows you to efficiently move draft invoices through the submittal, rejection, approval, and acceptance stages to produce final invoices. Electronic alerts are sent automatically to the appropriate employees to notify them that the next action in the approval process is ready for them to complete. You can enter approval comments for invoices that can be shared easily with others.

You turn on this feature on the Miscellaneous tab in Configuration » Billing » General.

After the Invoice Approvals feature is turned on, you complete the following configuration:

- Set up invoice approval processes in Configuration » Billing » Invoice Approval Process. You specify:
  - Who, within a project (project manager, principal, and so on), can approve and reject submitted invoices.
  - Who will receive alerts when invoices are submitted, approved, rejected, and unsubmitted.
  - How and when alerts are delivered, and the message in the alerts.
  - Specify in a project's billing terms (on the Misc tab) whether or not a project will use invoice approvals and which invoice approval process it will use.
  - As needed, you can specify on the General tab in User Options a delegate to approve invoices in your absence if you are an invoice approver.

To move invoices through the approval process, you:

- Submit invoices for approval in Interactive Billing or Batch Billing.
- Approve invoices in Interactive Approvals, Invoice Approvals, or Interactive Billing.
- Reject invoices in Interactive Approvals or Invoice Approvals.
- Unsubmit an invoice in Interactive Billing to begin the approval process again.
- Final accept an invoice in Interactive Billing or Batch Billing after it is approved.

Multicompany

If you have multiple companies in Vision, you must turn on and set up the Invoice Approvals feature for each company. However, the invoice approval processes that you set up are available for all companies; you do not have to set up separate approval processes for each company.

Enable the Invoice Approval Feature

Enable the optional Invoice Approval feature if you want invoices to be approved before they are accepted and posted.

To enable the Invoice Approval feature, complete the following steps:

1. From the Vision Navigation menu, click Configuration » Billing » General.
2. On the Miscellaneous tab, select the **Enable Invoice Approvals** check box.

3. In the **Default Approval Process** field, enter the invoice approval process to use for projects that require invoice approvals, and the **Approvals Process** field on the Misc tab in **Billing » Billing Terms** for a project is blank.

Although this default approval process is used when no approval process is entered for a project in Billing Terms, it does not prefill in the **Approvals Process** field in a project's billing terms. The default approval process that you enter on the Misc tab in **Configuration » Billing » Default Terms** prefills in the **Approvals Process** field in **Billing » Billing Terms** for new projects that you create.

Until you set up your own approval processes in Invoice Approvals (**Configuration » Billing » Invoice Approvals**), only the **Default** approval process displays in the drop-down list in the **Default Approval Process** field.

4. Click **Save** on the toolbar.

After you enable the Invoice Approval feature:

- The Invoice Approval Process menu item displays in **Configuration » Billing**.
  
  On the Invoice Approval Process form, you set up invoice approval processes to use for projects. An approval process defines who can approve and reject invoices and how and when notification alerts are sent.

- An **Enable Invoice Approvals** check box and an **Approval Process** field display on the Misc tab in **Configuration » Billing » Default Terms** and on the Misc tab in **Billing » Billing Terms**.
  
  In Default Billing Terms Configuration, you enter the default invoice approval settings to use for new projects. You can override the prefilled settings on a project-by-project basis in a project's billing terms.

  For projects that are set up before the Invoice Approval feature is turned on, you enter invoice approval settings in a project's billing terms. You can also use the use Search and Replace utility to enter the appropriate approval process for a group of projects.

**Multicompany**

If you have multiple companies in Vision, you must enable Invoice Approvals for each company.

**Invoice Approval Processes**

An invoice approval process is a set of instructions that defines who can approve and reject Billing invoices and how and when notification alerts are sent to the people involved in the approval process.

This applies only if you use the optional Invoice Approval feature.

Vision comes with one invoice approval process whose identification code is "DEFAULT."

You can set up additional approval processes on the Invoice Approval form in **Configuration » Billing » Interactive Approvals** after you turn on the Invoice Approval feature. This allows you to have different sets of approvers and notification methods for different projects. For example you may have a different approval process for projects whose invoices are issued in different countries. Or, you may have some projects that are approved by a project manager and others that are approved by the principal.

You specify the approval process for a project on a project's billing terms (on the Misc tab in **Billing » Billing Terms**).
DEFAULT Code for Invoice Approvals

Vision comes with one invoice approval process whose identification code is "DEFAULT."

This is set up on the Invoice Approval Process form in Configuration » Billing » Invoice Approval Process. In addition to DEFAULT, you can set up as many invoice approval processes as you need.

DEFAULT displays in the drop-down list in the:

- Default Approval Process field on the Miscellaneous tab in Configuration » Billing » General.
- Approval Process field on the Misc tab in Configuration » Billing » Default Terms.
- Approval Process field on the Misc tab in Billing » Billing Terms.

The settings on the Invoice Approval Process form for DEFAULT are:

<table>
<thead>
<tr>
<th>Action</th>
<th>Employee to Approve/Reject</th>
<th>Employee to Alert</th>
<th>Alert Frequency</th>
<th>Alert Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Submit</td>
<td>Interactive Billing</td>
<td>Project Manager</td>
<td>Per Invoice</td>
<td>Dashboard</td>
</tr>
<tr>
<td>Approve</td>
<td>Project Manager</td>
<td>Biller</td>
<td>Per Invoice</td>
<td>Dashboard</td>
</tr>
<tr>
<td>Reject</td>
<td>Project Manager</td>
<td>Biller</td>
<td>Per Invoice</td>
<td>Dashboard</td>
</tr>
<tr>
<td>Unsubmit</td>
<td>Interactive Billing</td>
<td>Project Manager</td>
<td>Per Invoice</td>
<td>Dashboard</td>
</tr>
</tbody>
</table>

Set Up Invoice Approval Processes

After you enable the Invoice Approval feature, you can set up one or more invoice approval processes.

An invoice approval process defines the invoice approval process among the individuals who work on a project. Vision comes with one approval process—DEFAULT.

To set up invoice approval processes, complete the following steps:

2. On the Invoice Approval Process form, click 🔄 New to open a blank invoice approval form.
3. Enter an identification code and description for the invoice approval process.
4. Complete the fields in the grid.
   The grid prefills with a row for each action—Submit, Approve, Reject, and Unsubmit. Enter the desired information for each action.
5. When you finish, click 📦 Save on the toolbar.

Invoice approval processes that you set up here display in the drop-down list in the:

- Default Approval Process field on the Miscellaneous tab in Configuration » Billing » General.
- Approval Process field on the Misc tab in Billing » Billing Terms.
Multiple Companies

If you have multiple companies in Vision, the invoice approval processes that you set up are available for all companies. You do not have to set up separate approval processes for each company.

Assign Another Person to Approve Invoices in Your Absence

You can assign another person to approve Billing invoices in your absence. This applies if you use the Invoice Approval feature.

If you normally approve Billing invoices, but you will be temporarily unavailable to do so, you can assign another employee to approve invoices in your place. For example, you may be going on a vacation.

To assign another person to approve invoices in your absence, complete the following steps:

1. From the Vision main toolbar, click Options.
2. On the General tab of the User Options form, select the Delegate Invoice Approvals to check box.
3. In the field to the right of the check box, enter the employee who will approve invoices in your absence.
4. Click OK to save your entries.

The person whom you designated to approve invoices will now receive invoice approval alerts and have the ability to approve and reject invoices for you. This person must also have the role security that allows access the Invoice Approvals and Interactive Billing menus in Billing and access to the appropriate projects. You (the delegator) will continue to receive alerts (along with the delegate) so that you are aware of any invoices processed in your absence.

5. When you can resume approving invoices, clear the Delegate Invoice Approvals to check box.

The delegate will stop receiving invoice approval alerts, and he or she will no longer be able to approve invoices on your behalf.

An alternative to using the delegate system is to create a different invoice approval process in Configuration » Billing » Invoice Approvals to use for projects when employees are unable to perform their invoice approval tasks. You can change the invoice approval process in Billing Terms for a project at any time. You can use Search and Replace utility to easily update the invoice approval process for a group of projects.
## Miscellaneous Tab of Billing Setup

Use this tab to specify miscellaneous billing setup options.

### Location

To display this tab, complete the following step:

1. From the Vision Navigation menu, click **Configuration ➤ Billing ➤ General**.

### Contents

<table>
<thead>
<tr>
<th>Release Holds Automatically</th>
<th>Select this check box if you want all Held (H) detail items for a project to be changed automatically to Billable (B) when you accept an invoice.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Enable effective dates for labor billing rates</strong></td>
<td>When you select this check box, the following occur:</td>
</tr>
<tr>
<td></td>
<td>• An <strong>Effective Date</strong> column displays in the billing rate tables; however, entry is not required. You use this option in conjunction with the Date Based Rates feature.</td>
</tr>
<tr>
<td></td>
<td>• Revenue Generation honors effective dates for billing labor rate tables, labor category tables, and labor code tables when calculating rates and extensions.</td>
</tr>
<tr>
<td></td>
<td>• The Refresh Billing Extensions utility honors the effective dates for billing labor rate tables, labor category tables, and labor code tables when recalculating billing extensions for transactions.</td>
</tr>
<tr>
<td></td>
<td>• The <strong>Use Rate Tables with Effective Dates</strong> option becomes available on the Rates tab of Plan Settings Configuration.</td>
</tr>
<tr>
<td></td>
<td>Be aware that after you enable this feature and create rate tables with effective dates, you cannot turn off effective dates for rate tables until you delete all effective dates from existing rate tables. However, it is probably rare that this feature will ever be turned off once turned on.</td>
</tr>
<tr>
<td>Include Add-ons when Reporting at Billing Rates</td>
<td>Select this check box to include the add-on fee charges when calculating billing extensions for project reports at billing rates. This setting lets you include add-ons in the billing extension calculation in postings and the Billing/Refresh Billing Extension procedure.</td>
</tr>
<tr>
<td>Non-billable Labor Code</td>
<td>Enter the labor code (for example, A009) or labor code mask (for example, ___9) that you want Vision to treat as non-billable. If employees enter this labor code combination on their timesheet, their billing rate for the timesheet line item is 0.</td>
</tr>
<tr>
<td>Unit of Measure</td>
<td>From the drop-down list, select the unit of measure to use for the measurements that you enter in the following fields on the General tab of the Billing Setup form:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Address Start</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Page 2 Start</strong></td>
</tr>
<tr>
<td></td>
<td>The <strong>Unit of Measure</strong> options are:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Inches</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Millimeters</strong></td>
</tr>
</tbody>
</table>
|                | When you switch from one unit of measure to the other, the measurements in the measurement fields on the General tab are automatically converted to the
new unit of measure.
(1 inch = 25.4 millimeter)

<table>
<thead>
<tr>
<th><strong>Enable Invoice Approvals</strong></th>
<th>Select this check box to turn on the Invoice Approval feature. After you turn it on:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• The <strong>Invoice Approval Process</strong> menu item displays in <strong>Configuration » Billing</strong>.</td>
</tr>
<tr>
<td></td>
<td>On the Invoice Approval Process form, you set up invoice approval processes to use for your projects. An approval process defines who can approve and reject invoices and how and when notification alerts are sent.</td>
</tr>
<tr>
<td></td>
<td>• An <strong>Enable Invoice Approvals</strong> check box and an <strong>Approval Process</strong> field display on the Misc tab in <strong>Configuration » Billing » Default Terms</strong> and on the Misc tab in <strong>Billing » Billing Terms</strong>.</td>
</tr>
<tr>
<td></td>
<td>In Default Billing Terms Configuration, you enter the default invoice approval settings to use for new projects. You can override the prefilled settings on a project-by-project basis in a project’s billing terms.</td>
</tr>
<tr>
<td></td>
<td>For projects that are set up before the Invoice Approval feature is turned on, you enter invoice approval settings in a project’s billing terms. You can also use the use Search and Replace utility to enter the appropriate approval process for a group of projects.</td>
</tr>
<tr>
<td><strong>Multicompany</strong></td>
<td>If you have multiple companies in Vision, you must enable Invoice Approvals for each company.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Default Approval Process</strong></th>
<th>From the drop-down list, select the invoice approval process to use for projects that require invoice approvals, but the <strong>Approvals Process</strong> field on the Misc tab in <strong>Billing » Billing Terms</strong> for a project is blank.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Although this default approval process is used when no approval process is entered for a project in Billing Terms, it does not prefill in the <strong>Approvals Process</strong> field in a project’s billing terms. The default approval process that you enter on the Misc tab in <strong>Configuration » Billing » Default Terms</strong> prefills in the <strong>Approvals Process</strong> field in <strong>Billing » Billing Terms</strong> for new projects that you create.</td>
</tr>
<tr>
<td></td>
<td>Until you set up your own approval processes in Invoice Approvals (<strong>Configuration » Billing » Invoice Approval Process</strong>), only the <strong>Default approval process</strong> displays in the drop-down list in the <strong>Default Approval Process</strong> field.</td>
</tr>
</tbody>
</table>

**Invoice Approval Process Form**

If you use the Invoice Approval feature, use this form to create or modify an invoice approval process.

An invoice approval process is a set of instructions that defines who can approve and reject Billing invoices and how and when notification alerts are sent to the people involved in the approval process.

This form is accessible only after you enable the Invoice Approval feature on the Miscellaneous tab in **Configuration » Billing » General**.
Vision comes with a default invoice approval process that is entered on this form whose identification code is "DEFAULT." In addition to this code, you can create other invoice approval process codes to use for your projects.

In a project's billing terms, you can specify an invoice approval process to use for a project's invoices.

**Location**

**To open this form, complete the following step:**

1. From the Vision Navigation menu, click **Configuration » Billing » Invoice Approval Process**.

**Content**

**Fields**

| Search | Click to open the Invoice Approval Process Lookup and select an existing invoice approval process that you want to view or modify.  
If you use the Multicompany feature, the list of invoice approval processes on the Invoice Approval Process Lookup dialog box is enterprise wide. It includes invoice approval processes for all companies in your enterprise. |
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Code</td>
<td>Enter the identification code for the new invoice approval process that you are creating.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a description for the invoice approval process. The description displays in the drop-down list for the <strong>Approval Process</strong> field on the Misc tab in <strong>Billing » Billing Terms</strong>. This is where you select an invoice approval process for a project.</td>
</tr>
</tbody>
</table>

**Actions Grid Columns**

**Action**

The **Actions** grid prefills with one row for each invoice approval action. Then, you complete the remaining grid fields in the row for that action.

The actions that prefill in the **Action** column are:

- **Submit** — When you submit an invoice in Interactive Billing or Batch Billing, it becomes available for invoice approval (to approve or reject).
- **Approve** — After an invoice is submitted, you can approve it in Interactive Billing, Invoice Approvals, or Interactive Approvals.
- **Reject** — After an invoice is submitted, you can reject it (instead of approve it) in Invoice Approvals or Interactive Approvals.
- **Unsubmit** — When you unsubmit an invoice in Interactive Billing, the transaction details are no longer associated with the submitted invoice, and the invoice status returns to New. An invoice must be submitted again to make it available to approve.

**Employee to Approve/Reject**

For the **Submit and Unsubmit** action rows:

This field prefills with **Interactive Billing**, and you **cannot** change it. This indicates that invoices are submitted and unsubmitted in Interactive Billing or Batch Billing by anyone who has role security to access these menu items and record access to the specific project.

For the **Approve and Reject** action rows:

Enter the employees who can accept or reject an invoice for the project. From the
When you select multiple employees to approve or reject, any of the selected employees will be able to perform the action.

**Employee to Alert**

This field applies to all actions. Enter the employees who will be alerted when the action is performed.

From the drop-down list, you can select any employee field from the Project Info Center, such as **Project Manager**, **Principal**, **Supervisor**, and **Biller**. This list also includes any user-defined employee field in the Project Info Center.

You can select multiple employees by pressing the CTRL key on your keyboard as you make employee selections with your mouse.

If you do not want a notification alert sent for an action, leave this field blank. For example, you might not want an alert sent when an invoice is unsubmitted.

**Alert Frequency**

Select the frequency for which you want alerts sent for an invoice approval action (submit, unsubmit, reject, or approve an invoice) in Interactive Billing, Batch Billing, Interactive Approvals, or Invoice Approvals.

Options are:

- **Alert per invoice** — After you enter a comment for the invoice in Interactive Billing, Batch Billing, Interactive Approvals, or Invoice Approvals, alerts are sent to each employee who is specified to receive an alert. The alert contains one invoice.

- **Alert per session** — Alerts are sent when you exit the billing or approval entry session. Alerts are sent to each employee who is specified to receive an alert. One or more alerts are sent—grouped by the invoice approval process for the invoices that are included in the session. The alerts contain multiple invoices.

  Example: An entry session for submitting invoices includes 15 total invoices (all to be approved by one person). Five of the invoices use invoice approval process "A" and 10 of the invoices use invoice approval process "B." Two alerts are sent to the approver—one alert includes the five invoices that use invoice approval process "A" and the other alert includes the 10 invoices that use invoice approval process "B."

**Alert Type**

Click in this field and then click ![Alert Type Lookup](image) to open the Alert Type Lookup dialog box, and select how you want the notification alert for the action to be delivered to employees:

Options are:

- **Dashboard**
- **Dashboard and Email**
- **Email**

**Dashboard Summary as Link**

This column is enabled only if you select **Dashboard** or **Dashboard and Email** in the **Alert Type** column.

Select this check box if you want the Dashboard summary text to be a link to the Billing invoice.

- For the submit action, the link to the Billing invoice opens Invoice Approvals form (Billing » Invoice Approvals). You must enter the
specific invoice.

- For the approve or reject actions, the link to the Billing invoice automatically opens the specific invoice on the Interactive Billing form (Billing » Interactive Billing).

When this option is not selected and you click the Dashboard summary, it displays a dialog box that provides the content of the Dashboard alert.

### Invoice Approval Process Form Toolbar

Use the commands on this toolbar when you enter configuration information for the Invoice Approval feature on the Invoice Approval form.

#### Location

To open this toolbar, complete the following step:


#### Content

<table>
<thead>
<tr>
<th>Save</th>
<th>Click to save modifications that you made on the form.</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Click to create a new invoice approval process code.</td>
</tr>
<tr>
<td></td>
<td>Select one of the following options:</td>
</tr>
<tr>
<td></td>
<td>- <strong>New Invoice Approval Process</strong> — Select this option to open a blank Invoice Approval Process form and create a new invoice approval process. A Submit, Approve, Reject, and Unsubmit action row prefill in the Actions grid.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Copy Current Invoice Approval Process</strong> — Select this option to copy the invoice approval process that is displayed on the Invoice Approval Process form into a blank Invoice Approval Process form. Then enter a new code and description for it, and edit it as needed.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Select Invoice Approval Process...</strong> — Select this option to open the Invoice Approval Process Lookup dialog box. Select an existing invoice approval process to copy into a blank Invoice Approval Process form to create a new invoice approval process.</td>
</tr>
<tr>
<td>Delete Invoice Approval Process</td>
<td>Click Delete to delete the invoice approval process code that is currently displayed on the form. You cannot delete an invoice approval process code if either of the following apply:</td>
</tr>
<tr>
<td></td>
<td>- The code is entered as the default on the Misc tab of the Billing Setup form in Configuration » Billing » General.</td>
</tr>
<tr>
<td></td>
<td>- The code is already entered in a project's billing terms.</td>
</tr>
<tr>
<td>Print</td>
<td>Click to view or print a report that includes all the invoice approval processes that you set up in Invoice Approval Process Configuration. This report lists each invoice approval code and description and shows you the setup information that is entered for each action in the Actions grid on the Invoice...</td>
</tr>
</tbody>
</table>
Alerts and the Invoice Approval Process

For each invoice approval process, you determine whether or not alerts will be sent when invoices are submitted, approved, rejected, or unsubmitted (each invoice approval action).

For each invoice approval action, you select the employees to be alerted, how they will be alerted (email, dashboard, or both), and the alert frequency (alerts sent per invoice or per billing or approval entry session). You specify these settings for an invoice approval process in Configuration » Billing » Invoice Approval Process.

You can specify that alerts are sent when invoices are:

- Submitted in Interactive Billing or Batch Billing.
- Approved in Interactive Billing, Invoice Approvals, or Interactive Approvals.
- Rejected in Invoice Approvals or Interactive Approvals.
- Unsubmitted in Interactive Billing.

**Alerts Sent per Invoice**

When you choose to have alerts sent per invoice for an invoice approval action:

- Alerts are sent after the action taker enters a comment for the invoice in Interactive Billing, Batch Billing, Interactive Approvals, or Invoice Approvals.

- Alerts are sent to each employee who is specified to receive an alert.

- One invoice is included in the alert that is sent to each employee.

**Alerts Sent per Session**

When you choose to send alerts per a billing or approval entry session for an invoice approval action:

- Alerts are sent when you exit the entry session in Interactive Billing, Batch Billing, Interactive Approvals, or Invoice Approvals.

- Alerts are sent to each employee who is specified to receive an alert.

- If multiple invoices have been processed during the invoice action, one or more alerts are sent—grouped by the invoice approval process for the invoices that are included in the session.

- Multiple invoices are included in the alert sent to each employee.

Example: An entry session for submitting invoices includes 15 total invoices (all to be approved by one person). Five of the invoices use invoice approval process “A” and 10 of the invoices use invoice approval process “B.” Two alerts are sent to the approver—one alert includes the five invoices that use invoice approval process “A” and the other alert includes the 10 invoices that use invoice approval process “B.”

**Hyperlinks in Alerts**

Alerts that are sent when invoices are submitted include a hyperlink to the Invoice Approvals application in Billing. In Invoice Approvals, you see only the invoices that require approval for projects for which you are defined as the approver, rejecter, or biller. As an invoice approver, your role access to projects (set up in role security) also determines the invoices that you see in Invoice Approvals.

Alerts that are sent when invoices are approved, rejected, or unsubmitted include a hyperlink to the specific invoice in the Interactive Billing application in Billing.
Alert Type Lookup Dialog Box

Use this dialog box to select how you want the notification alert for an invoice approval action to be delivered to employees.

Location

To open this form, complete the following steps:

2. On the Invoice Approval Process form, in the Actions grid, click in the Alert Type field to display and click .

Content

<table>
<thead>
<tr>
<th>Display Type</th>
<th>This prefills with Standard and you cannot change it.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search</td>
<td>Click this button to display and then select how you want the notification alerts for an invoice approval action to be delivered to employees. The options that display in the results box are:</td>
</tr>
<tr>
<td></td>
<td>• Dashboard</td>
</tr>
<tr>
<td></td>
<td>• Dashboard and Email</td>
</tr>
<tr>
<td></td>
<td>• Email</td>
</tr>
<tr>
<td>Search By</td>
<td>This field does not apply for alert types because there are only three possible alert types that automatically display in the results box on this dialog box.</td>
</tr>
<tr>
<td>Search Text</td>
<td>As an alternative to clicking the Search button to display a list of the notification methods, you can type either an &quot;e&quot; or a &quot;d&quot; in this field to display the email or dashboard delivery methods in the results box.</td>
</tr>
<tr>
<td>Results Box</td>
<td>The following delivery methods display in the results box after you click the Search button or enter an &quot;e&quot; or a &quot;d&quot; in the Search Text field:</td>
</tr>
<tr>
<td></td>
<td>• Dashboard</td>
</tr>
<tr>
<td></td>
<td>• Dashboard and Email</td>
</tr>
<tr>
<td></td>
<td>• Email</td>
</tr>
<tr>
<td></td>
<td>Click one of these delivery methods for the invoice approval action, and then click Select.</td>
</tr>
<tr>
<td>Clear</td>
<td>Click this button to clear all the entries on this dialog box.</td>
</tr>
<tr>
<td>Select</td>
<td>Click this button after you select a delivery method in the results box. You are return to the Invoice Approval Process form. The delivery method that you selected displays in the Alert Type field as underlined, blue text. Click the underlined text to open either the Email Configuration dialog box or the Dashboard dialog box to enter configuration settings for the delivery method.</td>
</tr>
<tr>
<td>Close</td>
<td>Click this button to ignore any selections that you made on this dialog box and return to the Invoice Approval Process form.</td>
</tr>
<tr>
<td>Help</td>
<td>Click this button to open the help topic for the Alert Type dialog box help.</td>
</tr>
</tbody>
</table>
Email Configuration Dialog Box

Use this dialog box to specify the subject and contents for the email alert for the selected invoice approval action.

Location

To open this form, complete the following steps:

2. In the Actions grid on the Invoice Approval Process form, after you select the Email alert type in the Alert Type field (on the Alert Type Lookup dialog box), click Email in the Alert Type field.

Content

| Summary field and Insert Field button | Enter a subject for the email alert in the Summary field. If the alert frequency for an invoice approval action is Alert per Invoice (on the Invoice Approval Process form), you can use a combination of text and Billing invoice fields for the summary. If the alert frequency for an invoice approval action is Alert per Session, the Insert Field button is not enabled, and you cannot insert Billing Invoice fields into the summary. To insert a Billing invoice field into the summary, place your mouse pointer in the Summary field in the location where you want to insert the field, and then click the Insert Field button above the Summary field. In the Column Selection dialog box, click the field to insert, and then click OK. Example: "An invoice for [:CL.Client] for [:PR.Name] is ready for your approval" This puts the invoice’s client name and project name in the email subject. |
| Alert Content text box | Enter the text for the body of the email alert in the text box. To insert an invoice-specific field into the text, place your mouse pointer in the place where you want the field located, and then click Insert Field option from the Alert Content toolbar. In the Column Selection dialog box, click the field to insert, and then click OK. Example: "Invoice for [:PR.WBS1] has been approved and is awaiting final invoicing." This identifies the project and phase for the invoice in the email subject. You can also click the Edit option on the Alert Content toolbar to open the Vision Text Editor dialog box and format the text. |
| Language | This field applies if you use the Multilingual feature in Vision. From the drop-down list, select the language to use for the alert. Only the languages for which you have purchased a license display in the list. |
| OK | Click OK to save the entries on the dialog box and return to the Invoice Approval form. |
| Cancel | Click Cancel to discard the current entries that you made on this dialog box and return to the Invoice Approval form. |
Dashboards Configuration Dialog Box

Use this dialog box to specify the summary and contents for the dashboard alert for the selected invoice approval action.

### Location

**To open this form, complete the following steps:**

1. From the Vision Navigation menu, click **Configuration » Billing » Invoice Approvals**.
2. In the **Actions** grid on the Invoice Approval Process form, after you select the Dashboard alert type in the **Alert Type** field (on the Alert Type Lookup dialog box), click **Dashboard** in the **Alert Type** field.

### Content

| Summary field and Insert Field button | Enter a summary for the dashboard alert in the **Summary** field.
| **If the alert frequency for an invoice approval action is Alert per Invoice** (on the Invoice Approval Process form), you can use a combination of text and Billing invoice fields for the summary.
| **If the alert frequency for an invoice approval action is Alert per Session**, the **Insert Field** button is not enabled, and you cannot insert Billing Invoice fields into the summary.
| To insert a Billing invoice field into the summary, place your mouse pointer in the **Summary** field in the location where you want to insert the field, and then click the **Insert Field** button above the field. In the Column Selection dialog box, click the field to insert, and then click **OK**.
| Example: "An invoice for [:CL.Client] for [:PR.Name] is ready for your approval"
| This adds the invoice’s client name and project name to the dashboard subject.

| Alert Content text box | Enter the text for the body of the dashboard alert in the text box.
| **To insert an invoice-specific field into the text, place your mouse pointer in the place where you want the field located, and then click **Insert Field** option from the Alert Content toolbar. In the Column Selection dialog box, click the field to insert, and then click **OK**.
| Example: "Invoice for [:PR.WBS1] has been approved and is awaiting final invoicing."
| This identifies the project and phase for the invoice in the dashboard subject.
| You can also click the **Edit** option on the Alert Content toolbar to open the Vision Text Editor dialog box and format the text.

| Language | This field applies if you use the Multilingual feature in Vision.
| From the drop-down list, select the language to use for the Dashboard alert. Only the languages for which you have purchased a license display in the list.

| OK | Click **OK** to save the entries on the dialog box and return to the Invoice Approval form.
| **Cancel** | Click **Cancel** to discard the current entries that you made on this dialog box and return to the Invoice Approval form.
Dashboard and Email Configuration Dialog Box

Use this dialog box to specify the summary and contents for the dashboard and email alert for the selected invoice approval action.

You enter information for each alert type on the separate Dashboard tab and Email tab.

Location

To open this form, complete the following steps:

1. From the Vision Navigation menu, click Configuration » Billing » Invoice Approvals.
2. In the Actions grid on the Invoice Approval Process form, after you select the Dashboard alert type in the Alert Type field (on the Alert Type Lookup dialog box), click the blue, underlined Dashboard and Email in the Alert Type field.

Content

The following same fields are included on both the Dashboard and Email tabs. Enter information for the dashboard alert on the Dashboard tab; enter information for email alert on the Email tab.

<table>
<thead>
<tr>
<th>Description</th>
<th>Details</th>
</tr>
</thead>
</table>
| Summary field and Insert Field button | Enter a summary for the alert in the Summary field.  
If the alert frequency for an invoice approval action is Alert per Invoice (on the Invoice Approval Process form), you can use a combination of text and Billing invoice fields for the summary.  
If the alert frequency for an invoice approval action is Alert per Session, the Insert Field button is not enabled, and you cannot insert Billing Invoice fields into the summary.  
To insert a Billing invoice field into the summary, place your mouse pointer in the Summary field in the location where you want to insert the field, and then click the Insert Field button above the field. In the Column Selection dialog box, click the field to insert, and then click OK.  
Example: "An invoice for [:CL.Client] for [:PR.Name] is ready for your approval"  
This adds the invoice's client name and project name to the alert subject. |
| Alert Content text box | Enter the text for the body of the alert in the text box.  
To insert an invoice-specific field into the text, place your mouse pointer in the place where you want the field located, and then click Insert Field option from the Alert Content toolbar. In the Column Selection dialog box, click the field to insert, and then click OK.  
Example: "Invoice for [:PR.WBS1] has been approved and is awaiting final invoicing."  
This identifies the project and phase for the invoice in the alert subject. |
| Language | This field applies if you use the Multilingual feature in Vision.  
From the drop-down list, select the language to use for the alert. Only the languages for which you have purchased a license display in the list. |
| OK | Click OK to save the entries on the dialog box and return to the Invoice Approval form. |
| Cancel | Click Cancel to discard the current entries that you made on this dialog box and return to the Invoice Approval form. |
Column Selection Dialog Box

Use this dialog box to select fields from the Project Info Center that you want to display in the subject of the notification alert for the invoice approval action.

Location

To open this form, complete the following steps:

2. On the Invoice Approval Process form, after you enter an alert type in the Alert Type field in the Actions grid, click the blue, underlined entry in the field to open either the Email Configuration dialog box or the Dashboard Configuration dialog box.
3. On either of these dialog boxes, click the Insert Field button.

Content

<table>
<thead>
<tr>
<th>Column</th>
<th>Click a Project Info Center field in this list to add it to the subject of the notification alert for the invoice approval action.</th>
</tr>
</thead>
<tbody>
<tr>
<td>OK</td>
<td>After you select a field in the Column box, click this button to return to the Email Configuration or Dashboard Configuration dialog box.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Click this button to return to the Email Configuration or Dashboard Configuration dialog box without making a field selection.</td>
</tr>
</tbody>
</table>

General Tab of Project Info Center

Use the General tab to enter, edit, or review information about a project including the project name and number, the name of the organization in your company working on the project, primary client and contact names, project manager, principal and supervisor names, project type and status, and user record access rights.

Each project record in the Project Info Center may have associated phases or tasks. Before you enter WBS information for a project, you must enter and save the project's general information. After you create the project record, you can enter as many phases and tasks as you need.

Location

To display the tab, complete the following steps:

1. From the Vision Navigation menu, click Info Center » Projects.
2. Click the General tab.

Contents

| Project | Enter a unique project identification number. | If Vision uses the auto numbering feature, you cannot enter a number in this field. Instead, [AUTONUMBER] displays in this field when you save the form. For a new project, after you save the project number, you can also enter the project's phase (second field). After saving the project number and phase, you can then enter the project's task (third field). The project number, phase, and task correlate with the |
## Work Breakdown Structure (WBS)

For Projects that have a defined multi-level WBS, a Phase/Task icon displays next to the Project Name. Click the icon to view the WBS tree structure.

You cannot use this field to change a project number after you create a project record.

You establish the length and format of your project numbers when you install Vision. If you need to change the length or format of your project numbers after installing Vision, use the Project Number Conversion utility.

### Phase

After you enter and save a project record, you can use this field to enter a phase that is associated with the project. Each project may have multiple phases.

The phase number is the second level of the Work Breakdown Structure.

### Task

After you enter and save a project record and a phase, you can enter a task that is associated with that phase. Each phase may have multiple tasks. You must enter a phase number before you enter a task number.

The task number is the third level of the Work Breakdown Structure.

### Opportunity

Enter the name of the opportunity associated with the project or use the Opportunity lookup or Quick Find to select an opportunity.

After you enter an opportunity in this field, you can click the opportunity name to open the Opportunity Info Center record in the current browser window. Or, right-click the name and then click on the Open in new window pop-up option to open the Opportunity Info Center record in a new browser window.

When you enter an opportunity in this field in a project record, the associated project’s number is entered in the Project field on the General tab of the Opportunity Info Center form.

If you create a new project record from an existing opportunity record, Vision enters the opportunity name in this field.

### Short Name

Enter a short name for the project. Use this field if the project name is too long to fully display on project reports and invoices.

### Promotional Project

This field is enabled for regular projects only.

Enter the name or number of the promotional project associated with the project, or use the Project lookup or Quick Find to select a project.

After you enter a promotional project, you can click the promotional project number to open the Project Info Center record in the current browser window. Or, right-click the number and then click the Open in new window option to open the Project Info Center record in a new browser window.

If you create a new project record from an existing promotional project record, Vision enters the promotional project number in this field.

### Long Name

Enter the full name of the project.

### Project Plan

Enter the name of the plan associated with the project or use the Plan lookup or Quick Find to select a plan.

After you enter a plan, you can click the plan name to open the Project Planning record in the current browser window. Or, right-click the name and then click the Open in new window option to open the Project Planning record in a new browser window.

If you create a new project record from a project plan, Vision enters the plan name in this field.

### Organization

Enter the organization that is responsible for the project or use the Organization
Multicompany. The organization code that you specify here indicates which company "owns" the project, phase, or task record. The active company determines which organizations are available for the Organization lookup.

<table>
<thead>
<tr>
<th><strong>Federal Project</strong></th>
<th>Select this option if the project is for an agency or branch of the federal government.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Referable</strong></td>
<td>Select this option if the project can be used as a reference.</td>
</tr>
<tr>
<td><strong>Primary Client</strong></td>
<td>Enter the name of the primary client associated with the project, or use the Client lookup or Quick Find to select the client. When you enter a client name in the <strong>Primary Client</strong> field:</td>
</tr>
<tr>
<td></td>
<td>• Vision creates a hyperlink between the client name and the corresponding Client Info Center record. You can then click the client name in this field to open the Client Info Center record.</td>
</tr>
<tr>
<td></td>
<td>• Vision adds the client’s name and related information to the Clients grid on the Clients/Contacts tab of the Project Info Center form.</td>
</tr>
<tr>
<td></td>
<td>• Vision adds the project’s name and related information to the Projects grid in the Client Info Center form.</td>
</tr>
<tr>
<td></td>
<td>To edit the client name, right-click the name and click <img src="image" alt="Edit" />. This temporarily disables the hyperlink feature, allowing you to edit the information in this field.</td>
</tr>
<tr>
<td><strong>Confidential</strong></td>
<td>When you use Vision Proposals, select this option to keep the <strong>Primary Client's</strong> and <strong>Owner's</strong> names confidential and to exclude their names from all proposals. When you include the project in a proposal, an alias that you create will be substituted for the client or owner name. If you select this option, the <strong>Alias</strong> field displays on the General tab. Use this field to enter the name you want to substitute for the client’s and owner’s actual name.</td>
</tr>
<tr>
<td><strong>Alias</strong></td>
<td>This field displays when you select the <strong>Confidential</strong> option. Enter the name you want to substitute for the <strong>Primary Client's</strong> or <strong>Owner's</strong> actual name when you include this project in a proposal.</td>
</tr>
<tr>
<td><strong>Client Address</strong></td>
<td>When you enter a client name in the <strong>Primary Client</strong> field on the General tab, Vision enters the primary address associated with that client record in the <strong>Client Address</strong> field. However, you can enter a different client address in this field. This address displays on client reports.</td>
</tr>
<tr>
<td></td>
<td>The actual address does not display in this field. When you enter a client address in the Client Info Center, you must also enter a description for the address and you must designate one address as the primary address. It is the description for the primary address that displays in the <strong>Client Address</strong> field on the General tab.</td>
</tr>
<tr>
<td></td>
<td>To select a different address, click <img src="image" alt="Find" /> to use the Address Lookup to select another address. The Address Lookup only lists addresses for the client entered in the <strong>Primary Client</strong> field.</td>
</tr>
<tr>
<td><strong>Primary Contact</strong></td>
<td>Enter the name of the primary contact associated with the project, or use the Contact lookup or Quick Find to select a contact. When you enter a contact name in this field:</td>
</tr>
<tr>
<td></td>
<td>• Vision creates a hyperlink between the contact name and the corresponding Contact Info Center record. You can then click the name in this field to open the Contact Info Center record in the current browser window. Or, right-click the name and then click the <strong>Open in new window</strong> option to open the</td>
</tr>
</tbody>
</table>
| Principal | Enter the name of the employee who is the principal for the project, or use the Employee lookup or Quick Find to select the employee. When you enter an employee name in this field:  
- Vision creates a hyperlink between the employee name and the corresponding Employee Info Center record. You can then click the name in this field to open the Employee Info Center record in the current browser window. Or, right-click the name and then click the *Open in new window* option to open the Employee Info Center record in a new browser window.  
- Vision adds the employee's name and related information to the Employees grid on the Team tab of the Project Info Center form.  
Note the following:  
- If you remove an employee from the Principal field of a project record, the employee is removed from the Employees grid on the Team tab of the Project Info Center record only if the employee's Team Status is Proposed. If the employee's Team Status is Active, the employee's name remains in the grid, but the Role field is cleared.  
- If you remove an employee from the Principal field of a project record, the project is removed from the Projects grid on the Projects tab of the associated Employee Info Center record only if the employee's Team Status is Proposed. If the employee's Team Status is Active, the project's name remains in the grid, but the Role field is cleared.  
- If you remove an employee (with role type Principal) from the Employees grid on the Team tab of the Project Info Center record, and that employee is also entered in the Principal field on the General tab of the Project Info Center record, the employee is also removed from the Principal field.  
- Vision does not update the Principal field when you change an employee's role on either the Team tab of the Project Info Center record or on the Project tab of the Employee Info Center record. When you make a change on either of those tabs, you must manually change your entry in the Principal field. |
|---|---|
| Project Manager | Enter the name of the employee who is the project manager for the project, or use the Employee lookup or Quick Find to select the employee. When you enter an employee name in this field:  
- Vision creates a hyperlink between the employee name and the corresponding Employee Info Center record. You can then click the name in this field to open the Employee Info Center record in the current browser window. Or, right-click the name and then click the *Open in new window* option to open the Employee Info Center record in a new browser window.  
Vision adds the employee's name and related information to the Employees grid on |
the Team tab of the Project Info Center form.

Vision adds the project’s name and related information to the Projects grid on the Projects tab of the Employee Info Center form.

To edit the name, right-click the name and click **Edit**. This temporarily disables the hyperlink feature and allows you to edit this field.

Note the following:

- If you remove an employee from the **Project Manager** field of a project record, the employee is removed from the Employees grid on the Team tab of the Project Info Center record only if the employee's **Team Status** is **Proposed**. If the employee's **Team Status** is **Active**, the employee's name remains in the grid, but the **Role** field is cleared.

- If you remove an employee from the **Project Manager** field of a project record, the project is removed from the Projects grid on the Projects tab of the associated Employee Info Center record only if the employee’s **Team Status** is **Proposed**. If the employee’s **Team Status** is **Active**, the project’s name remains in the grid, but the **Role** field is cleared.

- If you remove an employee (with role type **Project Manager**) from the Employees grid on the Team tab of the Project Info Center record, and that employee is also entered in the **Project Manager** field on the General tab of the Project Info Center form, the employee is also removed from the **Project Manager** field.

- Vision does not update the **Project Manager** field when you change an employee's role on either the Team tab of the Project Info Center record or on the Project tab of the Employee Info Center form. When you make a change on either of those tabs, you must manually change your entry in the **Project Manager** field.

<table>
<thead>
<tr>
<th><strong>Supervisor</strong></th>
<th>Enter the name of the employee who is the supervisor for the project, or use the Employee lookup or Quick Find to select the employee.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Supervisor</strong></td>
<td><strong>Enter the name of the employee who is the supervisor for the project, or use the Employee lookup or Quick Find to select the employee.</strong></td>
</tr>
</tbody>
</table>

When you enter an employee name in this field:

- Vision creates a hyperlink between the employee name and the corresponding Employee Info Center record. You can then click the name in this field to open the Employee Info Center record in the current browser window. Or, right-click the name and then click the **Open in new window** option to open the Employee Info Center record in a new browser window.

- Vision adds the employee's name and related information to the Employees grid on the Team tab of the Project Info Center form.

- Vision adds the project's name and related information to the Projects grid on the Projects tab of the specified Employee Info Center form.

To edit the name, right-click the name and click **Edit**. This temporarily disables the hyperlink feature and allows you to edit this field.

Note the following:

- If you remove an employee from the **Supervisor** field of a project record, the employee is removed from the Employees grid on the Team tab of the Project Info Center record only if the employee’s **Team Status is Proposed**. If the employee’s **Team Status is Active**, the employee’s name remains in the grid, but the **Role** field is cleared.

- If you remove an employee from the **Supervisor** field of a project record, the project is removed from the Projects grid on the Projects tab of the associated Employee Info Center record only if the employee's **Team Status is Proposed**. If the employee's **Team Status is Active**, the project's name
If you remove an employee (with role type **Supervisor**) from the Employees grid on the Team tab of the Project Info Center record, and that employee is also entered in the **Supervisor** field on the General tab of the Project Info Center record, the employee is also removed from the **Supervisor** field.

- Vision does not update the **Supervisor** field when you change an employee’s role on either the Team tab of the Project Info Center record or on the Project tab of the Employee Info Center record. When you make a change on either of those tabs, you must manually change your entry in the **Supervisor** field.

---

**Biller**

Click 📩 to open the Employee lookup, and select the employee who is responsible for creating the Billing invoices for a project.

You can also start typing in the **Biller** field and then press the ENTER key to use the Quick Find search to select the employee.

This field is informational if you do not use the Billing Invoice Approvals feature.

If you use the Billing Invoice Approvals feature, a biller has access in **Billing » Invoice Approvals** and **Billing » Interactive Approvals** to the projects for which they are specified as the biller. In addition, you can specify that the biller receive alerts when an invoice is submitted (in Invoice Approval Process Configuration).

If you are enabling Invoice Approvals for a group of existing projects, you can use the Search and Replace utility (**Utilities » Advanced Utilities » Search and Replace**) to insert employees into the **Biller** field for those projects, rather than entering each biller individually.

---

**Project Type**

Use this drop-down list to select the project type. You define project types in Code Table Configuration.

The project type is different from the project’s charge type, which indicates whether the project is a regular, overhead, or promotional project. You enter a project’s charge type on the Accounting Tab.

---

**Responsibility**

Use this drop-down list to select your company’s level of responsibility on this project. You define project responsibility settings in Code Table Configuration.

---

**Status**

Use this drop-down list to select the project’s status. A project’s status determines the validity of certain project-related transactions in Vision.

The status settings are:

- **Active** — You can use the project in any transaction that requires a project number.
- **Inactive** — Visions displays a warning if you try to use the project in any transaction that requires a project number. You must choose to proceed with the transaction after you receive the warning.
- **Dormant** — Vision prevents you from using the project number in any transaction that requires a project number, except for receipt, invoice, and historical data entry, and bill processing. Vision displays a warning when you process receipts, invoices, historical data, and bills, but you can complete the transaction.
- **Purged** — Vision does not allow any transaction activity on the project.

---

**Project Currency**

Multicurrency. Select the currency in which the project is managed; this can differ from the functional currency of the project’s home company.

The project currency is the currency in which a project is managed. The project currency is used for all project reporting and project planning. When labor or expense charges are made to the project, the charges are recorded in the project currency (as
well as all other appropriate currencies). After data is posted, you cannot change the project currency for the project.

**Billing Currency**

Multicurrency. Select the currency in which the project is managed; this can differ from the functional currency of the project’s home company. The billing currency is the currency used to generate invoices and billing reports for a project and all its phases and tasks. The project and billing currencies do not need to be the same. You can plan and manage a project in one currency and invoice the client in another. After data is posted, you cannot change the billing currency for the project.

**Available to CRM users**

This option displays if you use both Vision CRM and Vision Accounting. Select this option to allow CRM users to open and review the project record. Vision selects this option by default when you add a new project record. You can select or clear this option at any time.

**Available to Accounting users**

This option displays if you use both Vision CRM and Vision Accounting. Select this option to allow Accounting users to open and review the project record. Vision selects this option by default when you add a new project record. You can select this option at any time. However, you can clear this option only if the **Approved for use in processing** option is not selected.

If this option is selected when you save a new project record, Vision prompts you to enter required information on the Accounting tab. You must enter the required information before you can save the record.

**Approved for use in processing**

This option displays if you use Vision Accounting or Vision Project Control. Select this option if the project record is approved for use when processing accounting transactions. Vision selects this option by default when an Accounting user adds a new project record. It is disabled for all other users. If you are an Accounting user, you can select this option at any time. However, you can clear this option only if the project record has not been used in any accounting transactions.

If this option is selected when you save a new project record, Vision prompts you to enter required information on the Accounting tab. You must enter the required information before you can save the record.

**Memo**

Enter additional notes about the project.

You can enter text directly in this field or click Edit to use the Vision Text Editor to enter text.

### Billing Term Changes for Invoices that are Approved or Submitted for Approval

If you use the Invoice Approvals feature in Billing and you make changes to the billing terms for projects that have approved or submitted invoices in progress, the changes are not applied to these invoices.

For example, if you update the labor rate table in billing terms for a project that has a submitted or approved invoice, the invoice is not recalculated to incorporate the new rates. To recalculate amounts on the already approved or submitted invoice, you can resubmit it in Interactive Billing. Instead of resubmitting, you can insert new transactions in Interactive Approvals or Interactive Billing and recalculate the invoice.
How Security Settings Affect Vision Billing

Vision security is based on roles, or groups of users categorized by how they use Vision. The access rights assigned to your role for billing-related forms and actions determine your access to those forms and actions.

Your system administrator can configure your role's access rights as follows:

- Block or grant access to Billing or Billing menu options.
- Restrict interactive access to certain Billing options (for example, ability to allow or block access to modifying, deleting, writing-off, final processing, and placing transactions on hold).
- Restrict access to billing terms.
- Block ability to delete invoices.
- Restrict access to certain projects.
- Restrict access to billing groups.

Contact your system administrator for more information about your role's access rights.

Block or Grant Access to Billing Application Options

Your system administrator can block or grant access to the entire Billing application, or to any of the Billing forms. If your role does not have access to a form, it does not display under Billing in the Navigation pane.

Restrict Access to Certain Billing Options

Your system administrator can restrict your role's access to functions in the following Billing applications, even if they are available to you:

- Billing Terms (Allow final processing)
- Interactive Billing (Allow hold, Allow write-off, and more)
- Interactive Approvals (Allow hold, Allow write-off, and more)

If your firm enables invoice approval, the security settings that control your access to billing options in the Interactive Billing form also control your access to those same options in the Interactive Approvals form. (Some options in Interactive Billing are not applicable to the approval process. Those options are not available to anyone in the Interactive Approvals form.)

Restrict Access to Billing Terms

On the Roles form (Configuration Security Roles), your system administrator can control access to billing terms in a variety of ways:

- If Billing Terms is selected for your role in the list of menu options on the General tab, you have access to all tabs on the Billing Terms form. The selection in the Access column of the Application Record Access grid on the Record Access tab determines your level of access: read only, modify only, add or modify, or full access.
- If Billing Terms is not selected for your role in the list of menu options on the General tab and Percent Complete is selected for Billing Terms in the Application Record Access grid on the Record Access tab, you can only access Billing Terms from Interactive Billing, Invoice Approvals, or Interactive Approvals, and only if your role has access to those forms. On the Fees tab of the Billing Terms form, you can only enter percent complete and fee-to-date values and click Show Fee to display fee amounts. On
the General tab, you can only edit the **Description** field. You cannot edit other fields on those two tabs or display other Billing Terms tabs.

- **If Billing Terms** is not selected for your role in the list of menu options on the General tab and **None** is selected for **Billing Terms** in the **Application Record Access** grid on the Record Access tab, you can view all information on the Fees tab and General tab on the Billing Terms form but cannot update any of that information.

**Restrict or Allow the Ability to Process Final Bills from Batch Billing**

Your system administrator can grant or block your role's access to process final bills by selecting or not selecting **Allow final Processing** from the Accounting tab of the Roles form (**Configuration » Security » Roles**). For example, your administrator may allow your role access to certain functions in Batch Billing, such as processing draft bills, but block access to processing final bills.

**Block Ability to Delete Invoices**

To delete an invoice from Invoices on File within Interactive Billing, your system administrator must select the **Allow Invoices on file to be deleted** option from the Accounting tab of Security Role Configuration. If this option is not selected, your role cannot delete invoices. Deleting an invoice prevents you from being able to reprint or void the invoice.

**Restrict Access to Certain Projects Through Vision Billing**

If your role can access the Billing application, your system administrator can still restrict your role's access to certain projects. To do so, the system administrator selects the **Apply Project Record Level Security** option on the Accounting tab of Security Role Configuration. If this option is not selected, your role can access all projects through Vision Billing.

**Multicompany**

If your firm has enabled the Multicompany feature, and your system administrator does not select the **Apply Project Record Level Security** option, your billing personnel will have access to all projects in which the main billing project belongs to the active company.

**Restrict Access to Projects that Belong to Billing Groups**

From the Accounting tab of Security Role Configuration, your system administrator can also choose to apply your role's access rights to projects that belong to billing groups by selecting **Apply to Sub Projects in Billing Groups**.

The **Apply to Sub Projects in Billing Groups** setting works as follows:

- **If your system administrator has configured your role with this setting, you can view and edit information for all of your accessible main projects, and you can add any sub-project to which you have security access. If your role does not have access to the main project, however, you cannot view the sub-projects, regardless of your rights to access these sub-projects individually.**

- **If your role has not been configured with this setting but you have access rights to the main project, you can add any project as a sub-project, regardless of the security of those sub-projects.**
Billing Terms Security

You have two basic options for setting up security for billing terms. You can give a role access to all parts of the Billing Terms form, or you can limit access to fee percent complete information. The latter option enables you to give project managers access to update fee percent complete for their projects as part of the without giving them any other access to billing terms.

General Access

If you want a role to have general access to the Billing Terms form, select the Billing Terms check box on the General tab of the Roles form, and select the type of access (Read Only, Modify Only, Add/Modify, or Full) for Billing Terms in the grid on the Record Access tab. Users assigned to the role have only the type of access you select, but they have that access for all of the tabs on the Billing Terms form.

If, in addition, you want the users assigned to the role to be restricted only to the billing terms for the projects to which they have access, also select Billing under Apply Project access to on the Record Access tab.

Update Fee Percent Complete Access

Some firms want to be able to set up a role for project managers that only has access to fee information on the Billing Terms form. Project managers can review and update percent complete and fee-to-date information as part of the invoice approval process, for example, but cannot update any other billing terms information.

To implement this type of access, do not select the Billing Terms check box on the General tab of the Roles form. On the Record Access tab, select either Percent Complete or None for Billing Terms in the grid:

- Users assigned to a role for which Percent Complete is selected can view all information on the Fees tab on the Billing Terms form but can only update percent complete and fee-to-date fields on the Fees tab and the Description field on the General tab.
- Users assigned to a role for which None is selected can view all information on the Fees tab and General tab on the Billing Terms form but cannot update any of that information.

If, in addition, you want the users assigned to the role to be restricted only to the fee information for the projects to which they have access, also select Billing under Apply Project access to on the Record Access tab.

Users who only have access to fee information in Billing Terms cannot use the Billing Terms link in the Navigation pane, in the Project Info Center, or in Interactive Billing to display the Billing Terms form. They can only display the fee information using the Update Fees options in Invoice Approvals, Interactive Approvals, or Interactive Billing (assuming they have access to one or more of those forms).
Enable an Invoice Approval Process

If your firm enables the invoice approval feature on the Billing Setup form, you have the option to enable an invoice approval process for projects individually on the Misc tab of the Billing Terms tab.

Billing Groups

For billing groups, you perform this procedure only for the main project in the billing group. While you can also set the options related to invoice approval for the sub-projects in a billing group, those settings are ignored.

To an invoice approval process, complete the following steps:

1. From the Vision Navigation menu, click **Billing » Billing Terms** to display the Billing Terms form.
2. Open the project for which you want to enable invoice approval.
3. At the project level (the top level of the work breakdown structure), select the Misc tab. Vision displays the miscellaneous billing terms for the project.
4. Select the **Enable Invoice Approval** check box.
5. To specify the approval process for the project, select it in **Approval Process**.
   - To use the default approval process specified on the Billing Setup form, leave **Approval Process** blank.
6. Click **Save**.

Misc Tab of Billing Terms Form

Use the Misc tab to specify miscellaneous billing terms, such as billing limits, invoice override accounts, retainage settings, and tax codes.

Location

To display the Misc tab of the Billing Terms form, complete the following steps:

1. From the Vision Navigation menu, click **Billing » Billing Terms**.
2. Click the Misc tab.

Contents

<table>
<thead>
<tr>
<th>Limit method</th>
<th>The upset limit method determines how Vision displays upset limits on the invoice. There are five different upset limit methods:</th>
</tr>
</thead>
<tbody>
<tr>
<td>No limits</td>
<td>• No limits</td>
</tr>
<tr>
<td>Aggregate Limit</td>
<td>• Aggregate Limit</td>
</tr>
<tr>
<td>Individual Limits</td>
<td>• Individual Limits</td>
</tr>
<tr>
<td>Print individual limits - Calculate aggregate for sections with limits</td>
<td>• Print individual limits - Calculate aggregate for sections with limits</td>
</tr>
<tr>
<td>Print individual limits - Calculate aggregate for all sections</td>
<td>• Print individual limits - Calculate aggregate for all sections</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>Fee limit</strong></td>
<td>Enter the limit up to which fee charges may accrue for this project.</td>
</tr>
<tr>
<td><strong>Labor limit</strong></td>
<td>Enter the limit up to which labor charges may accrue for this project.</td>
</tr>
<tr>
<td><strong>Consult limit</strong></td>
<td>Enter the limit up to which consultant expense charges may accrue for this project.</td>
</tr>
<tr>
<td><strong>Expense limit</strong></td>
<td>Enter the limit up to which reimbursable expense charges may accrue for this project.</td>
</tr>
<tr>
<td><strong>Unit limit</strong></td>
<td>Enter the limit up to which unit expense charges may accrue for this project.</td>
</tr>
<tr>
<td><strong>Add-on limit</strong></td>
<td>Enter the limit up to which add-on fee charges may accrue for this project.</td>
</tr>
</tbody>
</table>

**Fee**

The default revenue account for fee billing is defined in the Billing Setup form. If you want to use a different revenue account for fee billing for the project, enter or select that account in this field.

Click **Find** to perform an account lookup.

If you enter an override account, it displays on the Invoice Accept dialog box in Interactive Billing and Batch Billing for the fee section.

**Labor**

The default revenue account for labor billing is defined in the Billing Setup form. If you want to use a different revenue account for labor billing for the project, enter or select that account in this field.

Click **Find** to perform an account lookup.

If you enter an override account, it displays on the Invoice Accept dialog box in Interactive Billing and Batch Billing for the labor section.

**Consult**

The default revenue account for consultant expense billing is defined in the Billing Setup form. If you want to use a different revenue account for consultant expense billing for the project, enter or select that account in this field.

Click **Find** to perform an account lookup.

If you enter an override account, it displays on the Invoice Accept dialog box in Interactive Billing and Batch Billing for the consultant expense section.

**Expense**

The default revenue account for reimbursable expense billing is defined in the Billing Setup form. If you want to use a different revenue account for reimbursable expense billing for the project, enter or select that account in this field.

Click **Find** to perform an account lookup.

If you enter an override account, it displays on the Invoice Accept dialog box in Interactive Billing and Batch Billing for the reimbursable expense section.
<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Unit</strong></td>
<td>The default revenue account for unit billing is defined in the Billing Setup form. If you want to use a different revenue account for unit billing for the project, enter or select that account in this field. Click <strong>Find</strong> to perform an account lookup. If you enter an override account, it displays on the Invoice Accept dialog box in Interactive Billing and Batch Billing for the unit section.</td>
</tr>
<tr>
<td><strong>Add-on</strong></td>
<td>The default revenue account for add-on fee billing is defined in the Billing Setup form. If you want to use a different revenue account for add-on fee billing for the project, enter or select that account in this field. Click <strong>Find</strong> to perform an account lookup. If you enter an override account, it displays on the Invoice Accept dialog box in Interactive Billing and Batch Billing for the add-on fee section.</td>
</tr>
<tr>
<td><strong>Retainage</strong></td>
<td>Select this option to specify retainage terms for this project. When you select this option, Vision enables the remaining fields in this section.</td>
</tr>
<tr>
<td><strong>Percent</strong></td>
<td>Enter the percentage to apply as the retainage amount on the invoice. You can then apply retainage amounts to individual sections of the invoice by selecting as many sections (Fee, Labor, Consult, Expense, Unit, Add-on). Retainage is usually based on a percent of the entire invoice, often around 10%.</td>
</tr>
<tr>
<td><strong>Limit</strong></td>
<td>Enter the maximum dollar amount of retainage that can be generated for this project.</td>
</tr>
<tr>
<td><strong>Fee</strong></td>
<td>Select this option to apply the retainage percentage to the Fee section of your invoice.</td>
</tr>
<tr>
<td><strong>Labor</strong></td>
<td>Select this option to apply the retainage percentage to the Labor section of your invoice.</td>
</tr>
<tr>
<td><strong>Consult</strong></td>
<td>Select this option to apply the retainage percentage to the Consultant Expenses section of your invoice.</td>
</tr>
<tr>
<td><strong>Expense</strong></td>
<td>Select this option to apply the retainage percentage to the Reimbursable Expenses section of your invoice.</td>
</tr>
<tr>
<td><strong>Unit</strong></td>
<td>Select this option to apply the retainage percentage to the Unit section of your invoice.</td>
</tr>
<tr>
<td><strong>Add-on</strong></td>
<td>Select this option to apply the retainage percentage to the Add-on Fees section of your invoice.</td>
</tr>
<tr>
<td><strong>Tax when Withheld/Invoiced</strong></td>
<td>To bill for taxes on retainage amounts when the retainage is withheld, select <strong>Tax when Withheld</strong>.</td>
</tr>
</tbody>
</table>
To bill for taxes on retainage amounts when you bill the client for the retainage, select **Tax when Invoiced**.

If **Taxes by Phase** is selected on the Sub-Ledger Terms tab for the project, you cannot select this option for a phase unless you also select **Retainage by Phase** on the Sub-Ledger Terms tab. If **Taxes by Task** is selected on the Sub-Ledger Terms tab for a phase, you cannot select this option for a task unless you also select **Retainage by Task** on the Sub-Ledger Terms tab for the phase.

If you change this setting after generating an invoice for the project, Vision determines whether or not to calculate taxes for the retainage invoice based on the setting that applied at the time you generated the original invoice.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Over/Under Fee</strong></td>
<td>This field is only available if <strong>Enable Allocation of Billed Revenue on Fee Invoices Based on Transaction</strong> is selected on the Fees tab of the Billing Setup form. If that option is selected, a default over/under billed fee account is also specified on that tab. That account is the revenue account to which Vision posts the difference between the billed fee amount and the sum of fee revenue amounts calculated from transaction detail. Most companies use the labor billed revenue account. If you select <strong>Allocate Billed Revenue on Fee Invoices Based on Transactions</strong> on the Fees tab in the Billing Terms form for the project and you want to use a different revenue account than the default account from Billing Setup for fee billed revenue calculation variances, enter or select that account in this field. Click <code>Find</code> to perform an account lookup. This field is also available for default billing terms but is not available for reporting default billing terms.</td>
</tr>
<tr>
<td><strong>Interest</strong></td>
<td>Enter the interest rate charged each period on overdue invoices for this project.</td>
</tr>
<tr>
<td><strong>Grace Period</strong></td>
<td>Enter the period after which overdue invoices become subject to interest charges.</td>
</tr>
<tr>
<td><strong>Tax Code</strong></td>
<td>Enter a code for a tax to be applied to the various billings on the invoice.</td>
</tr>
<tr>
<td><strong>Tax-2 Code</strong></td>
<td>Enter a second codes for a tax to be applied to the various billings on the invoice.</td>
</tr>
<tr>
<td><strong>Tax-3 Code</strong></td>
<td>Enter a third code for a tax to be applied to the various billings on the invoice.</td>
</tr>
<tr>
<td><strong>Next Invoice Number</strong></td>
<td>Vision displays the next invoice number to be assigned for the current project, when the invoice <strong>Numbering Method</strong> on the General tab of Billing Setup is set to <strong>Project</strong>. This field displays at the Billing Terms project level only. This field does not display if the invoice <strong>Numbering Method</strong> in Billing Setup is set to <strong>Companywide</strong>.</td>
</tr>
</tbody>
</table>
### Invoice Footer
Enter a footer message to print at the end of this project’s invoice.

Vision automatically wraps to a second footer line when you enter more than 70 characters. You do not have to enter a carriage return to get a second line. To create more than two footer lines, however, set the insertion point where you want each line to break and press Enter.

This field displays at the Billing Terms project level only.

If Companywide is selected as the Numbering Method from the General tab of the Billing Setup form, the text entered in the Billing Setup Invoice Footer field prints at the bottom of each invoice page. If you also enter text in the Billing Terms Invoice Footer field, the text prints at the end of the project's invoice. The Billing Terms Invoice Footer text always prints at the end of the invoice.

If you are using SQL Server 2005 Reporting Services and you press Enter to break a footer line, “garbage” characters appear in the footer if you export the invoice to the RTF file format or to Microsoft Word. This is due to a limitation of SQL Server 2005 Reporting Services. If that occurs, you can edit the RTF or DOC file to clean up the footer text.

### Print Invoices without Current Activity
Select this option to print both draft and final bills in Interactive or Batch Billing.

If you select this option, Vision prints an invoice for a project without current billings as long as the project has fee terms established and/or outstanding accounts receivable. Use this option to identify projects for which fee terms have not been properly updated.

This field displays at the Billing Terms project level only.

### Enable Invoice Approvals
To enable the online invoice approval process for the project, select this check box.

This check box is only available if both of the following are true:
- Invoice approval is enabled on the Billing Setup form.
- The billing terms are for the top level of the work breakdown structure.

For billing groups, Vision only looks at this check box for the main project in the billing group. How you set this option for other projects in the billing group has no effect.

### Approval Process
If you select Enable Invoice Approvals, select the approval process you want to use for the project.

If you select Enable Invoice Approvals but do not select an approval process, Vision uses the default approval process specified on the Billing Setup form.

This field is only available if both of the following are true:
- Invoice approval is enabled on the Billing Setup form.
- The billing terms are for the top level of the work breakdown structure.

For billing groups, Vision only looks at this field for the main project in
Billing Session Options

When you display the Interactive Billing form or Batch Billing form, you first define billing session options. The Billing Session Options dialog box displays automatically.

Options Summary

Billing Session options include invoice formatting and printing options, such as the invoice date and the period start and end date labels that will print on invoices, and billing parameters, such as the cut-off date or cut-off period (Bill-thru date or Bill-thru period) for including transactions on this session's invoices.

You can also specify printer options, such as the paper size to use when printing, and the paper tray source. Access printer options by clicking the Print Setup button on the Billing Sessions Options dialog.

You can also modify billing options at any time during your session by clicking Tools » Options from the Interactive Billing toolbar or Options from the Batch Billing toolbar.

Invoice Approval and Billing Session Options

If an invoice is submitted for approval, Vision sets the invoice status to Submitted. Vision also stores the billing session options that are in effect for that invoice at the time of submittal and disables some of those options so you cannot change them. Those options are retained through the invoice approval process.

The values that cannot be changed for an invoice that is still in the approval process are the following:

- Period Start Date
- Period End Date
- Bill-thru Date
- Bill-thru Period
- Bill Scheduled Invoices Thru
- Invoice Addressee

If you need to change any of the disabled options for a submitted or approved invoice, you must first unsubmit it. After you make the changes, the invoice must start the approval process again.

If, when you begin a final billing session, you enter a value for one of those "locked" billing session options that conflicts with the value entered for that option for an invoice during the approval process, Vision uses the value set during the approval process when it generates the invoice.

Billing Session Options Dialog Box

Use this dialog box to establish options for the current billing session.

This includes formatting and printing options, such as the invoice date and period start and end dates that will print on invoices, and billing parameters, such as the cut-off date or cut-off period (Bill-thru date or Bill-thru period) for including transactions on this session's invoices.
Location

To display the Billing Sessions dialog box, complete the following steps:

1. From the Vision Navigation menu, click Billing » Interactive Billing or Billing » Batch Billing.

You can also open the dialog box by clicking any of the following:

- Tools » Options in Interactive Billing
- Options in Batch Billing
- Tools » Options in Interactive Approvals

Contents

<table>
<thead>
<tr>
<th>Invoice Date</th>
<th>The current date appears by default. Select the invoice date that Vision should use for invoices and credit memos that you display or print during this Interactive Billing or Batch Billing session. Select the date by entering it in the field or clicking and selecting the date from the calendar. The invoice date is also posted to the Accounts Receivable Ledger for aging purposes.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Period Start Date</td>
<td>Select the period start date to appear on the invoice you will send to the client. This field defaults to the active period start date. Select the date by entering it in the field or clicking and selecting the date from the calendar. This field is for invoice display purposes only and will not affect the transaction detail appearing on the Labor, Expenses, and Units tabs. This billing session option cannot be changed for an invoice that has been submitted for approval. To change it, you must first unsubmit the invoice.</td>
</tr>
<tr>
<td>Period End Date</td>
<td>Select the period end date to appear on the invoice you will send to the client. This field defaults to the active period end date. Select the date by entering it in the field or clicking and selecting the date from the calendar. This field is for invoice display purposes only and will not affect the transaction detail appearing on the Labor, Expenses, and Units tabs. This billing session option cannot be changed for an invoice that has been submitted for approval. To change it, you must first unsubmit the invoice.</td>
</tr>
<tr>
<td>Bill-thru Date</td>
<td>Select a bill-through date if you want Vision to limit available billable transactions to only those timesheets or expense transaction dates (for example, reimbursable expense item date, meals expense item date, voucher date, and so on) that matches the date you select. Select the date by entering it in the field or clicking and selecting the date from the calendar. When you view transactions on the Labor, Expenses, and Units tabs, Vision only includes transactions with a transaction or voucher date on or before the specified bill-through date. Other items do not appear, but are</td>
</tr>
</tbody>
</table>

7.1 Online Help Updates
### Billing Invoice Approvals

By using this feature, you can prepare invoices for one billing period while posting billable transactions for subsequent periods. Instead of placing all of the newer transactions on **Hold**, you can use this field to include only the desired transactions.

Leave this field blank if you want to bill through the end of the period. Some companies use this option if they invoice bi-monthly.

Remember that this date is typically the user-specified transaction date for labor and expense transactions. Therefore, by using a bill-thru date, you are relying on the user to always specify the correct date. If your bill-thru date is also your period end date, Deltek recommends that you use the **Bill-thru Period** option, and keep the **Bill-thru Date** field blank.

This billing session option cannot be changed for an invoice that has been submitted for approval. To change it, you must first unsubmit the invoice.

#### Bill-thru Period

Enter a bill-through period (accounting period and 4-digit fiscal year), if you want Vision to limit available billable transactions to only those whose timesheet or expense transaction date (for example, reimbursable expense item date, meals expense item date, voucher date, and so on) fall within the specified period. When you view transactions on the Labor, Expenses, and Units tabs, Vision only includes transactions with transaction or voucher dates through the specified bill-through period. Other items do not appear, but are saved for future billing sessions.

By using this feature, you can prepare invoices for one billing period while posting billable transactions for subsequent periods. Instead of placing all of the newer transactions on **Hold**, you can use this option to include only the desired transactions.

This billing session option cannot be changed for an invoice that has been submitted for approval. To change it, you must first unsubmit the invoice.

#### Show Non-billables on Detail Tabs

Select this option to include all non-billable transactions on the Labor, Expenses, and Units tabs for this session. Vision will not display these items on the invoice. The company-wide default for this option is set up from the General tab of Billing Setup. You can override the company-wide default for the current session only by selecting or de-selecting this option.

By default, all expense/unit charges (for units billed as expenses) posted to 500-level accounts, and labor charges posted to any labor code except the non-billable labor code, appear on the Labor and Expenses tabs. This feature is useful to find items that may have been posted to the wrong account or labor code.

If you select this option, the following transactions appear on the transaction tabs in Interactive Billing:

- Any labor posted to the non-billable labor code on the Labor tab.
- Any expenses posted to a 600-level account on the Expenses tab.

Typically, this feature can be used with fee jobs. By displaying non-billable transactions, you can better estimate the fee amount or the fee percent complete. This flag may also help you "catch" any item that was incorrectly posted to a non-fee project. Deltek recommends that you enable this.
This option is only available during an Interactive Billing session. Depending on your Billing Setup options, this option may be display only.

| Default to project view on detail tabs | Select this option to display all data for all WBS levels when opening a project in Interactive Billing. After you have opened the project, you can use the Phase/Task lookup to view detail for a particular phase or task, but this view will be the default view each time you open an Interactive Billing session and select a project.

If you do not select this option, when a project is selected in Interactive Billing, the detail tab displays the information for the first project, phase, task combination. Deltek recommends clearing this option to improve performance if you have a significant amount of detail or if each level of work breakdown has different billing terms. In these cases, the data on the detail tab will take longer to display if this option is selected. |

| Bill Scheduled Invoices Thru | Enter or select a date in this field to determine which billing schedule milestones to include in the Batch Billing run or Interactive Billing session for each project selected that has an associated billing schedule.

This option is available only if your firm has enabled Scheduled Billing from Billing Configuration (Configuration » Billing » General » Fees tab). This billing session option cannot be changed for an invoice that has been submitted for approval.

**Examples for Batch Billing**

- Run draft invoices on a date prior to the *Invoicing Date*, but enter a future date in the *Bill Scheduled Invoices Thru* field to allow you to include all invoices that are to be billed by a certain date (end of the month, for example). By doing this, you can create a batch of invoices that could be sent to the project manager for review prior to the bills being mailed to clients.

- Enter a date that would allow you to bill a milestone prior to the *Invoicing Date* established in the Billing Schedule *(Billing » Billing Terms » Fees tab » Scheduled Billing grid)*. For example, if a project has a milestone of $10,000 due on February 28th, but you want to send the invoice on February 20th, you could enter February 28th in the *Bill Scheduled Invoices Thru* field, run the batch on February 20th, and bill the amount earlier than scheduled.

**Example for Interactive Billing**

Enter a date that would allow you to bill a milestone prior to the *Invoicing Date* established in the Billing Schedule *(Billing » Billing Terms » Fees tab » Scheduled Billing grid)*. For example, if a project has a milestone of $10,000 due on February 28th, but you want to send the invoice on February 20th, you could enter February 28th in the *Bill Scheduled Invoices Thru* field, create the invoices on February 20th, and bill the amount earlier than scheduled.

If you enter a future date in this field, and a project's billing schedule includes more than one milestone between the date you are creating the bills *(Invoice Date selected from the Billing Session Options dialog box)* and the *Bill Scheduled Invoices Thru* date, Vision combines the amounts
of all milestones to arrive at the amount to be billed on the invoice that is created for that project.

**If Multiple Milestones Fall Between the Date Bills Are Created and the Bill Scheduled Invoices Thru Date**

When more than one milestone falls between the date you create the bills (Invoice Date) and the date entered in the Bill Scheduled Invoices Thru field, Vision combines the amounts, or uses the highest percentage of total fee to create the invoice. Here are two examples:

- If the Fee Method and Fee Basis selected for a schedule’s milestone is based on an amount (Fees tab of Billing Terms form), the billing session Invoice Date is April 31st, and the project to be billed has two milestones that have not been billed yet with dates of March 1st for $10,000 and April 1st for $20,000, Vision creates an invoice for $30,000 for this project.

- If the Fee Method and Fee Basis is based on a percentage, the billing session Invoice Date is April 31st, and the project to be billed has two milestones that have not been billed yet with dates of March 1st for 20% and April 1st for 50%, Vision creates an invoice for 50% of the fee amount on the invoice.

**Multicompany**

If your company has enabled the Multicompany feature, this option is available only if scheduled billing is enabled for the current company.

| Starting period for transaction detail | Enter the beginning period (month and year) from which you want to include transaction data for overhead or promotional projects. Use this option to omit older transaction detail from displaying in transaction grids (Labor, Expenses, Units).

  The default is the current accounting period less one month. For example, if the current accounting period is 8/1/07, the starting period for transaction detail would be 7/1/07. |
| Number of periods to include | Enter a number to indicate the number of periods of transaction detail to include in the transaction detail grids (Labor, Expenses, Units) for overhead or promotional projects. The beginning period is based on the entry in the Starting period for transaction detail field.

  The value entered here applies only to the current session. For performance reasons, the entry in this field is not saved from session to session. |
| Invoice File Name | This option applies to Interactive Billing only. If you have already gone into the Accept form during this session, Vision automatically displays the name of the invoice data entry file selected.

  Otherwise, when you accept the first invoice in this Interactive Billing session, Vision displays a prompt asking you for an Invoice Transaction Entry file. As you finalize your invoices, Vision appends invoice amounts to this file.

  This field is for reference purposes only and cannot be changed. |
### Next Company Wide Invoice Number

For Interactive Billing and Batch Billing, this field is enabled only if **Companywide** is selected in the **Numbering Method** field for invoice numbers on the General tab of Billing Setup. This field is always disabled when you open the Billing Session Options dialog box from Interactive Approvals.

This field prefills with the next invoice number that will be used when you accept a final invoice. Vision increments this number by 1 after you accept a new invoice.

The invoice number in this field applies for both invoices and credit memos.

**Important Information About Changing the Invoice Number in this Field**

- You can change the number if the **Allow Changes to Next Invoice Number** check box is selected for invoice numbers on the General tab of Billing Setup.

- When you change the next invoice number and there are multiple users generating invoices, the next accepted invoice will acquire the next invoice number, regardless of which user changed the invoice number. To increase your chances of having a changed invoice number assigned to your invoice, change the next invoice number just before you accept an invoice instead of at the beginning of the billing entry session.

- When you change the number in the **Next Company Wide Invoice Number** field, it is also changed in the **Next Company Wide Invoice Number** field on the General tab of Billing Setup. When you use the company-wide invoice numbering method, you can change the next invoice number on either the Billing Session Options dialog box or on the General tab in Billing Setup.

When you use the Project numbering method for invoices, the project-based invoice numbers do not display on the Billing Session Options dialog box. When you use the project numbering method, you must change invoice numbers on the Misc tab in Billing Terms for a project.

### Preview Accepted Invoice

Select this option to display final invoices on your screen prior to printing them.

You can print a hard copy invoice from Print Preview mode. To do this, click **Print Report** at the top of the previewed invoice.

You may want to select this option when you have manually created invoices and you are now only recreating them in Vision, or if the invoices were created using another system.

This option is available from Interactive Billing only.

### Disable Upset Limits

Select this option to calculate final invoices in Interactive and/or Batch Billing without applying upset limits. This feature is useful if you are using upset limits to budget your projects, but are not required to bill them in this way.

The company-wide default for this option is set up from the General tab of Billing Setup. You can override the company-wide default for the current session only by selecting or de-selecting this option.
Depending on your Billing Setup options, this option may be disabled for editing.

**Invoice Addressee**
Select the option to print on the first line of the invoice address. Options are:

- **Address 1 of Billing Client's Billing Address** — Vision prints the text entered in the Address 1 field of the address specified as the project's billing address. You save client address information in the Client Info Center. You specify which saved address to use as a project's billing address from the Project Info Center.

- **Name of Billing Client** — Vision prints the client name, as entered in the project's Billing Client field, in the Project Info Center.

- **Name of Billing Contact** — Vision prints the contact name, as entered in the project's Billing Contact field.

- **Name of Billing Contact / Client** — Vision prints the name of the billing contact as the first address line and the name of the billing client will print as the second address line.

Vision prints the first (or first and second) line of the address based on the option you select, and below prints the information as entered on the remaining Address fields of the Billing client's billing address.

This billing session option cannot be changed for an invoice that has been submitted for approval.

**Report Printer**
The printer where you want hard copy reports to print for this billing session. The default is the printer set up for the current user from the Users tab of Configuration » Security » Users and Passwords. You can change this default from the Billing Session Printer dialog, accessible by clicking the Print Setup button.

**Retain Invoices for up to x hours**
This option allows you to set a limit on the number of hours each generated invoice is saved on the server. By default, each report is saved the number of hours entered in the retain report output for x hours field on the Servers tab of General System Settings.

The value entered in this field must be greater than zero (0) since Vision does not allow reports to be saved indefinitely.

**Print Setup**
Select this option to open the Billing Session Printer dialog box, from which you set printing options, such as the destination printer, and paper size.

---

**Interactive Billing Toolbar**
Use the toolbar on the Interactive Billing form to perform billing related actions, such as approving an invoice for billing and accepting a final invoice.

**Location**

To display the Interactive Billing toolbar, complete the following step:

1. From the Vision Navigation menu, click **Billing » Interactive Billing**.
Click **Invoice** on the toolbar to display a menu from which you can select the following actions:

- **Submit** — If invoice approval is enabled for the project, click **Submit** to submit the invoice for approval. This option is also available for submitted invoices so you can resubmit an invoice without having to unsubmit it first.

- **Approve** — If invoice approval is enabled for the project, click **Approve** to approve the invoice for billing. (This option is only available if the approval status of the invoice is Submitted and if you are an approver for the project.)

- **Unsubmit** — If invoice approval is enabled for the project, click **Unsubmit** if you want to start the approval process over from the start. Unsubmitting removes all approval history associated with the submitted invoice. (This option is only available for invoices that are submitted, approved, or rejected.)

- **Include New Transactions** — If invoice approval is enabled for the project, a transaction that is eligible for billing based on the billing session options has a New status if the invoice has not yet been submitted for approval or if the transaction was not linked to the invoice at the time it was submitted for approval. For example, a transaction that was transferred to the project after the invoice was submitted would have New in Invoice Status. If the invoice has been submitted, a transaction with New in Invoice Status will not be included on the invoice. If, for a submitted or approved invoice, you want to include all transactions with New in Invoice Status on the invoice, click **Include New Transactions**. Vision then changes the status to Submitted or Approved for those transactions to match the approval status of the invoice. (This option is only available if invoice approval is enabled for the project.)

- **Accept** — Click **Accept** to accept the final invoice for the project currently open in the Interactive Billing form. Note that your ability to use this option depends upon the setting for the Interactive Access option in Configuration. (If invoice approval is enabled for the project, this option is only available if the invoice is approved for billing.)

- **Print** — Click **Print** to print the invoice as is to a printer. Do this to review the invoice before creating a final invoice.

- **Preview** — Click **Preview** to view the invoice on the screen. Do this to review the invoice before creating a final invoice.

- **Assign Invoice Number** — Click this option to open the Assign Invoice dialog and assign the next invoice number Vision will use when invoices are generated. Whether the number will be used for the next invoice generated for the open project, or for the entire company depends on whether your company uses a per project or company-wide invoice Numbering Method (established from the General tab of Billing Setup).

- **Edit** - Click this option to open the Edit Invoice dialog. Select the format in which you want to edit the invoice:
  - **Adobe PDF** — Saves the file in PDF format to be viewed in Adobe Reader.
<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
</table>
| If you own a full copy of the Adobe Acrobat product, you can make minor edits to the PDF file. | - **Rich Text Format (RTF)** — Saves the file in RTF format, which can be opened and edited in any Word Processing program, such as WordPad.  
- **Microsoft Word Document** — Saves the file in DOC format, which can be opened and edited in Microsoft Word.  
- **Microsoft Excel Spreadsheet (Display Format)** — Saves the file in XLS format, for display and editing in Microsoft Excel. This option does not show cell borders. This is the Deltek recommended format if you plan to edit the invoice after exporting it.  
- **Microsoft Excel Spreadsheet (Data Format)** — Saves the file in XLS format, for display and editing in Microsoft Excel. This option displays cell borders. |
| Delete Edited Invoice— | Click this option to remove the link between an invoice saved in a third-party software format and Vision. Deleting the invoice does not delete the file from its location on your PC or your network. Selecting **Delete Edited Invoice** simply deletes the link that associates the edited invoice with the Vision project record on the General tab of the Interactive Billing form. |
| Upload | Saves a copy of the document on the Vision application server and associates the edited invoice with the project in Interactive Billing. |
| Billing Terms | Click **Billing Terms** to open the Billing Terms form. Do this to verify the billing terms for the project, phase, or task currently open in the Interactive Billing form. Modify billing terms, as necessary. |
| Update Fees | If the selected invoice includes fees, click **Update Fees** to open the Fees tab of the Billing Terms form. From here you can verify and update fee billing information. You can also review and update information on the General tab of the Billing Terms form. You must have the required security access for the Billing Terms form. |
| Retainage | Click **Retainage** to open the Bill Retainage dialog box. Do this to view a list of all invoices for the project having unbilled retainage. You can select any or all invoices to bill the retainage.  
This option is enabled only if the Retainage feature is enabled from System Settings, and the currently open project, phase, or task has established billing terms. |
| Tools | Click **Tools** to access these options:  
- **Invoices on File** — Click **Invoices on File** to open the Invoices on File dialog box, where you can print, preview on screen, delete, or void previously created invoices. Deltek recommends extreme caution when deciding to delete an invoice. |
Update Fees for a Project from a Billing Form

Prior to producing invoices, ensure that your fees are properly updated for the current billing period. You can do this from both Interactive and Batch Billing. For projects for which invoice approval is required, you can also do this from both the Invoice Approvals form and the Interactive Approvals form.

To update fees for your projects from a billing form, complete the following steps:

1. Click Update Fees on the toolbar on the Interactive Billing form, Batch Billing form, Invoice Approvals form, or Interactive Approvals form.
2. On the Fees tab of the Billing Terms form, update the fee information.
   Depending on your security access, you may be able to do some or all of the following:
   - Change the fee method and/or fee basis for the project.
   - Update the overall percent completes or the percent complete for the individual phases.
   - Update the current fee amounts being billed, such as lump sum fee amounts or fee percentage.
   - Add, modify, or delete billing phase fees.
   - Add or edit the information on the General tab.
3. Click Save when you finish updating fees.

Accept the Final Invoice from Interactive Billing

Accepting an invoice is the final billing operations step you perform through Interactive Billing before posting the transaction from the Vision Transaction Center. Although you can run a final batch of invoices through Batch Billing, typically you use Batch Billing to run draft invoices (pre-billing) and accept final invoices through Interactive Billing.

To accept a final invoice, complete the following steps:

1. From the Vision Navigation menu, click Billing » Interactive Billing.
2. On the Billing Session Options dialog box, select your billing session options and click OK.
   If invoice approval is enabled for one or more of the projects, some billing session options cannot be changed for those projects unless you first unsubmit the invoice. If you do that, the invoice must be approved again before you can accept it. If you enter a value for one of those "locked" billing session options that conflicts with the value entered for the invoice during the approval process, Vision uses the value set during the approval process when it generates the invoice.
3. On the Interactive Billing form, select the projects for which you want to create final invoices.


   Vision creates a group of transactions and displays the Invoice File Selection dialog prompting you to add the transactions to an existing invoice file, or to create a new invoice file for the transactions.

5. Do one of the following:
   - To select an existing file, click the file on the Invoice File Selection dialog box and click OK.
   - To create a new file, click New and enter a name for the file in File Name. The purpose of this name is to make the group of invoices easy to identify in the Transaction Center.

   Vision adds the transactions (the total amounts extended on the invoice for fees, labor, expenses, units, additional charges, and taxes) that develop from generating your final invoices to the selected or new invoice file and displays the Invoice Accept dialog box.

6. Review the invoice transaction accounts and amounts for the project and change any information if needed. You can change information by clicking in any field on the Invoice Accept dialog box and modifying the value, or by inserting invoice transactions.

7. When you are satisfied with the information that will appear on the final invoice, click OK to begin the accept process.

   When you accept multiple invoices during an Interactive Billing session, Vision adds all the invoices to the same invoice transaction entry file. After you accept all of the invoices, you can review and edit the transaction entry file from the Transaction Center as desired prior to updating your database.

Save an Invoice to Edit in a Third Party Software Program

You can save an invoice to your local drive, or a network drive in Adobe PDF, Microsoft Excel, RTF, or Microsoft Word format.

Then you can edit the invoice in any of these formats (with some limitations if the file is a PDF). When you choose to edit a file in a third-party software program, Vision associates the edited invoice with the project in Interactive Billing by creating an Edited Invoice on File link for the project on the General tab of Interactive Billing.

After editing the file, you can upload the file back into Vision. When you upload a file, Vision saves a copy of the document in the Vision database.

You can preview an edited invoice from the Invoice Approvals form or Interactive Approvals form, as well as from the Interactive Billing form.

---

You must belong to a role with the proper access rights to edit and/or upload invoices.

---

To save an invoice for editing in a third-party software program, complete the following steps:

1. From the Vision Navigation menu, click Billing » Interactive Billing.
2. Select options from the Billing Session Options dialog box and click OK.
3. Open the appropriate project.
4. Click **Invoice » Edit**. The Edit Invoice dialog box displays.
5. Select the format in which you want to edit the file. Options are:
   - **Adobe PDF** — Saves the file in PDF format to be viewed in Adobe Reader. If you own a full copy of the Adobe Acrobat product, you can make minor edits to the PDF file.
   - **Rich Text Format (RTF)** — Saves the file in RTF format, which can be opened and edited in any Word Processing program, such as WordPad.
   - **Microsoft Word Document** — Saves the file in DOC format, which can be opened and edited in Microsoft Word.
   - **Microsoft Excel Spreadsheet (Display Format)** — Saves the file in XLS format, for display and editing in Microsoft Excel. This option does not show cell borders. This is the Deltek recommended format if you plan to edit the invoice after exporting it.
   - **Microsoft Excel Spreadsheet (Data Format)** — Saves the file in XLS format, for display and editing in Microsoft Excel. This option displays cell borders.
6. Click **Edit**. Vision prompts you to save the file, or open the file. Click one of the following:
   - **Open this file from its current location** — Opens the file in the program associated with the file type you selected. For example, if you select **Microsoft Excel Spreadsheet (Display Format)** from step 5 and you select this option, after you click **OK**, the file opens in Microsoft Excel.
   - **Save this file to disk** — Saves the file to the location you specify. If you select this option, you are prompted to browse to a location on your local or network drive. Click **Save** when finished.
7. Click **OK**.

You can also download an invoice in any of the above formats by previewing the invoice (**Invoice, Preview**), clicking **Download Report**, and selecting the appropriate file format option in the dialog box that displays. However, if you download the file in this way, Vision will not create a link to the file from Interactive Billing, and you will not be able to use the Upload feature to save a copy of the file to the database.

### Send Email Invoices to Project Stakeholders

You have several options for distributing draft or final invoices from Batch Billing and Interactive Billing, including the ability to send invoices to project stakeholders as email attachments.

#### From Interactive Billing

To send invoices as email attachments from Interactive Billing, complete the following steps:

1. From the Vision Navigation menu, click **Billing » Interactive Billing**.
2. Open the appropriate project.
3. From the Interactive Billing toolbar, click **Invoice » Preview**.
   - The invoice displays in a new browser window.
4. Click **Email Report**.
5. On the Email Report dialog box, complete the information in the following fields:
   - **To** — Enter a valid email address(es) for the primary recipient of the invoice.
   - **CC** — Enter a valid email address(es) for interested parties to copy on the invoice.
   - **BCC** — Enter a valid email address(es) for interested parties to blind copy on the invoice.
   - **Subject** — By default, the subject includes one or more of the following elements: Invoice, Project Number, Client Name, Invoice Number, Invoice Date, and Firm Name. Edit the subject, if desired.
   - **File Type** — Select the format for the invoice file. Options are: Microsoft Word Document, Adobe PDF, Microsoft Excel Spreadsheet (Display Format), Microsoft Excel Spreadsheet (Data Format), HTTP link to report output.

   Sending draft invoices through email in Microsoft Excel format to project managers is an easy way to get feedback on draft invoices from project managers. Project managers can enter corrections or comments directly in the Excel spreadsheet, highlight their comments in a different color to make additions easy for the billing administrator to find, and easily send the files back to the administrator.

   - **Message** — Enter a message to accompany the invoice report. You can click the Text Editor icon to format the message text.

6. Click **Send**.

### From Batch Billing

When you generate draft or final invoices from Batch Billing, you can elect to distribute the invoices as email file attachments. To do that, select the **Email Invoices** check box on the Main tab of the Batch Billing form before you start the batch billing process.

You can select one of the following recipient groups or you can specify one or more email addresses:

- Project managers
- Principals
- Supervisors
- Billing contacts
- Primary contacts

When you select one of these groups, Vision retrieves the necessary email addresses from Info Center records, based on the projects for which you are generating invoices.

Vision provides the following file format options for the emailed invoices:

- Adobe PDF
- Rich Text Format (RTF)
- Microsoft Word Document
- Microsoft Excel Spreadsheet
- HTTP link to the invoice

You control the contents of the subject line and message text of the email message to which the invoice files are attached. In addition, you can insert fields in the subject or message (for example, [:Invoice Number] and [:Invoice Date]). As it generates the email messages, Vision
substitutes the corresponding values for any fields you have inserted so that each email message is tailored for its recipient automatically.

You cannot print and send email invoices simultaneously. You must select one option per Batch Billing run.

**From Project Review or Invoice Review**

You can also email a final invoice from either the Project Review form or the Invoice Review form. In the Project Review form, select the project, select the invoice in the **Aged A/R** grid on the Accounts Receivable tab, preview the invoice, and email it from the Preview window. The procedure is similar in the Invoice Review form.

**From Invoice Approvals or Interactive Approvals**

You can also email draft invoices as attachments when you preview them from either the Invoice Approvals form or the Interactive Approvals form.

**Billing Backup Report and Unbilled Detail and Aging Report**

If you normally print the Billing Backup report or the Unbilled Detail and Aging report along with your invoices, Vision emails these reports when it emails your invoices.

**Upload an Edited Invoice**

After you save an invoice in a third-party format, such as Microsoft Word, and made changes to that invoice, you can then upload the edited file back into Vision.

When you upload a file, Vision saves a copy of the document on the Vision application server and associates the edited invoice with the project in Interactive Billing.

When you open the project with the associated invoice from the Interactive Billing form, an **Edited Invoice on File** link will appear next to the **Invoice** field on the General tab if an edited invoice exists. Click this link to open the associated invoice in the appropriate third-party software program. Each time you edit the invoice in the third-party software, you must use the upload feature again to update this link, and ensure that it opens the most recent copy of your document.

You can also preview an edited invoice from the Invoice Approvals form or Interactive Approvals form, as well as from the Interactive Billing form.

**Important Information About Uploading an Edited Invoice:**

- You must belong to a role with the proper access rights to edit and/or upload invoices.
- Remember that although you can upload the edited invoice to link this file to your Vision billing records, **any changes to amounts or calculations that you have made to the invoice in a third-party software program will not be recorded in Vision.** If you change amounts in your document outside of Vision and you want the amounts to be updated in Vision, make any necessary changes in the Interactive Billing Invoice Accept dialog box during the last steps of accepting an invoice.
- Also, before exporting the invoice to a third-party tool, see if the functionality offered in Billing Configuration, Billing Terms, or the Invoice Template Editor can be used to meet your needs.

**To upload an edited invoice, complete the following steps:**

1. From the Vision Navigation menu, click **Billing » Interactive Billing.**
2. Select options from the Billing Session Options dialog box and click OK.

3. Open the project for which you want to upload an edited invoice.

4. Optional. Deltek recommends that you run the **Assign Invoice Number** utility to instruct Vision to reserve an invoice number.

   If you don't reserve the invoice number now, do it before you upload and accept the final invoice. If you do not manually assign an invoice number, Vision automatically assigns the next available invoice number when you accept the invoice.

5. Edit the invoice in third-party application.

   If you selected the option, **Print Assigned Invoice Number** from the General tab of the Billing Setup form, the invoice number is automatically added in the upper right of the invoice when you open the invoice in the third-party application. If you did not select this option, you must manually enter the invoice number that was assigned by Vision using the Assign Invoice Number utility in the previous step.

6. Click **Upload**. The Upload Edited Invoice dialog box displays.

7. Click **Browse** and browse to the edited invoice file.

8. Select the file and click **Open**.

9. Click **OK**.

Remember that you must upload an edited invoice each time you make a change in the third-party software program you use to edit the invoice. Uploading the document updates the **Edited Invoice on File** link on the General tab of Interactive Billing, ensuring that the link opens the most recent version of your document.

### Void a Final Invoice

If an invoice has been accepted for final billing, you can void the invoice.

#### General Ledger Impact

When you void an invoice, you choose whether or not to update the general ledger. Vision creates a transaction file when you void an invoice that reverses the entries created when you processed the final invoice originally. If you want to update your general ledger for the void, post that transaction file. In this case, your General Ledger reports and Accounts Receivable reports will reflect the void.

If you do not want to update the general ledger for the void, delete both the original transaction file for the invoice and the transaction file that Vision creates for the void. In this case, the transactions associated with the invoice are again marked as billable, but the void has no impact on general ledger balances.

#### Transaction Status

When you void an invoice, Vision changes the status of the billed transactions included on the invoice back to billable. Because voiding an invoice changes only transactions included on the invoice, any edits you made to other transactions not associated with the invoice prior to voiding an invoice are not affected by the void.

Also, when you void an invoice, any transactions that were written off or deleted during that invoice period are not restored. Because written-off and deleted transactions are not associated with a specific invoice, they are not available to be billed when you void an invoice.
**Invoice Number**
When you create a final invoice, an invoice number is assigned. When you void the invoice, the invoice number cannot be reused.

**Credit Memos**
When you void an invoice that has credit memos generated against it, you must also void the credit memos. Credit memos are **not** automatically voided when you void the original invoice.

**Who Can Void an Invoice**
You must belong to a role with the proper access rights to void invoices (Interactive Billing - Allow Final Processing).

**Invoice Approval Status**
If the project is set up to require that invoices be approved before you can accept them for final billing, the approval status of an invoice is set to Approved when you void it.

When you void an invoice for a project that uses invoice approvals, Vision checks for other invoices for the project that are currently in the approval process. If the project has another invoice that has been submitted for approval and is still in the approval process, you cannot void the final invoice unless you first unsubmit the invoice that is awaiting approval or wait until the submitted invoice has completed the approval process.

**General Tab of Interactive Billing**
Use the General tab of Interactive Billing to confirm key billing information for an invoice, such as billing approval status, a summary of a project’s billing terms, and the billing address.

**Location**

**To display the General tab of Interactive Billing, complete the following step:**

1. From the Vision Navigation menu, click **Billing » Interactive Billing**.

**Contents**

<table>
<thead>
<tr>
<th>Invoice Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Invoice Status</strong></td>
<td>If invoice approval is enabled for the project, this field displays the approval status for the invoice:</td>
</tr>
<tr>
<td><strong>New</strong></td>
<td>The invoice has not been submitted for approval. (If an invoice is submitted and then at some point is unsubmitted, Vision also assigns the New status to it.)</td>
</tr>
<tr>
<td><strong>Submitted by</strong> &lt;submitter name&gt; &lt;submission date and time&gt;</td>
<td>The invoice is submitted for approval.</td>
</tr>
<tr>
<td><strong>Approved by</strong> &lt;approver name&gt; &lt;approval date and time&gt;</td>
<td>The invoice is approved for billing.</td>
</tr>
<tr>
<td><strong>Rejected by</strong> &lt;rejecter name&gt; &lt;rejection date and time&gt;</td>
<td>The invoice has been rejected for billing.</td>
</tr>
</tbody>
</table>

If invoice approval is not enabled for the project, this field is not displayed.

If invoice approval is enabled for the project, click **Comment** to view a list of
approval actions carried out to date and any comments related to the invoice approval process.

If invoice approval is not enabled for the project, this field is not displayed.

<table>
<thead>
<tr>
<th>Billing Group</th>
<th>This option is selected if the current project, phase, or task belongs to a billing group. The main project of the billing group displays in the <strong>Main Project</strong> field.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Main Project</td>
<td>If the current project, phase, or task belongs to a billing group, Vision displays the main project number for the group.</td>
</tr>
<tr>
<td><strong>Multicompany</strong></td>
<td>If you have enabled the Multicompany feature, the company that &quot;owns&quot; the main project in the billing group is the company that generates the invoice for the entire billing group.</td>
</tr>
<tr>
<td>Invoice</td>
<td>This field displays the next invoice number to be used for this project when invoices are generated, if an invoice number has been assigned using the <strong>Assign Invoice Number</strong> option.</td>
</tr>
<tr>
<td>Edited Invoice on File</td>
<td>This link displays if a copy of an invoice that has been edited in a third-party software program (for example Microsoft Word, or Microsoft Excel) exists for the project. Click the link to open the edited invoice for viewing or further editing. If you make further changes, be sure to save the document and to use the upload feature to replace the document with the most current version on the Vision application server. After the invoice is accepted Vision removes the link. You can access accepted invoices from the Invoices on File dialog. In the Invoices on File dialog box, Vision indicates invoices that have been edited in third-party software applications with an asterisk (*).</td>
</tr>
</tbody>
</table>
| Billing Currency | **Multicurrency only**  
This non-editable field displays the currency used by your company to generate invoices and billing reports for the current project. You select the billing currency for each project on the Accounting tab of the Project Info Center. |
| Terms on File | This option is selected if the current project, phase, or task has effective billing terms established from the Billing Terms form.                                                                              |
| Project       | If billing terms exist for the current project, phase, or task, the project number whose terms the current project uses displays in this field.  
If the project is a sub-project in a billing group and **Consolidate Printing** is selected for the billing group's main project, the main project number appears in this field.  
If a phase or task is open in the Interactive Billing form, and phase or task terms are established, the project number appears in this field, but the terms used may be phase or task terms.  
For projects that have a defined multi-level WBS, an icon similar to the following 🌱 will display next to the project name. Click the icon to view the WBS tree structure. |
### Phase
If phase billing terms exist for the current phase or task, and main project terms are not being used, the phase number displays in this field.

If the project is a sub-project in a billing group and **Consolidate Printing** is selected for the billing group's main project, phase billing terms are not used, and this field is blank. The billing terms established at the project-level for the main project are used for all sub-projects.

If a task is open in the Interactive Billing form, and task terms are established, the phase number appears in this field, but the terms used will be task terms.

### Task
If task billing terms exist for the current task, the task number displays in this field.

If the project is a sub-project in a billing group and **Consolidate Printing** is selected for the billing group's main project, task billing terms are not used, and this field is blank. The billing terms established at the project-level for the main project are used for all sub-projects.

### Fee Method
Vision displays the method selected to determine how to bill fee amounts for the project, phase, or task open in the Interactive Billing form.

This method is established in the **Fee Method** field on the Fees tab of the Billing Terms form for the main project, current project, or the current project's phase or task, depending on which terms are being used.

### Labor Method
Vision displays the method selected to determine how to bill labor amounts for the project, phase, or task open in the Interactive Billing form.

This method is established in the **Labor Method** field on the Labor tab of the Billing Terms form for the main project, current project, or the current project's phase or task, depending on which terms are being used.

### Consultant Method
Vision displays the method selected to determine how to bill consultant expense amounts for the project, phase, or task open in the Interactive Billing form.

This method is established in the **Method** field in the Consultant Terms section of the Exp/Con/Unit tab of the Billing Terms form for the main project, current project, or the current project's phase or task, depending on which terms are being used.

### Expense Method
Vision displays the method selected to determine how to bill reimbursable expense amounts for the project, phase, or task open in the Interactive Billing form.

This method is established in the **Method** field in the Expense Terms section of the Exp/Con/Unit tab of the Billing Terms form for the main project, current project, or the current project's phase or task, depending on which terms are being used.

### Notes
Enter notes about this invoice. You can enter up to 255 characters of text in this field; the text will wrap as you enter text. These notes do not appear on the invoice, they are for internal reference only.

Notes entered in the **Notes** field on the General tab of the Billing Terms form at the project-level, or for the main billing group project, appear in this field.
You may want to enter a note in the Interactive Billing form if someone is billing the project other than the usual person.
You must belong to a role with the proper access rights to enter notes in this field (Interactive Billing - Allow Final Processing).

| Billing Address | Vision displays the address where the invoice will be sent. Vision uses the Billing Address specified for the project (or main project, if the project is part of billing group) on the Accounting tab of the Project Info Center. The addressee line(s) (first and or first and second) are determined by your selection from the Invoice Addressee field of the Billing Session Options dialog box. |

**Labor Tab of Interactive Billing**

The Labor tab of Interactive Billing lists all billable employee labor charges entered through timesheets, labor adjustments, or billing labor inserts for the selected project up through the current period, Bill-thru-Date, or Bill-thru Period, as entered in the Billing Session Options dialog box. This detail is available to be billed on the next invoice created.

**Location**

To display the Labor tab of Interactive Billing, complete the following steps:

1. From the Vision Navigation menu, click Billing » Interactive Billing.
2. Click the Labor tab.

**Contents**

<table>
<thead>
<tr>
<th>Invoice Status</th>
<th>If invoice approval is enabled for the project, this field displays the approval status for the transaction:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Submitted, Approved, or Rejected — The transaction was linked to the invoice at the time it was submitted for approval. Its approval status in this field is the same as the current approval status of the invoice.</td>
</tr>
<tr>
<td></td>
<td>New — Based on the billing session options for the invoice, the transaction is eligible to be included on the invoice, but either the invoice has not yet been submitted for approval, or the transaction was not linked to the invoice at the time it was submitted for approval. For example, a transaction that was transferred to the project after the invoice was submitted would have New in Invoice Status. If the invoice has been submitted, a transaction with New in Invoice Status will not be included on the invoice. If you want to include all transactions with New in Invoice Status on a submitted or approved invoice, click Invoice on the Interactive Approvals toolbar and click Include New Transactions on the menu.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Status</th>
<th>Select whether the labor charge is billable in this billing session. Options are:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Bill — Include in this billing session.</td>
</tr>
<tr>
<td></td>
<td>Hold — Save the transaction for billing at a later date.</td>
</tr>
<tr>
<td></td>
<td>Write-off — Mark hours that have been charged but cannot be billed. Selecting this option prevents the transaction from being billed, but allows</td>
</tr>
</tbody>
</table>
the amount to appear on reports. When you write-off a transaction, no accounting entries are made.

- **Delete** — Remove from the set of billable transactions. Changing the status to Delete does not actually delete the transaction. The status of Delete allows you to run reports that distinguish between write-off (hours charged but cannot be billed) and a transaction that was entered but removed before invoicing, possibly due to a data entry error.

The options that are available from this field depend on your role's access rights as set in the Billing Security area of the Accounting tab of Role Security. For example, if you belong to a role with Allow Delete selected, the Delete option is available from this field.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Billable</td>
<td>This field indicates whether a transaction is billable. A transaction is not billable if you post it to the non-billable labor code. You can view non-billable transactions only if the Show Non-billables on Detail Tabs option is selected on the Billing Session Options dialog box.</td>
</tr>
<tr>
<td>Date</td>
<td>Vision displays the date entered for the labor transaction on the timesheet, and/or labor adjustment transaction entry, or on a Billing Labor insert.</td>
</tr>
<tr>
<td>Phase</td>
<td>If you select to view the project level from the Phase/Task lookup for a project with phases, all of that project's phases display in the grid. The phase number displays in the Phase column, and all detail that corresponds to that phase displays in that row. You can also choose to select a particular phase from the Phase/Task lookup to view just the detail for that phase and any associated tasks in the grid. If you click Summary on the grid toolbar Vision displays a summary of all of the detail shown on the Labor tab, including all phases and tasks in the grid.</td>
</tr>
<tr>
<td>Task</td>
<td>If you select the project or phase level from the Phase/Task lookup for a project with tasks, all of the tasks for that project or phase display in the grid. The task number displays in the Task column, and all detail that corresponds to that task displays in that row. You can also choose to select a particular task from the Phase/Task lookup to view just the detail for that task. If you click Summary on the grid toolbar Vision displays a summary of all of the detail shown on the Labor tab, including all phases and tasks in the grid.</td>
</tr>
<tr>
<td>Labor Code</td>
<td>Vision displays the labor code to which time was charged on the timesheet, and/or labor adjustment transaction entry, or on a Billing Labor insert. If the labor code is incorrect, you can transfer the item from within this project/phase/task to the appropriate labor code.</td>
</tr>
<tr>
<td>Category</td>
<td>Vision displays the labor category to which time was charged on the timesheet, and/or labor adjustment transaction entry, or on a Billing Labor insert. If the category is incorrect, you can transfer the item from within this project/phase/task to the appropriate category.</td>
</tr>
<tr>
<td>Employee</td>
<td>Vision displays the employee number to which the hours/amount were charged on the timesheet, and/or labor adjustment transaction entry, or on a Billing Labor insert.</td>
</tr>
</tbody>
</table>
Name | Vision displays the employee name to which the hours/amount were charged on the timesheet, and/or labor adjustment transaction entry, or on a Billing Labor insert.

Hours | Vision displays the total number of regular, overtime, and secondary overtime hours. To see the breakout of regular, overtime, and secondary overtime hours, click View.

Rate | Vision displays the labor billing rate. This rate depends on the method specified at the Labor Method field on the Labor tab of the Billing Terms form.

Extension | Vision displays the extended amount (hours * rate) based on the current billing terms.

Comment | If a comment was entered on the timesheet, and/or for the labor adjustment transaction entry, or on a Billing Labor insert, the comment displays here.

To read the full comment, position the mouse pointer over the visible text, or click the text to display the comment in the Text Viewer dialog box.

Expenses Tab of Interactive Billing

The Expenses tab of Interactive Billing lists all billable expenses entered through expense transactions, or billing inserts for the selected project/phase/task, up through the current period, Bill-Through-Date, or Bill-Through Period, as entered in the Billing Session Options dialog box. These transactions are available to be billed on the next invoice created.

Location

To display the Expenses tab of Interactive Billing, complete the following steps:

1. From the Vision Navigation menu, click Billing » Interactive Billing.
2. Click the Expenses tab.

Contents

Invoice Status | If invoice approval is enabled for the project, this field displays the approval status for the transaction:

- **Submitted, Approved, or Rejected** — The transaction was linked to the invoice at the time it was submitted for approval. Its approval status in this field is the same as the current approval status of the invoice.

- **New** — Based on the billing session options for the invoice, the transaction is eligible to be included on the invoice, but either the invoice has not yet been submitted for approval, or the transaction was not linked to the invoice at the time it was submitted for approval. For example, a transaction that was transferred to the project after the invoice was submitted would have New in Invoice Status. If the invoice has been submitted, a transaction with New in Invoice Status will not be included on the invoice. If you want to include all transactions with New in Invoice Status on a submitted or approved invoice, click Invoice on the Interactive...
### Billable toolbar and click **Include New Transactions** on the menu.

<table>
<thead>
<tr>
<th>Status</th>
<th>Select whether the expense charge is billable in this billing session. Options are:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Bill</strong> — Include in this billing session.</td>
</tr>
<tr>
<td></td>
<td><strong>Hold</strong> — Save the transaction for billing at a later date.</td>
</tr>
<tr>
<td></td>
<td><strong>Write-off</strong> — Mark amounts that have been charged but cannot be billed. Selecting this option prevents the transaction from being billed, but allows the amount to appear on reports. When you write-off a transaction, no accounting entries are made.</td>
</tr>
<tr>
<td></td>
<td><strong>Delete</strong> — Remove from the set of billable transactions. Changing the status to <strong>Delete</strong> does not actually delete the transaction. The status of <strong>Delete</strong> allows you to run reports that distinguish between write-off (amounts charged that cannot be billed) and a transaction that was entered but removed before invoicing, possibly due to a data entry error.</td>
</tr>
</tbody>
</table>

The options that are available from this field depend on your role's access rights as set in the Billing Security area of the Accounting tab of Role Security. For example, if you belong to a role with **Allow Delete** selected, the **Delete** option is available from this field.

<table>
<thead>
<tr>
<th>Billable</th>
<th>This field indicates whether a transaction is billable. A transaction is generally not billable if you post it to a direct expense account (by default, 600-level account). You can only view non-billable transactions if the <strong>Show Non-billables on Detail Tabs</strong> option is selected on the Billing Session Options dialog box.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date</td>
<td>Vision displays the date associated with the expense charge as entered in transaction entry, or on a Billing Expense insert.</td>
</tr>
<tr>
<td>Phase</td>
<td>If you select to view the project level from the Phase/Task lookup for a project with phases, all of that project's phases display in the grid. The phase number displays in the Phase column, and all detail that corresponds to that phase displays in that row. You can also choose to select a particular phase from the Phase/Task lookup to view just the detail for that phase and any associated tasks in the grid. If you click <strong>Summary</strong> on the grid toolbar Vision displays a summary of all of the detail shown on the Expenses tab, including all phases and tasks in the grid.</td>
</tr>
<tr>
<td>Task</td>
<td>If you select the project or phase level from the Phase/Task lookup for a project with tasks, all of the tasks for that project or phase display in the grid. The task number displays in the Task column, and all detail that corresponds to that task displays in that row. You can also choose to select a particular task from the Phase/Task lookup to view just the detail for that task. If you click <strong>Summary</strong> on the grid toolbar Vision displays a summary of all of the detail shown on the Expenses tab, including all phases and tasks in the grid.</td>
</tr>
<tr>
<td>Account</td>
<td>This field indicates the expense account to which this expense was charged. This account is the account to which the charge was posted during transaction</td>
</tr>
</tbody>
</table>
entry, or the account you specify or on a Billing Expense insert. This field can only contain an expense account. This account is by default a 500-level account in the Standard Chart of Accounts. If the account is incorrect, you can perform a Billing Transfer to charge the transaction to the appropriate account.

<table>
<thead>
<tr>
<th><strong>Type</strong></th>
<th>Vision displays the transaction type (for example, <strong>Ex</strong> (Employee Expense), <strong>MI</strong> (Miscellaneous Expense)).</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Ref. No.</strong></td>
<td>Vision displays the reference number (often the invoice number) for this transaction as entered through transaction entry or on a Billing Expense insert. Leading zeros always display in the invoice number in this grid if your firm uses leading zeros.</td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>If you entered a description for this expense charge in transaction entry or on a billing expense insert, it appears here.</td>
</tr>
<tr>
<td><strong>Cost</strong></td>
<td>Vision displays the cost amount for this expense charge.</td>
</tr>
<tr>
<td><strong>Extension</strong></td>
<td>Vision displays the billing extension amount for this expense charge based on the applicable billing terms.</td>
</tr>
<tr>
<td><strong>Document</strong></td>
<td>A document icon displays in the Documents column when the expense has associated supporting documents.</td>
</tr>
</tbody>
</table>

### Units Tab of Interactive Billing

The Units tab lists all unit charges entered through unit transactions or billing unit inserts for the selected project/phase/task up through the current period, **Bill-Thru-Date**, or **Bill-Thru Period**, as entered in the Billing Session Options dialog box. This detail is available to be billed on the next invoice accepted.

#### Location

To display the Units tab of Interactive Billing, complete the following steps:

1. From the Vision Navigation menu, click **Billing » Interactive Billing**.
2. Click the Units tab.

#### Contents

<table>
<thead>
<tr>
<th><strong>Invoice Status</strong></th>
<th>If invoice approval is enabled for the project, this field displays the approval status for the transaction:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Submitted, Approved, or Rejected</strong> — The transaction was linked to the invoice at the time it was submitted for approval. Its approval status in this field is the same as the current approval status of the invoice.</td>
</tr>
<tr>
<td></td>
<td><strong>New</strong> — Based on the billing session options for the invoice, the transaction is eligible to be included on the invoice, but either the invoice has not yet been submitted for approval, or the transaction was not linked to the invoice at the time it was submitted for approval. For example, a</td>
</tr>
</tbody>
</table>
A transaction that was transferred to the project after the invoice was submitted would have **New in Invoice Status**. If the invoice has been submitted, a transaction with **New in Invoice Status** will not be included on the invoice. If you want to include all transactions with **New in Invoice Status** on a submitted or approved invoice, click **Invoice** on the Interactive Approvals toolbar and click **Include New Transactions** on the menu.

<table>
<thead>
<tr>
<th>Status</th>
<th>Select whether the unit charge is billable in this billing session. Options are:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• <strong>Bill</strong> — Include in this billing session.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Hold</strong> — Save the transaction for billing at a later date.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Write-off</strong> — Mark amounts that have been charged but cannot be billed.</td>
</tr>
<tr>
<td></td>
<td>Selecting this option prevents the transaction from being billed, but allows</td>
</tr>
<tr>
<td></td>
<td>the amount to appear on reports. When you write-off a transaction, no</td>
</tr>
<tr>
<td></td>
<td>accounting entries are made.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Delete</strong> — Remove from the set of billable transactions. Changing the</td>
</tr>
<tr>
<td></td>
<td>status to Delete does not actually delete the transaction. The status of</td>
</tr>
<tr>
<td></td>
<td>Delete allows you to run reports that distinguish between write-off (unit</td>
</tr>
<tr>
<td></td>
<td>amounts charged that cannot be billed) and a transaction that was entered</td>
</tr>
<tr>
<td></td>
<td>but removed before invoicing, possibly due to a data entry error.</td>
</tr>
<tr>
<td></td>
<td>The options that are available from this field depend on your role's access</td>
</tr>
<tr>
<td></td>
<td>rights as set in the Billing Security area of the Accounting tab of Role Security.</td>
</tr>
<tr>
<td></td>
<td>For example, if you belong to a role with <strong>Allow Delete</strong> checked, the <strong>Delete</strong></td>
</tr>
<tr>
<td></td>
<td>option is available from this field.</td>
</tr>
</tbody>
</table>

| Date | This field displays the date associated with this unit charge in unit transaction entry, or on a billing unit insert. |

| Phase | If you select to view the project level from the Phase/Task lookup for a project with phases, all of that project's phases display in the grid. The phase number displays in the Phase column, and all detail that corresponds to that phase displays in that row. You can also choose to select a particular phase from the Phase/Task lookup to view just the detail for that phase and any associated tasks in the grid. If you click **Summary** on the grid toolbar Vision displays a summary of all of the detail shown on the Units tab, including all phases and tasks in the grid. |

| Task | If you select the project or phase level from the Phase/Task lookup for a project with tasks, all of the tasks for that project or phase display in the grid. The task number displays in the Task column, and all detail that corresponds to that task displays in that row. You can also choose to select a particular task from the Phase/Task lookup to view just the detail for that task. If you click **Summary** on the grid toolbar Vision displays a summary of all of the detail shown on the Units tab, including all phases and tasks in the grid. |

<p>| Table | Vision displays the unit table that contains the applicable unit information for this unit charge, as specified in unit transaction entry, or on a billing unit insert. |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unit</td>
<td>This field displays the unit number to which the amount was charged.</td>
</tr>
<tr>
<td>Description</td>
<td>If you entered a description for this unit charge during unit transaction entry or on a billing unit insert, it displays here.</td>
</tr>
<tr>
<td>Quantity</td>
<td>Vision displays the quantity of this unit included in this unit charge.</td>
</tr>
<tr>
<td>Rate</td>
<td>This field displays the billing amount per unit for this unit.</td>
</tr>
<tr>
<td>Extension</td>
<td>Vision displays the billing extension amount for this unit charge based on the applicable billing terms.</td>
</tr>
</tbody>
</table>

**Invoice Approval Overview**

Invoice approval is an optional feature that enables your company to set up an approval process for client invoices that must be completed before the invoices can be accepted and posted.

This feature enables you to move draft invoices more efficiently through the submittal, approval, and acceptance stages to produce final invoices. Electronic notification alerts are sent automatically to the appropriate employees to notify them that the next action in the approval process is ready for them to complete. You can enter approval comments for invoices that can be shared easily with others.

**Enable and Set Up Invoice Approval for the Company**

Invoice approval is only available if it is enabled for your company on the Miscellaneous tab of the Billing Setup form (Configuration » Billing » General).

Your company can set up multiple approval processes on the Invoice Approval Process form (Configuration » Billing » Invoice Approval Process). For a given project, you then select the appropriate approval process from a list of available processes. Each approval process includes who can approve and reject invoices (project managers or principals, for example), who receives alerts at each stage of the process, and the type and frequency of those alerts.

**Enable Invoice Approval for a Project**

If invoice approval is enabled for your company, you have the option to enable or disable it for individual projects on the Misc tab of the Billing Terms form. If your company has more than one invoice approval process set up, you can also select the process you want to use for the project on that tab.

You enable invoice approval at the top level of the work breakdown structure (WBS) only. If the approver specified in the approval process is the project manager, the project manager for the top level of the WBS is the approver for all WBS levels of that project. Similarly, if you use billing groups, you enable invoice approval for a billing group by enabling it for the main project. In that case, if the project manager is the approver specified in the approval process, the project manager for the top level of the WBS for the main project is the approver for all of the sub-projects in the billing group.

If you are responsible for approving invoices, you can delegate that responsibility to another person on the User Options dialog box. That person receives the same approval alerts that Vision sends to you and the same access to approve and reject invoices in the Invoice Approvals and Interactive Approvals forms so he or she can approve invoices in your place if, for example, you are on vacation.
If invoice approval is enabled for a project, all invoices for the project must be approved before you can accept them for final billing.

**Invoice Approval Process**

The normal approval process includes the following stages:

- **Submit** — The person responsible for submitting invoices for the project uses either Interactive Billing or Batch Billing to submit the invoice for approval. When an invoice is submitted, Vision sends an alert to the person responsible for approving invoices for the project, as specified for the Submit action on the Invoice Approval form in Configuration. Once submitted, the invoice is available for review in Invoice Approvals and Interactive Approvals.

- **Approve** — The person responsible for approving invoices uses the Invoice Approvals or Interactive Approvals form to review and approve submitted invoices. When an invoice is approved, Vision sends an alert to the person responsible for accepting invoices and initiating final billing for the project, as specified for the Approve action on the Invoice Approval form in Configuration. The approver can also reject a submitted invoice if he or she wants to alert another person so they can resolve the issues that caused the rejection. In that case, Vision sends an alert to the person designated to receive the rejection alert, as specified for the Reject action on the Invoice Approval form in Configuration.

All approval-related email alerts have **Deltek Vision Invoice Approval** in the From field of the email.

**Who Can Perform Approval Process Actions**

Who can perform approval process actions depends on the action and on role security:

- **Submit** — Any user whose role has access to Interactive Billing or Batch Billing can submit an invoice for approval for projects to which they have record access.

- **Unsubmit** — Any user whose role has security access to Interactive Billing can unsubmit a previously submitted invoice for projects to which they have record access.

- **Approve** — Under normal circumstances, only the user assigned to the project in the role designated as the approving role for the approval process can approve an invoice for that project. "Role" here does not refer to security roles but to specific roles assigned in the Project Info Center, such as project manager, biller, principal, or supervisor. For example, if the approval process used for the project designates the project manager role as the approving role, only that project's project manager can approve an invoice for billing. However, that specific user can delegate the responsibility to another user on the User Options dialog box if, for example, they will be temporarily unavailable to approve invoices. To approve an invoice, the approver or delegate must have a security role that has access to the Invoice Approvals form or Interactive Approvals form.

- **Reject** — Under normal circumstances, only the user assigned to the project in the role designated as the rejecting role for the approval process can reject an invoice for that project. "Role" here does not refer to security roles but to specific roles assigned in the Project Info Center, such as project manager, biller, principal, or supervisor. For example, if the approval process used for the project designates the Project Manager role as the rejecting role, only that project's project manager can reject an invoice for billing. However, that user can delegate the responsibility to another user on the User Options dialog box if, for example, they will be temporarily unavailable to reject invoices. To reject an invoice, the rejecter or delegate must have a security role that has access to the Invoice Approvals or Interactive Approvals.
- **Edit invoice information** — A user who can approve or reject invoices can make changes to submitted invoices if his or her security role is given the necessary rights under **Billing Security** on the Accounting tab of the Roles form (**Configuration » Security » Roles**). In addition, some users (project managers, for example) may have access that enables them to update only fee percent complete information and the billing terms description on the Billing Terms form. If you change invoice information, Vision automatically recalculates the invoice.

**Edit an Invoice in the Approval Process**

While an invoice is in the approval process, you can still make changes to it if you have the necessary security access.

**Invoice Recalculation**

If you make changes to an invoice on the Interactive Billing, Invoice Approvals, or Interactive Approvals form (or on dialog boxes or forms that you access from one of those three forms) after it is submitted for approval, Vision automatically recalculates the invoice the next time you do one of the following:

- Approve or reject the invoice
- Preview the invoice
- Select a different project
- Close the form
- Go to the Billing Terms form from Interactive Billing or one of the approval forms
- Update fee percent complete information
- Use the **Include New Transactions** option to add transactions posted or transferred after the invoice was submitted

---

**Submitted Invoice**

After an invoice is submitted for approval, the users designated as approvers (or their delegates), assuming they have the necessary security access, can make changes to the submitted invoice and then approve the invoice without having to resubmit it. Those changes include the following:

- Place a transaction on hold.
- Write off a transaction.
- Delete a transaction.
- Transfer a transaction.
- Modify transaction detail.
- Modify billing terms.
• Include transactions with the New status (transactions that are eligible for inclusion based on the billing session options but were entered or transferred after the invoice was submitted).

If you need to include additional transactions on the invoice that are not eligible for inclusion based on the billing session options, you must unsubmit the invoice, change the billing session options to include those transactions, and submit the invoice again. This process is also necessary if you decide you want to bill transactions that were on hold or written off when the invoice was submitted originally.

**Approved Invoice**

After an invoice is approved and waiting to be accepted, anyone who can display the invoice in Interactive Billing and has the required security access can make changes to it. For example, the biller might need to make changes to the invoice based on comments from the approver. In most cases, it is not necessary to submit the invoice for approval again. The exception is if you need to include additional transactions on the invoice that are not eligible for inclusion based on the billing session options. In that case, you must unsubmit the invoice, change the billing session options to include those transactions, and submit the invoice again. This process is also necessary if you decide you want to bill transactions that were on hold or written off when the invoice was submitted originally.

**Rejected Invoice**

If an invoice is rejected, anyone who can display the invoice in Interactive Billing and who has the required security access can make changes to that invoice and submit it for approval again. In most cases, it is not necessary to unsubmit the invoice before you submit it again. The exception is if you need to include additional transactions on the invoice that are not eligible for inclusion based on the billing session options. In that case, you must unsubmit the invoice, change the billing session options to include those transactions, and submit the invoice again. This process is also necessary if you decide you want to bill transactions that were on hold or written off when the invoice was submitted originally.

**Invoice Edited in Microsoft Word or Other Application**

If the invoice has been downloaded to Microsoft Word or another application for editing, you can preview the edited invoice on the Invoice Approvals form or Interactive Approvals form. However, you cannot make any changes to invoice information on either of those forms.

**View Invoice Approval Status in Interactive Billing**

If invoice approval is enabled for the project, you can review the approval status and related comments for an invoice on the General tab of Interactive Billing.

**To review invoice approval status in Interactive Billing, complete the following steps:**

1. From the Vision Navigation menu, click **Billing » Interactive Billing** to display the Billing Session Options form.
2. Select your billing session options and click **OK**.
3. Select the project.
4. Review the approval status of the invoice in **Invoice Status**.
5. To review any comments related to the invoice approval process, click **Comments**.
6. In the Billing Comments dialog box, click the link in the Comment column for the comment you want to display.

7. If you entered the comment originally and you want to make changes to it, select the row for the action, edit the comment text in Comment Entry, and click OK.

Submit an Invoice for Approval from Interactive Billing

If invoice approval is enabled for the project, you must submit an invoice for approval before you can proceed with the billing process for that invoice. When you submit an invoice for approval, Vision sends an alert to the person responsible for reviewing the invoice and approving it for billing (the project manager, for example). Once submitted, the invoice is available for review on the Interactive Approvals form or Invoice Approvals form.

You can also use Batch Billing to submit invoices for approval.

To submit an invoice for approval from Interactive Billing, complete the following steps:

1. From the Vision Navigation menu, click Billing » Interactive Billing to display the Billing Session Options form.

2. Select your billing session options and click OK.

3. Select the project.


5. On the menu, click Submit.

6. If you want to enter comments related to the submittal, enter them in the Billing Comments dialog box. The comments will then be available to the person who approves the invoice.

7. To submit the invoice, click OK in the Billing Comments dialog box.

   If the invoice approval process for a project has been set up to send a dashboard and/or email alert when an invoice for a project is submitted, an alert is sent automatically to approvers. The alert includes a hyperlink to the Invoice Approvals application in Billing. In Invoice Approvals, you see only the invoices that require approval for projects for which you are defined as the approver, rejecter, or biller. As an invoice approver, your role access to projects (set up in role security) also determines the invoices that you see in Invoice Approvals. See the “Alerts and the Invoice Approval Process” topic for more information.

8. If you do not want to submit the invoice, click Cancel.

Submit Draft Invoices for Approval in Batch Billing

If you use the Invoice Approvals feature, you can use Batch Billing to submit multiple invoices at a time to be approved.

In the Invoice Approval process, invoices must be submitted for approval and then approved before they can be final accepted and posted. You can also use Interactive Billing to submit invoices for approval (one invoice at a time).

To submit invoices for approval in Batch Billing, complete the following steps:

2. On the Billing Session Options dialog box, select options for the batch such as the period start and end dates, and click OK.

3. On the Main tab of the Batch Billing form, select one of the following sets of options based on whether or not you want to include only invoices to be submitted for approval in the batch:

   If you have different printing requirements for invoices that require approval and invoices that do not require approval, you can run them in separate batches.

   If you want to only submit invoices for approval in the batch, select both of the following options:
   - Draft Run in the Run Type field drop-down list
   - Submit invoices for Projects with approvals enabled check box
   - Include Only Projects with approvals enabled option in the Projects Selection section

   If you want to submit invoices for approval and process other draft invoices that do not require invoice approval in one batch, select all of the following options:
   - Draft Run in the Run Type field drop-down list
   - Submit invoices for Projects with approvals enabled check box
   - Include All Projects option in the Projects Selection section

4. In the Select Specific Projects field, use the Project Lookup to further filter the projects for which you want to process invoices.

5. Choose how you want invoices to be reviewed.

   On the Main tab of the Batch Billing form, you can select various options that allow you to print, email, or not print invoices in the batch run.

   If you select the Do not print when generating invoices check box, which prevents invoices from being sent to the printer to be printed when you run the batch, submitted invoices will be available to review in Billing Invoice Approvals and Billing Interactive Approvals and available to print from the Previously Run Batches tab in Batch Billing.

6. Select the Do not create report for submitted invoices check box if you do not want to an invoice report to be printed when you run the batch. This allows the batch to be processed faster. Submitted invoices can be reviewed in Billing » Invoice Approvals or Billing » Interactive Approvals. Invoices are not emailed when you select this option.

7. Enter a description for the run in the Run Description field, and make any other appropriate selections on the Main tab.

8. To process the batch, click either of the following toolbar options on the Batch Billing form:
   - Run — This submits invoices for approval immediately. If you selected to include all projects (and include invoices that do not require approval in the batch), a draft invoice is printed for each invoice included in the batch run.
   - Schedule — This allows you to schedule the invoices to be submitted for approval automatically at a future time. If you selected to include all projects (and include invoices that do not require approval in the batch), a draft invoice is generated for each invoice included in the batch run.

9. In the Billing Comments dialog box, enter comments for invoice approvers such as "Please review and approve by Friday, March 27th." Then click OK.
The comments that you enter apply to all invoices in the batch that require approval. If you need to make specific comments for a project, then after you submit the invoices for approval in Batch Billing, go to Interactive Billing or Interactive Approvals and update the submitted comments.

- If you clicked Run on the Batch Billing form toolbar and the invoice approval process for the invoice’s project specified that a dashboard and/or email alert be sent when an invoice is submitted, an alert is sent automatically to approvers. The alert includes a hyperlink to the Invoice Approvals application in Billing. In Invoice Approvals, you see only the invoices that require approval for projects for which you are defined as the approver, rejecter, or biller. As an invoice approver, your role access to projects (set up in role security) also determines the invoices that you see in Invoice Approvals. See the “Alerts and the Invoice Approval Process” topic for more information.

- If you clicked Schedule on the Batch Billing toolbar, complete the entries in the Schedule dialog box to submit the invoices at a future time, and click OK. When the invoices are submitted, if you specified that a dashboard and/or email alert be sent to approvers when an invoice for a project is submitted, an alert is sent automatically to approvers — the same as when you click Run to submit invoices for approval immediately.

## Approve or Reject Invoices on the Invoice Approvals Form

If you are responsible for approving invoices for billing, you can review invoices and approve or reject them on the Invoice Approvals form, as described below, or on the Interactive Approvals form or Interactive Billing form. When you approve or reject an invoice, Vision sends an alert to the person responsible for the next step in the process so they can either initiate the final billing process for an approved invoice or resolve the issues that caused you to reject the invoice.

If necessary, you can also approve invoices on the Interactive Billing form.

To approve or reject an invoice on the Invoice Approvals form, complete the following steps:

1. From the Vision Navigation menu, click Billing » Invoice Approvals.
2. To restrict the list of invoices displayed in the grid, specify the criteria under Invoice Selection Filter, and click Refresh Invoices.
3. Review the information provided in the grid for the first invoice.
4. To display the draft invoice, click Preview.
5. To display more detailed information, click View Details on the grid toolbar to display the Interactive Approvals form.

   Click Invoice Approvals on the Interactive Approvals toolbar to return to the Invoice Approvals form.

6. To enter comments as you preview the invoice, click Comments on the grid toolbar to open the Billing Comments dialog box.
As you preview the invoice, you can bring the Billing Comments dialog box to the top when you want to enter a comment. Until you actually approve or reject the invoice, the action associated with the comment is In Process.

7. To change the fee percent complete for the invoice, if applicable, or edit the billing terms description, click Update Fees on the grid toolbar.

To change any other information for the invoice, click View Details on the grid toolbar to display the invoice information on the Interactive Approvals form.

If the invoice has been downloaded to Microsoft Word or another application for editing and uploaded to Billing, you cannot change any invoice information on the Invoice Approvals form or the Interactive Approvals form.

8. To approve the invoice for billing, click Approve on the grid toolbar. Click Reject if you want to alert the person responsible for billing to circumstances that prevent the invoice from being approved for billing.

If the option you want is not available, you do not have the necessary approval rights for the selected project.

9. To add comments related to the approval or rejection, enter them in the Billing Comments dialog box.

If the invoice approval process for a project has been set up to send a dashboard and/or email alert when an invoice for the project is approved or rejected, an alert is sent automatically. The alert includes a hyperlink to the specific invoice in Interactive Billing. See the “Alerts and the Invoice Approval Process” topic for more information.

10. To approve or reject the invoice, click OK in the Billing Comments dialog box.

If you do not want to approve or reject the invoice, click Cancel.

11. Repeat steps 3 – 10 for each invoice.

Approve or Reject Invoices on the Interactive Approvals Form

If you are responsible for approving invoices for billing, you can review invoices and approve or reject them on the Interactive Approvals form, as described below, or on the Invoice Approvals form or Interactive Billing form. When you approve or reject an invoice, Vision sends an alert to the person responsible for the next step in the process so they can either initiate the final billing process for an approved invoice or resolve the issues that caused you to reject the invoice.

If necessary, you can also approve invoices on the Interactive Billing form.

To approve or reject an invoice on the Interactive Approvals form, complete the following steps:

1. From the Vision Navigation menu, click Billing » Interactive Approvals.

2. Select the project.

The search results for the project lookup include only the projects you have rights to approve.
3. To review comments entered when the invoice was submitted, click **Comments** on the General tab to open the Billing Comments dialog box.

4. Click **Preview** to display the draft invoice itself.

5. Review the invoice information on the General tab and on the tabs that display transaction detail, and make any necessary changes.

   To change the fee percent complete for the invoice, if applicable, or edit the billing terms description, click **Update Fees** on the toolbar.

   > If the invoice has been downloaded to Microsoft Word or another application for editing, you cannot change any invoice information on the Interactive Approvals form or the Invoice Approvals form.

6. To enter comments as you review the invoice detail or preview the invoice, click **Comments** on the General tab to open the Billing Comments dialog box.

   > As you review the invoice detail or preview the invoice, you can bring the Billing Comments dialog box to the top when you want to enter a comment. Until you actually approve or reject the invoice, the action associated with the comment is **In Process**.

7. On the toolbar on the Interactive Approvals form, click **Approve** to approve the invoice for billing. Click **Reject** if you want to alert the person responsible for billing to circumstances that prevent the invoice from being approved for billing.

   If the option you want is not available, you do not have the necessary approval rights for the selected project.

8. To enter any comments related to the approval or rejection, enter them in the Billing Comments dialog box.

9. To approve or reject the invoice, click **OK** in the Billing Comments dialog box.

   If the invoice approval process for a project has been set up to send a dashboard and/or email alert when an invoice for the project is approved or rejected, an alert is sent automatically. The alert includes a hyperlink to the specific invoice in Interactive Billing. See the “Alerts and the Invoice Approval Process” topic for more information.

10. If you do not want to approve or reject the invoice, click **Cancel**.

### Unsubmit an invoice

If the status of an invoice is Submitted, Approved, or Rejected, you can unsubmit that invoice if, for example, you want to start the approval process over from the start.

Unsubmitting an invoice essentially reverses the previous submission and removes any information associated with it. Vision assigns the New status to the invoice and to all transactions originally associated with the submitted invoice. In addition, Vision discards the previous billing session settings and any comments entered as part of the approval process. (In contrast, when you reject an invoice, the invoice is still linked to the original set of transactions, billing session options, and approval comments.)

If you just need to make changes to the detail and start the approval process again, you do not need to unsubmit. Instead, make the changes and then submit the invoice again. This is the most common procedure when an invoice is rejected with comments outlining what needs to be changed to be approved.
To unsubmit an invoice, complete the following steps:

1. From the Vision Navigation menu, click **Billing » Interactive Billing** to display the Billing Session Options form.
2. Select your billing session options and click **OK**.
3. Select the project.
4. On the toolbar on the Interactive Billing form, click **Invoice**.
5. On the menu, click **Unsubmit**.

   If the invoice approval process for a project has been set up to send a dashboard and/or email alert when an invoice for the project is unsubmitted, an alert is sent automatically. The alert includes a hyperlink to the specific invoice in Interactive Billing. See the “Alerts and the Invoice Approval Process” topic for more information.

### Invoice Approvals Form Overview

If the Invoice Approval feature is enabled for your company and you are responsible for approving invoices for billing, use the Invoice Approvals form to review invoices and to approve or reject them. (You can also approve invoices in the Interactive Approvals form or Interactive Billing form.) When you approve or reject an invoice, Vision sends an alert to the person responsible for the next step in the process so they can either initiate the final billing process for an approved invoice or resolve the issues that caused you to reject the invoice.

Billers can also use this form to check on the approval status of their invoices.

### Display the Invoice Approvals Form

Use the Invoice Approvals form to review and approve invoices that have been submitted for approval.

**To display the Invoice Approvals form, complete the following step:**

1. From the Vision Navigation menu, click **Billing » Invoice Approvals**.

### Invoice Approvals Toolbar

Use the toolbar on the Invoice Approvals form to generate the Invoice Approval report, display the currently selected project on the Project Review form or in Project Info Center, or display help topics for the Invoice Approvals form.

### Contents

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Print</strong></td>
<td>Click this option to specify options for the Invoice Approval report and generate the report.</td>
</tr>
<tr>
<td><img src="image" alt="Project Review" /></td>
<td>Click this option to display information for the project on the Project Review form in a separate window. This option is not available if your security role does not have access to the Project Review form.</td>
</tr>
<tr>
<td><img src="image" alt="Project Info Center" /></td>
<td>Click this option to display the currently selected project in the Project Info Center in a separate window. If you have the required security access, you can edit the</td>
</tr>
</tbody>
</table>
**Info Center**

| Info Center | project information in that window. This option is not available if your security role does not have access to the Project Info Center. |

**Help**

| Info Center | Click this option for information about the Invoice Approvals form. |

**Invoice Approvals Form**

Use the Invoice Approvals form to review and approve invoices that have been submitted for approval.

**Contents**

| Status | Use these check boxes to filter the list of invoices by invoice approval status. |

| Project | To filter the list of invoices by project, use this field to perform a project lookup and select one or more projects. Click to display the Project Lookup dialog box. The lookup only returns projects with invoices in the approval process for which you are the approver or the biller and for which you have the required security access. If this field is blank, the grid displays all submitted, approved, or rejected invoices for all projects for which you are the approver, rejecter, biller, or an approver's or rejecter's delegate, and for which you have the required security access. For billing groups, the list only displays the main projects. |

| Approver | To filter the list of invoices by approver, use this field to perform an employee lookup and select one or more employees. The grid only displays submitted, approved, or rejected invoices for which the selected employees are approvers. If this field is blank, the invoices are not filtered by approver. If your security access restricts you to projects for which you are the approver, you do not need to use this filter. Vision automatically filters the projects so that only your projects are displayed. |

| Refresh Invoices | Click Refresh Invoices to update the list of invoices in the grid based on your entries in the Invoice Selection Filter fields. |

**Invoices in Approval Process Grid**

| Invoices in Approval Process Drop-down | The Vision grids contain a drop-down that allows you to print a snapshot of the grid information, or export the grid's data to a Microsoft Excel spreadsheet. |

| Preview | Click this button to display the draft invoice. If the billing terms are set up to generate the Billing Backup report, a dialog box displays to give you the option to include the Billing Backup report in the preview. |
If the invoice has been downloaded to Microsoft Word or another application for editing, Vision displays that invoice file in the appropriate application when you click **Preview**, rather than generating a preview version from the current invoice data.

| **Comments** | Select an invoice, and click **Comments** to display the Billing Comments dialog box to review or enter comments for that invoice. The dialog box displays a list of approval actions carried out to date and any comments related to the invoice approval process.

To enter a comment, click **Insert** in the grid toolbar, and enter the comment text in **Comment Entry**.

When you actually approve or reject the invoice, the action associated with the new comment changes from **In Process** to **Approved** or **Rejected**.

If it is not already displayed, the Billing Comments dialog box displays automatically when you click **Approve** or **Reject** so you can enter comments for those actions. Whether or not you enter a comment, you must click **OK** in the Billing Comments dialog box to complete the approval or rejection. |

| **Update Fees** | If the selected invoice includes fees, click this option to display the Billing Terms form and update the percent complete. Whether or not the invoice has fees, you can also click this option if you want to update the description or other information on the General tab of the Billing Terms form.

This option is only available if the approval status of the invoice is Submitted and if the invoice has not been downloaded to Microsoft Word or another application for editing. You must also have the required security access for the Billing Terms form. |

| **View Details** | If you need to make changes to the invoice information or want to see more detailed information, click this option to display the invoice information in the Interactive Approvals form.

This option is only available if you have security access to the Interactive Approvals form. To return to the Invoice Approvals form, click **Invoice Approvals** on the Interactive Approvals toolbar. |

| **Approve** | Click this option to approve the selected invoice for billing. The Billing Comments dialog box opens when you click this option. Use that dialog box to enter any comments about the approval.

**Note:** You must click **OK** in the Billing Comments dialog box to complete the approval. If you click **Cancel**, the invoice approval status does not change.

This option is only available if the approval status is Submitted and if you are an approver for the project. |
Click this option to alert the person responsible for billing to circumstances that prevent the selected invoice from being approved for billing. The Billing Comments dialog box opens when you click this option. Use that dialog box to explain the reason for the rejection.

**Note:** You must click **OK** in the Billing Comments dialog box to complete the rejection. If you click **Cancel**, the invoice approval status does not change.

This option is only available if the approval status of the invoice is Submitted and if you are a rejector for the project.

<table>
<thead>
<tr>
<th>Project</th>
<th>This field displays the project number. If the invoice is for a billing group, this is the project number of the main project.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Name</td>
<td>This field displays the project short name. If the invoice is for a billing group, this is the name of the main project.</td>
</tr>
<tr>
<td>Client</td>
<td>This field displays the billing client name for the project.</td>
</tr>
<tr>
<td>Currency Code</td>
<td>If you use the Multicurrency feature, this field displays the currency code for the billing currency.</td>
</tr>
<tr>
<td>Invoice Total</td>
<td>This field displays the total invoice amount in the billing currency. The total for all listed invoices displays at the bottom of the grid.</td>
</tr>
<tr>
<td>Invoice Status</td>
<td>This field displays the approval status for the invoice: <strong>Submitted</strong>, <strong>Approved</strong>, or <strong>Rejected</strong>.</td>
</tr>
<tr>
<td>Approver</td>
<td>This field displays the name of the person who is responsible for approving the invoice. If more than one person is designated as an approver, all are listed. If an approver has specified a delegate on the User Options dialog box, the delegate's name is listed also.</td>
</tr>
<tr>
<td>Update by</td>
<td>This field displays the name of the person who carried out the most recent approval-related action.</td>
</tr>
<tr>
<td>Update Date</td>
<td>This field contains the date and time that the latest approval-related action was carried out.</td>
</tr>
<tr>
<td>Comments</td>
<td>This field displays the first part of the text of the comment related to the current approval status. Click the text to display the complete comment.</td>
</tr>
</tbody>
</table>

**Interactive Approvals Form Overview**

If the Invoice Approval feature is enabled for your company and you are responsible for approving invoices for billing, use the Interactive Approvals form to review invoices, make changes to them, and approve or reject them. *(You can also approve invoices in the Invoice Approvals form or the Interactive Billing form.)* When you approve or reject an invoice, Vision sends an alert to the...
person responsible for the next step in the process so they can either initiate the final billing process for an approved invoice or resolve the issues that caused you to reject the invoice.

**Display the Interactive Approvals Form**

Use the Interactive Approvals form to review and approve invoices that have been submitted for approval.

**To display the Interactive Approvals form, complete the following step:**

1. From the Vision Navigation menu, click **Billing » Interactive Approvals**.

**Interactive Approvals Toolbar**

Use the toolbar on the Interactive Approvals form to approve or reject, preview, and make changes to submitted invoices.

<table>
<thead>
<tr>
<th>Contents</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preview</td>
<td>Click this option to display the draft invoice. If the billing terms are set up to generate the Billing Backup report, a dialog box displays to give you the option to include the Billing Backup report in the preview. If the invoice has been downloaded to Microsoft Word or another application for editing, Vision displays that invoice file in the appropriate application when you click <strong>Preview</strong>, rather than generating a preview version from the current invoice data.</td>
</tr>
<tr>
<td>Update Fees</td>
<td>If the selected invoice includes fees, click <strong>Update Fees</strong> to display the Billing Terms form and update the percent complete. Whether or not the invoice has fees, you can also click this option if you want to update the description or other information on the General tab of the Billing Terms form. This option is only available if the approval status of the invoice is Submitted and if the invoice has not been downloaded to Microsoft Word or another application for editing. You must also have the required security access for the Billing Terms form.</td>
</tr>
<tr>
<td>Include New</td>
<td>On the Labor, Expense, and Units tabs, a transaction that is eligible for billing based on the billing session options has a New status if the transaction was not linked to the invoice at the time it was submitted for approval. For example, a transaction that was transferred to the project after the invoice was submitted would have <strong>New in Invoice Status</strong>. If the invoice has been submitted, a transaction with <strong>New in Invoice Status</strong> will not be included on the invoice. If you want to include all transactions with <strong>New in Invoice Status</strong> on the invoice, click <strong>Include New Transactions</strong> on the toolbar. Vision then changes the status to Submitted for those transactions. This option is not available if the invoice has been downloaded to Microsoft Word or another application for editing.</td>
</tr>
<tr>
<td>Transactions</td>
<td></td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| **Approve**     | Click this option to approve the selected invoice for billing. Vision sends an alert to the user defined in the invoice approval process to direct them to final accept the invoice.  
**Note:** You must click OK in the Billing Comments dialog box to complete the approval. If you click Cancel, the invoice approval status does not change.  
This option is only available if the approval status is Submitted and if you are an approver for the project.  
After you approve an invoice, you can no longer make changes to the invoice information or transaction detail in Interactive Approvals. To make changes, display the invoice on the Interactive Billing form. |
| **Reject**      | Click this option if the invoice cannot be approved. Vision sends an alert to the user defined in the invoice approval process to direct them to final accept the invoice.  
**Note:** You must click OK in the Billing Comments dialog box to complete the rejection. If you click Cancel, the invoice approval status does not change.  
This option is only available if the approval status of the invoice is Submitted and if you are a rejecter for the project.  
After you reject an invoice, you can no longer make changes to the invoice information or transaction detail in Interactive Approvals. To make changes, display the invoice on the Interactive Billing form. |
| **Invoice Approvals** | Click this option to display, on the Invoice Approvals form, a summary of all invoices in the approval process for which you are defined as approver, rejecter, or biller.  
If you used the View Details option on the toolbar on the Invoice Approvals form to display an invoice on the Interactive Approvals form, click this option to return to the Invoice Approvals form. |
| **Project Review** | Click this option to display information for the project on the Project Review form.  
This option is not available if your security role does not have access to the Project Review form. |
| **Project Info Center** | Click this option to display the currently selected project in the Project Info Center in a separate window. If you have the required security access, you can edit the project information in that window.  
This option is not available if your security role does not have access to the Project Info Center. |
| **Help**        | Click this option for information about the Interactive Approvals form. |
General Tab of Interactive Approvals

Use the General tab of the Interactive Approvals form to review summary information for the project and invoice, and to review any comments related to the approval process.

Currency Amounts

All amounts on this tab are for the element of the work breakdown structure that is currently displayed. If you are at the top level of the WBS, the amounts are for the project as a whole. If you go to an element at the WBS 2 level, the amounts are for that element.

The exception is if the project is the main project in a billing group. In that case, if you are at the top level of the WBS, the amounts are for the billing group as a whole. At lower WBS levels, the amounts are only for the lower level element you have selected.

If your firm uses the Multicurrency feature, all amounts on this tab are in the billing currency.

Contents

| Invoice Status | This field displays the approval status for the invoice:
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>▪ <strong>Submitted by</strong>&lt;submitter name&gt; &lt;submission date and time&gt; — The invoice is submitted for approval.</td>
</tr>
<tr>
<td></td>
<td>▪ Approved by&lt;approver name&gt; &lt;approval date and time&gt; — The invoice is approved for final billing.</td>
</tr>
<tr>
<td></td>
<td>▪ Rejected by&lt;rejecter name&gt; &lt;rejection date and time&gt; — The invoice has been rejected for billing.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Edited Invoice on File</th>
<th>This text only appears if the invoice has been downloaded to Microsoft Word or another application for editing.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>To display the edited invoice file, click the <strong>Preview Invoice</strong> button. The invoice displays in the application used to edit it.</td>
</tr>
<tr>
<td></td>
<td>If an edited invoice exists, you cannot make any changes to invoice information on the Interactive Approvals form.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Comments</th>
<th>Click <strong>Comments</strong> to display the Billing Comments dialog box to review or enter comments for the invoice. The dialog box displays a list of approval actions carried out to date and any comments related to the invoice approval process.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>To enter a comment, click ✉️ <strong>Insert</strong> in the grid toolbar, and enter the comment text in <strong>Comment Entry</strong>.</td>
</tr>
<tr>
<td></td>
<td>When you actually approve or reject the invoice, the action associated with the new comment changes from <strong>In Process</strong> to <strong>Approved</strong> or <strong>Rejected</strong>.</td>
</tr>
<tr>
<td></td>
<td>If it is not already displayed, the Billing Comments dialog box displays automatically when you click ✅ <strong>Approve</strong> or 🚫 <strong>Reject</strong> so you can enter comments for those actions. Whether or not you enter a comment, you must click <strong>OK</strong> in the Billing Comments dialog box to complete the approval or rejection.</td>
</tr>
</tbody>
</table>

<p>| Preview Invoice | Click this button to display the draft invoice. If the billing terms are set up to generate the Billing Backup report, a dialog box displays to give you the |</p>
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preview</td>
<td>When you click <strong>Preview</strong>, Vision displays the invoice file in the appropriate application.</td>
</tr>
</tbody>
</table>

**Billing Group Main Project**

- **This option is selected if the current project, phase, or task belongs to a billing group. The main project of the billing group displays in the field next to the check box.**

  **Multicompany**

  - If you have enabled the Multicompany feature, the company that "owns" the main project in the billing group is the company that generates the invoice for the entire billing group.

**Invoice Section**

- **These fields display the labels for the invoice sections.**

**Submitted Invoice**

- **These fields display the total current amount for each section of the selected invoice for the currently selected WBS element.**

**Prior Billed to Date**

- **These fields display the total amount billed to date on previous invoices for each section of the selected invoice for the currently selected WBS element.**

  **Note:** If you include billed-to-date amounts on the invoices for the project and you set up the billing terms to use phase or task rollup, the billed-to-date amounts in these fields do not match the amounts on the invoices one for one. Whether or not you use the rollup feature for invoices, these fields always display amounts for individual phases and tasks, not rolled up amounts.

**Billing Address**

- **These fields display the billing address for the project.**

  Vision uses the billing address specified for the project (or main project, if the project is part of billing group) on the Accounting tab of the Project Info Center. The addressee lines are determined by your selection in the **Invoice Addressee** field of the Billing Session Options dialog box.

**Currency**

- **This field displays the billing currency code.**

  All currency amounts on this tab are in the billing currency.

**Organization**

- **This field displays the organization for the currently selected WBS element.**

**Client**

- **This field displays the client for the currently selected WBS element.**

**Client Contact**

- **This field displays the client's billing contact for the currently selected WBS element.**

**Compensation**

- **This field displays the total compensation amount for the currently selected WBS element.**
### Consultant Fee
This field displays the total fee for consultants for the currently selected WBS element.

### Reimb. Allowance
This field displays the total reimbursable allowance for the currently selected WBS element.

### Revenue
This field displays the job-to-date revenue for the currently selected WBS element.

### Billed
This field displays the job-to-date amount billed for the currently selected WBS element.

### Received
This field displays the job-to-date receipts total for the currently selected WBS element.

### AR
This field displays the current accounts receivable balance for the currently selected WBS element.

---

### Labor Tab of Interactive Approvals

By default, the Labor tab of Interactive Approvals lists all billable employee labor charges entered through timesheets, labor adjustments, or billing labor inserts for the selected project that are currently associated with the invoice.

The list also includes transactions that are available and eligible to be billed, based on the billing session options, but are not currently included on the invoice. Those transactions have **New** in **Invoice Status**, rather than **Submitted**.

---

### Edited Invoice

If the invoice has been downloaded to Microsoft Word or another application for editing, you cannot make any changes to invoice information on this tab or any other Interactive Approvals tabs.

---

### Contents

<table>
<thead>
<tr>
<th><strong>Labor Drop-down</strong></th>
<th>The Vision grids contain a drop-down that allows you to print a snapshot of the grid information, or export the grid’s data to a Microsoft Excel spreadsheet.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>View</strong></td>
<td>Select a transaction and click this option to view the transaction in the Billing Labor View dialog box.</td>
</tr>
<tr>
<td><strong>Bill</strong></td>
<td>Select one or more transactions and click this option to change <strong>Status</strong> to <strong>Bill</strong> for those transactions.</td>
</tr>
<tr>
<td><strong>Hold</strong></td>
<td>Select one or more transactions and click this option to change <strong>Status</strong> to <strong>Hold</strong> for those transactions.</td>
</tr>
<tr>
<td><strong>Write-Off</strong></td>
<td>Select one or more transactions and click this option to change <strong>Status</strong> to <strong>Write-off</strong> for those transactions.</td>
</tr>
<tr>
<td><strong>Delete</strong></td>
<td>Select one or more transactions and click this option to change <strong>Status</strong> to <strong>Delete</strong> for those transactions.</td>
</tr>
<tr>
<td><strong>Insert</strong></td>
<td>To insert a transaction into the grid, click this option.</td>
</tr>
<tr>
<td><strong>Modify</strong></td>
<td>Select a transaction and click this option to change the date, comment, description, hours, or amount/quantity for the transaction.</td>
</tr>
<tr>
<td><strong>Transfer</strong></td>
<td>Click this option to transfer labor hours and amounts from project to project, or within the same project (from labor code to labor code, account to account, and so on), without exiting Vision Billing.</td>
</tr>
<tr>
<td><strong>Summary</strong></td>
<td>Click this option to view totals for all the transactions displayed in the grid, such as hours, cost amount, and billing extensions.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Invoice Status</strong></th>
<th>This field displays the approval status for the transaction:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Submitted</strong></td>
<td>The transaction was linked to the invoice at the time the invoice was submitted for approval.</td>
</tr>
<tr>
<td><strong>New</strong></td>
<td>Based on the billing session options for the invoice, the transaction is eligible to be included on the invoice, but the transaction was not linked to the invoice at the time it was submitted for approval. For example, a transaction that was transferred to the project after the invoice was submitted would have <strong>New</strong> in <strong>Invoice Status</strong>. A transaction with <strong>New</strong> in <strong>Invoice Status</strong> will not be included on the invoice. If you want to include all transactions with <strong>New</strong> in <strong>Invoice Status</strong>, click <strong>Include New Transactions</strong> on the Interactive Approvals toolbar. If you make a change to a transaction that requires recalculation of the invoice, <strong>New</strong> displays in this field until the recalculation occurs. After the recalculation, this status matches the approval status of the invoice as a whole.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Status</strong></th>
<th>Select whether the transaction is billable in this billing session. If you change <strong>Status</strong> for a submitted transaction, Vision will automatically recalculate the invoice when you approve or reject the invoice, preview the invoice, select another project, or close Interactive Approvals. The options in <strong>Status</strong> are the following:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Bill</strong></td>
<td>Include in this billing session.</td>
</tr>
<tr>
<td><strong>Hold</strong></td>
<td>Save the transaction for billing at a later date.</td>
</tr>
<tr>
<td><strong>Write-off</strong></td>
<td>Mark hours that have been charged but cannot be billed. Selecting this option prevents the transaction from being billed, but allows the amount to appear on reports. When you write-off a transaction, no accounting entries are made.</td>
</tr>
<tr>
<td><strong>Delete</strong></td>
<td>Remove from the set of billable transactions. Changing the status to <strong>Delete</strong> does not actually delete the transaction. The status of <strong>Delete</strong> enables you to run reports that distinguish between write-off (hours charged but cannot be billed) and a transaction that was entered but removed before invoicing, possibly due to a data entry error. The options that are available from this field depend on your role's access rights as set in the Billing Security area of the Accounting tab of Role Security.</td>
</tr>
</tbody>
</table>
example, if you belong to a role with Allow Delete selected, the Delete option is available from this field.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Billable</td>
<td>This field indicates whether a transaction is billable. A transaction is not billable if you post it to the non-billable labor code. You can view non-billable transactions only if the Show Non-billables on Detail Tabs option is selected on the Billing Session Options dialog box.</td>
</tr>
<tr>
<td>Date</td>
<td>Vision displays the date entered for the labor transaction on the timesheet, and/or labor adjustment transaction entry, or on a billing labor insert.</td>
</tr>
<tr>
<td>Phase</td>
<td>If you select to view the project level from the Phase/Task lookup for a project with phases, all of that project's phases display in the grid. The phase number displays in the Phase column, and all detail that corresponds to that phase displays in that row. You can also choose to select a particular phase from the Phase/Task lookup to view just the detail for that phase and any associated tasks in the grid. If you click Summary on the grid toolbar, Vision displays a summary of all of the detail shown on the Labor tab, including all phases and tasks in the grid.</td>
</tr>
<tr>
<td>Task</td>
<td>If you select the project or phase level from the Phase/Task lookup for a project with tasks, all of the tasks for that project or phase display in the grid. The task number displays in the Task column, and all detail that corresponds to that task displays in that row. You can also choose to select a particular task from the Phase/Task lookup to view just the detail for that task. If you click Summary on the grid toolbar, Vision displays a summary of all of the detail shown on the Labor tab, including all phases and tasks in the grid.</td>
</tr>
<tr>
<td>Labor Code</td>
<td>Vision displays the labor code to which time was charged on the timesheet, and/or labor adjustment transaction entry, or on a Billing Labor insert. If the labor code is incorrect, you can transfer the item from within this project/phase/task to the appropriate labor code.</td>
</tr>
<tr>
<td>Category</td>
<td>Vision displays the labor category to which time was charged on the timesheet, and/or labor adjustment transaction entry, or on a Billing Labor insert. If the category is incorrect, you can transfer the item from within this project/phase/task to the appropriate category.</td>
</tr>
<tr>
<td>Employee</td>
<td>Vision displays the employee number to which the hours/amount were charged on the timesheet, and/or labor adjustment transaction entry, or on a Billing Labor insert.</td>
</tr>
<tr>
<td>Name</td>
<td>Vision displays the employee name to which the hours/amount were charged on the timesheet, and/or labor adjustment transaction entry, or on a Billing Labor insert.</td>
</tr>
<tr>
<td>Hours</td>
<td>Vision displays the total number of regular, overtime, and secondary overtime hours. To see the breakout of regular, overtime, and secondary overtime hours, click View.</td>
</tr>
</tbody>
</table>
## Rate
Vision displays the labor billing rate. This rate depends on the method specified at the **Labor Method** field on the Labor tab of the Billing Terms form.

## Extension
Vision displays the extended amount (hours * rate) based on the current billing terms.

## Comment
If a comment was entered on the timesheet and/or for the labor adjustment transaction entry, or on a Billing Labor insert, the comment displays here. To read the full comment, position the mouse pointer over the visible text, or click the text to display the comment in the Text Viewer dialog box.

## Expenses Tab of Interactive Approvals
By default, the Expenses tab of Interactive Approvals lists all billable expenses entered through expense transactions, or billing inserts for the selected project that are currently associated with the invoice.

The list also includes transactions that are available and eligible to be billed, based on the billing session options, but are not currently included on the invoice. Those transactions have **New** in **Invoice Status**, rather than **Submitted**.

### Edited Invoice
If the invoice has been downloaded to Microsoft Word or another application for editing, you cannot make any changes to invoice information on this tab or any other Interactive Approvals tabs.

## Contents
<table>
<thead>
<tr>
<th>Expenses Drop-down</th>
<th>The Vision grids contain a drop-down that allows you to print a snapshot of the grid information, or export the grid's data to a Microsoft Excel spreadsheet.</th>
</tr>
</thead>
<tbody>
<tr>
<td>View</td>
<td>Select a transaction and click this option to view the transaction in the Billing Expense View dialog box.</td>
</tr>
<tr>
<td>Bill</td>
<td>Select one or more transactions and click this option to change <strong>Status</strong> to <strong>Bill</strong> for those transactions.</td>
</tr>
<tr>
<td>Hold</td>
<td>Select one or more transactions and click this option to change <strong>Status</strong> to <strong>Hold</strong> for those transactions.</td>
</tr>
<tr>
<td>Write-Off</td>
<td>Select one or more transactions and click this option to change <strong>Status</strong> to <strong>Write-off</strong> for those transactions.</td>
</tr>
<tr>
<td>Delete</td>
<td>Select one or more transactions and click this option to change <strong>Status</strong> to <strong>Delete</strong> for those transactions.</td>
</tr>
<tr>
<td>Insert</td>
<td>To insert a transaction into the grid, click this option.</td>
</tr>
<tr>
<td>Modify</td>
<td>Select a transaction and click this option to change the date, description, amount, or tax code override information for the transaction.</td>
</tr>
</tbody>
</table>
### Transfer
Click this option to transfer expense amounts from project to project, or within the same project (from account to account, for example), without exiting Vision Billing.

### Summary
Click this option to view totals for all the transactions displayed in the grid, such as total cost amount and billing extension.

### Invoice Status
This field displays the approval status for the transaction:

- **Submitted** — The transaction was linked to the invoice at the time it was submitted for approval.
- **New** — Based on the billing session options for the invoice, the transaction is eligible to be included on the invoice, but the transaction was not linked to the invoice at the time it was submitted for approval. For example, a transaction that was transferred to the project after the invoice was submitted would have **New in Invoice Status**. A transaction with **New in Invoice Status** will not be included on the invoice. If you want to include all transactions with **New in Invoice Status**, click **Include New Transactions** on the Interactive Approvals toolbar.

If you make a change to a transaction that requires recalculation of the invoice, **New** displays in this field until the recalculation occurs. After the recalculation, this status matches the approval status of the invoice as a whole.

### Status
Select whether the transaction is billable in this billing session. If you change **Status** for a submitted transaction, Vision will automatically recalculate the invoice when you approve or reject the invoice, preview the invoice, select another project, or close Interactive Approvals.

The options in **Status** are the following:

- **Bill** — Include in this billing session.
- **Hold** — Save the transaction for billing at a later date.
- **Write-off** — Mark amounts that have been charged but cannot be billed. Selecting this option prevents the transaction from being billed, but allows the amount to appear on reports. When you write-off a transaction, no accounting entries are made.
- **Delete** — Remove from the set of billable transactions. Changing the status to **Delete** does not actually delete the transaction. The status of **Delete** allows you to run reports that distinguish between write-off (amounts charged that cannot be billed) and a transaction that was entered but removed before invoicing, possibly due to a data entry error.

The options that are available from this field depend on your role's access rights as set in the Billing Security area of the Accounting tab of Role Security. For example, if you belong to a role with **Allow Delete** selected, the **Delete** option is available from this field.

### Billable
This field indicates whether a transaction is billable. A transaction is generally not billable if you post it to a direct expense account (by default, 600-level...
You can only view non-billable transactions if the **Show Non-billables on Detail Tabs** option is selected on the Billing Session Options dialog box.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Date</strong></td>
<td>Vision displays the date associated with the expense charge as entered in transaction entry, or on a billing expense insert.</td>
</tr>
<tr>
<td><strong>Phase</strong></td>
<td>If you select to view the project level from the Phase/Task lookup for a project with phases, all of that project's phases display in the grid. The phase number displays in the <strong>Phase</strong> column, and all detail that corresponds to that phase displays in that row. You can also choose to select a particular phase from the Phase/Task lookup to view just the detail for that phase and any associated tasks in the grid. If you click <strong>Summary</strong> on the grid toolbar Vision displays a summary of all of the detail shown on the Expenses tab, including all phases and tasks in the grid.</td>
</tr>
<tr>
<td><strong>Task</strong></td>
<td>If you select the project or phase level from the Phase/Task lookup for a project with tasks, all of the tasks for that project or phase display in the grid. The task number displays in the <strong>Task</strong> column, and all detail that corresponds to that task displays in that row. You can also choose to select a particular task from the Phase/Task lookup to view just the detail for that task. If you click <strong>Summary</strong> on the grid toolbar, Vision displays a summary of all of the detail shown on the Expenses tab, including all phases and tasks in the grid.</td>
</tr>
<tr>
<td><strong>Account</strong></td>
<td>This field indicates the expense account to which this expense was charged. This account is the account to which the charge was posted during transaction entry, or the account you specify or on a Billing Expense insert. This field can only contain an expense account. This account is by default a 500-level account in the Standard Chart of Accounts. If the account is incorrect, you can perform a billing transfer to charge the transaction to the appropriate account.</td>
</tr>
<tr>
<td><strong>Type</strong></td>
<td>Vision displays the transaction type (for example, <strong>Ex</strong> (Employee Expense), <strong>MI</strong> (Miscellaneous Expense)).</td>
</tr>
<tr>
<td><strong>Ref. No.</strong></td>
<td>Vision displays the reference number (often the invoice number) for this transaction as entered through transaction entry or on a Billing Expense insert. Leading zeros always display in the invoice number in this grid if your firm uses leading zeros.</td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>If you entered a description for this expense charge in transaction entry or on a billing expense insert, it appears here.</td>
</tr>
<tr>
<td><strong>Cost</strong></td>
<td>Vision displays the cost amount for this expense charge.</td>
</tr>
<tr>
<td><strong>Extension</strong></td>
<td>Vision displays the billing extension amount for this expense charge based on</td>
</tr>
</tbody>
</table>
the applicable billing terms.

| Document | A document icon displays in the Documents column when the transaction has associated supporting documents. |

**Units Tab of Interactive Approvals**

By default, the Units tab of Interactive Approvals lists all unit charges entered through unit transactions or billing unit inserts for the selected project that are currently associated with the selected invoice.

The list also includes transactions that are available and eligible to be billed, based on the billing session options, but are not currently included on the invoice. Those transactions have **New** in Invoice Status, rather than **Submitted**.

**Edited Invoice**

If the invoice has been downloaded to Microsoft Word or another application for editing, you cannot make any changes to invoice information on this tab or any other Interactive Approvals tabs.

**Contents**

<table>
<thead>
<tr>
<th>Units Drop-down</th>
<th>The Vision grids contain a drop-down that allows you to print a snapshot of the grid information, or export the grid's data to a Microsoft Excel spreadsheet.</th>
</tr>
</thead>
<tbody>
<tr>
<td>View</td>
<td>Select a transaction and click this option to view the transaction in the Billing Unit View dialog box.</td>
</tr>
<tr>
<td>Bill</td>
<td>Select one or more transactions and click this option to change <strong>Status</strong> to <strong>Bill</strong> for those transactions.</td>
</tr>
<tr>
<td>Hold</td>
<td>Select one or more transactions and click this option to change <strong>Status</strong> to <strong>Hold</strong> for those transactions.</td>
</tr>
<tr>
<td>Write-Off</td>
<td>Select one or more transactions and click this option to change <strong>Status</strong> to <strong>Write-off</strong> for those transactions.</td>
</tr>
<tr>
<td>Delete</td>
<td>Select one or more transactions and click this option to change <strong>Status</strong> to <strong>Delete</strong> for those transactions.</td>
</tr>
<tr>
<td>Insert</td>
<td>To insert a transaction into the grid, click this option.</td>
</tr>
<tr>
<td>Modify</td>
<td>Select a transaction and click this option to change the date, description, or unit quantity for the transaction.</td>
</tr>
<tr>
<td>Transfer</td>
<td>Click this option to transfer units from project to project, or within the same project, without exiting Vision Billing.</td>
</tr>
<tr>
<td>Summary</td>
<td>Click this option to view totals for all the transactions displayed in the grid, such as total billing extension.</td>
</tr>
</tbody>
</table>
### Invoice Status

This field displays the approval status for the transaction:

- **Submitted** — The transaction was linked to the invoice at the time it was submitted for approval.
- **New** — Based on the billing session options for the invoice, the transaction is eligible to be included on the invoice, but the transaction was not linked to the invoice at the time it was submitted for approval. For example, a transaction that was transferred to the project after the invoice was submitted would have New in Invoice Status. A transaction with New in Invoice Status will not be included on the invoice. If you want to include all transactions with New in Invoice Status, click Include New Transactions on the Interactive Approvals toolbar.

If you make a change to a transaction that requires recalculation of the invoice, New displays in this field until the recalculation occurs. After the recalculation, this status matches the approval status of the invoice as a whole.

### Status

Select whether the transaction is billable in this billing session. If you change Status for a submitted transaction, Vision will automatically recalculate the invoice when you approve or reject the invoice, preview the invoice, select another project, or close Interactive Approvals.

The options in Status are the following:

- **Bill** — Include in this billing session.
- **Hold** — Save the transaction for billing at a later date.
- **Write-off** — Mark amounts that have been charged but cannot be billed. Selecting this option prevents the transaction from being billed, but allows the amount to appear on reports. When you write-off a transaction, no accounting entries are made.
- **Delete** — Remove from the set of billable transactions. Changing the status to Delete does not actually delete the transaction. The status of Delete allows you to run reports that distinguish between write-off (unit amounts charged that cannot be billed) and a transaction that was entered but removed before invoicing, possibly due to a data entry error.

The options that are available from this field depend on your role's access rights as set in the Billing Security area of the Accounting tab of Role Security. For example, if you belong to a role with Allow Delete checked, the Delete option is available from this field.

### Date

This field displays the date associated with this unit charge in unit transaction entry, or on a billing unit insert.

### Phase

If you select to view the project level from the Phase/Task lookup for a project with phases, all of that project's phases display in the grid. The phase number displays in the Phase column, and all detail that corresponds to that phase displays in that row.

You can also choose to select a particular phase from the Phase/Task lookup to view just the detail for that phase and any associated tasks in the grid.

If you click Summary on the grid toolbar, Vision displays a summary of all of the detail shown on the Units tab, including all phases and tasks in the grid.
If you select the project or phase level from the Phase/Task lookup for a project with tasks, all of the tasks for that project or phase display in the grid. The task number displays in the Task column, and all detail that corresponds to that task displays in that row.

You can also choose to select a particular task from the Phase/Task lookup to view just the detail for that task.

If you click Summary on the grid toolbar Vision displays a summary of all of the detail shown on the Units tab, including all phases and tasks in the grid.

Vision displays the unit table that contains the applicable unit information for this unit charge, as specified in unit transaction entry, or on a billing unit insert.

This field displays the unit number to which the amount was charged.

If you entered a description for this unit charge during unit transaction entry or on a billing unit insert, it displays here.

Vision displays the quantity of this unit included in this unit charge.

This field displays the billing amount per unit for this unit.

Vision displays the billing extension amount for this unit charge based on the applicable billing terms.

Use this dialog box to enter comments related to invoice approval actions for invoices that require approval.

When you are in Interactive Billing, Invoice Approvals, or Interactive Approvals, this dialog box displays when you submit, approve, or reject an invoice. The comments apply to the specific invoice that you are processing.

When you are in Batch Billing, this dialog box displays when you submit a batch of invoices for approval. The comments apply to all the invoices that you are submitting.

After you enter comments in this dialog box, you can view them in Billing » Invoice Approvals or Billing » Interactive Approvals. You can also edit any comments that you made.

This dialog box displays from any of the following locations:

- **Invoice Approvals** — From the Vision Navigation menu, click Billing » Invoice Approvals. On the Invoice Approvals form, click Comments. This dialog box also displays automatically when you click Approve or Reject on the grid toolbar.

- **Interactive Billing** — From the Vision Navigation menu, click Billing » Interactive Billing, and click the Comments button on the General tab. This dialog box also opens automatically when you click Invoice on the form toolbar, and then click Submit, Approve, or Reject.
### Interactive Approvals
- From the Vision Navigation menu, click **Billing » Interactive Approvals**, and click the **Comments** button on the General tab. This dialog box also opens automatically when you click 🟢 Approve or 🔴 Reject on the form toolbar.

### Batch Billing
- From the Vision Navigation menu, click **Billing » Batch Billing**. On the Batch Billing form, select the **Submit invoices for projects with approvals enabled** check box, and click the Run or Schedule toolbar option.

---

### Contents
The following fields and grid displays only when this dialog box opens in Interactive Billing, Invoice Approvals, or Interactive Approvals:

#### Fields
| Project | These fields display the project number and name associated with the invoice. |

#### Comments Grid
| Insert | If you are reviewing an invoice in the Invoice Approvals form or Interactive Approvals form and want to enter new comments as you proceed, click Comments to open this dialog box, and click 🟢 Insert to add an In Process action row to the grid. You can then switch back and forth from previewing the invoice, or from reviewing invoice transactions on the Invoice Approvals form or Interactive Approvals form, to this dialog box when you want to enter a comment. When you click either 🟢 Approve or 🔴 Reject, Vision changes the action for the inserted row and the new comments to Approved or Rejected. This option is only available if you open the Billing Comments dialog box from the Invoice Approvals form or Interactive Approvals form. Note: If you insert a row and, before you click OK, you decide you do not want to add a comment, click Cancel to remove the row. If you insert a row, enter a comment, and click OK, and then you later decide you want to remove your comment, you can delete the comment text, but the row will remain. You cannot delete an inserted row after you click OK. |
| Action | This column displays the approval actions that have occurred for the invoice: Submitted, Approved, or Rejected. |
| Name | This column displays the name of the person who carried out the action. |
| Date | This column displays the date and time that the action occurred. |
| Comment | If a comment was entered for the action, this column contains all or part of that comment. To view the full text of a long comment, position the mouse pointer over the text in this column to read the comment in a tooltip, or click the text to display it in the Text Viewer dialog box. |
Text Box and Buttons

The following fields and buttons display when this dialog box opens in Interactive Billing, Invoice Approvals, Interactive Approvals, or Batch Billing:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Comment Entry</td>
<td>Enter a new comment or edit an existing comment directly in this text box.</td>
</tr>
<tr>
<td>and Edit</td>
<td>You can only edit comments that you entered originally. You can view comments</td>
</tr>
<tr>
<td></td>
<td>entered by others, but you cannot edit them.</td>
</tr>
<tr>
<td></td>
<td>If you need additional formatting options, click Edit on the Comment Entry</td>
</tr>
<tr>
<td></td>
<td>toolbar to open the Text Editor dialog box and format the text.</td>
</tr>
<tr>
<td>OK</td>
<td>Click OK to save your entries. If this dialog box displayed when you clicked</td>
</tr>
<tr>
<td></td>
<td>Submit, Accept, or Reject, you must click OK to complete that action,</td>
</tr>
<tr>
<td></td>
<td>whether or not you enter a comment.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Click Cancel to discard your unsaved entries.</td>
</tr>
<tr>
<td></td>
<td>If this dialog box displayed when you clicked Submit, Accept, or Reject,</td>
</tr>
<tr>
<td></td>
<td>you must click OK to complete that action, whether or not you enter a</td>
</tr>
<tr>
<td></td>
<td>comment. If you click Cancel, the action is not carried out, and the approval</td>
</tr>
<tr>
<td></td>
<td>status of the invoice does not change.</td>
</tr>
</tbody>
</table>

Invoice Approvals and Batch Billing Overview

If you use the Invoice Approval feature in Vision, you can perform some of the Invoice Approval tasks in Batch Billing.

You can complete the following Invoice Approval tasks in Batch Billing:

- Print a group of draft invoices that have not yet been submitted. This allows you to review invoices before the approval process starts. To edit any of the invoices before you submit them, you must use Interactive Billing.
- Submit a group of draft invoices for approval. When you submit the invoices, you can chose whether or not to print or email the submitted invoices to the approver. If you do not print or email them, the approver can preview the invoices in Billing Invoice Approvals or Billing Interactive Approvals.
- Final accept a group of approved draft invoices.

Batch Billing Checklist for Processing Invoices that Require Approval

If you use the Invoice Approval feature in Vision, you can perform some of the Invoice Approval tasks in Batch Billing.

The following checklist includes the steps to produce an invoice, some of which you can complete in Batch Billing.

<table>
<thead>
<tr>
<th>Done?</th>
<th>Step</th>
<th>Where Accessed?</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Enter and post timesheets, labor adjustments, and any expenses.</td>
<td>Transaction Center » Transaction Entry, and Transaction Posting</td>
</tr>
<tr>
<td>Done?</td>
<td>Step</td>
<td>Where Accessed?</td>
</tr>
<tr>
<td>-------</td>
<td>----------------------------------------------------------------------</td>
<td>-----------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Review the Unbilled Detail and Aging report for the project.</td>
<td>Reporting » Billing, Unbilled Detail and Aging Report</td>
</tr>
<tr>
<td></td>
<td>Run draft invoices for projects and review them.</td>
<td>Billing » Batch Billing</td>
</tr>
<tr>
<td></td>
<td>Submit draft invoices for approval.</td>
<td>Billing » Batch Billing</td>
</tr>
<tr>
<td></td>
<td>Review invoices, update fees, transfer, hold, view, bill, write-off,</td>
<td>Billing » Interactive Approvals</td>
</tr>
<tr>
<td></td>
<td>modify, delete or insert transactions.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Approve or reject invoices.</td>
<td>Billing » Invoice Approvals or Billing » Interactive Approvals</td>
</tr>
<tr>
<td></td>
<td>Process a final run for a group of approved draft invoices (accept the invoices).</td>
<td>Billing » Batch Billing</td>
</tr>
<tr>
<td></td>
<td>Post the invoice transaction file.</td>
<td>Transaction Center » Transaction Posting</td>
</tr>
</tbody>
</table>

### Print Draft Invoices in Batch Billing Before You Submit Them for Approval

If you use the Invoice Approval feature, for invoices that require approval, you can print draft invoices in Batch Billing to review them before you submit the invoices for approval.

To edit any of the invoices before you submit them, you must use Interactive Billing.

**To print a batch of draft invoices that have not yet been submitted for approval, complete the following steps:**

1. From the Vision Navigation menu, click **Billing » Batch Billing**.
2. On the Billing Session Options dialog box, select options for the batch such as the period start and end dates, and click **OK**.
3. On the Main tab of the Batch Billing form, select the following options to ensure that only project that require approval are included in the batch:
   - **Draft Run** in the **Run Type** field drop-down list
   - **Include Only Projects with approvals enabled** option in the **Projects Selection** section
4. Be sure the following check boxes are not selected on the Main tab:
   - **Submit invoices for Projects with approvals enabled** check box
   - **Do not print when generating invoices** check box
5. In the **Select Specific Projects** field, use the Project Lookup to select the projects that you want to include in the draft run.
6. Enter a description for the run in the **Run Description** field, and make any other appropriate selections on the Main tab.
7. Click either of the following Batch Billing form toolbar options:

- **Run** — This prints the batch of draft invoices immediately. A dialog box indicates the number of projects processed and the number of invoices generated.
- **Schedule** — This allows you to schedule the invoices to be printed automatically at a future time.

Submit Draft Invoices for Approval in Batch Billing

If you use the Invoice Approvals feature, you can use Batch Billing to submit multiple invoices at a time to be approved.

In the Invoice Approval process, invoices must be submitted for approval and then approved before they can be final accepted and posted. You can also use Interactive Billing to submit invoices for approval (one invoice at a time).

To submit invoices for approval in Batch Billing, complete the following steps:

1. From the Vision Navigation menu, click **Billing » Batch Billing**.
2. On the Billing Session Options dialog box, select options for the batch such as the period start and end dates, and click **OK**.
3. On the Main tab of the Batch Billing form, select one of the following sets of options based on whether or not you want to include only invoices to be submitted for approval in the batch:

   If you have different printing requirements for invoices that require approval and invoices that do not require approval, you can run them in separate batches.

   If you want to only submit invoices for approval in the batch, select both of the following options:

   - **Draft Run** in the **Run Type** field drop-down list
   - **Submit invoices for Projects with approvals enabled** check box
   - **Include Only Projects with approvals enabled** option in the **Projects Selection** section

   If you want to submit invoices for approval and process other draft invoices that do not require invoice approval in one batch, select all of the following options:

   - **Draft Run** in the **Run Type** field drop-down list
   - **Submit invoices for Projects with approvals enabled** check box
   - **Include All Projects** option in the **Projects Selection** section

4. In the **Select Specific Projects** field, use the Project Lookup to further filter the projects for which you want to process invoices.

5. Choose how you want invoices to be reviewed.

   On the Main tab of the Batch Billing form, you can select various options that allow you to print, email, or not print invoices in the batch run.

   If you select the **Do not print when generating invoices** check box, which prevents invoices from being sent to the printer to be printed when you run the batch, submitted invoices will be available to review in Billing Invoice Approvals and Billing Interactive Approvals and available to print from the Previously Run Batches tab in Batch Billing.
6. Select the **Do not create report for submitted invoices** check box if you do not want to
an invoice report to be printed when you run the batch. This allows the batch to be
processed faster. Submitted invoices can be reviewed in **Billing » Invoice Approvals** or
**Billing » Interactive Approvals**. Invoices are not emailed when you select this option.

7. Enter a description for the run in the **Run Description** field, and make any other
appropriate selections on the Main tab.

8. To process the batch, click either of the following toolbar options on the Batch Billing
form:
   - **Run** — This submits invoices for approval immediately. If you selected to include all
     projects (and include invoices that do not require approval in the batch), a draft
     invoice is printed for each invoice included in the batch run.
   - **Schedule** — This allows you to schedule the invoices to be submitted for approval
     automatically at a future time. If you selected to include all projects (and include
     invoices that do not require approval in the batch), a draft invoice is generated for
     each invoice included in the batch run.

9. In the Billing Comments dialog box, enter comments for invoice approvers such as
"Please review and approve by Friday, March 27th." Then click **OK**.

The comments that you enter apply to all invoices in the batch that require approval. If
you need to make specific comments for a project, then after you submit the invoices for
approval in Batch Billing, go to Interactive Billing or Interactive Approvals and update the
submitted comments.

If you clicked **Run** on the Batch Billing form toolbar and you specified that a dashboard
and/or email alert be sent to approvers when an invoice for a project is submitted, an
alert is sent automatically to approvers. (Alerts and their message content are specified
for an invoice approval process in **Configuration » Billing » Invoice Approval Process**.
An invoice approval process is specified for a project in its billing terms.) The alerts
include a hyperlink to the Invoice Approval application in Billing.

10. If you clicked **Schedule** on the Batch Billing toolbar, complete the entries in the Schedule
dialog box to submit the invoices at a future time, and click **OK**. When the invoices are
submitted, if you specified that a dashboard and/or email alert be sent to approvers when
an invoice for a project is submitted, an alert is sent automatically to approvers—the
same as when you click **Run** to submit invoices for approval immediately.

**Final Accept Approved Invoices in Batch Billing**

If you use the Invoice Approvals feature, you can use Batch Billing to final accept multiple
approved invoices at one time.

Invoices must be submitted and approved before they can be final accepted. You can also final
accept invoices (one at a time) in Interactive Billing. After you final accept invoices, you post
them.

**To final accept approved invoices in Batch Billing, complete the following steps:**

1. From the Vision Navigation menu, click **Billing » Batch Billing**.

2. On the Billing Session Options dialog box, select options for the batch such as the period
   start and end dates, and click **OK**.

3. On the Main tab of the Batch Billing form, select **Final Run** in the **Run Type** field drop-
down list.

4. Select the group of projects to include in the batch.
To include only approved invoices in the batch, select the Include Only Projects with approvals enabled option in the Projects Selection section.

To include approved invoices and draft invoices that do not require approval in the batch, select the Include All Projects option in the Projects Selection section.

5. In the Select Specific Projects field, use the Project Lookup to select specific projects to include in the batch.

6. Select from the various options that allow you to print, email, or not print invoices in the batch run.

7. Enter a description for the batch in the Run Description field, and make any other appropriate selections on the Main tab.

8. To final accept approved invoices, click either of the following Batch Billing form toolbar options:
   - Run — This final accepts the invoices immediately. A dialog box displays to indicate the number of projects that are processed and the number of invoices generated. Each invoice is printed if you did not select the Do not print when generating invoices check box. An invoice transaction entry file is created. You must post the file in Transaction Center » Transaction Posting to update your general ledger.
   - Schedule — This allows you to schedule the invoices to be final accepted automatically at a future time. At the future time, when processing is complete, invoices are generated, printed, and an invoice transaction entry file is created. You must post the file in Transaction Center » Transaction Posting to update your general ledger.

Main Tab of the Batch Billing Form

Use this tab to select settings for processing a group of draft or final invoice or to submit a group of invoices for approval if you use the Invoice Approval feature.

These settings allow you to do things such as generate invoices with or without printing them, send the invoices to others by email, and create other reports for the batch run.

Location

To open the Main tab of the Batch Billing form, complete the following steps:

2. On the Batch Billing form, click the Main tab.

Contents

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Saved Options</td>
<td>From the Saved Options drop-down list, select a set of options to use with the current batch run. To select a set of options, click the Global Options or Personal Options folder to expand options, and click the option that you want to use. You, or your company, must have saved at least one set of global or personal settings to have options available from this dialog box. You save settings using the Organize function.</td>
</tr>
</tbody>
</table>
Billable Invoice Approvals

| **Organize** | Click **Organize** to display the Organize Options dialog box, where you can save all current settings for the Batch Billing run, such as the run type, to use for future runs. |
| **Default** | Click **Default** to restore the Vision default Batch Billing options. You can establish any set of global options as the default by selecting **Use as default options** from the Organize Options dialog box. Clicking **Default** does not affect any saved sets of Batch Billing options. |
| **Run Type** | Select whether to create draft or final invoices for the batch run: Select whether to create draft or final invoices for the batch run: This option is only enabled for users who belong to a role with the **Batch Billing - Allow Final Processing** option selected in the Billing Security area on the Accounting tab of Roles Security. This field prefills with **Draft Run** for all other users.  
  - **Draft Run** — Select this option to produce draft (pre-billing) invoices that you can review before you create final invoices to send to customers. Draft invoices can be previewed and edited in Interactive Billing. When draft invoices are ready to be final invoiced and sent to customers, you either process them as a final run in Batch Billing or you accept each draft invoice individually in Interactive Billing. You must select **Draft** when you select the **Submit invoices for Projects with approvals enabled** check box.  
  - **Final Run** — Select this option to produce final accepted invoices that you can send to customers. An invoice transaction file is created for the final invoices. You must post the file in **Transaction Center » Transaction Posting**. |
| **Run Description** | Enter a name for this batch billing run. For example, if you firm creates separate batch runs for each office, you can include the office name in the description. This description displays in the **Run Description** field in the Batch Billing Runs grid on the Previously Run Invoices tab. The description entered here does not need to be unique. Vision distinguishes runs by their date stamp (displayed in the **Date** field in the Batch Billing Runs grid). |
| **Submit invoices for Projects with approvals enabled** | This check box displays only if the Invoice Approvals feature is enabled. If you use the Multicompany feature, this check box is enabled only if the company that you have open has the Invoice Approvals feature enabled. You can select this check box only if you select **Draft Run** in the **Run Type** field. Select this check box to submit invoices that require approval. Invoices for projects without billing terms will not be submitted. This option is similar to the submit functionality in Interactive Billing. After you click **Run** on the Batch Billing form toolbar:  
  - The status of the invoices and the transactions associated with the submitted invoices changes from **New** to **Submitted**. You can see the invoice status in the grid in **Billing » Invoice Approvals**.  
  - You can enter a comment in the Billing Comments dialog box that applies to all submitted invoices in the draft run.  
  - Vision sends an alert to the person or people who are responsible for approving invoices if alerts have been set up for the submit action for the invoice approval process that is specified for a project. |

**Billing Terms Overrides Section:**
### Outstanding A/R

The options for printing outstanding accounts receivable on invoices are:

- **Billing Terms** — Select this option to print outstanding accounts receivable on a project-by-project basis, according to the AR printing option(s) on the General tab of the Billing Terms form.

- **Always Print** — Select this option to print outstanding accounts receivable for all of the projects included in this Batch Billing run, regardless of the settings on the General tab of the Billing Terms form.

- **Never Print** — Select this option to bypass printing outstanding accounts receivable for the projects included in this Batch Billing run regardless of the settings on the General tab of the Billing Terms form.

### Billed to Date

The options for printing billed-to-date amounts on invoices are:

- **Billing Terms** — Select this option to print billed-to-date amounts on a project-by-project basis, according to the Billed-to-date printing option(s) on the General tab of the Billing Terms form.

- **Always Print** — Select this option to print billed-to-date for all of the projects included in this Batch Billing run, regardless of the settings on the General tab of the Billing Terms form.

- **Never Print** — Select this option to bypass printing billed-to-date for the projects included in this Batch Billing run, regardless of the settings on the General tab of the Billing Terms form.

### Billing Backup

The options for printing Billing Backup reports are:

- **Billing Terms** — Select this option to print billing backup information on a project-by-project basis, according to the Print Backup Report option on the Billing Backup tab of the Billing Terms form.

- **Always Print** — Select this option to print billing backup information for all of the projects included in this Batch Billing run, whether or not Print Backup Report is selected for those projects on the Billing Backup tab of the Billing Terms form.

- **Never Print** — Select this option to bypass printing billing backup information for the projects included in this Batch Billing run, regardless of the settings on the Billing Backup tab of the Billing Terms form.

If your firm uses the Multilingual feature, Vision generates the Billing Backup report in the same language as the associated invoice.

If you use the Invoice Approval feature, the Billing Backup options allow you to view the Billing Backup report for previewing submitted invoices in Billing » Invoice Approvals or Billing » Interactive Approvals.

### Print Invoices Without Current Activity

The options for printing invoices without current activity are:

- **Billing Terms** — Select this option to print invoices with no current billings on a project-by-project basis, according to the Print Invoices Without Current Activity option on the Misc tab of the Billing Terms form. When this option is selected on the Billing Terms form, Vision includes projects in the run that have no current billings, providing the projects have fee terms established and/or outstanding accounts receivable. Deltek recommends this option for Fee projects.

- **Always Print** — Select this option to print invoices for all projects, regardless of the setting on the Misc tab of the Billing Terms form.

- **Never Print** — Select this option to bypass printing invoices for projects with no current billings, regardless of the setting on the Misc tab of the Billing Terms form. Please note that if the Print Invoices with only
### A/R option is selected from the Billing Setup form (Configuration » Billing » General), then invoices without current activity, but with outstanding accounts receivable will print, even if the Never Print option is selected.

### Invoice Template
Select a template to use for all invoices to be printed during this Batch Billing run. For this Batch Billing run only, this overrides the default invoice template set on a project-by-project basis on the General tab of the Billing Terms form.

You can use this option, for example, when all draft invoices use a single draft template, but final invoices use a variety of templates.

### Sort Invoices By Section:

#### First
Select the option for your first sort when printing invoices:

Some of the following sort options are default labels, which may have been tailored in your application to meet your company’s business requirements. Contact your system administrator for further information about the labels your company uses.

- Billing Client Number
- Billing Client Name
- Project Manager Number
- Project Manager Name
- Principal Number
- Principal Name
- Supervisor Number
- Supervisor Name
- Organization Level 1
- Organization Level 2
- Organization Level 3

If your company added user-defined fields to the Project Info Center, these fields also appear as sort options from the First, Second, and Third sort fields.

Invoices are sorted in alphabetic order by project name or number, based on the option selected from the Project field, and in all sort fields (First, Second, Third) in the corresponding order. For example, If you select Project Manager as your First sort, and Client as your second sort, the invoice associated with Project Manager Scott Andersen and client Ace Builders will print before the invoice associated with Project Manager Scott Andersen and client Blue Builders.

#### Second
Select the option you want to use as your second sort when printing invoices:

Some of the following sort options are default labels, which may have been tailored in your application to meet your company’s business requirements. Contact your system administrator for further information about the labels your company uses.

- Billing Client Number
- Billing Client Name
- Project Manager Number
- Project Manager Name
If your company added user-defined fields to the Project Info Center, these fields also appear as sort options from the First, Second, and Third sort fields.

Invoices are sorted in alphabetic order, based on the option selected from the **Project** field, and in all sort fields (First, Second, Third) in the corresponding order.

| Third | Select the option you want to use as your third sort when printing invoices:
|       | Some of the following sort options are default labels, which may have been tailored in your application to meet your company’s business requirements. Contact your system administrator for further information about the labels your company uses:
|       | • Billing Client Number
|       | • Billing Client Name
|       | • Project Manager Number
|       | • Project Manager Name
|       | • Principal Number
|       | • Principal Name
|       | • Supervisor Number
|       | • Supervisor Name
|       | • Organization Level 1
|       | • Organization Level 2
|       | • Organization Level 3

If your company added user-defined fields to the Project Info Center, these fields also appear as sort options from the **First**, **Second**, and **Third** sort fields.

Invoices are sorted in alphabetic order, based on the option selected from the Project field, and in all sort fields (**First**, **Second**, **Third**) in the corresponding order.

| Project | Select whether you want to sort invoices using the project **Name** or project **Number**.
| Do not print when generating invoices | Select this check box to generate draft or final invoices without automatically sending the invoices to a printer to be printed. After invoices are generated, you can review or print them on the Previously Run Invoices tab.
|       | If you are submitting invoices for approval and you select this check box, you can print and preview submitted invoices in **Billing » Invoice Approvals** or **Billing » Interactive Approvals**.
| Do not create | This check box is enabled only if you are submitting invoices for approval. This
### Report for Submitted Invoices

Means you have selected both of the following on this tab:

- **Draft Run** in the **Run Type** field is selected.
- **Submit invoices for Projects with approvals** enabled check box is selected.

Leave this check box cleared, if you want all invoices in the batch to be printed automatically when you run the batch.

Select this check box if you do not want all invoices in the batch to be printed automatically when you run the batch. This reduces the time it takes to process a Batch Billing run.

When you select this check box:

- Approvers can preview the submitted invoices in **Billing » Invoice Approvals** or **Billing » Interactive Approvals**.
- You will not be able to preview the submitted invoices on the Previously Run Batches tab on the Batch Billing form.
- You can select the **Print batch invoice list** check box on this tab to print a list of the submitted invoices in the batch.
- Invoices will not be emailed.

### Include Unbilled Detail Report with Each Invoice

Select this check box to print the corresponding Unbilled Detail report with each invoice. The Unbilled Detail report lists all posted transactions for the project with a pending status, such as to be billed (B), to be deleted (D), hold (H), or to be written-off (W).

If you select this option, Vision uses the **Bill-thru Date** set from the Batch Billing form for the report, rather than the **Aging Date** option set in the Unbilled Detail Report's Options dialog box.

Vision formats the report’s name as follows:

**Batch Unbilled [wbs1Label] [WBS1] [Invoice Number]**

For example, you might see:

**Batch Unbilled Project 199900100 Draft.roi**

Additionally, Vision stores the username and time (in seconds) to ensure that even when you run multiple batch billing runs, the Unbilled Detail reports from that are from separate batches will be unique.

If your firm uses the Multilingual feature, Vision generates invoices and supporting reports in the language saved with the applicable invoice template. However, it does not automatically use that language for Unbilled Detail reports. The Unbilled Detail reports, because they are intended for internal use only, are generated in the language that you select when you log in to process batch billing. (You can, however, create a set of saved options for a specific language for the Unbilled Detail and Aging report in Reporting and then select that set of options for the report when you run the batch billing process.)

### Use Default Terms for Draft Invoices

Select this check box if you want Vision to use the default billing terms (**Configuration » Billing » Project Default Terms**) for all projects that do not have billing terms established.

### Print Batch Invoice List

Select this check box to print a list of invoices with current activity for the current run. The list includes the project name, invoice number, and invoice totals for each invoice at the end of the batch run.

If you use the Invoice Approval feature and you select this check box when you are submitting invoices for approval, the default billing terms are used for previewing the submitted invoice in **Billing » Invoice Approvals**.
**Print Supporting Documents**
Select this option to print the supporting documents that are associated with the invoice.

**Projects Selection Section:**

**Select Specific Projects**
Click ✗ Find in this field to select the projects whose invoices you want to process in Batch Billing. In the Project Lookup dialog box that opens, you can perform a Standard, Advanced, SQL Where Clause or Saved search to select a group of projects. To include all projects in the run, leave the default All Projects selected in the Select Specific Projects field.

If you use the Invoice Approval feature
Three Include options also display below the Select Specific Projects field if you use the Invoice Approval feature. After you select one of the Include options, click ✗ Find in the Select Specific Projects field to open the Project Lookup and select a group of projects whose invoices you want to include in the Batch Billing run.

The Include option that you select does not affect the list of projects that display in the Project Lookup in the Select Specific Projects field. All projects are included in the Project Lookup.

When you use invoice approvals, the invoices included in the Batch Billing run are based on which Include option that you select and what you select in the Select Specific Projects field. For example, if you select Include Only Projects with Approvals enabled, and in the Select Specific Projects field, you select projects from only one organization in your company, then the invoices included in the batch run are only for the projects from that one organization that have Invoice Approvals enabled.

**Include**
These options display only if you have the Invoice Approval feature turned on (the Enable Invoice Approvals check box is selected on the Miscellaneous tab in Configuration » Billing » General).

Select one of the following options to determine which invoices will be included in the Batch Billing run:

- **All Projects**
  Select this option to include invoices for all projects. This includes projects that require invoice approvals and projects that do not require invoice approvals.

  For draft runs, this includes invoices that have not yet been submitted for approval if they require approval and all invoices that do not require approval that meet the project selection criteria in the Select Specific Projects field.

  For final runs, this includes draft invoices that have a status of Approved for projects that require approval and all draft invoices that do not require approval that meet the project selection criteria in the Select Specific Projects field.

- **Only Projects with Approvals enabled**
  Select this option to include invoices for only projects that require invoice approvals (Enable Invoice Approvals is selected on the Misc tab in the Billing Terms for a project).

  For projects that are part of billing groups: Vision looks at the Invoice Approvals setting for the main project of a billing group to determine whether or not to include the invoices for the whole group of projects that make up the billing group.

  For draft runs, only invoices with a New status are included in the run.
Invoices with a Not Submitted, Approved, or Rejected status are not included.

For final runs, only approved invoices that meet the project selection criteria in the Select Specific Projects field are included in the run.

- **Only Projects with Approvals not enabled**

Select this option to include invoices for only projects that do not require invoices to be approved (Enable Invoice Approvals is cleared on the Misc tab in the Billing Terms for a project) that also meet the project selection criteria in the Select Specific Projects field.

For projects that are part of billing groups: Vision looks at the Invoice Approvals setting for the main project of a billing group to determine whether or not to include the invoices for the whole group of projects that make up the billing group.

After you select one of the Include options, enter selection criteria in the Project Lookup dialog box in the Select Specific Projects field to include invoices for a smaller or specific set of projects.

For example, if you select Include Only Projects with Approvals enabled, and in the Select Specific Projects field, you select only projects from only one organization, then the projects included in the run are only the invoices for that one organization that have Invoice Approvals enabled.

The Include option that you select does not affect the list of projects that display in the Project Lookup in the Select Specific Projects field. All projects are included in the Project Lookup.

### Email Invoices Section:

**Email Invoices**

Select this check box if you want to send copies of draft or final invoices as email attachments.

If you normally print the Billing Backup report and the Unbilled Detail report along with your invoices, Vision also sends these reports as email attachments along with the invoices.

**If you use the Invoice Approvals feature and you are submitting invoices for approval in Batch Billing**

The invoice approval process for a project may be configured in Invoice Approval Configuration to automatically send email alerts to invoice approvers when invoices are submitted. If that is the case and you select the Email Invoices check box to send submitted draft invoices as email attachments to invoice approvers, they will receive two emails regarding invoices that they need to approve.

When you select the Do not create report for submitted invoices option, emails with invoices attached are not generated.

**Email single file**

If you select this check box, Vision merges all invoices and supporting reports for a recipient into a single file and sends that file as an email attachment. Each recipient gets one email message.

If you do not select the Email single file check box, Vision merges each invoice with its supporting reports into a separate file and attaches each file to a separate email. In this case, Batch Billing could generate multiple email messages for a single recipient.

In either case, Vision also creates a single file for the billing batch that contains all invoices and related reports. You can view that file from the Previously Run Batches tab of the Batch Billing form.

If you want to generate the reports as Microsoft Excel files, do not select this check box. If Email single file is selected, the option to generate Excel files is not
Specifying the recipients of the invoices you will distribute by email:

Some of the following options are default labels, which may have been tailored in your application to meet your company’s business requirements. Contact your system administrator for further information about the labels your company uses.

- **Project Manager** — Select this option to send invoices to the project manager associated with each project that is being billed.
- **Principal** — Select this option to send invoices to the principal associated with each project that is being billed.
- **Supervisor** — Select this option to send invoices to the supervisor associated with each project that is being billed.
- **Billing Contact** — Select this option to send invoices to the billing contact associated with each project that is being billed.
- **Primary Contact** — Select this option to send invoices to the primary client contact associated with each project that is being billed.
- **Specific email address** — Select this option to send invoices to an email address you specify, rather than to a predefined group of recipients. Enter the email address in the field below the **To** field. If you want to send email to multiple addresses, enter all of them in that field, with semicolons (;) as separators between them. You can also click to select the addresses you want from the Contact or Employee Info Centers.

To send copies to recipients other than the primary recipients, enter one or more email addresses for CC and BCC recipients. If you want to send copies to multiple addresses, enter all of them in the field, with semicolons (;) as separators between them. You can also click to select the addresses you want from the Contact or Employee Info Centers.

To insert a field as part of the subject line of the email (for example, `[:Invoice Number]` and `[:Invoice Date]`), click **Insert Field**, select one or more fields in the Fields dialog box, and click **OK**. As it generates the email messages, Vision substitutes the corresponding values for any fields you have inserted in the subject line so that each one is tailored for its recipient.

Note that the project- and invoice-specific fields are only available if you do not select the **Email single file** check box.

Enter the subject line for the email messages.

You can click the **Insert Field** button to select and insert fields into the subject line (for example, `[:Invoice Number]` and `[:Invoice Date]`). As it generates the email messages, Vision substitutes the corresponding values for any fields you have inserted in the subject line so that each one is tailored for its recipient.

Enter the text of the email message.

Click **Edit** to open the Text Editor to view and work on the message in a larger space, to apply formatting options, and to check spelling.

To insert a field as part of the subject line of the email (for example, `[:Invoice Number]` and `[:Invoice Date]`), click **Insert Field**, select one or more fields in the Fields dialog box, and click **OK**. As it generates the email messages,
Vision substitutes the corresponding values for any fields you have inserted in the message text so that each message is tailored for its recipient. Note that the project- and invoice-specific fields are only available if you do not select the Email single file check box.

<table>
<thead>
<tr>
<th>Invoice file type</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>If you selected the Email invoices to option, select the file format for emailed invoices:</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Adobe PDF</strong> — Sends emails with a PDF attachment. The PDF format can be viewed in Adobe Acrobat Reader. If you own a full copy of the Adobe Acrobat product, you can make minor edits to the PDF file.</td>
<td></td>
</tr>
<tr>
<td><strong>Rich Text Format (RTF)</strong> — Sends emails with an RTF attachment. This format can be opened and edited in any Word Processing program, such as WordPad.</td>
<td></td>
</tr>
<tr>
<td><strong>Microsoft Word Document</strong> — Sends emails with a Word document (DOC) attachment. This format can be opened and edited in Microsoft Word.</td>
<td></td>
</tr>
<tr>
<td><strong>Microsoft Excel Spreadsheet (Display Format)</strong> — Sends emails with an Excel spreadsheet (XLS) attachment. This format can be opened and edited in Microsoft Excel. The spreadsheet will have no visible gridlines or row and column headers.</td>
<td></td>
</tr>
<tr>
<td><strong>Microsoft Excel Spreadsheet (Data Format)</strong> — Sends emails with an Excel spreadsheet (XLS) attachment. This format can be opened and edited in Microsoft Excel. The spreadsheet will have visible gridlines and row and column headers.</td>
<td></td>
</tr>
<tr>
<td><strong>HTTP link to invoice</strong> — Sends emails with a hyperlink that when clicked opens the invoice within Vision. When the email recipient clicks on the link, the link directs the user to Vision and opens the invoice in a browser window. If the email recipient is not currently logged in to Vision, the recipient is directed to the Vision login page first. Then after the user logs in, Vision displays the invoice in a browser window.</td>
<td></td>
</tr>
</tbody>
</table>

The Microsoft Excel file format option is only available if you are using SQL Server 2008 Reporting Services on your report server and if you do not select the Email single file check box. Also note that if you generate the Unbilled Detail report along with the invoices, the invoice and the report will be in separate attached Excel files because there is no way to merge Excel files.

**Billing Comments Dialog Box**

Use this dialog box to enter comments related to invoice approval actions for invoices that require approval.

When you are in Interactive Billing, Invoice Approvals, or Interactive Approvals, this dialog box displays when you submit, approve, or reject an invoice. The comments apply to the specific invoice that you are processing.

When you are in Batch Billing, this dialog box displays when you submit a batch of invoices for approval. The comments apply to all the invoices that you are submitting.

After you enter comments in this dialog box, you can view them in Billing » Invoice Approvals or Billing » Interactive Approvals. You can also edit any comments that you made.

**Location**

This dialog box displays from any of the following locations:
• **Invoice Approvals** — From the Vision Navigation menu, click **Billing » Invoice Approvals**. On the Invoice Approvals form, click **Comments**. This dialog box also displays automatically when you click **Approve** or **Reject** on the grid toolbar.

• **Interactive Billing** — From the Vision Navigation menu, click **Billing » Interactive Billing**, and click the **Comments** button on the General tab. This dialog box also opens automatically when you click **Invoice** on the form toolbar, and then click **Submit**, **Approve**, or **Reject**.

• **Interactive Approvals** — From the Vision Navigation menu, click **Billing » Interactive Approvals**. On the Interactive Approvals form, click **Approve** or **Reject** on the form toolbar.

• **Batch Billing** — From the Vision Navigation menu, click **Billing » Batch Billing**. On the Batch Billing form, select the **Submit invoices for projects with approvals enabled** check box, and click the **Run** or **Schedule** toolbar option.

## Contents

The following fields and grid displays only when this dialog box opens in Interactive Billing, Invoice Approvals, or Interactive Approvals:

### Fields

| Project | These fields display the project number and name associated with the invoice. |

### Comments Grid

| Insert | If you are reviewing an invoice in the Invoice Approvals form or Interactive Approvals form and want to enter new comments as you proceed, click **Comments** to open this dialog box, and click **Insert** to add an **In Process** action row to the grid. You can then switch back and forth from the Invoice Approvals form or Interactive Approvals form to this dialog box when you want to enter a comment. When you click either **Approve** or **Reject**, Vision changes the action for the inserted row and the new comments to **Approved** or **Rejected**. This option is only available if you open the Billing Comments dialog box from the Invoice Approvals form or Interactive Approvals form. **Note:** If you insert a row and, before you click **OK**, you decide you do not want to add a comment, click **Cancel** to remove the row. If you insert a row, enter a comment, and click **OK**, and then you later decide you want to remove your comment, you can delete the comment text, but the row will remain. You cannot delete an inserted row after you click **OK**. |
| Action | This column displays the approval actions that have occurred for the invoice: **Submitted**, **Approved**, or **Rejected**. |
| Name | This column displays the name of the person who carried out the action. |
| Date | This column displays the date and time that the action occurred. |
| Comment | If a comment was entered for the action, this column contains all or part of that comment. To view the full text of a long comment, position the mouse pointer over the text in this column to read the comment in a tooltip, or click the text to display it in the Text Viewer. |
**Text Box and Buttons**

The following fields and buttons display when this dialog box opens in Interactive Billing, Invoice Approvals, Interactive Approvals, or Batch Billing:

<table>
<thead>
<tr>
<th><strong>Comment Entry and Edit</strong></th>
<th>Enter a new comment or edit an existing comment directly in this text box. You can only edit comments that you entered originally. You can view comments entered by others, but you cannot edit them.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>If you need additional formatting options, click Edit on the Comment Entry toolbar to open the Text Editor dialog box and format the text.</td>
</tr>
<tr>
<td><strong>OK</strong></td>
<td>Click OK to save your entries. If this dialog box displayed when you clicked ✅ Submit, ✅ Accept, or ✅ Reject, you must click OK to complete that action, whether or not you enter a comment.</td>
</tr>
<tr>
<td><strong>Cancel</strong></td>
<td>Click Cancel to discard your unsaved entries.</td>
</tr>
<tr>
<td></td>
<td>If this dialog box displayed when you clicked ✅ Submit, ✅ Accept, or ✅ Reject, you must click OK to complete that action, whether or not you enter a comment. If you click Cancel, the action is not carried out, and the approval status of the invoice does not change.</td>
</tr>
</tbody>
</table>
Include the Batch Invoice List

The Batch Invoice List is a list of invoices with current activity for the current Batch Billing run that prints at the end of the current batch billing run.

The list includes the project number, project name, invoice number, and invoice totals for each invoice. If you use the Invoice Approvals feature, the report also includes a Submitted column that indicates whether or not an invoice has been submitted for approval.

You control whether or not the Batch Invoice List prints after an invoice by using the Print batch invoice list check box on the Main tab of the Batch Billing form when you process invoices in Batch Billing.

Invoice Approval Report

This report provides an audit trail of comments and the current approval status of Billing invoices that go through an invoice approval process.

This report is available only if you use the Vision Invoice Approvals feature.

By selecting different filter and column options for this report, you can generate a variety of different reports, such as the following:

- Approval Comment History by Project report — You can create a report that contains all invoice approval comments from the invoice approval process. Use this as an audit trail of changes that were requested through the billing comments for projects.

- Submitted Invoice report — You can create a report that contains a list of submitted invoices, who submitted them, and when they were submitted. These invoices are ready to be approved.

- Submitted Invoices by Project Manager report — You can create a report that contains a list of submitted invoices by project manager or see the status of all invoices for a project manager. A biller might use this report to keep track of the status of invoices in the approval process.

- Approved Invoice report — You can create a report that contains a list of approved invoices and their invoice comments. These invoices are ready to be accepted.

- Rejected Invoice report — You can create a report that contains a list of rejected invoices with invoice comments. This can help you determine the next additional action required before you can approve the invoice.

Display the Invoice Approval Report

To locate this report, complete the following steps:

1. From the Vision Navigation menu, click Reporting » Billing.
2. In the Reports grid, select Invoice Approval.
3. Click to display the Options dialog box.

Invoice Approval General Tab

Use the General tab to select report options for the Invoice Approval report and to save sets of options for reuse.
## Invoice Approval Columns

Use the Columns tab to select or clear columns, change column sequence, provide new column labels, set column widths, or select number and date formats for the Invoice Approval report.

### Contents

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project</td>
<td>This column displays the project number from the invoice.</td>
</tr>
<tr>
<td>Project Name</td>
<td>This column displays the project name on the invoice.</td>
</tr>
<tr>
<td>Invoice</td>
<td>This column displays the invoice number. This is blank for invoices that have not been finalized.</td>
</tr>
<tr>
<td>Invoice Date</td>
<td>This column displays the invoice date.</td>
</tr>
<tr>
<td>Action</td>
<td>This column displays the current action (Submitted, Approved, or Rejected) that has been completed for an invoice.</td>
</tr>
<tr>
<td>Action Date</td>
<td>This column displays the date on which the current action occurred for an invoice.</td>
</tr>
<tr>
<td>Action By</td>
<td>This column displays the name of the person who completed the current action in the approval process for an invoice.</td>
</tr>
<tr>
<td>Column</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Approver</td>
<td>This column displays the name of the person who is responsible for approving the invoice. If more than one person is designated as an approver, all are listed. If an approver has specified a delegate on the User Options dialog box, the delegate's name is listed also.</td>
</tr>
<tr>
<td>Comment</td>
<td>This column displays the comments that are entered for an invoice in the Comment Entry text box on the Billing Comments dialog box when an invoice is submitted, approved, or rejected in Interactive Billing, Invoice Approvals, Interactive Approvals, or Batch Billing.</td>
</tr>
<tr>
<td>Billing Client Name</td>
<td>This column displays an invoice’s billing client that is entered on the Accounting tab of the Project Info Center.</td>
</tr>
<tr>
<td>Billing Client Number</td>
<td>This column displays the client number for the billing client that is entered on the Accounting tab of the Project Info Center.</td>
</tr>
<tr>
<td>Project Manager</td>
<td>This column displays the project manager that is entered on the General tab of the Project Info Center.</td>
</tr>
<tr>
<td>Principal-In-Charge</td>
<td>This column displays the principal-in-charge that is entered on the General tab of the Project Info Center.</td>
</tr>
<tr>
<td>Supervisor</td>
<td>This column displays the supervisor that is entered on the General tab of the Project Info Center.</td>
</tr>
<tr>
<td>Biller</td>
<td>This column displays the biller that is entered on the General tab of the Project Info Center.</td>
</tr>
</tbody>
</table>
Transaction Auto Numbering

Overview
The Transaction Auto Numbering feature allows you to set up auto numbering for your Vision transactions.

Configure Transaction Auto Numbering
The Transaction Auto Numbering tab of Accounting » System Settings allows you to set up auto numbering for your Vision transactions. When auto numbering is enabled, Vision automatically generates a reference number for each transaction. These reference numbers can be sequential as you add transactions to your database, and you can define the structure of these identification numbers to match your firm's business requirements.

Auto numbers can be set up by company and/or by bank. When autonumbers are in use and you create a new record, **[AUTONUMBER]** displays in the following field types for the record: **Reference** or **Check**.

Situations Where You Cannot Use Auto Numbering
You cannot set up auto numbering for A/P Vouchers when the **Require Entry of Voucher Numbers** option is selected in System A/P configuration for A/P Vouchers.

You should not set up auto numbering when transactions contain open transaction files for the transaction type and designated company/bank.

Auto Numbers Out of Sequence
The following situations will result in auto numbers displaying out of sequence:

- A posting failed for a transaction, or a user unposts a transaction file.
- Transactions are posted for different periods at the same time. You must update the next reference number prior to and after posting data in a prior period.
- A payment run is deleted after Process Checks has occurred.
- Process Checks is run, but not posted. Another payment using the same bank code is processed and posted, which will cause the first process to be out of sequence.

Bank Transaction Auto Numbering Grid

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>

**Grid Toolbar Options**

- The Vision grids contain a drop-down list that displays a combination of the following options:
  - Print grid information
  - Export grid data to Excel
  - Enable Grouping
- Not all options are available on all grids. [http://hq1apprd44vs/Vision70/Help/en-]
## Insert
To enter a new bank transaction, click [ ] to add a blank row to the grid. Enter bank transaction information in the blank row. The blank row is inserted below the row that is selected when you click [ ]. The selected row has [ ] at the beginning of the row. [http://hq1apprd44vs/Vision70/Help/en-us/cf_accounting_system_labor_categories_tab.htm - Top](http://hq1apprd44vs/Vision70/Help/en-us/cf_accounting_system_labor_categories_tab.htm - Top)

## Delete
To delete a bank transaction in the grid, click anywhere in the transaction’s row to select it, and click [ ]. [http://hq1apprd44vs/Vision70/Help/en-us/cf_accounting_system_labor_categories_tab.htm - Top](http://hq1apprd44vs/Vision70/Help/en-us/cf_accounting_system_labor_categories_tab.htm - Top)

### Grid Columns

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Company</td>
<td>This field displays if using Vision Multicompany. Use the drop-down list to select a company.</td>
</tr>
<tr>
<td>Bank Code</td>
<td>Use the drop-down list to select a bank code for the transaction. If you select to use autonumbering with receipts and/or payments for this bank code, the reference number will be automatically applied whenever this bank code is selected.</td>
</tr>
<tr>
<td>Receipts</td>
<td>Select this option to use auto numbering with Cash Receipts and Employee Repayments. When the transaction is posted, Vision applies the <strong>Next Receipt Reference Number</strong>. When this option is not selected, you must manually enter a reference number.</td>
</tr>
<tr>
<td>Next Receipt Reference Number</td>
<td>Enter the reference number for the receipt. This is the basis for the auto numbering feature. Vision will automatically update the reference with the next sequential number for each additional receipt.</td>
</tr>
<tr>
<td>Payments</td>
<td>Select this option to use auto numbering with the following payment transactions: AP Disbursements, Cash Disbursements, AP Payment Processing, Employee Payment Processing, and Payroll Payment Processing. When the disbursement transactions are posted, Vision applies the <strong>Next Payments Reference Number</strong>. When the <strong>Process Checks</strong> button is selected for the payment processing transactions, the reference number is applied.</td>
</tr>
<tr>
<td>Next Payments Reference Number</td>
<td>Enter the reference number (same as the check number) for the payment. This is the basis for the auto numbering feature. Vision will automatically update the reference with the next sequential number for each additional payment. You can update this field at any time.</td>
</tr>
</tbody>
</table>

### Last System Generated Voucher Reference Number for Companies Not Listed Below:
This option displays the last system generated number. Use this as a reference when entering your next reference number to avoid entering duplicates.
Transaction Auto Numbering

## Transaction Entry Auto Numbering Grid

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Grid Toolbar Options</strong></td>
<td></td>
</tr>
</tbody>
</table>

- **Transaction Entry Auto Numbering Drop-down**: The Vision grids contain a drop-down list that displays a combination of the following options:
  - Print grid information
  - Export grid data to Excel
  - Enable Grouping
  
  Not all options are available on all grids. [http://hq1apprd44vs/Vision70/Help/en-us/cf_accounting_system_labor_categories_tab.htm](http://hq1apprd44vs/Vision70/Help/en-us/cf_accounting_system_labor_categories_tab.htm)

- **Insert**: To enter a new transaction, click to add a blank row to the **Transaction Entry** grid. Enter transaction information in the blank row.

  The blank row is inserted below the row that is selected when you click . The selected row has at the beginning of the row. [http://hq1apprd44vs/Vision70/Help/en-us/cf_accounting_system_labor_categories_tab.htm](http://hq1apprd44vs/Vision70/Help/en-us/cf_accounting_system_labor_categories_tab.htm)

- **Delete**: To delete a transaction in the grid, click anywhere in the transaction's row to select it, and click .


<table>
<thead>
<tr>
<th>Grid Columns</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Company</strong></td>
<td>This field displays if using Vision Multicompany. Use the drop-down list to select a company.</td>
</tr>
<tr>
<td><strong>Transaction Type</strong></td>
<td>Use the drop-down list to select the transaction type: Journal Entries or AP Vouchers. AP Vouchers is only available if the <strong>Require Entry of Voucher Numbers</strong> option is not selected in Configuration &gt;&gt; Accounting &gt;&gt; System AP. The Voucher Number and the Reference Number are the same.</td>
</tr>
<tr>
<td><strong>Next Reference Number</strong></td>
<td>Enter the reference number for the transaction. This is the basis for the auto numbering feature. Vision will automatically update the field with the next sequential number. You can update this field at any time.</td>
</tr>
</tbody>
</table>

## Processing

### Assign Check Numbers for Remaining Checks

Use this procedure to assign check numbers. If you saved a posting run when you are part way through processing it, you can select the posting run and start at step 3 of this procedure.
To assign check numbers sequentially, complete the following steps:

1. After you open or create a posting run, and select one or more vouchers on the Vendor Review tab of the A/P Payment Processing form, click **Process Checks** on the A/P Payment Processing toolbar.

   Vision displays this notice:

   **Warning:** check processing makes permanent changes to your Vision database. Be sure you have reviewed your vouchers, settings, and cash requirements carefully before proceeding.

   **Are you sure you want to proceed?**

2. Click **Yes** to continue. The Check Printing and Numbering form displays.

3. Click **Assign Numbers**. The Assign Check Numbers dialog displays.

   If the auto numbering feature is enabled, the **Assign Numbers** option is disabled because Vision automatically assigns the check numbers. The check numbers are automatically assigned when you click the **Process Checks** button. See the Transaction Auto Numbering Tab of **Configuration > Accounting > System Settings** for more information.

4. In the **Check Number** field, enter the starting check number. Deltek recommends not re-using check numbers in the same check processing run. This can cause unexpected results in Reporting, Bank Statement Reconciliation, and Void Check Processing.

   If the auto numbering feature is enabled, the automatically assigned check numbers display.

5. In the Assign to field, select Remaining Checks.

6. In the Assignment Order field, select Ascending or Descending.

7. Click **Assign**. Vision displays a notice that describes the check numbering procedure and asks you to confirm.

8. Click **Yes** to continue.

Deltek recommends that you print a file copy of the check before you continue to the step of posting payments.

**Check Printing and Numbering Form**

Use this form to:

- Preview checks
- Display the dialog boxes to use for printing checks and assigning check numbers
- Generate a Remittance Advice report
- Print a file copy of the check faces and stubs

**To preview and print checks, complete the following steps:**

1. After you open or create a posting run, and select one or more vouchers on the Vendor Review tab of the A/P Payment Processing form, click **Process Checks** on the A/P Payment Processing toolbar.

   Vision displays this notice:
Warning: check processing makes permanent changes to your Vision database. Be sure you have reviewed your vouchers, settings, and cash requirements carefully before proceeding.

Are you sure you want to proceed?

2. Click Yes to continue. Vision displays the Check Printing and Numbering form.

<table>
<thead>
<tr>
<th>Field/Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Top Pane:</strong></td>
<td></td>
</tr>
<tr>
<td>Bank</td>
<td>Enter the bank code to use for this check run.</td>
</tr>
<tr>
<td><strong>Multicurrency</strong></td>
<td>If you use the Multicurrency feature, the bank code also controls the check's currency. The check Amount is expressed in this currency. <a href="http://hq1apprd44vs/Vision70/Help/en-us/ap_Check_Printing_and_Numbering_Form.htm">http://hq1apprd44vs/Vision70/Help/en-us/ap_Check_Printing_and_Numbering_Form.htm</a></td>
</tr>
<tr>
<td>Description</td>
<td>This field displays the description for the bank code. <a href="http://hq1apprd44vs/Vision70/Help/en-us/ap_Check_Printing_and_Numbering_Form.htm">http://hq1apprd44vs/Vision70/Help/en-us/ap_Check_Printing_and_Numbering_Form.htm</a></td>
</tr>
<tr>
<td>Printed</td>
<td>This flag displays whether the check has been printed. <a href="http://hq1apprd44vs/Vision70/Help/en-us/ap_Check_Printing_and_Numbering_Form.htm">http://hq1apprd44vs/Vision70/Help/en-us/ap_Check_Printing_and_Numbering_Form.htm</a></td>
</tr>
<tr>
<td>Assigned</td>
<td>This flag displays whether a number is given to the check. <a href="http://hq1apprd44vs/Vision70/Help/en-us/ap_Check_Printing_and_Numbering_Form.htm">http://hq1apprd44vs/Vision70/Help/en-us/ap_Check_Printing_and_Numbering_Form.htm</a></td>
</tr>
<tr>
<td><strong>Grid Columns:</strong></td>
<td></td>
</tr>
<tr>
<td>Bank</td>
<td>Click this option to display the bank code. <a href="http://hq1apprd44vs/Vision70/Help/en-us/ap_Check_Printing_and_Numbering_Form.htm">http://hq1apprd44vs/Vision70/Help/en-us/ap_Check_Printing_and_Numbering_Form.htm</a></td>
</tr>
<tr>
<td>Payee</td>
<td>This field identifies the check payee. This data is from either Address 1 or Name in the vendor record, as specified in Check Payee in either Configuration » Accounting » System AP » Accounts Payable Tab, or Configuration » Accounting » Company AP » Accounts Payable Tab. <a href="http://hq1apprd44vs/Vision70/Help/en-us/ap_Check_Printing_and_Numbering_Form.htm">http://hq1apprd44vs/Vision70/Help/en-us/ap_Check_Printing_and_Numbering_Form.htm</a></td>
</tr>
<tr>
<td>Amount</td>
<td>This field displays the amount of the check. <strong>Multicurrency</strong> If you use the Multicurrency feature, the amount is expressed in the bank's currency. <a href="http://hq1apprd44vs/Vision70/Help/en-us/ap_Check_Printing_and_Numbering_Form.htm">http://hq1apprd44vs/Vision70/Help/en-us/ap_Check_Printing_and_Numbering_Form.htm</a></td>
</tr>
<tr>
<td>Sequence</td>
<td>This field displays the sequence number for the payment processing run. <a href="http://hq1apprd44vs/Vision70/Help/en-us/ap_Check_Printing_and_Numbering_Form.htm">http://hq1apprd44vs/Vision70/Help/en-us/ap_Check_Printing_and_Numbering_Form.htm</a></td>
</tr>
</tbody>
</table>
### Bank Reconciliation Main Tab

The Bank Reconciliation Main tab displays the following information:

- Selected bank and corresponding bank code.
- Fiscal period in which the bank statement was created.
- Selected statement date for the corresponding bank and bank code.
- Statement number.
- Opening and closing balances.

### Create a New Statement Date

Prior to reconciling your bank statements, you must select the bank code and statement date to reconcile. You would create a new statement date if no statement dates exist for the bank, or if you just want to create a new statement date for this bank.

To create a new statement date, complete the following steps:

1. Click Accounting » Bank Reconciliation.
2. In the **Bank** field on the Bank Statement Selection dialog box, click the drop-down arrow. Vision displays the banks established in your system.

3. Select the bank to reconcile.

4. In the **Existing/New Statement** field, click the drop-down arrow and select **New**.

5. In the New Statement Date field, click the calendar icon and select the statement date. You cannot create a statement with the same bank and date combination. If you do so, Vision displays a warning message: "**Statement Date xx/yy already exists for Period xx/yyyy. Do you want to select the existing Statement Date?**"

6. Enter the **Statement Number**, using a maximum of twelve alpha-numeric characters.

7. Enter the **Opening Balance** and **Closing Balance**.

8. Click **Select**. Vision opens the Bank Reconciliation form for the specified statement date.

---

**Generate the Bank Statement Reconciliation Report**

The Bank Statement Reconciliation report lists all cleared and uncleared deposits and checks, their statement dates, the transaction type for each deposit and check, the statement number, and all miscellaneous amounts entered on the Miscellaneous tab. This report also lists the account summary as shown on the Bank Statement Reconciliation screen.

The report should tie out in one of the following two ways:

- Closing Balance = closing balance on the bank’s statement.

**Multicurrency**

If your firm uses the Multicurrency feature, all amounts in bank reconciliation are displayed in the currency of the account associated with the bank code.

**To generate the Bank Statement Reconciliation report, complete the following steps:**

1. Click **Accounting » Bank Reconciliation**.

2. In the **Bank** field on the Bank Statement Selection dialog box, click the drop-down arrow. Vision displays the banks established in your system.

3. Select the bank to reconcile.

4. In the **Existing/New Statement** field, click the drop-down arrow and select **Existing**.

5. In the **Existing Statement Date** field, click the drop-down arrow. Vision displays the statement dates that were previously created for this bank.

6. Select the statement date.

7. Click **Select**. Vision opens the Bank Statement Reconciliation form for the specified statement date.

8. Click the **Print** button to generate the Bank Statement Reconciliation Report.
A/P Disbursement Fields

To display the A/P Disbursements form in Transaction Entry, complete the following steps:

1. Select Transaction Center » Transaction Entry to display the Transaction Entry form.
2. From the drop-down list for the Transaction Type field, select A/P Disbursements.
3. Select a file and click Open.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check Number</td>
<td>Enter the check number. If the selected bank has autonumbering configured,</td>
</tr>
<tr>
<td></td>
<td>a number in this field is not entered. Instead, AUTONUMBER automatically</td>
</tr>
<tr>
<td></td>
<td>displays in this field when you save the form. The number is based on the</td>
</tr>
<tr>
<td></td>
<td>Reference Number that is entered on the Bank Transaction Auto Numbering Grid.</td>
</tr>
<tr>
<td>Bank</td>
<td>From the drop-down list, select the bank code for this disbursement file.</td>
</tr>
<tr>
<td></td>
<td>If the selected bank has autonumbering configured, AUTONUMBER displays in</td>
</tr>
<tr>
<td></td>
<td>the Check Number field when you save the form.</td>
</tr>
<tr>
<td>Date</td>
<td>Enter the date for this transaction or click the calendar icon to display</td>
</tr>
<tr>
<td></td>
<td>the calendar lookup and then select the appropriate date.</td>
</tr>
<tr>
<td>Voucher</td>
<td>This field displays only when Require entry of voucher numbers is selected</td>
</tr>
<tr>
<td></td>
<td>in Configuration/Accounting/System AP. When this field displays, you must</td>
</tr>
<tr>
<td></td>
<td>enter the voucher number for this transaction. This is displayed in Vendor</td>
</tr>
<tr>
<td></td>
<td>Review.</td>
</tr>
<tr>
<td>Vendor</td>
<td>Perform one of the following actions to enter the vendor number:</td>
</tr>
<tr>
<td></td>
<td>• In the Search field, enter all or part of the vendor number. Vision</td>
</tr>
<tr>
<td></td>
<td>searches for matching records in your database. If only one possible match</td>
</tr>
<tr>
<td></td>
<td>is found, Vision enters the record. If more than one possible match is found,</td>
</tr>
<tr>
<td></td>
<td>Vision displays a list. Select the correct vendor from the list.</td>
</tr>
<tr>
<td>Address</td>
<td>If a vendor has more than one address established in the Vendor Info Center,</td>
</tr>
<tr>
<td></td>
<td>use the drop-down list to select the code for the appropriate address.</td>
</tr>
<tr>
<td>Invoice Date</td>
<td>Enter the date from the vendor’s invoice. Click the calendar icon to use the</td>
</tr>
<tr>
<td></td>
<td>calendar lookup and select the appropriate date. Vision uses this date to</td>
</tr>
<tr>
<td></td>
<td>calculate the payment date if the vendor’s payment terms specify</td>
</tr>
</tbody>
</table>
that the vendor should be paid a specific number of days after the invoice date.

For example, if most of your vendors have payment terms of Next, you would enter Next as your default payment terms. Then, when you add vendors in the Vendor Info Center, the Payment Terms field displays Next. http://hq1apprd44vs/Vision70/Help/en-us/tc_A_P_Disb_Fields.htm

### Invoice Number

Enter the invoice number. This number prints on your check to the vendor so that the vendor can identify the invoice being paid. Usually, this number is a number or code that is shown on the invoice. http://hq1apprd44vs/Vision70/Help/en-us/tc_A_P_Disb_Fields.htm

### Status

This field displays the current status of the transaction file. http://hq1apprd44vs/Vision70/Help/en-us/tc_A_P_Disb_Fields.htm

### Approved By

If the transaction file has been Approved, then this field displays the approver. http://hq1apprd44vs/Vision70/Help/en-us/tc_A_P_Disb_Fields.htm

## Cash Disbursement Fields

To display the Cash Disbursements form in Transaction Entry, complete the following steps:

1. Select Transaction Center » Transaction Entry to display the Transaction Entry form.
2. From the drop-down list for the Transaction Type field, select Cash Disbursement.
3. Select a file and click Open.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check Number</td>
<td>Enter the check number for this cash disbursement. If you enter fewer than 7 characters, Vision adds leading zeros. If the selected bank has autonumbering configured, you cannot enter a number in this field. Instead, [AUTONUMBER] automatically displays in this field when you save the form. The number is based on the Reference Number that is entered on the Bank Transaction Auto Numbering Grid. <a href="http://hq1apprd44vs/Vision70/Help/en-us/tc_Cash_Disb_Fields.htm">http://hq1apprd44vs/Vision70/Help/en-us/tc_Cash_Disb_Fields.htm</a> - Cash_Disbursement_Fields</td>
</tr>
<tr>
<td>Bank</td>
<td>Select the bank code to associate with this transaction. The bank code directs the implicit posting for the transaction entry file. If the selected bank has autonumbering configured, [AUTONUMBER] automatically displays in the Check Number field when you save the form. <a href="http://hq1apprd44vs/Vision70/Help/en-us/tc_Cash_Disb_Fields.htm">http://hq1apprd44vs/Vision70/Help/en-us/tc_Cash_Disb_Fields.htm</a> - Cash_Disbursement_Fields</td>
</tr>
<tr>
<td>Date</td>
<td>Enter the date for this transaction or click the calendar icon to display the calendar lookup and then select the appropriate date. <a href="http://hq1apprd44vs/Vision70/Help/en-us/tc_Cash_Disb_Fields.htm">http://hq1apprd44vs/Vision70/Help/en-us/tc_Cash_Disb_Fields.htm</a> - Cash_Disbursement_Fields</td>
</tr>
<tr>
<td>Payee</td>
<td>If you want a specific name to display on the check, enter that name in this field. <a href="http://hq1apprd44vs/Vision70/Help/en-us/tc_Cash_Disb_Fields.htm">http://hq1apprd44vs/Vision70/Help/en-us/tc_Cash_Disb_Fields.htm</a> - Cash_Disbursement_Fields</td>
</tr>
<tr>
<td>Status</td>
<td>This field displays the current status of the transaction</td>
</tr>
</tbody>
</table>
Approved By
If the transaction file has been approved, then this field displays the approver.

Field Description
Reference
Enter a number by which to reference this journal entry transaction. If you enter fewer than 7 characters, Vision adds leading zeros.

If the selected company has autonumbering configured, you cannot enter a number in this field. Instead, [AUTONUMBER] automatically displays in this field when you save the form. The number is based on the Reference Number that is entered on the Transaction Auto Numbering Grid.

Date
Enter the date for this journal entry or click the calendar icon to display the calendar lookup and then select the appropriate date.

- For labor adjustment and timesheet transactions, enter a date for each detail line.
- For expense transactions, enter a date for the entire record.

Description
Enter a text description. For journal entries there are two descriptions:

- This Description field. This required field is located on the top portion of the journal entry file. It applies to the whole record.
- The Description field listed at the beginning of each detail line is an optional field, and applies only to that line item.

Type
Select the type of journal entry.

Update project billing amount when adjust revenue
Select this field if you want Vision to include the amount of this journal entry when it calculates job-to-date billings for the referenced project. You must check this field if you use a billing-based revenue method for the project and you are making an entry to a revenue account.

If you use the labor cross-charge feature of Organization, then Vision selects this field automatically when it creates journal entries to transfer.
7.1 Online Help Updates

Transaction Auto Numbering

### A/P Voucher Fields

To display the A/P Voucher Entry form in Transaction Entry, complete the following steps:

1. Select **Transaction Center** » **Transaction Entry** to display the Transaction Entry form.
2. From the drop-down list for the **Transaction Type** field, select **A/P Vouchers**.
3. Select a file and click **Open**.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Vendor</strong></td>
<td>Enter the vendor number or click ![Vendor lookup](<a href="http://hq1apprd44vs/Vision70/Help/en-us/tc_Voucher_Fields.htm">http://hq1apprd44vs/Vision70/Help/en-us/tc_Voucher_Fields.htm</a> - Voucher_Fields) and use the Vendor lookup to select a vendor number.</td>
</tr>
<tr>
<td><strong>Invoice Date</strong></td>
<td>Enter the date for the invoice or click the calendar icon to display the calendar lookup and then select the appropriate date. For example, if most of your vendors will have payment terms of Next, you would enter Next as your default payment terms on the Accounts Payable tab of Configuration » Accounting » Company AP Configuration. Then, when you add vendors, the Payment Terms field on the Accounting tab of Vendor Info Center will, by default, display Next. This payment term setting will then fill in the Invoice Date field automatically, or instead, you can you can override the default value: ![Invoice Date](<a href="http://hq1apprd44vs/Vision70/Help/en-us/tc_Voucher_Fields.htm">http://hq1apprd44vs/Vision70/Help/en-us/tc_Voucher_Fields.htm</a> - Voucher_Fields)</td>
</tr>
<tr>
<td><strong>Invoice Number</strong></td>
<td>Enter a unique number for the invoice ![Invoice Number](<a href="http://hq1apprd44vs/Vision70/Help/en-us/tc_Voucher_Fields.htm">http://hq1apprd44vs/Vision70/Help/en-us/tc_Voucher_Fields.htm</a> - Voucher_Fields)</td>
</tr>
<tr>
<td><strong>Voucher Date</strong></td>
<td>Enter the date for the voucher or click the calendar icon to display the calendar lookup and then select the appropriate date. This is the date on which a vendor’s invoice becomes a voucher in Vision. It is used when filtering reports by date or processing billings by date. In Billing, for example, when you enter a <strong>Bill Thru</strong> date under <strong>Transaction Detail</strong> in the Billing Session Options dialog box, Vision refers to <strong>Voucher Date</strong>; or, when you select dates from <strong>Time Frame</strong> for project or vendor reports, Vision also refers to the date of the invoice.</td>
</tr>
</tbody>
</table>
### Voucher
Enter the voucher number. This field displays when you manually assign a voucher number. AP Vouchers is only available if the Require Entry of Voucher Numbers option is not selected in Configuration >> Accounting >> System AP.

The Voucher Number and the Reference Number are the same.

#### Multicompany
If you are using the Multicompany feature, voucher numbers must be unique across the enterprise. If you decide to enter voucher numbers manually, rather than having Vision generate them automatically, you must specify a valid range of voucher numbers for each company on the Accounts Payable Tab of Company AP Configuration.

### Payment Date
Use these fields to specify the payment terms and the corresponding date.

From the drop-down list for the first field, select one of the following payment terms:

- **Next** — Payment for any outstanding vouchers will be processed with the next check processing run.
- **Hold** — Payment for any outstanding vouchers is on hold until you manually modify the payment terms.
- **PWP (Pay When Paid)** — Payment for any outstanding vouchers will be processed with the check processing run immediately following your company’s full receipt of payment (from the client) for the jobs associated with the vouchers.
- **Date** — Enter a date in the corresponding field.

If you select Date, use the second field to enter the date or click the calendar icon to display the calendar lookup and then select the appropriate date.

### A/P Liability
Select the type of AP Liability account (such as trade, consultant or employee).

### Bank
Enter the bank code that will be used for this voucher file. To receive a list of the bank codes entered in your database, click the drop-down arrow in this field.

#### Multicurrency
If you are using the Multicurrency feature, the account specified via the bank code determines the payment currency for the transaction. (You specify the account's currency when you set up the account in the Chart of Accounts Info Center.)

### Address
Select the vendor's address.

If there is a Primary address designated for the vendor, the Address field automatically defaults to the Primary address. If there is no Primary address designated, but there are addresses entered for the vendor, then Vision automatically defaults to the first address entered.

---

**voucher:** [http://hq1apprd44vs/Vision70/Help/en-us/tc_Voucher_Fields.htm - Voucher_Fields](http://hq1apprd44vs/Vision70/Help/en-us/tc_Voucher_Fields.htm - Voucher_Fields)

**Payment Date**

**A/P Liability**

**Bank**

**Address**
Transaction Auto Numbering

## Status
This field displays the current status of the transaction.

http://hq1apprd44vs/Vision70/Help/en-us/tc_Voucher_Fields.htm - Voucher_Fields

## Approved By
If the transaction file has been Approved, then this field displays the approver.

http://hq1apprd44vs/Vision70/Help/en-us/tc_Voucher_Fields.htm - Voucher_Fields

---

### Cash Receipt Fields

To display the Cash Receipt form in Transaction Entry, complete the following steps:

1. Select **Transaction Center » Transaction Entry** to display the Transaction Entry form.
2. From the drop-down list for the **Transaction Type** field, select **Cash Receipt**.
3. Select a file and click **Open**.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reference</td>
<td>Enter a number by which to reference this transaction. If you enter fewer than 7 characters, Vision adds leading zeros. Deltek recommends that you use today’s date as the reference number for your cash receipts. This will sort the receipts by date in the bank statement reconciliation. If multiple references exist within a single deposit, use a notation on the end of the date. For example: reference numbers 062806A, 062806B would be deposits A and B for 6/28/06. If the selected bank has autonumbering configured, you cannot enter a number in this field. Instead, <strong>[AUTONUMBER]</strong> automatically displays in this field when you save the form. The number is based on the Reference Number that is entered on the Bank Transaction Auto Numbering Grid.</td>
</tr>
<tr>
<td>Bank</td>
<td>Select the bank code to associate with this transaction. The bank code directs the implicit posting for the transaction entry file. If the selected bank has autonumbering configured, <strong>[AUTONUMBER]</strong> automatically displays in the Reference field when you save the form.</td>
</tr>
<tr>
<td>Date</td>
<td>Enter the date for this transaction or click the calendar icon to display the calendar lookup and then select the appropriate date.</td>
</tr>
<tr>
<td>Comment</td>
<td>Enter a comment for the cash receipt/employee repayment. If you do not complete this field, Vision automatically defaults to &quot;Deposit&quot; (as long as a Reference number is entered).</td>
</tr>
<tr>
<td>Status</td>
<td>This field displays the current status of the transaction.</td>
</tr>
</tbody>
</table>
Employee Repayment Fields

The fields at the top of the form apply to the entire transaction record.

To display the Employee Repayments form in Transaction Entry complete the following steps:

1. Select **Transaction Center, Transaction Entry** to display the Transaction Entry form.
2. From the drop-down list for the **Transaction Type** field, select **Employee Repayments**.
3. Select a file and click **Open**.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reference</td>
<td>Enter a number by which to reference this transaction.</td>
</tr>
<tr>
<td></td>
<td>Note: When Auto Numbering is enabled, the Reference Number for the Employee</td>
</tr>
<tr>
<td></td>
<td>Repayment will be the next receipt reference number if the selected bank for</td>
</tr>
<tr>
<td></td>
<td>the employee repayment is configured for autonumbering. This occurs because</td>
</tr>
<tr>
<td></td>
<td>the number for the selected bank will be applied instead of the reference</td>
</tr>
<tr>
<td></td>
<td>number. Vision displays a message indicating that the selected row is using</td>
</tr>
<tr>
<td></td>
<td>an autonumber bank.</td>
</tr>
<tr>
<td>Date</td>
<td>Select the date for this transaction. For employee repayment and timesheet</td>
</tr>
<tr>
<td></td>
<td>transactions, enter a date for each detail line. For expense transactions,</td>
</tr>
<tr>
<td></td>
<td>enter a date for the entire file. Enter the date or click the calendar icon</td>
</tr>
<tr>
<td></td>
<td>to display the calendar lookup and then select the appropriate date.</td>
</tr>
<tr>
<td>Comment</td>
<td>For employee repayments and timesheets, this is an optional field. You can</td>
</tr>
<tr>
<td></td>
<td>enter a comment for the employee repayment/timesheet.</td>
</tr>
<tr>
<td></td>
<td>For cash receipts and employee repayments, this is a required field. You can</td>
</tr>
<tr>
<td></td>
<td>enter a comment for the cash receipt/employee repayment.</td>
</tr>
<tr>
<td>Status</td>
<td>This field displays the current status of the transaction file.</td>
</tr>
<tr>
<td>Approved By</td>
<td>If the transaction file has been Approved, then this field displays the</td>
</tr>
<tr>
<td></td>
<td>approver.</td>
</tr>
</tbody>
</table>

http://hq1apprd44vs/Vision70/Help/en-us/tc_cash_receipt_fields.htm - Cash Receipt Fields

http://hq1apprd44vs/Vision70/Help/en-us/tc_employee_repay_Fields.htm - Employee Repayment Fields
Transaction Document Management

Overview
The Transaction Document Management (TDM) feature allows you to upload documents in support of Accounts Payable Vouchers and Employee Expense Report transactions.

Utilities - Files Administration
The Files Administration utility allows you to search for and view the supporting documents that were uploaded for Vision transactions, and confirm that the files between the Vision and FILESTREAM databases are synchronized. It also includes filters that allow you to insert various criteria to refine your search for supporting documents. Refer to the Vision Advanced Technical Administration Guide for additional Files Administration information.

This utility also works with Adobe InDesign templates that were uploaded for use with the Vision Merge Templates feature.

To view the documents that have been uploaded using the Files Administration utility, complete the following steps:

1. From the Utilities menu, select Files Administration. The Files Administration dialog box displays.
2. Use the Date Range fields to select the start and end dates to define the date range to search. Vision defaults to use the past three days.
3. Click Refresh Files List to populate the Files grid. Records that match the start and end date criteria display.
4. To further refine your results set, complete one or more of the following:
   - Enter specific text that you want to find. Vision searches the File Name and Description fields to locate the matching text.
   - Open the lookup and select a User ID.
   - Use the drop-down list to select a Vision Application. This drop-down list displays the applications that allow supporting documents.
5. Click Refresh Files List to activate the search. The Files grid updates to list all documents that match the specified criteria.
6. Click the File Name hyperlink to open the associated PDF.

If you receive an error message that the file is missing, the Vision and TDM databases are not in sync.

Data Synchronization Issue
The Databases Out of Sync dialog box displays when the files in the Vision and FILESTREAM databases are not synchronized. This file mismatch can occur when there is a database backup or restore on one database, but not the other. In this situation, the File Name hyperlink cannot open the selected file. Click OK to return to the Files Administration utility.

Contact your system administrator for details.
General Tab of Weblink Utility

Use the General tab of Weblink utility to specify the database connection information, such as the server name, user name, and password. You can also disable the process server or the server-to-server synchronization server on a given database from this tab.

Location

To display the General tab of the Weblink utility, complete the following step:

1. Access the Vision Web/Application server using the Weblink utility URL (http://[Vision Web/Application Server Name]/[name of virtual directory for Vision]/weblink.htm).

Contents

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Current Database</strong></td>
<td>Select the database that you want to configure. Use the menu to add or remove databases from this list.</td>
</tr>
<tr>
<td>▪ New — Click <strong>New</strong> to add a database to the list of databases available for configuration.</td>
<td></td>
</tr>
<tr>
<td>▪ New &gt;&gt; Copy Current — Select a database from the list and click <strong>Copy Current</strong> to copy all information except the name of the database into a new record. After copying an existing database record, enter a new database name, and edit other configuration information as needed. Click <strong>Save</strong> when done.</td>
<td></td>
</tr>
<tr>
<td>▪ Delete — Select a database and click <strong>Delete</strong> to delete the database information from the Weblink utility.</td>
<td></td>
</tr>
<tr>
<td>SQL Server</td>
<td>Enter the name of the database server, as entered in Microsoft SQL Server.</td>
</tr>
<tr>
<td>Database Name</td>
<td>Enter the name of the Vision database to which you are connecting.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter the description for the preceding database, as it will appear from the Vision logon form.</td>
</tr>
<tr>
<td>Windows Authentication</td>
<td>Specify a Windows User account to use to connect to your SQL Server database. This user account must have been created as a valid user account in SQL Server and must have the appropriate rights to the Vision database. This account also needs to be configured as the Identity of the IIS Application Pool. The default Application Pool is DeltekVisionAppPool and the default identity is a local administrator account, ‘\DeltekVision’ which is created by the Vision installation.</td>
</tr>
<tr>
<td>▪ If this box is selected, then the <strong>SQL Username</strong> and <strong>SQL Password</strong> fields are disabled. (The Windows username and password will be used instead.)</td>
<td></td>
</tr>
<tr>
<td>▪ If this box is not selected, then you must specify a database username and password to use.</td>
<td></td>
</tr>
<tr>
<td>SQL Username</td>
<td>Enter the username of the Microsoft SQL Server administrative who will manage this database. By default, this is DeltekVision, but it can be any SQL username that you want to specify. Deltek does not recommend using the sa account.</td>
</tr>
<tr>
<td>SQL Password</td>
<td>Enter the corresponding password for this user account.</td>
</tr>
<tr>
<td><strong>Disable Process Server</strong></td>
<td>Select this option if you do not want to use this database for scheduled jobs. If selected, this database is not polled for jobs. If you change this option (select or clear it), you must restart your process servers for the change to take effect.</td>
</tr>
<tr>
<td>---------------------------</td>
<td>--------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Disable Server to Server Synchronization</strong></td>
<td>Select this option if you do not want to use the current database for server to server synchronization. Otherwise, remove the selection for this option.</td>
</tr>
<tr>
<td><strong>Virtual Dir (optional)</strong></td>
<td>Enter a specific virtual directory (for example, VisionTest) for this database to appear as an available database only for the specified virtual directory. If you leave this field blank, the database will be accessible by all virtual directories on a given Web server.</td>
</tr>
<tr>
<td><strong>SaaS / Hosted Instance</strong></td>
<td>If you are setting up a hosted instance of Vision, select this check box. Otherwise, leave this check box unselected. This option enables Deltek or other vendors who offer hosted instances of Vision to hide or disable system-level functionality that is not appropriate in a &quot;software as a service&quot; environment. If you select this check box, the following are no longer available to users of the hosted instance of Vision:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Location of Reports on Application Server</strong> field on the Load Reports tab of the Report Server form (<strong>Utilities » Report Administration</strong>)</td>
</tr>
<tr>
<td></td>
<td>• Report Printers tab of the Report Server form (<strong>Utilities » Report Administration</strong>)</td>
</tr>
<tr>
<td></td>
<td>• Process Server Management form (<strong>Utilities » Process Server » Server Management</strong>)</td>
</tr>
<tr>
<td></td>
<td>• Backup Database utility (<strong>Utilities » Backup Database</strong>)</td>
</tr>
<tr>
<td></td>
<td>• <strong>Email Server, Port, Username, Password, and Application URL</strong> fields on the Email tab of the General System Settings form (<strong>Configuration » General » System Settings</strong>)</td>
</tr>
<tr>
<td></td>
<td>• Servers tab of the General System Settings form (<strong>Configuration » General » System Settings</strong>)</td>
</tr>
<tr>
<td></td>
<td>• <strong>Report Printers</strong> option on the <strong>Functional Areas</strong> drop-down list on the Access Rights tab of the Roles form (<strong>Configuration » Security » Roles</strong>)</td>
</tr>
<tr>
<td></td>
<td>• <strong>Integrated Enabled, Domain, and Report Printer</strong> on the Users tab of the Users and Passwords form (<strong>Configuration » Security » Users and Passwords</strong>)</td>
</tr>
<tr>
<td></td>
<td>• Option to select a printer in <strong>Default Printer</strong> on the Reporting tab of the User Options dialog box (<strong>Options</strong> on the Vision main toolbar)</td>
</tr>
<tr>
<td><strong>Save</strong></td>
<td>Select this option to save your changes.</td>
</tr>
<tr>
<td><strong>New</strong></td>
<td>Select this option to create a new database entry.</td>
</tr>
<tr>
<td><strong>Delete</strong></td>
<td>Select this option to delete the current database entry.</td>
</tr>
<tr>
<td><strong>Test</strong></td>
<td>Click <strong>Test</strong> to test the connection for the session state storage database. If the database specified in the <strong>Database Setup</strong> fields does not contain the necessary tables to store the session state, when you test the database...</td>
</tr>
</tbody>
</table>
connection, the Weblink utility asks you if it should create the necessary tables. Click Yes at this prompt to create the tables and configure the specified database for session state storage.

<table>
<thead>
<tr>
<th>Change Password</th>
<th>Select this option to change your Weblink password.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete Old Databases</td>
<td>This option is typically used for internal Deltek purposes. Click this button to remove all databases whose version is different from the database version used with Deltek Vision (for example, if you are running multiple databases at one site, perhaps in a test scenario). Weblink also removes all databases to which a connection cannot be made. If there are any pending Weblink changes, a message displays asking if these changes should be saved before removing the old database. After the old and unreachable databases are removed, Weblink is refreshed with the new data.</td>
</tr>
</tbody>
</table>
| Enable Transactional Document Management | Select this option to enable the Transactional Document Management (TDM) feature in Vision. TDM provides support for uploading and attaching documents to various types of transactions and proposals. When you select this option, the following occurs:  
  - The default FileStream SQL Server and FileStream Database Name display.  
  - If you test the database connection, the necessary TDM tables are reviewed. If these tables are not configured correctly, the Weblink utility asks you if it should create the necessary tables. Click Yes at the prompt to automatically create the tables. You can test again to confirm a successful connection.  
  Additional FileStream configuration information is available in the Deltek Vision Advanced Technical Administration Guide. |
| FileStream SQL Server | This field is enabled when the Enable Transactional Document Management option is selected. If the FileStream SQL Server is located on the same SQL Server as the Vision database, the Vision name automatically defaults into this field. If the FileStream SQL Server is not located on the same server as the Vision database, you can enter the name of the FileStream SQL Server in this field. |
| FileStream Database Name | This field is enabled when the Enable Transactional Document Management option is selected. This field displays the name of the FileStream Database, which defaults to match Vision Database name with the word Files appended at the end. For example, for a database named Vision, the FileStream Database name is VisionFiles. You can modify the FileStream Database name, as needed. |
| Help                  | Select this option to access online Help related to the Weblink utility. |

Voucher Transactions

Add a New Accounts Payable Voucher

To add a new Accounts Payable voucher file, complete the following steps:

1. Select Transaction Center » Transaction Entry from the Vision Navigation menu.
2. Select Voucher from the Transaction Type drop-down
3. Click New. The New File dialog box displays. Complete the fields on this dialog box and click OK to save your changes. This information is now used to identify the transaction and verify its accuracy. The Voucher form displays.

4. Complete the fields on the Voucher form, if necessary.

5. Use the Voucher Lookup toolbar menu to access the Voucher lookup and search for open vouchers, if necessary.

6. Each line of the AP Vouchers grid contains details related to the current transaction. Refer to the following to record the voucher’s details:

   - **Add a new AP voucher entry**: Put the row selector on the row above where you want to add the new code, and click Insert. Each line of this grid represents one Accounts Payable voucher entry for each project; therefore, an employee may have many Accounts Payable voucher entries for several different projects, and each project can have a different phase number and labor code.

   - **Add a new Accounts Payable voucher entry that is similar to an existing entry**: Place the row selector on the row you want to copy, and click Copy. Modify the row, if necessary.

   - **Delete an Accounts Payable voucher entry**: Put the row selector on the desired line and click Delete. The Accounts Payable voucher entry is removed from the grid.

7. Complete/modify the fields on the grid, if necessary.

### A/P Voucher Fields

The fields at the top of the form apply to the entire transaction record.

**To display the A/P Voucher form in Transaction Entry, complete the following steps:**

1. Select Transaction Center, Transaction Entry to display the Transaction Entry form.
2. From the drop-down list for the Transaction Type field, select A/P Vouchers.
3. Select a file and click Open.

#### Contents

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Vendor</strong></td>
<td>Enter the vendor number or click ![Vendor lookup](C:\Documents and Settings\maleaheller\My Documents\Vision Europa\transaction center\WebHelp\tc_Voucher_Fields.htm - Voucher_Fields) and use the Vendor lookup to select a vendor number.</td>
</tr>
<tr>
<td><strong>Multicompany</strong></td>
<td>If you are using the Multicompany feature, the list of vendors available in the lookup is limited to those who have accounting data specified within the active company.</td>
</tr>
<tr>
<td><strong>Invoice Date</strong></td>
<td>Enter the date for the invoice or click the calendar icon to display the calendar lookup and then select the appropriate date. Vision uses this date to calculate the payment date if the vendor’s payment terms specify that the vendor should be paid a specific number of days after the invoice date. For example, if most of your vendors will have payment terms of Next, you would enter</td>
</tr>
</tbody>
</table>
Next as your default payment terms on the Accounts Payable tab of Configuration » Accounting » Company AP Configuration. Then, when you add vendors, the Payment Terms field on the Accounting tab of Vendor Info Center will, by default, display **Next**. This payment term setting will then fill in the **Invoice Date** field automatically, or instead, you can you can override the default value.

<table>
<thead>
<tr>
<th>Invoice Number</th>
<th>Enter a unique number for the invoice.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voucher Date</td>
<td>Enter the date for the voucher or click the calendar icon to display the calendar lookup and then select the appropriate date. This is the date on which a vendor’s invoice becomes a voucher in Vision. It is used when filtering reports by date or processing billings by date. In Billing, for example, when you enter a <strong>Bill Thru</strong> date under <strong>Transaction Detail</strong> in the Billing Session Options dialog box, Vision refers to <strong>Voucher Date</strong>; or, when you select dates from <strong>Time Frame</strong> for project or vendor reports, Vision also refers to the date of the voucher.</td>
</tr>
<tr>
<td>Voucher</td>
<td>Enter the voucher number. <strong>Multicompany</strong> If you are using the Multicompany feature, voucher numbers must be unique across the enterprise. If you decide to enter voucher numbers manually, rather than having Vision generate them automatically, you must specify a valid range of voucher numbers for each company on the Accounts Payable Tab of Company AP Configuration.</td>
</tr>
<tr>
<td>Payment Date</td>
<td>Use these fields to specify the payment terms and the corresponding date. From the drop-down list for the first field, select one of the following payment terms:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Next</strong> — Payment for any outstanding vouchers will be processed with the next check processing run.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Hold</strong> — Payment for any outstanding vouchers is on hold until you manually modify the payment terms.</td>
</tr>
<tr>
<td></td>
<td>• <strong>PWP (Pay When Paid)</strong> — Payment for any outstanding vouchers will be processed with the check processing run immediately following your company’s full receipt of payment (from the client) for the jobs associated with the vouchers.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Date</strong> — Enter a date in the corresponding field. If you select <strong>Date</strong>, use the second field to enter the date or click the calendar icon to display the calendar lookup and then select the appropriate date.</td>
</tr>
</tbody>
</table>
A/P Liability
Select the type of AP Liability account (such as trade, consultant or employee). C:\Documents and Settings\maleaheller\My Documents\Vision Europa\transaction center\WebHelp\tc_Voucher_Fields.htm - Voucher_Fields

Bank
Enter the bank code that will be used for this voucher file. To receive a list of the bank codes entered in your database, click the drop-down arrow in this field.

Multicurrency
If you are using the Multicurrency feature, the account specified via the bank code determines the payment currency for the transaction. (You specify the account's currency when you set up the account in the Chart of Accounts Info Center.) C:\Documents and Settings\maleaheller\My Documents\Vision Europa\transaction center\WebHelp\tc_Voucher_Fields.htm - Voucher_Fields

Address
Select the vendor’s address.
If there is a Primary address designated for the vendor, the Address field automatically defaults to the Primary address. If there is no Primary address designated, but there are addresses entered for the vendor, then Vision automatically defaults to the first address entered. C:\Documents and Settings\maleaheller\My Documents\Vision Europa\transaction center\WebHelp\tc_Voucher_Fields.htm - Voucher_Fields

Status
This field displays the current status of the transaction file. C:\Documents and Settings\maleaheller\My Documents\Vision Europa\transaction center\WebHelp\tc_Voucher_Fields.htm - Voucher_Fields

Approved By
If the transaction file has been Approved, then this field displays the approver.

AP Voucher Grid Fields
The grid fields represent individual transaction line items.

To display the A/P Voucher form in Transaction Entry, complete the following steps:
1. Select Transaction Center, Transaction Entry to display the Transaction Entry form.
2. From the drop-down list for the Transaction Type field, select A/P Vouchers.
3. Select a file and click Open. The grid displays on the lower part of the screen.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Enter a description for the line item. Voucher and disbursement descriptions display on invoices, Accounts Payable reports, and General Ledger reports. C:\Documents and Settings\maleaheller\My Documents\Vision Europa\transaction center\WebHelp\tc_voucher_Grid_Fields.htm - Voucher_Grid_Fields</td>
</tr>
<tr>
<td>Project</td>
<td>Perform one of the following actions to enter the project number:</td>
</tr>
<tr>
<td></td>
<td>• In the Project field, enter all or part of the project number. Vision searches for matching records in your database. If only one possible match is found, Vision enters the record. If more than one possible match is found, Vision displays a list</td>
</tr>
</tbody>
</table>
### Phase
Perform one of the following actions to enter the phase number:

- In the **Phase** field, enter all or part of the phase number. Vision searches for matching records in your database. If only one possible match is found, Vision enters the record. If more than one possible match is found, Vision displays a list of all possible matches. Select the correct phase from the list.

- Click to use a Lookup to find and select the phase record.  

### Task
Perform one of the following actions to enter the task number:

- In the **Task** field, enter all or part of the task number. Vision searches for matching records in your database. If only one possible match is found, Vision enters the record. If more than one possible match is found, Vision displays a list of all possible matches. Select the correct task from the list.

- Click to use a Lookup to find and select the task record.  

### Expense Code
The vendor's default expense code automatically displays in this field after the project, phase, and task have been selected for the voucher, but the field remains blank if an expense code value was not set up for the vendor on the Accounting tab of the Vendor Info Center.

The field is required only if the **Enable expense codes** option is configured to require expense codes for all project charge types or for projects with a regular charge type.

To select an expense code or to modify the default code, click the field's drop-down arrow.

This field displays on the AP Voucher grid only if the expense code feature is enabled in Configuration » Accounting » System AP.  

### Account
The project type and account number **must** be compatible:

- If the disbursement is for a regular project, enter a reimbursable or direct account.
- If the disbursement is for an overhead project, enter an indirect account.

Perform one of the following actions to enter the account number in this field:

- In the **Account** field, enter all or part of the account number. Vision searches for matching records in your database. If only one possible match is found, Vision enters the record. If more than one possible match is found, Vision displays a list...
of all possible matches. Select the correct account from the list.

- Click 📚 to use a Lookup to find and select the account record you want to open.

**Multicurrency**

If you are using the Multicurrency feature and a currency has been specified for this account (on the General tab of the Accounts Info Center), the account is a foreign denominated account. All transactions affecting a foreign denominated account must be in the same currency.

**Multicompany**

If you are using the Multicompany feature, you cannot specify an intercompany account in this field.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Net Amount</strong></td>
<td>The voucher's net amount.</td>
</tr>
<tr>
<td><strong>Tax Code</strong></td>
<td>This field displays only if the Enable Tax Auditing feature option is selected on the Tax Auditing tab (Configuration » Accounting » Company Settings). Use this field to enter tax code information, which is based on the country code for the country taxing goods and services.</td>
</tr>
<tr>
<td><strong>Tax Amount</strong></td>
<td>The voucher's tax amount.</td>
</tr>
<tr>
<td><strong>Tax-2 Code</strong></td>
<td>This field displays only if the Enable Tax Auditing feature option is selected on the Tax Auditing tab (Configuration » Accounting » Company Settings). Use this field to enter tax code information, which is based on the country code for the country taxing goods and services.</td>
</tr>
</tbody>
</table>

**Multicurrency**

If you are using the Multicurrency feature, the debit account specified for this tax code (on the Tax Codes form in Accounting Configuration) may be a foreign currency denominated account.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Tax-2 Amount</strong></td>
<td>Vision automatically calculates the tax amount in this field. C:\Documents and Settings\maleaheller\My Documents\Vision Europa\transaction center\WebHelp\tc_voucher_Grid_Fields.htm - Voucher_Grid_Fields</td>
</tr>
<tr>
<td><strong>Amount</strong></td>
<td>Enter the amount of the voucher line item. This amount will be charged to the project, task, and account combination you enter on this line. C:\Documents and Settings\maleaheller\My Documents\Vision Europa\transaction center\WebHelp\tc_voucher_Grid_Fields.htm - Voucher_Grid_Fields</td>
</tr>
</tbody>
</table>
| **Exchange Override Rate** | Multicurrency, only.  
Vision stores each transaction amount you enter in the currency that you selected on the New File dialog box.  
Vision also stores the amount in the functional currency of the company that owns (via organization structure) the project, phase, or task charged for the transaction. If the transaction currency and functional currency differ, Vision uses the daily exchange rates you establish in Configuration to calculate the amount in the functional currency. Usually, a transaction is recorded using the exchange rate in effect on the date the transaction took place, unless you specify an override.  
If you must override this exchange, you can use this field to override the exchange rate for a single line item. C:\Documents and Settings\maleaheller\My Documents\Vision Europa\transaction center\WebHelp\tc_voucher_Grid_Fields.htm - Voucher_Grid_Fields |
| **Payment Amount**  | This is the amount to be paid.  
Multicurrency  
If you are using the Multicurrency feature, then the account specified via the bank code determines the payment currency for the transaction. (You specify the account's currency when you set up the account in the Chart of Accounts Info Center.) C:\Documents and Settings\maleaheller\My Documents\Vision Europa\transaction center\WebHelp\tc_voucher_Grid_Fields.htm - Voucher_Grid_Fields |
| **Suppress Bill**   | Select this option to suppress billing on an expense. The amount on each detail line is costed to the general ledger only (and does not become a billable transaction). If you select this option, then the expense does not flow through to the Billing application. C:\Documents and Settings\maleaheller\My Documents\Vision Europa\transaction center\WebHelp\tc_voucher_Grid_Fields.htm - Voucher_Grid_Fields |
| **Purchase Order**  | If the voucher is created from a purchase order, then this field displays the purchase order number. Otherwise, this field remains blank. C:\Documents and Settings\maleaheller\My Documents\Vision Europa\transaction center\WebHelp\tc_voucher_Grid_Fields.htm - Voucher_Grid_Fields |
| **Document**        | Use this field to associate one or more documents with the voucher. A displays to indicate a document is uploaded and associated. |
Supporting Document Dialog Box Overview

The A/P Voucher, Expense Report, and Expense transaction grids include a document feature that allows you to associate documents with the main transaction and each associated transaction. You can use these documents in support of the transaction through the entire course of the Vision processes, from the initial entry to the final invoice that you send to the client.

You can either select documents that are specific to each transaction line, or choose to attach the same documents to multiple transaction lines.

The following sections outline general procedures for using the Supporting Documents feature. See the individual transaction types for details specific to that transaction.

Open the Supporting Document Dialog Box

To open the Supporting Document dialog box, complete the following steps:

1. Open the transaction file.
2. Add a transaction line to the grid.
3. Click the **Upload Document** button in the **Document** column. The Supporting Document dialog box displays. This dialog box lists the documents that are associated with the transaction line.

Supporting Document Dialog Box Toolbar and Buttons

- **Upload** — Click **Upload** to access the browse/open file dialog box. Using standard Windows functionality, select one or more documents and click **Open** to upload the documents to the Supporting Document dialog box.
- **View** — Select a document from the grid and click **View** to view the PDF version of the document.
- **Delete** — Select a document from the grid and click **Delete** to remove the document from the dialog box. If this document is only associated with the current transaction, it is deleted. If the document is associated with at least one other transaction, a confirmation message displays. Click **Yes** to confirm the deletion.
- **Exit** — Following standard Windows conventions, click the **Exit** button in the top right corner to close the dialog box. When you exit, any action that has occurred on the dialog box will be cancelled. This includes upload, delete, description change, **Select** option, and **Associate with...** option.
- **OK** — Click **OK** to save your changes and close the Supporting Document dialog box.
- **Cancel** — Click **Cancel** to cancel any action that has occurred on the dialog box.
- **Help** — Click **Help** to open the Vision online help application.

Upload a Document on the Supporting Documents Dialog Box

To upload a document on the Supporting Document dialog box, complete the following steps:

1. Click the **Upload** button on the Supporting Document dialog box to access the browse/open file dialog box.
2. Using standard Windows functionality, select one or more documents and click **Open**. The accepted file types are as follows: PDF, Word, Excel, jpeg, tiff, png, bmp, and gif.

Vision does not support the upload of a password protected document.

Vision checks the file type to ensure it is an accepted form. If not accepted, an error message displays. If accepted, the documents are converted to PDF format, uploaded, and display on the Supporting Document dialog box.

Prior to uploading an Excel file, it is important to format the file so that each Excel page has a defined print area. This will ensure that the PDF conversion process will not insert page breaks or change the formatting such that columns are broken.

3. Select the **Select** option to associate the document with the current transaction/expense/invoice.

4. If there is an option to automatically associate the document with all new transactions that are entered, select it as needed.

5. Modify the document’s **Description** field as needed. You cannot modify the document’s **File Name** field. The description field cannot be blank.

If you click Cancel before you click OK to include the documents, the documents are not included with the transaction, and are not saved on the Supporting Document dialog box.

### View a Document on the Supporting Documents Dialog Box

To view a document on the Supporting Documents dialog box, complete the following steps:

1. On the Supporting Document dialog box, select the document that you want to view. **Note:** Vision converts all uploaded documents, regardless of their original format, to PDF format.

2. Click **View**. A viewer displays, showing a preview of the document in PDF format.

3. Click the X in the right corner of the viewer to close the display.

### Automatically Associate a Document with a Transaction

You can automatically associate a document with one or more transaction lines as you enter them on the grid.

To automatically associate a document, complete the following steps:

1. Click the **Upload Document** button in the Document column. The Supporting Document dialog box displays. This dialog box lists the documents that are associated with the transaction.
2. Select the documents that you want to automatically associate with additional transactions as they are entered on the grid, and select the Associate with new... option next to each document.

3. Click OK. The documents will associate with any new transaction that is entered into the grid.

   Note: If you click Cancel before you click OK to associate the documents, the documents are not associated with the transaction, and are not saved on the Supporting Document dialog box.

Remove a Document’s Association from a Transaction

To remove a document’s association with a transaction, complete the following steps:

1. On the Supporting Document dialog box, select the document that you want to remove.

2. Remove the checkmark in the Select option. This removes the document’s association with the transaction.

3. Click OK. If the document is not associated with any other transaction, it is deleted from the Supporting Document dialog box when you save or when the transaction is automatically saved when you leave the application.

Remove a Document’s Automatic Association with New Transaction Lines

To remove a document’s automatic association with new transaction lines, complete the following steps:

1. On the Supporting Document dialog box, select the document that you want to remove.

2. Remove the checkmark in the Associate with new... option. This stops the document from associating with any new transactions that are entered on the grid.

3. Click OK. If the document is not associated with any other transaction, it is deleted from the Supporting Document dialog box when you save the transaction.

Delete a Document from all Transaction Lines

To delete a document from all transaction lines on the grid, complete the following steps:

1. On the Supporting Document dialog box, select the document that you want to remove.

2. Click the Delete toolbar button on the Supporting Document dialog box. If this document is only associated with the current transaction, it is deleted. If the document is associated with at least one other transaction on the grid, a confirmation message displays. Click Yes to confirm the deletion.

A/P Vouchers Supporting Documents

Attach a Document to an A/P Voucher Transaction Line

The A/P Vouchers grid includes a document feature that allows you to associate documents with the voucher and with each associated transaction. You can use these documents in support of the transaction through the entire course of the Vision processes, from the initial entry to the final invoice that you send to the client.

You can either select documents that are specific to each transaction line, or choose to attach the same documents to multiple transaction lines.
To attach a document to an A/P Voucher transaction line, complete the following steps:

1. Select Transaction Center » Transaction Entry.
2. Select A/P Voucher from the Transaction Type drop-down.
3. Open the Supporting Documents dialog box and upload the document. See Supporting Documents Overview for detailed steps.
   
   The Associate with new transactions option is selected by default for each document in the dialog box. When this option is selected for a document, the document is automatically associated with any new transaction that is entered into this grid.

4. Click the Select option next to each individual document that you want to associate with this transaction. You can modify the document’s Description field as needed. You cannot modify the document’s File Name field.

5. Remove the Associate with new transactions option for each document that you do not want to associate with new transactions that are added to the grid.

6. Click OK to close the Supporting Document dialog box. The Upload Document icon on the voucher transaction line changes to indicate Document Uploaded. You can hover over this icon to view a tooltip that describes the attached documents.

   If you click Cancel before you click OK to associate the documents, the documents are not associated with the voucher transaction line, and are not saved on the Supporting Document dialog box.

7. Click OK to return the AP Vouchers grid.

Delete an A/P Voucher Transaction

You can delete a transaction from the Vision database; however, deleting a transaction from the Vision database cannot be undone and the transaction would have to be re-entered if deleted in error. Verify that you no longer need the transaction file before you delete it from the database!

To delete an A/P Voucher transaction from the database, complete the following steps:

1. Select Transaction Center » Transaction Entry from the Vision Navigation menu.
2. Select A/P Voucher from the Transaction Type drop-down.
3. Put the row selector on the line of the transaction you wish to delete.
4. Click Delete. Vision asks you to confirm your delete.

   If the transaction has an associated document, the document is deleted when the transaction is deleted unless the document is associated with another transaction.

5. Click Yes to delete the transaction from the database.

Time & Expense - Expense Reports Supporting Documents

Attach a Document to an Expense Report

The Expense Reports grid includes a document feature that allows you to associate documents with the expense report and with each associated expense. You can use these documents in support of the expense report through the entire course of the Vision processes.
You can either select documents that are specific to each expense line, or choose to attach the same documents to multiple expense lines.

**To attach a document to an expense report, complete the following steps:**

2. Open the Supporting Documents dialog box and upload the document. See Supporting Documents Overview for detailed steps.
   
   The **Associate with new expense lines** option is selected by default for each document in the dialog box. When this option is selected for a document, the document is automatically associated with any new expense that is entered into this grid.
3. Click the **Select** option next to each individual document that you want to associate with this expense. You can modify the document’s **Description** field as needed. You cannot modify the document’s **File Name** field.
4. Click **OK** to close the Supporting Document dialog box. The **Upload Document** icon on the expense line changes to indicate **Document Uploaded**. You can hover over this icon to view a tooltip that describes the attached documents.

If you click **Cancel** before you click **OK** to include the documents, the documents are not included with the expense line, and are not saved on the Supporting Document dialog box.

**Interactive Billing - Expenses Supporting Documents**

**Attach a Document to an Expense in Interactive Billing**

The Expenses tab of Interactive Billing includes a document feature that allows you to associate documents with the expenses. You can either select documents that are specific to each expense line, or choose to attach the same documents to multiple expense lines.

**To attach a document to an expense, complete the following steps:**

1. Select **Interactive Billing » Expenses**.
2. Open the Supporting Documents dialog box and upload the document. See Supporting Documents Overview for detailed steps.
3. If the expense is a billable transaction, the documents are listed on this dialog box with the **Print with Invoice** option selected. You can modify this option if **Print Supporting Documents** is selected on the Billing Backup tab of Vision Billing Terms.
4. Click the **Select** option next to each individual document that you want to associate with this expense. You can modify the document’s **Description** field as needed. You cannot modify the document’s **File Name** field.
5. Click **OK** to close the Supporting Document dialog box. The **Upload Document** icon on the expense line changes to indicate **Document Uploaded**. You can hover over this icon to view a tooltip that describes the attached documents.

If you click **Cancel** before you click **OK** to include the documents, the documents are not included with the expense line, and are not saved on the Supporting Document dialog box.
Delete Supporting Documents

You can only delete documents that have been uploaded in Interactive Billing. You can only upload a supporting document for an A/P Voucher or Employee Expense transaction. You cannot delete a document that was uploaded in Expense Reports or AP Vouchers.

Print with Invoice

When the **A/P Voucher** or **Expense Reports** options are **not** selected on the Billing Backup tab, but the **Print with Invoice** option is selected for the associated document, the document will not be printed when the invoice is previewed, printed or accepted. However, if the **A/P Voucher** and/or **Expense Reports** options are selected on the Billing Backup tab, and the **Print with Invoice** option is selected for the associated document, then the document will be printed when the invoice is previewed, printed or accepted.

If you do not want a document included when the invoice is previewed, printed, or accepted, you can remove the **Print with Invoice** selection for that document. However, one or both of the **A/P Voucher** and **Expense Reports** options in the Print Supporting Documents group box on the Billing Backup tab must be selected before you can change the **Print with Invoice** option.

Delete a Document from the Supporting Documents Dialog Box in Interactive Billing

To delete a document from the Supporting Document dialog box, complete the following steps:

1. Click the **Upload** button on the Supporting Document dialog box to access the browse/open file dialog box.
2. The Delete option is only available for documents that were uploaded in Interactive Billing. Select a document from the grid and click **Delete** to remove the document from the dialog box. You cannot delete a document that was uploaded in Expense Reports.
3. Click **OK** to return to the grid.

Accept an Invoice

Use the **Accept** option to accept the invoice for the project currently open in Interactive Billing. Note that your ability to use this option depends upon the setting for the **Interactive Access** option in Configuration. (If invoice approval is enabled for the project, this option is only available if the invoice is approved for billing.)

To accept an invoice from the Supporting Document dialog box, complete the following steps:

1. Go to **Interactive Billing » Expenses**.
2. Select an invoice from the Expenses grid.
3. From the Invoice menu, select **Accept**. The Invoice Accept dialog box displays. Review the invoice amounts on this dialog box.
4. Click **OK**.
5. Vision asks you to confirm the invoice acceptance. Click **Yes** to accept. The invoice displays with the supporting documents added as additional pages in the invoice.
6. Click the arrow buttons to scroll through the invoice pages.
7. If the invoice is configured to print, it will be sent directly to the designated printer. If not configured to print, the invoice displays in Adobe Reader.

8. Review the invoice amounts on this dialog box.

If the invoice includes transactions that are associated with supporting documents, and those documents are configured to print with the invoice, the invoice will include those documents.

**View the Supporting Documents that are Associated with the Transaction**

Before you accept an invoice, you can view the supporting documents that are associated with the transactions that belong to the project.

**To view the supporting documents, complete the following steps:**

1. Go to Interactive Billing.
2. From the Invoice menu, select View Supporting Documents. The Supporting Documents dialog box displays, listing all of the supporting documents, and their document type, filename, description, and Print with Invoice setting.
3. Select the Print with Invoice option for the respective documents that you want to print with the invoice.
4. Complete one of the following:
   - Select View All to view all supporting documents. Adobe Reader opens and lists all documents compiled into one document, in the order displayed on the dialog box.
   - Select View Selected to only view the selected supporting documents.
5. Close Adobe Reader.
6. Click OK to close the supporting documents dialog box.

**Preview an Invoice**

When an invoice is accepted, the supporting documents are automatically associated with the invoice in the Vision database. This allows you to view the documents again if you use the Print feature from any of the following areas: Project Review » Accounts Receivable, Invoice Review, and Invoices on File.

**To preview an invoice, complete the following steps:**

1. Go to Interactive Billing.
2. Select a Project or Billing group.
3. From the Invoice menu, select Preview.
4. Complete one of the following:
   - If the Print Backup Report option is selected on the Billing Terms form, the Billing Backup report will print after invoices are generated for the project through Interactive or Batch Billing. Click Yes to view the report in the report dialog.
   - If the Print Supporting Documents option is selected on the Billing Terms form, you are prompted to Print Supporting Documents. Click Yes to view the draft invoice in your default PDF viewer.
If both Print Backup Report and Print Supporting Documents options are selected, the Preview Options dialog box displays. You can change the selected options as needed and click OK. If Print Support Documents is selected, the draft invoice displays in your default PDF viewer. If Print Supporting Documents is not selected, the draft invoice displays in the standard report dialog.

Print an Invoice

To print an invoice, complete the following steps:

1. Go to Interactive Billing.
2. Select a Project or Billing group.
3. From the Invoice menu, select Print.
4. Before printing, Vision checks the following settings:
   - If the Print Backup Report option is selected on the Billing Terms form, the Billing Backup report will print after invoices are generated for the project through Interactive or Batch Billing.
   - If the Print Supporting Documents option is selected on the Billing Terms form, the report will include all designated supporting documents.
   - If both Print Backup Report and Print Supporting Documents options are selected, the Billing Backup report and supporting documents are included.
5. If the invoice is configured to print, it will be sent directly to print at the designated printer. If not configured to print, the invoice displays in Adobe Reader.

   **Note:** The invoice displays with the supporting documents added as additional pages.

Sort the Supporting Documents

The order in which the supporting documents display as additional pages is static based on the following constraints:

- Because each project has billing terms that identify the invoice template, the invoice template’s configuration dictates the sort order of sections. If consultants are listed before expenses on the invoice template, then documents associated with consultant transactions will display before documents associated with expense transactions.
- The secondary sort criterion is the Work Breakdown Structure (WBS) level. Because all documents are associated at the lowest level of the WBS, the sort will follow the hierarchy of the WBS when there are multiple levels. For example, a document associated with Task 1 would print before a document associated with Task 2.

Transfer Transaction Detail Between Projects

After transferring detail between projects during an Interactive Billing session, Vision posts the transactions to the appropriate project(s) and to the general ledger. Postings are logged to unique posting sequence numbers for each type of transfer (labor, expense, unit) performed during the session. These postings display in the Posting Logs Transaction Center, as well as on the Posting Review Report, also accessible from the Transaction Center.

To transfer transaction detail between projects, complete the following steps:

1. From the Vision Navigation menu, click Billing » Interactive Billing.
2. Open the appropriate project.

3. Select the **Labor**, **Expenses** or **Units** tab, depending on the type of transaction to transfer. Vision displays all outstanding labor, expense, or unit transactions posted to this project, phase, or task.

   If you are transferring labor to another project, be aware that the transfer will not remove the employee whose hours were charged to the original project from the Project Info Center Team tab. If this employee is not a member of the originating project's team, after the transfer the employee must be removed manually from that project's Team tab in the Project Info Center.

   Any supporting documents associated with the transaction will also transfer. If only a partial transfer occurs, the associated supporting documents will be available to both transactions.

4. Click the record selector box next to the transaction line you want to transfer to select the transaction. You can select multiple transactions, but you must transfer each transaction in its entirety when doing so. To perform a partial transfer you must select a single transaction.

   Depending on whether or not you have selected the **Default to project view on detail tabs** option from the Billing Session Options dialog box, the detail grid may display all transactions including those at different WBS levels (for example if Project A has three phases A1, A2, and A3, and phase A1 has two tasks, B1 and B2, you can select to transfer Project A, Phase A2 and Project A, Phase A1 and Task B1). Vision allows you to select any combination of transactions and transfer them to any project, phase, or task that you have access to. However, if the selected transactions have different labor codes, you cannot transfer to another labor code. The labor code option on the transfer dialog box will not be enabled.

5. Click **Transfer**. Vision displays the Billing Labor, Expense, or Unit Transfer dialog box, depending on the type of transaction.

6. Be sure that **Within current (Project, Phase, Task)** option is not selected when transferring Labor or Expense transaction detail. This option does not appear in the Billing Unit Transfer dialog box.

7. Enter the destination of the labor, expense, or unit transfer in the **Project**, **Phase**, and **Task** fields, as appropriate. The name of the project, phase, or task appears to the right. Verify that you have selected the appropriate destination for the transfer.

   To select a phase, you must also select the phase's project. To select a task, you must also select the corresponding phase and project.

8. Complete additional information on the appropriate dialog boxes:

   - Billing Labor Transfer
   - Billing Expense Transfer
   - Billing Unit Transfer

9. Click **OK** from the dialog box. Vision removes or reduces the amount of the transaction from the source project and assigns the total or partial transfer to the destination project.
Billing Backup Tab of Billing Terms Form

The Billing Backup tab allows you to define the labor and expense information you want to display on the Billing Backup report. This tab and the fields on this tab are enabled at the billing terms project level only.

If your firm uses the Multilingual feature, Vision generates the Billing Backup report in the same language as the associated invoices.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Print Backup Report</strong></td>
<td>Select this option to print the Billing Backup report after invoices are generated for this project through Interactive or Batch Billing.</td>
</tr>
<tr>
<td>C:\Documents and Settings\maleaheller\My Documents\Vision Europa\Billing\bill_billingbackup_tab_of_billing_terms_form.htm - Top</td>
<td></td>
</tr>
<tr>
<td><strong>Show Labor</strong></td>
<td>Select this option to print labor billing detail on the Billing Backup report. You can use the labor related options on this tab to further specify the type of labor detail that prints on the report.</td>
</tr>
<tr>
<td>C:\Documents and Settings\maleaheller\My Documents\Vision Europa\Billing\bill_billingbackup_tab_of_billing_terms_form.htm - Top</td>
<td></td>
</tr>
<tr>
<td><strong>Labor Code</strong></td>
<td>Select this option to show the labor code associated with each employee labor transaction shown on the Billing Backup report. The labor code description does not print. If you would like the labor code description to print, you can sort based on labor code.</td>
</tr>
<tr>
<td>C:\Documents and Settings\maleaheller\My Documents\Vision Europa\Billing\bill_billingbackup_tab_of_billing_terms_form.htm - Top</td>
<td></td>
</tr>
<tr>
<td><strong>Labor Category</strong></td>
<td>Select this option to show the labor category associated with each employee labor transaction shown on the Billing Backup report. The labor category description does not print. If you would like the labor category description to print, you can sort based on labor category.</td>
</tr>
<tr>
<td>C:\Documents and Settings\maleaheller\My Documents\Vision Europa\Billing\bill_billingbackup_tab_of_billing_terms_form.htm - Top</td>
<td></td>
</tr>
<tr>
<td><strong>Timesheet Comments</strong></td>
<td>Select this option to display timesheet comments (if any) for labor transactions included on the Billing Backup report. The expanded text content will appear when this option is selected.</td>
</tr>
<tr>
<td>C:\Documents and Settings\maleaheller\My Documents\Vision Europa\Billing\bill_billingbackup_tab_of_billing_terms_form.htm - Top</td>
<td></td>
</tr>
<tr>
<td><strong>Employee Number</strong></td>
<td>Select this option to show the employee number associated with each employee labor transaction shown on the Billing Backup report.</td>
</tr>
<tr>
<td>C:\Documents and Settings\maleaheller\My Documents\Vision Europa\Billing\bill_billingbackup_tab_of_billing_terms_form.htm - Top</td>
<td></td>
</tr>
</tbody>
</table>
Sort Labor

Select a sort method to use in addition to the two sorting methods selected on the Labor tab of Billing Terms. Options are:

- **None** — No additional sort.
- **By labor code** — Sort by labor code description. When this option is selected, the Billing Backup report displays the description of the labor code, not the code itself. The labor code description used depends on the labor code table selected from the **Sort Table** field. Since selecting the option to **Print Labor Code** displays the labor code and not the description, sorting by labor code allows you to display the description of the labor code on the report, in addition to grouping by labor code.
- **By date** — Sort by transaction date.
- **By employee** — Sort by employee name.
- **By labor category** — Sort by labor category description. When this option is selected, the Billing Backup report displays the description of the labor category, not the number associated with the category. The labor category description used depends on the labor category table selected from the **Sort Table** field. Since selecting the option to **Print Labor Category** displays the labor category and not the description, sorting by labor category allows you to display the description of the labor category on the report, in addition to grouping by labor category.

The sort you select here acts as a third sort following the first two sorting options on the Labor tab of Billing Terms. The sort allows the invoice to include consolidated information only, while including detailed subtotals by a sort on the Billing Back report. This option is intended as a sort to be used in addition to the two options on the Labor tab. If you select the same sort here as is selected in the two sort fields on the Labor tab, there will be no impact on sorting.

Sort Table

If **By Labor Code** or **By labor category** is selected from the **Sort By** field, this field lists the labor code or labor category tables available for selection.

Include Labor for

Select an option from the drop-down list to include labor on the Billing Backup report based on whether or not labor and/or fee billing terms are established for a given project.

Options are:

- **Sections with labor terms** — Select this option to include labor on the Billing Backup report for any phase or task that has labor billing terms defined. For example, suppose you have a project established that has two levels of work breakdown structure, and at the second level, the phase level, you have labor billing terms defined. Selecting this option will include this phase-level labor detail on the Billing Backup report.

- **Sections with labor or fee terms** — Select this option to include labor on the Billing Backup report for any phase or task that has labor and/or fee billing terms defined. For example, suppose you have a project established that has three levels of
work breakdown structure, and at the second and third levels, the phase and task levels, you have some phases and tasks with labor billing terms defined and some with fee billing terms defined. Selecting this option will include labor for all of these phases and tasks on the Billing Backup report. Labor associated with fee-based billing terms shows hours only, and zero amounts.

Labor or fee billing terms must be defined at the phase or task level for labor to print for these sub-levels, unless the Labor Method (Labor tab) or Fee Method (Fee tab) is established at the project level.

Use as Project Reporting Default Terms for Fee Sections of Draft Invoices

Select this option to use project reporting default terms to determine the labor amounts that display on the billing backup portion of draft invoices for a fee invoice.

If this option is selected, when the invoice is generated, the billing backup first looks to the project's labor terms to see if the option to use for project reporting default terms only is selected. If this option is not selected and the project's Labor Method is set to No labor billing, then Vision uses the project reporting default terms defined in Billing Configuration.

- The project reporting default terms are only used to calculate the amounts. The formatting of the billing backup, detail that is included in the labor section, and sorting is defined on the billing backup tab.
- If a project has lower WBS levels (phase, task for example), Vision first looks to the lowest WBS level and then upwards (task, phase, project, for example).
- The Use as Project Reporting Default Terms for Fee Sections of Draft Invoices field is only enabled when the user has selected the Sections with labor or fee terms option from the Include labor for field (see previous item in this list).
- When this option is selected it is possible that the total on the invoice will not match the total on the billing backup report.

Show Expense Consultant Unit

Select this option to print consultant, expense, and unit expense on the Billing Backup report. You can use the expense-related options on this tab to further specify the type of expense data that prints on the report.

Transaction Type

Select this option to print the transaction type of each expense transaction on the report.

Vendor Invoice and Date

Select this option to control the amount of information that appears on
<table>
<thead>
<tr>
<th><strong>AP Voucher Descriptions</strong></th>
<th>Select this option to print the AP voucher and AP disbursement descriptions associated with AP transactions on the Billing Backup report.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Employee Expense Descriptions</strong></td>
<td>Select this option to print employee expense report line item descriptions on the Billing Backup report. The description that prints is the main description entered by an employee on the expense report.</td>
</tr>
<tr>
<td><strong>Employee Expense Reason</strong></td>
<td>Select this option to print the reason for each expense entered on the expense report. This reason is entered by the employee on the expense report. This option is available only if your company uses the Employee Expense application.</td>
</tr>
<tr>
<td><strong>Mileage for Employee Expense</strong></td>
<td>Select this option to print the mileage amount as calculated on the expense report. Vision retrieves this information from the employee expense report. This option is available only if your company uses Vision Employee Expense.</td>
</tr>
<tr>
<td><strong>Sort Exp\Con</strong></td>
<td>Select a sort method to use in addition to the invoice sorting method selected on the Expense\Consultant\Unit tab of the Billing Terms form. Options are:</td>
</tr>
<tr>
<td></td>
<td>- None</td>
</tr>
<tr>
<td></td>
<td>- By vendor</td>
</tr>
<tr>
<td></td>
<td>- By date</td>
</tr>
<tr>
<td><strong>Sort Table</strong></td>
<td>If By vendor is selected from the Sort By field, this field lists the Expenses by vendor tables available for selection.</td>
</tr>
</tbody>
</table>
### Print Supporting Documents

Select this option to automatically include supporting documents when the invoice is previewed, printed, or accepted.

You must select this option to enable the **AP Voucher** and **Expense Reports** options for supporting documents.

### AP Voucher

Select this option for the following to occur:

- When a billable AP Voucher transaction is posted, and has a supporting document associated with it, the supporting document is automatically set to be included in the invoice.
- The **Include in Invoice** column displays for AP Voucher transactions when the Supporting Documents dialog box is opened in Interactive Billing.

Note: When the **AP Voucher** option is not selected, but the **Include in Invoice** option is selected for the associated document, the document will not be included when the invoice is printed.

### Expense Reports

Select this option for the following to occur:

- When a billable Expense Report transaction is posted, and has a supporting document associated with it, the supporting document is automatically set to be included in the invoice.
- The **Include in Invoice** column displays for expense report transactions when the Supporting Documents dialog box is opened in Interactive Billing.

Note: When the **Expense Reports** option is not selected, but the **Include in Invoice** option is selected for the associated document, the document will not be included when the invoice is printed.

---

### Reporting

**Expense Detail Columns Tab (Reporting)**

Use the Columns tab to select or clear columns, change column sequence, provide new column labels, set column widths, or select number and date formats.

**Contents**

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transaction Date</td>
<td>This column displays the date on which the transaction was posted.</td>
</tr>
<tr>
<td></td>
<td>Exception: If the detail is from the History Loading utility, this column displays the accounting period.</td>
</tr>
<tr>
<td>Transaction Amount</td>
<td>This column displays the amount of the transaction.</td>
</tr>
<tr>
<td>Description</td>
<td>This column displays the description of the transaction.</td>
</tr>
<tr>
<td>Fiscal Period</td>
<td>This column displays the accounting period in which the transaction was posted.</td>
</tr>
</tbody>
</table>
### Posting Sequence

This column displays the posting sequence number for the transaction. Vision assigns the sequence numbers during the posting process.

Vision assigns 1 to the first group of transactions posted during an accounting period, 2 to the second group, and so on.

To see a numbered list of all of the postings for the current accounting period, click **Transaction Center » Posting Review Report** from Vision Navigation menu.

### Billing Status

This column displays the billing status of the transaction. The following are the possible statuses:

- **B** — Billable: The transaction is released and available for billing to the client.
- **D** — To be deleted: The transaction is marked for deletion.
- **F** — Final billed: The transaction has been billed to the client.
- **H** — Held: The transaction is being held temporarily to prevent billing to the client.
- **M** — Modified: The transaction has been modified in some way from its original form.
- **N** — Not billable: The transaction is not billable.
- **O** — Deleted: The transaction was marked for deletion, included in a billing run, and deleted.
- **R** — Partial Hold/Released: Part of the transaction has been held or released.
- **T** — Transferred: The transaction was moved from one project, phase, or task to another.
- **W** — To be written off: The transaction has been written off, but the invoice has not been posted.
- **X** — Written off: The transaction has been written off, and the invoice has been posted.

### Line Number

This column displays the voucher line number if the transaction type is one of the following:

- **AP** — Accounts Payable voucher
- **CV** — Accounts Payable disbursement
- **EX** — Employee expense

### Invoice Number

This column displays the billed invoice number of the transaction.

### Transaction Organization

This column displays the organization assigned to the project at the time of the transaction.

### Project Currency Code

This column displays the three-character code for the project currency.

### Billing Currency Code

This column displays the three-character code for the billing currency.

### Functional Currency Code

This column displays the three-character code for the functional currency.
Voucher | This column displays the voucher number for the transaction.
---|---
**Vendor or Unit Number** | This column displays the vendor number if the transaction type is one of the following:
- AP — Accounts Payable voucher
- CV — Accounts Payable disbursement
This column displays the unit number for transactions involving units.
---|---
**Vendor Name** | This column displays the name of the vendor associated with the transaction.
---|---
**Vendor Organization** | This column displays the organization within your company for which this vendor provides goods or services.
---|---
**Unit Quantity** | This column displays the number of units for the transaction (for example, 5 pipes).
---|---
**Cost Rate per Unit** | This column displays the cost amount per unit.
If your firm uses date-based rates, Vision uses the cost rate in effect at the time the transaction was posted.
---|---
**Bill Rate per Unit** | This column displays the amount to bill the client for each unit.
If your firm uses date-based rates, Vision uses the billing rate in effect at the time the transaction was posted.
---|---
**Transfer Project** | For a labor adjustment, this column displays the project from which the labor adjustment transaction was transferred.
---|---
**Transfer Phase** | For a labor adjustment, this column displays the phase from which the labor adjustment transaction was transferred.
---|---
**Transfer Task** | For a labor adjustment, this column displays the task from which the labor adjustment transaction was transferred.
---|---
**Project** | This column displays the project number for the transaction.
---|---
**Phase** | This column displays the phase number for the transaction.
---|---
**Task** | This column displays the task number for the transaction.
---|---
**Supporting Documents** | This column displays the document icon to indicate the transaction has one or more supporting documents.

**Drill Down Overview**

You can drill down from a previewed report to display more information about a value on the report. Vision displays the related detail in a separate window.

Report data from which you can drill down is identified by bright blue text. In many cases, you can drill down on the following:

- **Record identifiers** — Vision displays additional information from that record. For example, if you drill down on a project number, Vision displays related information about the project from the project record in the database.
- **Numeric data** — Vision displays the supporting detail for the report amount.
Note that you can only drill down from reports that you display on the Preview page in the preview mode. You cannot drill down if you change the display on the Preview page to print layout mode, and you cannot drill down from reports that you download to files and display in other applications. In addition, if you are drilling down to an AP Posting Log or Expense Detail report, a document icon displays to indicate the transaction is associated with a document.

Drilling Down from General Ledger Reports

For General Ledger reports, Vision provides a Drill Down tab in the Options dialog box. On that tab, select the types of data for which you want to drill down. Vision organizes the drill down report based on your selection. For example, if you select Transaction Type and drill down from a balance or total, the drill-down report displays the amount that each transaction type (for example, cash disbursements, cash receipts, journal entries) contributed to the balance or total.

Drilling Down from Visualizations

You can also drill down to related reports from data displayed on Visualization maps.

Print or Preview a Posting Log

A posting log enables you to view information about a batch of transactions. Vision produces a posting log each time you post a transaction. The log lists all disbursements posted during that session.

Vision Configuration includes an option to automatically print posting logs whenever a transaction is posted.

To print a posting log, complete the following steps:

1. Select Transaction Center » Posting Logs from the Vision Navigation menu.
2. Select the transaction type from the Transaction Type drop-down. The Transaction grid lists all transaction files. (If you wish to view only transactions you have created, select Show only transactions created by me.)
3. Highlight the transaction files for which you will print a log. A posting log can be identified by the posting sequence number or the date and time stamp of the posting.
4. Click the Posting Log icon on the toolbar.
5. Select the Print option from the Posting Log menu to send the posting log to your default printer. Or, select the Preview option to view the posting log on your screen. If you selected Show Report Options from the Transaction List menu, Vision displays an Options dialog box. From this dialog box, you can Set Reporting Options for a Posting Log before printing or previewing it.

A document icon displays in the Supporting Documents column when the transaction has associated supporting documents.

Note:

Print or Preview a Transaction List

To print a transaction list, complete the following steps:

1. Select Transaction Center » Transaction Entry or Transaction Lists from the Vision Navigation menu.
2. Select the type of transaction from the **Transaction Type** drop-down.

3. Select the transaction file you want to print from the Transaction grid.

4. Select **Transaction List » Print** to display the Print dialog box, or select **Transaction List » Preview** to display the list on screen.

5. If you selected **Show Report Options** from the Transaction List menu, Vision displays an Options dialog box.
Vision Performance Management Dashboards

Make Performance Dashboards Available as Web Dashparts: Overview

Before someone can use a performance dashboard, it must be added as a Web dashpart to their Vision Dashboard.

Deltek recommends that only Vision system administrators be given the access necessary to add performance dashboards as Web dashparts and to make them available to the appropriate groups of Vision users.

You can only add dashparts for performance dashboards if the workbooks containing the performance dashboards have been published to the Tableau server.

System administrators have two basic ways to make a new dashpart available to other users:

- **Add the dashpart as a role-based or a global dashpart.** Use this method to update the Vision Dashboards of existing users. Vision adds the new dashpart to the list of unused dashparts for those users with the appropriate Vision security roles. Each user can then add the dashpart to the Vision Dashboard if they want to display it.

- **Add the dashpart as the system administrator’s personal dashpart, and save his or her Vision Dashboard for other users.** Because this process replaces the user’s personal Vision Dashboard with the system administrator’s Vision Dashboard, it is used primarily to set up the initial Vision Dashboard for new Vision users. If you use it to distribute a new version of your standard Vision Dashboard, be aware that any changes that individual users have made to their personal version of the Vision Dashboard will be lost.

For complete information on how to set up and work with dashparts and the Vision Dashboard, go to Vision help. In the Contents pane of the Vision help window, click Dashboard.

Because the performance dashboards often display sensitive information intended for specific management roles, it is usually not appropriate to make them available as global dashparts.

Make Performance Dashboards Available as Web Dashparts for All or Selected Roles

You can make a performance dashboard available, as a dashpart, to either all Vision users or selected Vision users.

**To make a performance dashboard available as a dashpart for all or selected roles, complete the following steps:**

1. If your Vision Dashboard is not visible, click **Dashboard** on the Vision toolbar to display it.
2. Click **Configure** on the Vision Dashboard toolbar.
3. On the menu, select **Add Web Dashpart** to display the Add Web Dashpart dialog box.
4. In **Web Part Name**, enter the name you want Vision to display for the dashpart.
5. In **Address Type**, select **Performance Management Dashboard**.
6. In **Dashboard**, select the performance dashboard you want to add as a dashpart. The selection list only includes published dashboards for the current database and language.

7. Do one of the following to indicate who can use the new dashpart:
   - To make the dashpart available to selected roles in Vision, clear both the **Personal** check box and the **Access to all roles** check box. In **Available Roles**, select the roles that you want to have access to the dashpart, and click **Add** to move them to the **Assigned Roles** list box.
   - To make the dashpart available to all Vision users, select the **Access to all roles** check box.

8. Click **Save**.

### Make Performance Dashboards Available as Web Dashparts by Saving Your Vision Dashboard

You can make performance dashboards available, as dashparts, to other Vision users by adding a set of performance dashboards to your own Vision Dashboard and then saving your dashboard for a group of users.

**To add a performance dashboard as a dashpart by saving your Vision Dashboard for other users, complete the following steps:**

1. If your Vision Dashboard is not visible, click **Dashboard** on the Vision toolbar to display it.

2. Click **Configure** on the Vision Dashboard toolbar.

3. On the menu, select **Add Web Dashpart** to display the Add Web Dashpart dialog box.

4. In **Web Part Name**, enter the name you want Vision to display for the dashpart.

5. In **Address Type**, select **Performance Management Dashboard**.

6. In **Dashboard**, select the performance dashboard you want to add as a dashpart. The selection list only includes published dashboards for the current database and language.

7. Select the **Personal** check box.

8. Click **OK**.

9. Repeat steps 2 – 8 for each dashpart you want the users to have.

10. Click **Configure** on the Vision Dashboard toolbar.

11. On the menu, select **Save Dashboard for Users** to display the Save Dashboard for Users dialog box.

12. In the list box on the left, select one or more users for whom you want to save the Vision Dashboard, and click **Add**. (To select multiple users, hold down the **CTRL** key and click each one. To select a group of users who are listed consecutively, hold down the **SHIFT** key and click the first and last user in the group.)

13. Repeat step 12 until you have selected all users and moved them to the list box on the right.

14. Select the **Copy personal Web Dashparts (with new names)** check box.

15. Click **Apply**.
16. When Vision displays a message that asks you to confirm that you want to replace the selected users’ Vision Dashboards, click Yes to continue.

Add or Remove Access to a Performance Dashboard for a Vision Role

You can make performance dashboards available, as dashparts, to other Vision users by adding a set of performance dashboards to your own Vision Dashboard and then saving your dashboard for a group of users.

To add or remove access to a dashpart for a Vision role, complete either of the following sets of steps:

1. If your Vision Dashboard is not visible, click Dashboard on the Vision toolbar to display it.
2. On your Vision Dashboard, click the title of the dashpart for which you want to add or remove access for a role.
3. On the menu, select Configure to display the Add Web Dashpart dialog box.
4. Do one of the following to indicate who can use the new dashpart:
   - To add access for a role, select that role in Available Roles, and click Add to move it to the Assigned Roles list box.
   - To remove access for a role, select that role in Assigned Roles and click Remove to remove it from the Assigned Roles list box.
5. Click Save.
   Or
2. In the Roles form, select the role for which you want to modify access to Web dashparts.
3. Click the Access Rights tab.
4. In Functional Area, select Web Dashparts.
5. Do one of the following:
   - To add access to a dashpart for the role, select that dashpart in Available Web Dashparts, and click Add to move it to the Selected Web Dashparts list box.
   - To remove access to a dashpart for the role, select that dashpart inSelected Web Dashparts and click Remove to remove it from the Selected Web Dashparts list box.
6. Click Save on the Roles toolbar.

Add a Performance Dashboard Dashpart to Your Vision Dashboard

Before you can display a performance dashboard on your Vision Dashboard, it must be made available to you as a Web dashpart. You can add any dashparts to your Vision Dashboard that are available to your security role.
Note that you can also display the available performance dashboards from Vision Reporting (Reporting » Performance Management).

For complete information on how to set up and work with dashparts and the Vision Dashboard, go to Vision help. In the Contents pane of the Vision help window, click Dashboard.

To add an available performance dashboard dashpart to your personal Vision Dashboard, complete the following steps:

1. If your Vision Dashboard is not visible, click Dashboard on the Vision toolbar to display it.
2. Click Configure on the Vision Dashboard toolbar.
3. On the menu, select Show Unused Dashparts to display the Add Unused Dashparts dialog box.
4. In Available Parts, select one or more dashparts that you want to add to your Vision Dashboard.
5. Click OK.

Send a Link to a Dashboard View in Email

To share the contents of a dashboard with others, you can send a link to it in an email message. The recipient of the email can then view and interact with the dashboard.

To send a link to a dashboard view in email, complete the following steps:

1. Interact with the dashboard to create the view of the data that you want.
2. Click Share in the lower left corner of the dashboard.
3. In the Share View dialog box, select the link information in Email and paste the link into your email message.
4. Click Done.

Embed a Dashboard View in a Web Page

To share the contents of a dashboard view with others, you can embed it in a Web page. For example, you could add it to a blog, a wiki, or a Web application. Those who access the Web page can then view and interact with the dashboard.

To embed a dashboard view in a Web page, complete the following steps:

1. Interact with the dashboard to create the view of the data that you want.
2. Click Share in the lower left corner of the dashboard.
3. To display the embedded dashboard with a fixed width and height, click Display Options in the Share View dialog box and enter the dimensions.
4. To include the dashboard toolbar, click Display Options and select Show Toolbar.
5. Select the HTML code in Embed and paste it into your Web page.
6. Click Done.
Create a Custom View for a Dashboard
You can create a custom view of a performance dashboard so you can display that view quickly in the future or share it with others.

To create a custom view of a dashboard, complete the following steps:

1. Interact with the dashboard to create the view of the data that you want.
2. Click either Remember my changes or the name of the current view, whichever is displayed in the lower left corner of the dashboard.
3. Enter a name for the new view.
4. Click Remember.

Display a View for a Dashboard
If custom views exist for a dashboard, you can select that view to display it, rather than having to reconstruct it using filters and other options.

To display a custom view for a dashboard, complete the following steps:

1. Click either Remember my changes or the name of the current view, whichever is displayed in the lower left corner of the dashboard.
2. Locate the view under either My Custom Views or Other Custom Views, and click the view name.

Change the Default View for a Dashboard
If you create a custom view for a dashboard and you prefer it to your current default view, you can make that custom view your default.

To change the default view for a dashboard, complete the following steps:

1. If the view that you want as the default is not currently applied, click either Remember my changes or the name of the current view, whichever is displayed in the lower left corner of the dashboard, and select that view.
2. After the view is applied, click the name of the current view in the lower left corner of the dashboard.
3. Click Change default to <view name>.
4. Click anywhere outside of the Custom Views dialog box to close it.

Make a Custom View Available to Other Dashboard Users
If you create a custom view for a dashboard, you can make it available as an optional view to others who use that dashboard.

To make a view available to other dashboard users, complete the following steps:

1. Click either Remember my changes or the name of the current view, whichever is displayed in the lower left corner of the dashboard.
2. Click Manage Custom Views.
3. Click  next to the view.
4. The icon changes to
5. Click Done.
6. Click anywhere outside of the Custom Views dialog box to close it.

**Rename a Custom View**

If you create a custom view for a dashboard, you can later change its name.

**To change the name of a view, complete the following steps:**

1. Click either Remember my changes or the name of the current view, whichever is displayed in the lower left corner of the dashboard.
2. Click Manage Custom Views.
3. Enter the name you want.
4. Click Done.
5. Click anywhere outside of the Custom Views dialog box to close it.

**Delete a Custom View**

If you create a custom view for a dashboard and later decide you do not need it, you can delete it so it no longer displays in My Custom Views.

**To delete a view, complete the following steps:**

1. Click either Remember my changes or the name of the current view, whichever is displayed in the lower left corner of the dashboard.
2. Click Manage Custom Views.
3. Click  next to the view.
4. **Note:** If you click  and then, before you click Done, you decide you do not want to delete the view, click Undo.
5. Click Done to confirm the deletion.
6. Click anywhere outside of the Custom Views dialog box to close it.

**Export a Dashboard as an Image File**

If you want others to see a particular version of dashboard data, you can export an image of the dashboard in a Portable Network Graphics (.PNG) image file and then, for example, distribute it by email, annotate it in a graphics application, or print it.

**To export a dashboard as an image file, complete the following steps:**

1. Interact with the dashboard to display the version of the data that you want others to see.
2. Click  at the bottom of the dashboard.
3. Select **Image** on the shortcut menu.

4. In the Export Image dialog box, click **Download**.

5. In the File Download dialog box, do either of the following:
   - Click **Save**. In the Save As dialog box, select the location to which you want to save
     the file, enter a file name, and click **Save**.
   - Click **Open** to open the image in your default application for working with .PNG files.

---

**Export a Dashboard as a .PDF File**

If you want others to see a particular version of dashboard data, you can export the dashboard in an Adobe Acrobat Portable Document Format (.PDF) file and then, for example, distribute it by email, annotate it in Acrobat, or print it.

**To export a dashboard as a .PDF file, complete the following steps:**

1. Interact with the dashboard to display the version of the data that you want others to see.

2. Click 🖥️ at the bottom of the dashboard.

3. Select **PDF** on the shortcut menu to display the Export PDF dialog box.

4. In **Layout**, click **Portrait** or **Landscape** to indicate the orientation you want.

5. In **Paper Size**, select the size of paper on which you want to print the dashboard.

6. In **Scaling**, indicate if you want the dashboard image scaled automatically, scaled by a percentage you select, or scaled based on paper height or width.

7. In **Content**, do one of the following:
   - Select **This Dashboard** to include the entire dashboard in the .PDF file.
   - Select **Sheets in Dashboard** to include only one or more selected charts. Select the charts you want in **Sheets to Export**.

8. If you selected Sheets in Dashboard in Content, select the charts you want in Sheets to Export.

9. Click **Export**.

10. When a message displays that indicates that the PDF file has been created, click **Download**.

11. In the File Download dialog box, do either of the following:
   - Click **Save**. In the Save As dialog box, select the location to which you want to save
     the file, enter a file name, and click **Save**.
   - Click **Open** to open the file in your default application for working with .PDF files.

---

**Remove All Filters and Selections for a Dashboard**

Normally, you apply filters to a dashboard and make selections on the charts to focus your view of the data. However, you can use the Revert All icon to view the data with no filters or selections applied. That includes any automatic filters (for example the filter on Project Manager Sample dashboards that only includes data for projects for which you are the project manager).
The Revert option does not display the Original View or your default view (if different from the Original View). To display the Original View or a custom view, click Remember my changes at the bottom of the dashboard and select the view. You can also display the Original View by clicking the Refresh icon in the upper-right corner of the dashpart.

To remove all of the currently applied filters and selections for a dashboard, complete the following step:

1. Click 🔃 at the bottom of the dashboard.

   The dashboard displays without any filters or selections applied.

**Pause Automatic Updates**

To pause automatic updates for a dashboard, click the Pause Automatic Updates icon.

**To pause automatic updates for a dashboard, complete the following step:**

1. Click 🔄 at the bottom of the dashboard.

**Refresh Data for the Dashboard View**

If you think the displayed dashboard view does not reflect the current data in the Analysis Cubes, use the Refresh Data icon to load the current data for that view.

**To refresh data for the current dashboard view, complete the following step:**

1. Click 🔃 at the bottom of the dashboard.

**Select Filter Values**

Use the filter lists at the top of the dashboard to filter the data included on the dashboard. As you select values, Vision updates the dashboard based on your selections.

**To select filter values for a filter, complete the following steps:**

1. To display a list of filter values, click in the box under the filter name.

2. Do one or more of the following:
   - If **All** is selected and you want to select just a few filter values, click **All** to clear all filter values.
   - To select one or more filter values, click each value.
   - To clear one or more filter values, click each value you want to clear.
   - To include all possible filter values, click **All**.

3. To close the filter list, click in the box under the filter name.

**Search for a Filter Value**

Some filter lists contain many values. In those cases, you can search for the values you want to select.
To search for a value in a filter list, complete the following steps:

1. To clear all selected values before you search for the value you want, do one of the following:
   - If All is not currently selected in the filter list, click All to select all values and then click it again to clear all values.
   - If All is currently selected in the filter list, click All once to clear all values.

2. Position the mouse pointer above the right end of the filter box to display the search icon:

3. Click the search icon.

4. Type one or more characters from the filter value you want to find.
   - As you type, a list of the filter values that contain the string of characters is displayed. That list include all values that contain the string of characters, regardless of the position of the string in the value. The characters need not appear at the beginning of the filter value.

5. When the value you want is displayed, click it to filter the dashboard based on that value.

6. Click X or press Esc to close the search list.

7. Click X or press Esc again to get out of search mode.

Show Fewer or More Filter Values

By default, each filter list displays all possible filter values, even if other filters you have applied make some of those values invalid. You have the option to exclude those invalid values from the list.

To limit the list of values for a filter to those that are valid based on other applied filters, complete the following steps:

1. Position the mouse pointer above the right end of the filter box to display the Show Fewer Values/Show More Values icon:

2. Click the Show Fewer Values/Show More Values icon.

3. To restore all possible values to the filter list, click the Show Fewer Values/Show More Values icon again.

Drill Down to More Detailed Data

For many charts and tables, you can drill down from higher level data to more detailed data.

To drill down to more detailed data, complete the following steps:

1. To display the Drill Down icon, position the mouse pointer in the heading information for the dimension from which you want to drill down.
2. Click $\text{+}$.

3. To reverse the drill down and again display data at a higher level, position the mouse pointer in the heading information for the original level to display $\equiv$, and click that icon.
Vision Performance Management — Sample Performance Dashboards

Sample Performance Dashboards Overview

Vision provides a set of sample performance dashboards that you can use as examples of the capabilities of performance dashboards and as a starting point for building your own dashboards. Each set is designed for a specific management and responsibility role in your firm, from corporate executives to project managers.

After you complete the installation and implementation processes, you can display the sample performance dashboards from Vision. However, because they are not tailored for your data (your work breakdown structure or organization structure, for example) and for your specific business intelligence needs, you will want to modify them or create additional performance dashboards.

The sample performance dashboards are designed based on the following assumptions:

- The organization structure has two levels.
- The work breakdown (project) structure has three levels.
- Both the Principal field and the Project Manager fields are being used for their intended purpose.
- The Multicompany feature is not enabled. If you are using the Multicompany feature, you can display the sample dashboards, but you must apply an organization filter if you want the data to be meaningful.

Though it is unlikely that you will be able to use any of the sample performance dashboards without making at least some modifications, the dashboards, when published, do automatically use the Vision system labels that you specify for your firm on the Labels tab of the General System Settings form (Configuration » General » System Settings).

For the most part, the roles with which the sample dashboards are associated are just labels to suggest the appropriate users for each set of dashboards. They do not correspond to actual roles established in Vision. The exceptions are the project manager and principal roles. The dashboards for those roles are automatically filtered to display only data for projects for which the user is identified as the project manager or principal in Vision.)

Business Development Manager Performance Dashboards

The business development manager performance dashboards help the business development manager monitor progress against goals, assess marketing efforts, and forecast future sales.

- BD Manager Sample – Pipeline Revenue
- BD Manager Sample – Promotional Costs
- BD Manager Sample – Opportunity Wins and Projections

Executive Performance Dashboards

The executive performance dashboards provide an enterprise-wide view. These dashboards display metrics that focus on overall company health.

- Executive Sample – Project Status
- Executive Sample – Days Outstanding Metrics
- Executive Sample – Accounts Receivable and Promotional Costs
- Executive Sample – Opportunity Wins and Projections
- Executive Sample – Utilization and Realization
- Executive Sample – Pipeline Revenue
- Executive Sample – Revenue Analysis
- Executive Sample – Trends and Multipliers
- Executive Sample – Profit Drilldown

**Finance Performance Dashboards**

The Finance performance dashboards provide a graphical view of data available on an income statement or balance sheet. Use these performance dashboards to compare trends over time.

- Finance Sample – Balance Sheet
- Finance Sample – Income Charts

**Organization Manager Performance Dashboards**

The Organization Manager performance dashboards are designed for those who are responsible for the financial performance of an organization, for the profitability of projects within that organization, and for the utilization of employees assigned to that organization. Vision automatically filters the data for these performance dashboards to include only the projects assigned to the top-level organization level to which the user is assigned.

- Organization Manager Sample – Project Status
- Organization Manager Sample – Days Outstanding Metrics
- Organization Manager Sample – AR Trending
- Organization Manager Sample – Opportunity Wins and Projections
- Organization Manager Sample – Pipeline Revenue
- Organization Manager Sample – Charts at Billing
- Organization Manager Sample – Charts at Cost
- Organization Manager Sample – Profit Drilldown
- Organization Manager Sample – Variance Drilldown

**Principal Performance Dashboards**

The Principal performance dashboards are designed for those responsible for a group of project managers and for the successful completion of a group of projects. Vision automatically filters the project data for these dashboards to include only the projects to which the user is assigned as principal.

- Principal Sample – Project Status
- Principal Sample – Days Outstanding Metrics
- Principal Sample – AR Trending
- Principal Sample – Pipeline Revenue
- Principal Sample – Opportunity Wins and Projections
- Principal Sample – Charts at Billing
- Principal Sample – Charts at Cost
- Principal Sample – Profit Drilldown
- Principal Sample – Variance Drilldown

**Project Manager Performance Dashboards**

The Project Manager performance dashboards are designed for those responsible for the successful and profitable completion of projects. Vision automatically filters the data for these performance dashboards to include only the projects for which the current Vision user is the project manager.

- Project Manager Sample – Project Status
- Project Manager Sample – Days Outstanding Metrics
- Project Manager Sample – Project AR
- Project Manager Sample - Charts at Billing
- Project Manager Sample – Charts at Cost
- Project Manager Sample – Profit Drilldown
- Project Manager Sample – Variance Drilldown

**Resource Manager Performance Dashboards**

The resource manager performance dashboards help the resource manager make good hiring and firing decisions, determine recipients of promotions and bonuses, and identify projects that are overstaffed or understaffed and shift resources to correct staffing imbalances.

- Resource Manager Sample – Pipeline Revenue
- Resource Manager Sample – Utilization and Realization
- Resource Manager Sample – Opportunity Wins and Projections

**BD Manager Sample – Pipeline Revenue Performance Dashboard**

The BD Manager Sample – Pipeline Revenue performance dashboard contains the Pipeline Revenue chart. That chart enables you to view historical revenue trends while projecting future workload based on data from the Planning module.

**Pipeline Revenue Chart**

The Pipeline Revenue chart displays a stacked bar for each year and level 1 organization. Each bar segment represents either the actual amount billed or the total planned compensation.

For comparison, the chart also displays a black broken line across each bar that represents the organization revenue target.

The Pipeline Revenue chart illustrates how you can use multiple measures on the same chart.

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Type</td>
<td>Bar Chart</td>
</tr>
<tr>
<td>Measures</td>
<td>Billed</td>
</tr>
<tr>
<td></td>
<td>Plan Total Compensation Billing</td>
</tr>
</tbody>
</table>
Use the Key Performance Indicators tab of the Analysis Cubes form in Vision (Configuration » General » Analysis Cubes) to specify target values for the RevenueTargetProjectOrg1 KPI. (The performance dashboards will not display the targets you specify until you use the Vision Resource Kit to update the Analysis Cubes to include those targets.)

**Filter Options**

You can filter the project data for this performance dashboard based on any or all of the following:

- One or two organization levels (depending on Vision Performance Management configuration)
- Project type
- Client
- Project manager
- Project principal
- Project charge type (Default: Regular)
- Project status
- Transaction year (Default: most recent three years)

**BD Manager Sample – Promotional Costs Performance Dashboard**

The BD Manager Sample – Promotional Costs performance dashboard enables you to track expenditures on marketing efforts.

**Promotional Costs by Client Type Chart**

Each chart line on the Promotional Costs by Client Type chart represents the amounts spent on promotional projects for a specific client type for the fiscal years you select. You can use this chart to evaluate your expenditures on marketing efforts, broken down by type of client.

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Type</td>
<td>Line Chart</td>
</tr>
<tr>
<td>Measures</td>
<td>Promotional Spent at Cost</td>
</tr>
<tr>
<td>Drill Down</td>
<td>From fiscal year to quarter to period</td>
</tr>
</tbody>
</table>

**Automatic Filters**

Vision automatically filters the data to only include projects with the Promotional charge type.
Filter Options
You can filter the project data for this performance dashboard based on any or all of the following:

- One or two organization levels (depending on Vision Performance Management configuration)
- Fiscal year (Default: most recent three years)

BD Manager Sample – Opportunity Wins and Projections Performance Dashboard
The BD Manager Sample – Opportunity Wins and Projections performance dashboard helps you compare the projected revenue associated with opportunities to your revenue targets.

Wins and Projections from Opportunities Chart
Each chart bar in the Wins and Projections from Opportunities chart represents the total revenue that is associated with opportunities for the indicated level 1 organization that have an estimated start date in the year indicated. Each segment of the bar represents the revenue associated with opportunities currently assigned to that opportunity stage.

For comparison, the chart also displays a black broken line across each bar that represents the target revenue amount for each organization and time period.

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Type</td>
<td>Stacked Bar Chart</td>
</tr>
<tr>
<td>Measures</td>
<td>Opportunity Revenue</td>
</tr>
<tr>
<td>Key Performance Indicator (KPI)</td>
<td>OpportunitySalesTargetOrg1</td>
</tr>
<tr>
<td>Drill Down</td>
<td>From calendar year to quarter to month</td>
</tr>
</tbody>
</table>

Use the Key Performance Indicators tab of the Analysis Cubes form in Vision (Configuration » General » Analysis Cubes) to specify target values for the OpportunitySalesTargetOrg1 KPI. (The performance dashboards will not display the targets you specify until you use the Vision Resource Kit to update the Analysis Cubes to include those targets.)

Filter Options
You can filter the opportunity data for this performance dashboard based on any or all of the following:

- One or two organization levels (depending on Vision Performance Management configuration)
- Opportunity client
- Opportunity stage
- Opportunity type
- Transaction year (Default: most recent three years)
Executive Sample – Project Status Performance Dashboard

The Executive Sample – Project Status performance dashboard helps you monitor performance of labor billing against budget for your firm.

Project Budget

Use the Project Budget table to view comparisons of actual, budgeted, and projected financial indicators. This table illustrates how you can use multiple measures in the same table.

To make full use of this table, you must have the Planning module. If you do not have Planning, the table only displays data for the **Labor Total Billing** and **AR Over 60** measures.

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Chart Type</strong></td>
<td>Table</td>
</tr>
</tbody>
</table>
| **Measures**   | Baseline Labor Billing  
                 Labor Total Billing  
                 EAC Labor Billing  
                 Total Baseline – EAC Labor Billing  
                 EAC Multiplier Billing  
                 AR Over 60: Calculated as AR Balance 61-90 + AR Balance 91-120 + AR Balance Over 120 |
| **Drill Down** | From organization level 1 to organization level 2 to principal to project manager |

Only actual hours for the current active period are used in the calculation of EAC data in the Project Budget table. In other words, EAC does not include planned hours for the current period.

Filter Options

You can filter the project data for the Project Budget table based on any or all of the following:

- One or two organization levels (depending on Vision Performance Management configuration)
- Project type
- Project charge type (Default: Regular)
- Project status
- Project primary client
- Project principal
- Project manager
Executive Sample – Days Outstanding Metrics Performance Dashboard

The Executive Sample – Days Outstanding Metrics performance dashboard contains two charts that help you monitor days sales outstanding (DSO) and days WIP outstanding (DWO for your firm.

Days Sales Outstanding

Use the Days Sales Outstanding chart to view DSO for the 90-day period preceding the most recent selected period, and compare that value to the target value:

\[
DSO = \frac{Accounts\ Receivable\ Balance}{(Revenue\ Total\ for\ the\ last\ 90\ transaction\ days / 90)}
\]

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Type</td>
<td>Bullet Chart</td>
</tr>
<tr>
<td>Chart Components</td>
<td>Black horizontal bar — DSO value for past 90 days</td>
</tr>
<tr>
<td></td>
<td>Black vertical bar — DSO target value</td>
</tr>
<tr>
<td></td>
<td>Shaded areas — 0 – 60% of target, 60 – 80% of target, 80 – 100+% of target</td>
</tr>
<tr>
<td>Measures</td>
<td>DSO 90</td>
</tr>
<tr>
<td>Key Performance Indicator (KPI)</td>
<td>DSOTargetNoDimension</td>
</tr>
<tr>
<td>Drill Down</td>
<td>None</td>
</tr>
</tbody>
</table>

Use the Key Performance Indicators tab of the Analysis Cubes form in Vision (Configuration » General » Analysis Cubes) to specify target values for the DSOTargetNoDimension KPI. (The performance dashboards will not display the targets you specify until you use the Vision Resource Kit to update the Analysis Cubes to include those targets.)

Days WIP Outstanding

Use the Days WIP Outstanding chart to view DWO for the 90-day period preceding the most recent selected period, and compare that value to the target value:

\[
DWO = \frac{Unbilled\ Total}{(Revenue\ Total\ for\ the\ last\ 90\ transaction\ days/90)}
\]

The Standard Edition of Microsoft SQL Server 2008/2008 R2 does not support this chart. You must have the Enterprise Edition. If you have the Standard Edition, the dashboard does not display this chart.
<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Type</td>
<td>Bullet Chart</td>
</tr>
<tr>
<td>Chart Components</td>
<td><strong>Black horizontal bar</strong> — DWO value for past 90 days</td>
</tr>
<tr>
<td></td>
<td><strong>Black vertical bar</strong> — DWO target value</td>
</tr>
<tr>
<td></td>
<td><strong>Shaded areas</strong> — 0 – 60% of target, 60 – 80% of target, 80 – 100% of target</td>
</tr>
<tr>
<td>Measures</td>
<td>DWO 90</td>
</tr>
<tr>
<td>Key Performance Indicator (KPI)</td>
<td>DWOTargetNoDimension</td>
</tr>
<tr>
<td>Drill Down</td>
<td>None</td>
</tr>
</tbody>
</table>

Use the Key Performance Indicators tab of the Analysis Cubes form in Vision (Configuration » General » Analysis Cubes) to specify target values for the DWOTargetNoDimension KPI. (The performance dashboards will not display the targets you specify until you use the Vision Resource Kit to update the Analysis Cubes to include those targets.)

**Filter Options**

You can filter the project data for the Days Sales Outstanding and Days WIP Outstanding charts based on any or all of the following:

- One or two organization levels (depending on Vision Performance Management configuration)
- Project type
- Project primary client
- Project principal
- Project manager
- Fiscal year (Default: most recent fiscal year)

**Executive Sample – Accounts Receivable and Promotional Costs**

The Executive Sample – Promotional Costs and AR Trending performance dashboard contains two charts that enable you to track expenditures on marketing efforts and evaluate trends in your accounts receivable balance.

**Promotional Costs by Client Type Chart**

Each chart line on the Promotional Costs by Client Type chart represents the amounts spent on promotional projects for a specific client type for the fiscal years you select. You can use this chart to evaluate your expenditures on marketing efforts, broken down by type of client.
### AR Trend Chart

Each chart line on the AR Trend chart represents the trend of the accounts receivable balance for one of your aging categories as of the end of each year you select. You can use this chart to track your success in reducing AR over time.

If you are using the credit memo feature, the chart includes a chart line for credit memo amounts.

The AR Trend chart illustrates how you can use multiple measures on the same chart.

---

**The Standard Edition of Microsoft SQL Server 2008/2008 R2 does not support this chart. You must have the Enterprise Edition. If you have the Standard Edition, the dashboard does not display this chart, and the name of the dashboard is Executive Sample – Promotional Costs.**

---

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Chart Type</strong></td>
<td>Line Chart</td>
</tr>
<tr>
<td><strong>Measures</strong></td>
<td>Promotional Spent at Cost</td>
</tr>
<tr>
<td><strong>Drill Down</strong></td>
<td>From fiscal year to quarter to period</td>
</tr>
</tbody>
</table>

#### Credit Memo Amounts

Credit memo amounts tend to be small compared to AR balances, making it difficult to tell, from the AR Trend chart, what the actual amounts are. To display an amount, position the mouse pointer on that data point on the chart.

#### Automatic Filters

Vision automatically filters the data for the Promotional Costs by Client Type chart to only include projects with the Promotional charge type. That filter does not affect the AR Trend chart, however.
Filter Options
You can filter the dashboard data based on any or all of the following:

- One or two organization levels (depending on Vision Performance Management configuration)
- Project principal
- Project manager
- Project type
- Project billing client
- Fiscal year (Default: most recent three years)

Executive Sample – Opportunity Wins and Projections Performance Dashboard
The Executive Sample – Opportunity Wins and Projections performance dashboard helps you compare the projected revenue associated with opportunities to your revenue targets.

Wins and Projections from Opportunities Chart
Each chart bar in the Wins and Projections from Opportunities chart represents the total revenue associated with opportunities that have an estimated start date in the year indicated. Each segment of the bar represents the revenue associated with opportunities currently assigned to that opportunity stage.

For comparison, target revenue amounts for each time period are displayed as a superimposed broken line.

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Type</td>
<td>Stacked Bar Chart</td>
</tr>
<tr>
<td>Measures</td>
<td>Opportunity Revenue</td>
</tr>
<tr>
<td>Key Performance Indicator (KPI)</td>
<td>OpportunitySalesTargetNoDimension</td>
</tr>
<tr>
<td>Drill Down</td>
<td>From calendar year to quarter to month</td>
</tr>
</tbody>
</table>

Use the Key Performance Indicators tab of the Analysis Cubes form in Vision (Configuration » General » Analysis Cubes) to specify target values for the OpportunitySalesTargetNoDimension KPI. (The performance dashboards will not display the targets you specify until you use the Vision Resource Kit to update the Analysis Cubes to include those targets.)

Filter Options
You can filter the opportunity data for this performance dashboard based on any or all of the following:

- One or two organization levels (depending on Vision Performance Management configuration)
- Opportunity client
Executive Sample – Utilization and Realization Performance Dashboard

The Executive Sample – Utilization and Realization performance dashboard enables you to monitor actual labor utilization and realization, compare actual labor utilization to planned utilization, and review planned utilization for future time periods.

Utilization and Realization Chart

The Utilization and Realization chart displays the following for each calendar year:

- A bar for actual utilization rate (Direct hours / Standard hours)
- A bar for actual realization rate (Labor realization hours / Standard hours)
- A data point for the planned utilization rate

The chart only displays values for **Standard Planned Billable Utilization** if you have the Planning module.

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Type</td>
<td>Bar Chart</td>
</tr>
<tr>
<td>Measures</td>
<td>Direct Over Standard Hours</td>
</tr>
<tr>
<td></td>
<td>Labor Realization Over Standard Hours</td>
</tr>
<tr>
<td></td>
<td>Standard Planned Billable Utilization</td>
</tr>
<tr>
<td>Drill Down</td>
<td>From calendar year to quarter to month</td>
</tr>
</tbody>
</table>

Filter Options

You can filter the data for this performance dashboard based on any or all of the following:

- One or two organization levels (depending on Vision Performance Management configuration)
- Employee
- Employee labor category
- Employee status
- Transaction year (Default: most recent three years)
## Executive Sample – Pipeline Revenue Performance Dashboard

The Executive Sample – Pipeline Revenue performance dashboard enables you to view historical revenue trends while projecting future workload based on data from the Planning module.

### Pipeline Revenue Chart

The Pipeline Revenue chart displays a stacked bar for each year and level 1 organization. Each bar segment represents either the actual amount billed or the total planned compensation.

For comparison, the chart also displays a black broken line across each bar that represents the organization revenue target.

The Pipeline Revenue chart illustrates how you can use multiple measures on the same chart.

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Type</td>
<td>Bar Chart</td>
</tr>
<tr>
<td>Measures</td>
<td>Billed</td>
</tr>
<tr>
<td></td>
<td>Plan Total Compensation Billing</td>
</tr>
<tr>
<td>Key Performance Indicator (KPI)</td>
<td>RevenueTargetProjectOrg1</td>
</tr>
<tr>
<td>Drill Down</td>
<td>From calendar year to quarter to month</td>
</tr>
</tbody>
</table>

Use the Key Performance Indicators tab of the Analysis Cubes form in Vision ([Configuration » General » Analysis Cubes](#)) to specify target values for the `RevenueTargetProjectOrg1` KPI. (The performance dashboards will not display the targets you specify until you use the Vision Resource Kit to update the Analysis Cubes to include those targets.)

### Filter Options

You can filter the project data for this performance dashboard based on any or all of the following:

- One or two organization levels (depending on Vision Performance Management configuration)
- Project type
- Project client
- Project manager
- Project principal
- Project charge type (Default: Regular)
- Project status
- Transaction year (Default: most recent three years)

## Executive Sample – Revenue Analysis Performance Dashboard

The Executive Sample – Revenue Analysis performance dashboard contains three key revenue-centered metrics for the company.
Cash Receipts by Organization Level 1 Chart

Each bar on this chart represents the cash receipts amount for an organization or, if you drill down, for a principal or project manager.

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Type</td>
<td>Bar Chart</td>
</tr>
<tr>
<td>Measures</td>
<td>Received</td>
</tr>
<tr>
<td>Drill Down</td>
<td>From organization level 1 to organization level 2 to principal to project manager</td>
</tr>
</tbody>
</table>

Gross Margin by Project Type Chart

Each bar on this chart represents the gross margin amount for a project type.

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Type</td>
<td>Bar Chart</td>
</tr>
<tr>
<td>Measures</td>
<td>Gross Margin</td>
</tr>
<tr>
<td>Drill Down</td>
<td>None</td>
</tr>
</tbody>
</table>

Revenue Analysis at Cost Chart

Each pair of bars on this chart represents total revenue and labor cost. The + data points reference the Gross Margin Percent scale on the right axis to indicate the gross margin percentages.

The Revenue Analysis at Cost chart illustrates how you can use multiple measures on the same chart.

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Type</td>
<td>Dual Axis Bar Chart</td>
</tr>
<tr>
<td>Measures</td>
<td>Left axis: Revenue, Labor Total Cost Right axis: Gross Margin Percent (+)</td>
</tr>
<tr>
<td>Drill Down</td>
<td>From fiscal year to quarter to period</td>
</tr>
</tbody>
</table>

Automatic Filter

Vision automatically filters the data to only include projects with the Regular charge type.

Filter Options

You can filter the project data for this performance dashboard based on any or all of the following:

- One or two organization levels (depending on Vision Performance Management configuration)
- Project type
- Project manager
- Project status
- Fiscal year (Default: most recent three years)

**Chart Selections as Filters**
When you click on a data point on one of the charts, the other charts are filtered also based on the dimension associated with that data point.

<table>
<thead>
<tr>
<th>Chart</th>
<th>Chart Selection Filters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cash Receipts by Organization Level 1</td>
<td>Organization level 1&lt;br&gt;<strong>Other filters available when you drill down:</strong>&lt;br&gt;Organization level 2, principal, project manager</td>
</tr>
<tr>
<td>Gross Margin by Project Type</td>
<td>Project type</td>
</tr>
<tr>
<td>Revenue Analysis at Cost</td>
<td>Fiscal year&lt;br&gt;<strong>Other filters available when you drill down:</strong>&lt;br&gt;Fiscal quarter, fiscal period</td>
</tr>
</tbody>
</table>

**Executive Sample – Trends and Multipliers Performance Dashboard**
The Executive Sample – Trends and Multipliers performance dashboard provides three charts you can use to monitor effective multipliers and profit percentages and to review trends for a number of additional key metrics for your firm.

**Effective Multiplier Chart**
The Effective Multiplier chart compares the current effective multiplier value for the selected years to the target multiplier value.

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Type</td>
<td>Bullet Chart</td>
</tr>
<tr>
<td>Chart Components</td>
<td>Black horizontal bar — Effective multiplier value&lt;br&gt;Black vertical bar — Effective multiplier target value&lt;br&gt;Shaded areas — 0 – 60% of target, 60 – 80% of target, 80 – 100+% of target</td>
</tr>
<tr>
<td>Measures</td>
<td>Effective Multiplier</td>
</tr>
<tr>
<td>Key Performance Indicator (KPI)</td>
<td>EffectiveMultiplierNoDimension</td>
</tr>
</tbody>
</table>
### Profit Percent Chart

The Profit Percent chart compares the current profit percentage for the selected years to the target percentage.

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Type</td>
<td>Bullet Chart</td>
</tr>
<tr>
<td>Chart Components</td>
<td>Black horizontal bar — Profit percent excluding overhead</td>
</tr>
<tr>
<td></td>
<td>Black vertical bar — Profit percent excluding overhead target</td>
</tr>
<tr>
<td></td>
<td>Shaded areas — 0 - 60% of target percentage, 60 - 80% of target percentage, 80 – 100+% of target percentage</td>
</tr>
<tr>
<td>Measures</td>
<td>Profit Percent</td>
</tr>
<tr>
<td>Key Performance Indicator (KPI)</td>
<td>ProfitPercentNoDimension</td>
</tr>
</tbody>
</table>

Vision does not include overhead in the calculation of values for the Profit Percent measure.

Use the Key Performance Indicators tab of the Analysis Cubes form in Vision (Configuration » General » Analysis Cubes) to specify company target values for the ProfitPercentNoDimension KPI. (The performance dashboards will not display the targets you specify until you use the Vision Resource Kit to update the Analysis Cubes to include those targets.)

### Trend Analysis at Cost Chart

The Trend Analysis at Cost chart is a collection of small line charts that tracks the change in the value, over time, of several key metrics. The values are based on cost rates.

This chart illustrates how you can use multiple measures on the same chart.

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Type</td>
<td>Line chart collection</td>
</tr>
<tr>
<td>Measures</td>
<td>Revenue</td>
</tr>
</tbody>
</table>
### Executive Sample – Profit Drilldown Performance Dashboard

The Executive Sample – Profit Drilldown performance dashboard compares revenue, labor total cost, expense total cost, and gross margin by organization.

#### Profit Drilldown by Organization Level 1 Chart

Each bar on this chart includes a layer for revenue, labor total cost, expense total cost, and gross margin. For further analysis, you can drill down from organization as far as the project manager level.

This performance dashboard provides a good example of how you can set up multiple drill-down levels.

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Type</td>
<td>Layered Bar Chart</td>
</tr>
<tr>
<td>Measures</td>
<td>Revenue, Labor Total Cost, Expense Cost, Gross Margin</td>
</tr>
</tbody>
</table>
### Automatic Filter

Vision automatically filters the data to only include projects with the Regular charge type.

### Filter Options

You can filter the project data for this performance dashboard based on any or all of the following:

- One or two organization levels (depending on Vision Performance Management configuration)
- Project type
- Project manager
- Project status
- Fiscal year (Default: most recent three years)

### Finance Charts Sample – Balance Sheet Charts Performance Dashboard


#### Total by Balance Sheet Account Type Chart

The Total by Balance Sheet Account Type bar chart displays a bar for each account type and fiscal year combination. Each bar represents the total closing balances for accounts of the indicated type.

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Type</td>
<td>Bar Chart</td>
</tr>
<tr>
<td>Measures</td>
<td>Balance Closing</td>
</tr>
<tr>
<td>Drill Down</td>
<td>From fiscal year to quarter to period</td>
</tr>
</tbody>
</table>

#### Total Balance Sheet Account Type Chart

The Total Balance Sheet Account Type line chart displays the total closing balance trend for balance sheet accounts over the indicated fiscal years.

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Type</td>
<td>Line Chart</td>
</tr>
<tr>
<td>Measures</td>
<td>Balance Closing</td>
</tr>
<tr>
<td>Characteristic</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Drill Down</td>
<td>From fiscal year to quarter to period</td>
</tr>
</tbody>
</table>

**Balance Sheet Account Type Table**

The Balance Sheet Account Type table provides the actual closing balance total amounts by fiscal year and account type. You can drill down from account type to account as well as from fiscal year to quarter or period.

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Type</td>
<td>Table</td>
</tr>
<tr>
<td>Measures</td>
<td>Balance Closing</td>
</tr>
<tr>
<td>Drill Down</td>
<td>From fiscal year to quarter to period</td>
</tr>
<tr>
<td></td>
<td>From account type to account number</td>
</tr>
</tbody>
</table>

**Automatic Filter**

Vision automatically filters the data to only include accounts with one of the following account types: Asset, Liability, or Net Worth.

**Filter Options**

You can filter the account data for this performance dashboard based on any or all of the following:

- Balance sheet account type (Asset, Liability, and Net Worth)
- Fiscal year (Default: most recent three years)

**Chart Selections as Filters**

When you interact with a chart or table, other objects may be filtered also. For example, if you click on one of the bars in the Total by Balance Sheet Account Type chart, the entire dashboard is filtered based on the account type and fiscal year associated with that bar.

**Finance Charts Sample – Income Charts Performance Dashboard**


**Total by Income Account Type Chart**

The Total by Income Account Type bar chart displays a bar for each account type and fiscal year combination. Each bar represents the total closing balances for accounts of the indicated type.
<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Type</td>
<td>Bar Chart</td>
</tr>
<tr>
<td>Measures</td>
<td>Amount</td>
</tr>
<tr>
<td>Drill Down</td>
<td>From fiscal year to quarter to period</td>
</tr>
</tbody>
</table>

**Total Income Account Type by Organization Level 1 Chart**

The Total Income Account Type by Organization Level 1 bar chart displays the total closing balances for all income statement accounts by organization and fiscal year.

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Type</td>
<td>Line Chart</td>
</tr>
<tr>
<td>Measures</td>
<td>Amount</td>
</tr>
<tr>
<td>Drill Down</td>
<td>From fiscal year to quarter to period</td>
</tr>
</tbody>
</table>

**Income Account Type Table**

The Income Account Type table provides the actual closing balance total amounts by fiscal year and account type. You can drill down from account type to account as well as from fiscal year to quarter or period.

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Type</td>
<td>Table</td>
</tr>
<tr>
<td>Measures</td>
<td>Amount</td>
</tr>
<tr>
<td>Drill Down</td>
<td>From fiscal year to quarter to period From account type to account number</td>
</tr>
</tbody>
</table>

**Automatic Filter**

Vision automatically filters the data to only include accounts with one of the following account types: Revenue, Reimbursable Consultant, Reimbursable, Direct Consultant, Direct, Indirect, or Other Charges.

**Filter Options**

You can filter the account data for this performance dashboard based on any or all of the following filters:

- One or two organization levels (depending on Vision Performance Management configuration)
- Income statement account type (Revenue, Reimbursable Consultant, Reimbursable, Direct Consultant, Direct, Indirect, and Other Charges)
- Fiscal year (Default: most recent three years)

**Chart Selections as Filters**

When you click on a data point on one of the charts, the other charts are filtered also based on the dimension associated with that data point.

<table>
<thead>
<tr>
<th>Chart</th>
<th>Chart Selection Filters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total by Income Account Type</td>
<td>Account type or fiscal year</td>
</tr>
<tr>
<td>Total Income Account Type by Organization Level 1</td>
<td>Fiscal year or organization level 1</td>
</tr>
<tr>
<td>Income Account Type</td>
<td>Fiscal year or organization level 1</td>
</tr>
</tbody>
</table>

**Organization Manager Sample – Project Status Performance Dashboard**

The Organization Manager Sample – Project Status performance dashboard helps you monitor performance of labor billing against budget for your organization.

**Project Budget**

Use the Project Budget table to view comparisons of your current actual, budgeted, and projected financial indicators. This table illustrates how you can use multiple measures in the same table.

To make full use of this table, you must have the Planning module. If you do not have Planning, the table only displays data for the **Labor Total Billing** and **AR Over 60** measures.

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Type</td>
<td>Table</td>
</tr>
<tr>
<td>Measures</td>
<td>Baseline Labor Billing</td>
</tr>
<tr>
<td></td>
<td>Labor Total Billing</td>
</tr>
<tr>
<td></td>
<td>EAC Labor Billing</td>
</tr>
<tr>
<td></td>
<td>Total Baseline – EAC Labor Billing</td>
</tr>
<tr>
<td></td>
<td>EAC Multiplier Billing</td>
</tr>
<tr>
<td></td>
<td><strong>AR Over 60</strong>: Calculated as $AR Balance 61-90 + AR Balance 91-120 + AR Balance Over 120</td>
</tr>
<tr>
<td>Drill Down</td>
<td>From project manager through the lowest work breakdown structure level</td>
</tr>
</tbody>
</table>

Only actual hours for the current active period are used in the calculation of EAC data in the Project Budget table. In other words, EAC does not include planned hours for the current period.
**Automatic Filter**

Vision automatically filters the data to only include project data for the top-level organization to which the current Vision user is assigned in the Employee Info Center. ("Top-level organization" is an organization at the highest organization level selected as a filter option in Vision Performance Management configuration.)

**Filter Options**

You can filter the project data for the Project Budget table based on any or all of the following:

- One organization level (depending on Vision Performance Management configuration)
- Project type
- Project status
- Project primary client
- Project manager
- Project principal
- Project charge type (Default: Regular)

**Organization Manager Sample – Days Outstanding Metrics Performance Dashboard**

The Organization Manager Sample – Days Outstanding Metrics performance dashboard contains two charts that help you monitor days sales outstanding (DSO) and days WIP outstanding (DWO) for your organization.

**Days Sales Outstanding**

Use the Days Sales Outstanding chart to view DSO for the 90-day period preceding the most recent selected period, and compare that value to the target value:

DSO = Accounts Receivable Balance / (Revenue Total for the last 90 transaction days / 90)

The Standard Edition of Microsoft SQL Server 2008/2008 R2 does not support this chart. You must have the Enterprise Edition. If you have the Standard Edition, the dashboard does not display this chart.

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Type</td>
<td>Bullet Chart</td>
</tr>
<tr>
<td>Chart Components</td>
<td><strong>Black horizontal bar</strong> — DSO value for past 90 days</td>
</tr>
<tr>
<td></td>
<td><strong>Black vertical bar</strong> — DSO target value</td>
</tr>
<tr>
<td></td>
<td><strong>Shaded areas</strong> — 0 – 60% of target, 60 – 80% of target, 80 – 100% of target</td>
</tr>
<tr>
<td>Measures</td>
<td>DSO 90</td>
</tr>
<tr>
<td>Key Performance Indicator (KPI)</td>
<td>DSOTargetOrg1</td>
</tr>
</tbody>
</table>
Use the Key Performance Indicators tab of the Analysis Cubes form in Vision (Configuration » General » Analysis Cubes) to specify target values for the DSOTargetOrg1 KPI. (The performance dashboards will not display the targets you specify until you use the Vision Resource Kit to update the Analysis Cubes to include those targets.)

**Days WIP Outstanding**

Use the Days WIP Outstanding chart to view DWO for the 90-day period preceding the most recent selected period, and compare that value to the target value:

\[
DWO = \frac{\text{Unbilled Total}}{\text{(Revenue Total for the last 90 transaction days / 90)}}
\]

The Standard Edition of Microsoft SQL Server 2008/2008 R2 does not support this chart. You must have the Enterprise Edition. If you have the Standard Edition, the dashboard does not display this chart.

Use the Key Performance Indicators tab of the Analysis Cubes form in Vision (Configuration » General » Analysis Cubes) to specify target values for the DWOTargetOrg1 KPI. (The performance dashboards will not display the targets you specify until you use the Vision Resource Kit to update the Analysis Cubes to include those targets.)

**Automatic Filter**

Vision automatically filters the data to only include project data for the top-level organization to which the current Vision user is assigned in the Employee Info Center. (“Top-level organization” is an organization at the highest organization level selected as a filter option in Vision Performance Management configuration.)

**Filter Options**

You can filter the project data for the Days Sales Outstanding and Days WIP Outstanding charts based on any or all of the following:
- One organization level (depending on Vision Performance Management configuration)
- Project type
- Project manager
- Project primary client
- Fiscal year (Default: most recent fiscal year)

**Organization Manager Sample – AR Trending Performance Dashboard**

The Organization Manager Sample – AR Trending performance dashboard contains a chart that enables you to evaluate trends in your accounts receivable balance.

**AR Trend Chart**

Each chart line on the AR Trend chart represents the trend of the accounts receivable balance for one of your aging categories as of the end of each year you select. You can use this chart to track your success in reducing AR over time.

If you are using the credit memo feature, the chart includes a chart line for credit memo amounts.

The AR Trend chart illustrates how you can use multiple measures on the same chart.

---

The Standard Edition of Microsoft SQL Server 2008/2008 R2 does not support this chart. You must have the Enterprise Edition. If you have the Standard Edition, this dashboard is not available.

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Chart Type</strong></td>
<td>Line Chart</td>
</tr>
</tbody>
</table>
| **Measures** | AR Over 30: Calculated as AR Balance 31-45 + AR Balance 46-60 + AR Balance 61-90 + AR Balance 91-120 + AR Balance Over 120  
AR Over 60: Calculated as AR Balance 61-90 + AR Balance 91-120 + AR Balance Over 120  
AR Over 90: Calculated as AR Balance 91-120 + AR Balance Over 120  
AR Over 120: Calculated as AR Balance Over 120  
Credit Memo Amount |
| **Drill Down** | From fiscal year to quarter to period |

Credit memo amounts tend to be small compared to AR balances, making it difficult to tell, from the AR Trend chart, what the actual amounts are. To display an amount, position the mouse pointer on that data point on the chart.
Automatic Filters
Vision automatically filters the data to only include data for the top-level organization to which the current Vision user is assigned in the Employee Info Center. ("Top-level organization" is an organization at the highest organization level selected as a filter option in Vision Performance Management configuration.)

Filter Options
You can filter the data for this dashboard based on any or all of the following:
- One organization level (depending on Vision Performance Management configuration)
- Project manager
- Project type
- Project billing client
- Fiscal year (Default: most recent three years)

Organization Manager Sample – Opportunity Wins and Projections Performance Dashboard
The Organization Manager Sample – Opportunity Wins and Projections performance dashboard helps you compare the projected revenue associated with opportunities to your revenue targets.

Wins and Projections from Opportunities Chart
Each chart bar in the Wins and Projections from Opportunities chart represents the total revenue associated with opportunities that are assigned to the manager's organization and that have an estimated start date in the year indicated. Each segment of the bar represents the revenue associated with opportunities currently assigned to that opportunity stage.

For comparison, target revenue amounts for each time period are displayed as a superimposed broken line.

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Type</td>
<td>Stacked Bar Chart</td>
</tr>
<tr>
<td>Measures</td>
<td>Opportunity Revenue</td>
</tr>
<tr>
<td>Key Performance Indicator (KPI)</td>
<td>OpportunitySalesTargetOrg1</td>
</tr>
<tr>
<td>Drill Down</td>
<td>From calendar year to quarter to month</td>
</tr>
</tbody>
</table>

Use the Key Performance Indicators tab of the Analysis Cubes form in Vision (Configuration » General » Analysis Cubes) to specify target values for the OpportunitySalesTargetOrg1 KPI. (The performance dashboards will not display the targets you specify until you use the Vision Resource Kit to update the Analysis Cubes to include those targets.)

Automatic Filters
Vision automatically filters the data to only include opportunities for the top-level organization to which the current Vision user is assigned in the Employee Info Center. ("Top-level organization" is
an organization at the highest organization level selected as a filter option in Vision Performance Management configuration.)

Filter Options
You can filter the opportunity data for this performance dashboard based on any or all of the following:

- One organization level (depending on Vision Performance Management configuration)
- Opportunity project manager
- Opportunity primary client
- Opportunity stage
- Opportunity type
- Transaction year (Default: most recent three years)

Organization Manager Sample – Pipeline Revenue Performance Dashboard
The Organization Manager Sample – Pipeline Revenue performance dashboard enables you to view historical revenue trends while projecting future workload based on data from the Planning module.

Pipeline Revenue Chart
The Pipeline Revenue chart displays a stacked bar for each year. Each bar segment represents either the actual amount billed or the total planned compensation.

For comparison, the chart also displays a black broken line across each bar that represents the revenue target for your top-level organization.

The Pipeline Revenue chart illustrates how you can use multiple measures on the same chart.

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Type</td>
<td>Bar Chart</td>
</tr>
<tr>
<td>Measures</td>
<td>Billed</td>
</tr>
<tr>
<td></td>
<td>Plan Total Compensation Billing</td>
</tr>
<tr>
<td>Key Performance Indicator (KPI)</td>
<td>RevenueTargetProjectOrg1</td>
</tr>
<tr>
<td>Drill Down</td>
<td>From calendar year to quarter to month</td>
</tr>
</tbody>
</table>

Use the Key Performance Indicators tab of the Analysis Cubes form in Vision (Configuration » General » Analysis Cubes) to specify target values for the RevenueTargetProjectOrg1 KPI. (The performance dashboards will not display the targets you specify until you use the Vision Resource Kit to update the Analysis Cubes to include those targets.)

Automatic Filters
Vision automatically filters the data to only include project data for the top-level organization to which the current Vision user is assigned in the Employee Info Center. (“Top-level organization” is
an organization at the highest organization level selected as a filter option in Vision Performance Management configuration.)

**Filter Options**

You can filter the project data for this performance dashboard based on any or all of the following:

- One organization level (depending on Vision Performance Management configuration)
- Project type
- Project client
- Project principal
- Project manager
- Project charge type (Default: Regular)
- Project status
- Transaction year (Default: most recent three years)

**Organization Manager Sample – Charts at Billing Performance Dashboard**

The Organization Manager Sample – Charts at Billing performance dashboard contains four charts that each focuses on key billing-based metrics for an organization’s projects.

**Realization Ratio Chart**

The Realization Ratio measure value is calculated as Net Revenue @ Billing / Direct Labor Billing.

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Type</td>
<td>Bullet Chart</td>
</tr>
<tr>
<td>Chart Components</td>
<td>Black horizontal bar — Realization ratio value</td>
</tr>
<tr>
<td></td>
<td>Black vertical bar — Realization ratio target value</td>
</tr>
<tr>
<td></td>
<td>Shaded areas — 0 – 60% of target, 60 – 80% of target, 80 – 100% of target</td>
</tr>
<tr>
<td>Measures</td>
<td>Realization Ratio</td>
</tr>
<tr>
<td>Key Performance Indicator (KPI)</td>
<td>RealizationRatioTargetOrg1</td>
</tr>
<tr>
<td>Drill Down</td>
<td>None</td>
</tr>
</tbody>
</table>

Use the Key Performance Indicators tab of the Analysis Cubes form in Vision (Configuration » General » Analysis Cubes) to specify company target values for the RealizationRatioTargetOrg1 KPI. (The performance dashboards will not display the targets you specify until you use the Vision Resource Kit to update the Analysis Cubes to include those targets.)
### Variance Percent Chart

The **Variance Percent** measure value is calculated as **Variance / Revenue**.

**(Variance = Revenue – Spent @ Billing)**

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Type</td>
<td>Bullet Chart</td>
</tr>
<tr>
<td>Chart Components</td>
<td>Black horizontal bar — Variance percent&lt;br&gt;Black vertical bar — Variance percent target&lt;br&gt;Shaded areas — 0 – 60% of target percentage, 60 – 80% of target percentage, 80 – 100+% of target percentage</td>
</tr>
<tr>
<td>Measures</td>
<td>Variance Percent</td>
</tr>
<tr>
<td>Key Performance Indicator (KPI)</td>
<td>VariancePercentTargetOrg1</td>
</tr>
<tr>
<td>Drill Down</td>
<td>None</td>
</tr>
</tbody>
</table>

Use the Key Performance Indicators tab of the Analysis Cubes form in Vision (**Configuration** » **General** » **Analysis Cubes**) to specify company target values for the **VariancePercentTargetOrg1** KPI. (The performance dashboards will not display the targets you specify until you use the Vision Resource Kit to update the Analysis Cubes to include those targets.)

### Trend Analysis at Billing Chart

The Trend Analysis at Billing chart tracks the change in the value, over time, of several key metrics. The values are based on billing rates.

This chart illustrates how you can use multiple measures on the same chart.

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Type</td>
<td>Line chart</td>
</tr>
<tr>
<td>Measures</td>
<td>Revenue&lt;br&gt;Billed&lt;br&gt;Unbilled&lt;br&gt;Labor Total Hours&lt;br&gt;Labor Total Billing&lt;br&gt;Expense Billing&lt;br&gt;Variance&lt;br&gt;Realization Ratio</td>
</tr>
<tr>
<td>Drill Down</td>
<td>None</td>
</tr>
</tbody>
</table>
Revenue Analysis at Billing Chart

Each pair of bars on this chart represents total revenue and labor billing. The ★ data points reference the Variance Percent scale on the right axis to indicate the variance percentages.

The Revenue Analysis at Billing chart illustrates how you can use multiple measures on the same chart.

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Type</td>
<td>Dual Axis Bar Chart</td>
</tr>
<tr>
<td>Measures</td>
<td>Left axis: Revenue, Labor Total Billing</td>
</tr>
<tr>
<td></td>
<td>Right axis: Variance Percent ( ★ )</td>
</tr>
<tr>
<td>Drill Down</td>
<td>From fiscal year to quarter to period</td>
</tr>
</tbody>
</table>

Automatic Filters

Vision automatically filters the data to only include project data for the top-level organization to which the current Vision user is assigned in the Employee Info Center. (*Top-level organization* is an organization at the highest organization level selected as a filter option in Vision Performance Management configuration.)

Filter Options

You can filter the project data for this performance dashboard based on any or all of the following:

- One organization level (depending on Vision Performance Management configuration)
- Project type
- Project manager
- Project status
- Project charge type (Default: Regular)
- Fiscal year (Default: most recent three years)

Chart Selections as Filters

When you click on a data point on one of the charts, the other charts are filtered also based on the dimension associated with that data point.

<table>
<thead>
<tr>
<th>Chart</th>
<th>Chart Selection Filters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trend Analysis at Billing</td>
<td>Fiscal year</td>
</tr>
<tr>
<td>Revenue Analysis at Billing</td>
<td>Fiscal year</td>
</tr>
<tr>
<td></td>
<td>Other filters available when you drill down:</td>
</tr>
<tr>
<td></td>
<td>Fiscal quarter, fiscal period</td>
</tr>
</tbody>
</table>
Organization Manager Sample – Charts at Cost Performance Dashboard

The Organization Manager Sample – Charts at Cost performance dashboard contains four charts that each focuses on key cost-based metrics for an organization’s projects.

**Effective Multiplier Chart**

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Type</td>
<td>Bullet Chart</td>
</tr>
<tr>
<td>Chart Components</td>
<td>Black horizontal bar — Effective multiplier value</td>
</tr>
<tr>
<td></td>
<td>Black vertical bar — Effective multiplier target value</td>
</tr>
<tr>
<td></td>
<td>Shaded areas — 0 – 60% of target, 60 – 80% of target, 80 – 100+% of target</td>
</tr>
<tr>
<td>Measures</td>
<td>Effective Multiplier</td>
</tr>
<tr>
<td>Key Performance Indicator (KPI)</td>
<td>EffectiveMultiplierTargetOrg1</td>
</tr>
<tr>
<td>Drill Down</td>
<td>None</td>
</tr>
</tbody>
</table>

Use the Key Performance Indicators tab of the Analysis Cubes form in Vision (Configuration » General » Analysis Cubes) to specify company target values for the EffectiveMultiplierTargetOrg1 measure. (The performance dashboards will not display the targets you specify until you use the Vision Resource Kit to update the analysis cubes to include those targets.)

**Profit Percent Excluding Overhead Chart**

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Type</td>
<td>Bullet Chart</td>
</tr>
<tr>
<td>Chart Components</td>
<td>Black horizontal bar — Profit percent excluding overhead</td>
</tr>
<tr>
<td></td>
<td>Black vertical bar — Profit percent excluding overhead target</td>
</tr>
<tr>
<td></td>
<td>Shaded areas — 0 – 60% of target percentage, 60 – 80% of target percentage, 80 – 100+% of target percentage</td>
</tr>
<tr>
<td>Measures</td>
<td>Gross Margin Percent</td>
</tr>
<tr>
<td>Key Performance Indicator (KPI)</td>
<td>ProfitPercentExcludingOHTargetOrg1</td>
</tr>
<tr>
<td>Drill Down</td>
<td>None</td>
</tr>
</tbody>
</table>
Use the Key Performance Indicators tab of the Analysis Cubes form in Vision (Configuration » General » Analysis Cubes) to specify company target values for the ProfitPercentExcludingOHTargetOrg1 KPI. (The performance dashboards will not display the targets you specify until you use the Vision Resource Kit to update the Analysis Cubes to include those targets.)

Vision does not include overhead in the calculation of values for the Gross Margin Percent measure.

**Trend Analysis at Cost Table**

The Trend Analysis at Cost chart tracks the change in the value, over time, of several key metrics. The values are based on cost rates.

This chart illustrates how you can use multiple measures on the same chart.

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Type</td>
<td>Line chart</td>
</tr>
<tr>
<td>Measures</td>
<td>Revenue</td>
</tr>
<tr>
<td></td>
<td>Billed</td>
</tr>
<tr>
<td></td>
<td>Unbilled</td>
</tr>
<tr>
<td></td>
<td>Labor Total Hours</td>
</tr>
<tr>
<td></td>
<td>Labor Total Cost</td>
</tr>
<tr>
<td></td>
<td>Expense Cost</td>
</tr>
<tr>
<td></td>
<td>Gross Margin</td>
</tr>
<tr>
<td></td>
<td>Effective Multiplier</td>
</tr>
<tr>
<td>Drill Down</td>
<td>None</td>
</tr>
</tbody>
</table>

**Revenue Analysis at Cost Chart**

Each pair of bars represents total revenue and labor cost. The data points reference the Gross Margin Percent scale on the right axis to indicate the gross margin percentages.

The Revenue Analysis at Cost chart illustrates how you can use multiple measures on the same chart.

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Type</td>
<td>Dual Axis Bar Chart</td>
</tr>
<tr>
<td>Measures</td>
<td>Left axis: Revenue, Labor Total Cost</td>
</tr>
<tr>
<td></td>
<td>Right axis: Gross Margin Percent (+)</td>
</tr>
<tr>
<td>Drill Down</td>
<td>From fiscal year to quarter to period</td>
</tr>
</tbody>
</table>

Vision does not include overhead in the calculation of values for the Gross Margin Percent measure.
Automatic Filters

Vision automatically filters the data to only include project data for the top-level organization to which the current Vision user is assigned in the Employee Info Center. (“Top-level organization” is an organization at the highest organization level selected as a filter option in Vision Performance Management configuration.)

Filter Options

You can filter the project data for this performance dashboard based on any or all of the following:

- One organization level (depending on Vision Performance Management configuration)
- Project type
- Project manager
- Project status
- Project charge type (Default: Regular)
- Fiscal year (Default: most recent three years)

Chart Selections as Filters

When you click on a data point on one of the charts, the other charts are filtered also based on the dimension associated with that data point.

<table>
<thead>
<tr>
<th>Chart</th>
<th>Chart Selection Filters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trend Analysis at Cost</td>
<td>Fiscal year</td>
</tr>
<tr>
<td>Revenue Analysis at Cost</td>
<td>Fiscal year</td>
</tr>
<tr>
<td></td>
<td><strong>Other filters available when you drill down:</strong></td>
</tr>
<tr>
<td></td>
<td>Fiscal quarter, fiscal period</td>
</tr>
</tbody>
</table>

Organization Manager Sample – Profit Drilldown Performance Dashboard

The Organization Manager Sample – Profit Drilldown performance dashboard compares revenue, labor total cost, expense total cost, and gross margin by project manager.

Profit Drilldown by Project Manager Chart

Each bar on this chart includes a layer for revenue, labor total cost, expense total cost, and gross margin. For further analysis, you can drill down from project manager to the project level.

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Type</td>
<td>Layered Bar Chart</td>
</tr>
<tr>
<td>Measures</td>
<td>Revenue</td>
</tr>
<tr>
<td></td>
<td>Labor Total Cost</td>
</tr>
<tr>
<td></td>
<td>Expense Cost</td>
</tr>
</tbody>
</table>
### Automatic Filters
Vision automatically filters the data to only include projects for which both of the following are true:

- The charge type is Regular.
- The top-level organization to which the project is assigned is the top-level organization to which the current Vision user is assigned in the Employee Info Center. (“Top-level organization” is an organization at the highest organization level selected as a filter option in Vision Performance Management configuration.)

### Filter Options
You can filter the project data for this performance dashboard based on any or all of the following:

- One organization level (depending on Vision Performance Management configuration)
- Project
- Project type
- Project manager
- Project status
- Fiscal year (Default: most recent three years)

### Organization Manager Sample – Variance Drilldown Performance Dashboard
The Organization Manager Sample – Variance Drilldown performance dashboard compares revenue, labor total billing, expense total billing, and variance by project manager.

### Variance Drilldown by Project Manager Chart
Each bar on this chart includes a layer for revenue, labor total billing, expense total billing, and the variance. For further analysis, you can drill down from project manager through the project work breakdown structure (WBS) levels.

---

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gross Margin</td>
<td></td>
</tr>
<tr>
<td>Drill Down</td>
<td>From project manager through the lowest level of the work breakdown structure</td>
</tr>
</tbody>
</table>

---

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Type</td>
<td>Layered Bar Chart</td>
</tr>
<tr>
<td>Measures</td>
<td>Revenue</td>
</tr>
<tr>
<td></td>
<td>Labor Total Billing</td>
</tr>
<tr>
<td></td>
<td>Expense Total Billing</td>
</tr>
<tr>
<td></td>
<td>Variance (Revenue – (Labor Total Billing +</td>
</tr>
</tbody>
</table>
Vision Performance Management — Sample Performance Dashboards

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expense Total Billing</td>
<td></td>
</tr>
<tr>
<td>Drill Down</td>
<td>From project manager through the lowest level of the work breakdown structure</td>
</tr>
</tbody>
</table>

**Automatic Filters**

Vision automatically filters the data to only include projects for which both of the following are true:

- The charge type is Regular.
- The top-level organization to which the project is assigned is the top-level organization to which the current Vision user is assigned in the Employee Info Center. (“Top-level organization” is an organization at the highest organization level selected as a filter option in Vision Performance Management configuration.)

**Filter Options**

You can filter the project data for this performance dashboard based on any or all of the following:

- One organization level or no organization filter (depending on Vision Performance Management configuration)
- Project manager
- Project type
- Project status
- Project
- Fiscal year (Default: most recent three years)

**Principal Sample – Project Status Performance Dashboard**

The Principal Sample – Project Status performance dashboard helps you monitor performance of labor billing against budget for your projects.

**Project Budget Table**

Use the Project Budget table to view comparisons of actual, budgeted, and projected financial indicators for your projects. This table illustrates how you can use multiple measures in the same table.

To make full use of this table, you must have the Planning module. If you do not have Planning, the table only displays data for the **Labor Total Billing** and **AR Over 60** measures.

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Type</td>
<td>Table</td>
</tr>
<tr>
<td>Measures</td>
<td>Baseline Labor Billing</td>
</tr>
<tr>
<td></td>
<td>Labor Total Billing</td>
</tr>
<tr>
<td></td>
<td>EAC Labor Billing</td>
</tr>
<tr>
<td>Characteristic</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Total Baseline – EAC Labor Billing</td>
<td></td>
</tr>
<tr>
<td>EAC Multiplier Billing</td>
<td></td>
</tr>
<tr>
<td>AR Over 60: Calculated as AR Balance 61-90 + AR Balance 91-120 + AR Balance Over 120</td>
<td></td>
</tr>
<tr>
<td>Drill Down</td>
<td>From project manager through the lowest level of the work breakdown structure</td>
</tr>
</tbody>
</table>

Only actual hours for the current active period are used in the calculation of EAC data in the Project Budget table. In other words, EAC does not include planned hours for the current period.

### Automatic Filters
Vision automatically filters the data to only include projects for which the principal assigned to the project is the current Vision user.

### Filter Options
You can filter the project data for the Project Budget table based on any or all of the following:

- Project manager
- Project primary client
- Project type
- Project status
- Project charge type (Default: Regular)

### Principal Sample – Days Outstanding Metrics Performance Dashboard
The Principal Sample – Days Outstanding Metrics performance dashboard contains two charts that help you monitor days sales outstanding (DSO) and days WIP outstanding (DWO for your projects.

#### Days Sales Outstanding Chart
Use the Days Sales Outstanding chart to view DSO for your projects for the 90-day period preceding the most recent selected period, and compare that value to the target value:

\[
DSO = \frac{\text{Accounts Receivable Balance}}{\left(\frac{\text{Revenue Total for the last 90 transaction days}}{90}\right)}
\]

If you select multiple fiscal years in the **Year** filter, the dashboard displays a separate chart for each year.

---

The **Standard Edition** of Microsoft SQL Server 2008/2008 R2 does not support this chart. You must have the Enterprise Edition. If you have the Standard Edition, the dashboard does not display this chart.
### Characteristic | Description
--- | ---
**Chart Type** | Bullet Chart

**Chart Components**
- **Black horizontal bar** — DSO value for past 90 days
- **Black vertical bar** — DSO target value
- **Shaded areas** — 0 – 60% of target, 60 – 80% of target, 80 – 100+% of target

**Measures**
- **DSO 90**

**Key Performance Indicator (KPI)**
- **DSOTargetPrincipal**

**Drill Down**
- None

Use the Key Performance Indicators tab of the Analysis Cubes form in Vision (Configuration » General » Analysis Cubes) to specify target values for the **DSOTargetPrincipal** KPI. (The performance dashboards will not display the targets you specify until you use the Vision Resource Kit to update the Analysis Cubes to include those targets.)

**Days WIP Outstanding Chart**

Use the Days WIP Outstanding chart to view DWO for your projects for the 90-day period preceding the most recent selected period, and compare that value to the target value:

\[
\text{DWO} = \frac{\text{Unbilled Total}}{\text{(Revenue Total for the last 90 transaction days/90)}}
\]

If you select multiple fiscal years in the **Year** filter, the dashboard displays a separate chart for each year.

---

**The Standard Edition of Microsoft SQL Server 2008/2008 R2 does not support this chart. You must have the Enterprise Edition. If you have the Standard Edition, the dashboard does not display this chart.**

---

### Characteristic | Description
--- | ---
**Chart Type** | Bullet Chart

**Chart Components**
- **Black horizontal bar** — DWO value for past 90 days
- **Black vertical bar** — DWO target value
- **Shaded areas** — 0 – 60% of target, 60 – 80% of target, 80 – 100+% of target

**Measures**
- **DWO 90**

**Key Performance Indicator (KPI)**
- **DWOTargetPrincipal**

**Drill Down**
- None
Use the Key Performance Indicators tab of the Analysis Cubes form in Vision (Configuration » General » Analysis Cubes) to specify target values for the DWOTargetPrincipal KPI. (The performance dashboards will not display the targets you specify until you use the Vision Resource Kit to update the Analysis Cubes to include those targets.)

**Automatic Filters**

Vision automatically filters the data to only include projects for which the principal assigned to the project is the current Vision user.

**Filter Options**

You can filter the project data for the Days Sales Outstanding and Days WIP Outstanding charts based on any or all of the following:

- Project type
- Project manager
- Project primary client
- Fiscal year (Default: most recent year)

**Principal Sample – AR Trending Performance Dashboard**

The Principal Sample – AR Trending performance dashboard helps you track your success in reducing AR over time.

**AR Trend Chart**

Each chart line on the AR Trend chart represents the trend of the accounts receivable balance for one of your aging categories. If you are using the credit memo feature, the chart includes a chart line for credit memo amounts.

The AR Trend chart illustrates how you can use multiple measures on the same chart.

---

**The Standard Edition of Microsoft SQL Server 2008/2008 R2 does not support this chart. You must have the Enterprise Edition. If you have the Standard Edition, this dashboard is not available.**

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Chart Type</strong></td>
<td>Line Chart</td>
</tr>
</tbody>
</table>
| **Measures**   | AR Over 30: Calculated as AR Balance 31-45 + AR Balance 46-60 + AR Balance 61-90 + AR Balance 91-120 + AR Balance Over 120  
AR Over 60: Calculated as AR Balance 61-90 + AR Balance 91-120 + AR Balance Over 120  
AR Over 90: Calculated as AR Balance 91-120 + AR Balance Over 120  
AR Over 120: Calculated as AR Balance Over 120 |
### Credit Memo Amount

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Credit Memo Amount</td>
<td></td>
</tr>
<tr>
<td>Drill Down</td>
<td>From fiscal year to quarter to period</td>
</tr>
</tbody>
</table>

Credit memo amounts tend to be small compared to AR balances, making it difficult to tell, from the AR Trend chart, what the actual amounts are. To display an amount, position the mouse pointer on that data point on the chart.

### Automatic Filters

Vision automatically filters the data to only include projects for which the principal assigned to the project is the current Vision user.

### Filter Options

You can filter the data for this dashboard based on any or all of the following:

- Project manager
- Project type
- Project billing client
- Fiscal year (Default: most recent three years)

### Principal Sample – Pipeline Revenue Performance Dashboard

The Principal Sample – Pipeline Revenue performance dashboard enables you to view historical revenue trends while projecting future workload based on data from the Planning module.

### Pipeline Revenue Chart

The Pipeline Revenue chart displays a stacked bar for each time period. Each bar segment represents either the actual amount billed or the total planned compensation for your projects.

For comparison, the chart also displays a black broken line across each bar that represents the revenue target for your projects.

The Pipeline Revenue chart illustrates how you can use multiple measures on the same chart.

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Type</td>
<td>Bar Chart</td>
</tr>
<tr>
<td>Measures</td>
<td>Billed, Plan Total Compensation Billing</td>
</tr>
<tr>
<td>Key Performance Indicator (KPI)</td>
<td>RevenueTargetProjectPrincipal</td>
</tr>
<tr>
<td>Drill Down</td>
<td>From calendar year to quarter to month</td>
</tr>
</tbody>
</table>

Use the Key Performance Indicators tab of the Analysis Cubes form in Vision (Configuration » General » Analysis Cubes) to specify target values for the RevenueTargetProjectPrincipal KPI. (The performance dashboards will not display the targets you specify until you use the Vision Resource Kit to update the Analysis Cubes to include those targets.)
**Automatic Filters**

Vision automatically filters the data to only include projects for which the principal assigned to the project is the current Vision user.

**Filter Options**

You can filter the project data for this performance dashboard based on any or all of the following:

- Project type
- Project client
- Project manager
- Project charge type (Default: Regular)
- Project status
- Transaction year (Default: most recent three years)

**Principal Sample – Opportunity Wins and Projections Performance Dashboard**

The Principal Sample – Opportunity Wins and Projections performance dashboard helps you compare the projected revenue associated with opportunities to your revenue targets.

**Wins and Projections from Opportunities Chart**

Each chart bar in the Wins and Projections from Opportunities chart represents the total revenue associated with opportunities that are assigned to the principal and that have an estimated start date in the time period indicated. Each segment of the bar represents the revenue associated with opportunities currently assigned to that opportunity stage.

For comparison, target revenue amounts for each time period are displayed as a superimposed broken line.

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Type</td>
<td>Stacked Bar Chart</td>
</tr>
<tr>
<td>Measures</td>
<td>Opportunity Revenue</td>
</tr>
<tr>
<td>Key Performance Indicator (KPI)</td>
<td>OpportunitySalesTargetPrincipal</td>
</tr>
<tr>
<td>Drill Down</td>
<td>From calendar year to quarter to month</td>
</tr>
</tbody>
</table>

Use the Key Performance Indicators tab of the Analysis Cubes form in Vision (Configuration » General » Analysis Cubes) to specify target values for the OpportunitySalesTargetPrincipal KPI. (The performance dashboards will not display the targets you specify until you use the Vision Resource Kit to update the Analysis Cubes to include those targets.)

**Automatic Filters**

Vision automatically filters the data to only include opportunities for which the current Vision user is the assigned principal.
Filter Options
You can filter the opportunity data for this performance dashboard based on any or all of the following:
- Opportunity project manager
- Opportunity client
- Opportunity stage
- Opportunity type
- Transaction year (Default: most recent three years)

Principal Sample – Charts at Billing Performance Dashboard
The Principal Sample – Charts at Billing performance dashboard contains four charts that each focuses on key billing-based metrics for a principal's projects.

Variance Percent Chart
The Variance Percent measure value is calculated as Variance / Revenue.
(Variance = Revenue – Spent @ Billing)

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Type</td>
<td>Bullet Chart</td>
</tr>
<tr>
<td>Chart Components</td>
<td>Black horizontal bar — Variance percent</td>
</tr>
<tr>
<td></td>
<td>Black vertical bar — Variance percent target</td>
</tr>
<tr>
<td></td>
<td>Shaded areas — 0 – 60% of target percentage, 60 – 80% of target percentage, 80 – 100% of target percentage</td>
</tr>
<tr>
<td>Measures</td>
<td>Variance Percent</td>
</tr>
<tr>
<td>Key Performance Indicator (KPI)</td>
<td>VariancePercentTargetPrincipal</td>
</tr>
<tr>
<td>Drill Down</td>
<td>None</td>
</tr>
</tbody>
</table>

Use the Key Performance Indicators tab of the Analysis Cubes form in Vision (Configuration » General » Analysis Cubes) to specify company target values for the VariancePercentTargetPrincipal KPI. (The performance dashboards will not display the targets you specify until you use the Vision Resource Kit to update the Analysis Cubes to include those targets.)

Realization Ratio Chart
The Realization Ratio measure value is calculated as Net Revenue @ Billing / Direct Labor Billing.

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Type</td>
<td>Bullet Chart</td>
</tr>
<tr>
<td>Characteristic</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| **Chart Components** | **Black horizontal bar** — Realization ratio value  
**Black vertical bar** — Realization ratio target value  
**Shaded areas** — 0 – 60% of target, 60 – 80% of target, 80 – 100+% of target |
| **Measures** | **Realization Ratio** |
| **Key Performance Indicator (KPI)** | **RealizationRatioTargetPrincipal** |
| **Drill Down** | None |

Use the Key Performance Indicators tab of the Analysis Cubes form in Vision (Configuration » General » Analysis Cubes) to specify company target values for the RealizationRatioTargetPrincipal KPI. (The performance dashboards will not display the targets you specify until you use the Vision Resource Kit to update the Analysis Cubes to include those targets.)

**Trend Analysis at Billing Chart**

The Trend Analysis at Billing chart tracks the change in the value, over time, of several key metrics. The values are based on billing rates.

This chart illustrates how you can use multiple measures on the same chart.

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Chart Type</strong></td>
<td>Line chart</td>
</tr>
</tbody>
</table>
| **Measures** | Revenue  
Billed  
Unbilled  
Labor Total Hours  
Labor Total Billing  
Expense Billing  
Variance  
Realization Ratio |
| **Drill Down** | None |

**Revenue Analysis at Billing Chart**

Each pair of bars on this chart represents total revenue and labor billing. The ★ data points reference the Variance Percent scale on the right axis to indicate the variance percentages.

The Revenue Analysis at Billing chart illustrates how you can use multiple measures on the same chart.
### Automatic Filters

Vision automatically filters the data to only include projects for which the principal assigned to the project is the current Vision user.

### Filter Options

You can filter the project data for this performance dashboard based on any or all of the following:

- Project manager
- Project type
- Project status
- Project charge type (Default: Regular)
- Fiscal year (Default: most recent three years)

### Chart Selections as Filters

When you click on a data point on one of the charts, the other charts are filtered also based on the dimension associated with that data point.

<table>
<thead>
<tr>
<th>Chart</th>
<th>Chart Selection Filters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trend Analysis at Billing</td>
<td>Fiscal year</td>
</tr>
<tr>
<td>Revenue Analysis at Billing</td>
<td>Fiscal year</td>
</tr>
<tr>
<td></td>
<td>Other filters available when you drill down:</td>
</tr>
<tr>
<td></td>
<td>Fiscal quarter, fiscal period</td>
</tr>
</tbody>
</table>

### Principal Sample – Charts at Cost Performance Dashboard

The Principal Sample – Charts at Cost performance dashboard contains four charts that each focuses on key cost-based metrics for a principal’s projects.

### Effective Multiplier Chart

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Type</td>
<td>Bullet Chart</td>
</tr>
<tr>
<td>Chart Components</td>
<td>Black horizontal bar — Effective multiplier</td>
</tr>
</tbody>
</table>
### Effective Multiplier

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Black vertical bar</td>
<td>Effective multiplier target value</td>
</tr>
<tr>
<td>Shaded areas</td>
<td>0 – 60% of target, 60 – 80% of target, 80 – 100+% of target</td>
</tr>
</tbody>
</table>

#### Measures
- Effective Multiplier

#### Key Performance Indicator (KPI)
- EffectiveMultiplierTargetPrincipal

#### Drill Down
- None

Use the Key Performance Indicators tab of the Analysis Cubes form in Vision (Configuration » General » Analysis Cubes) to specify company target values for the EffectiveMultiplierTargetPrincipal KPI. (The performance dashboards will not display the targets you specify until you use the Vision Resource Kit to update the Analysis Cubes to include those targets.)

### Profit Percent Excluding Overhead Chart

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Type</td>
<td>Bullet Chart</td>
</tr>
<tr>
<td>Chart Components</td>
<td>Black horizontal bar — Profit percent excluding overhead</td>
</tr>
<tr>
<td></td>
<td>Black vertical bar — Profit percent excluding overhead target</td>
</tr>
<tr>
<td></td>
<td>Shaded areas — 0 – 60% of target percentage, 60 – 80% of target percentage, 80 – 100+% of target percentage</td>
</tr>
<tr>
<td>Measures</td>
<td>Gross Margin Percent</td>
</tr>
<tr>
<td>Key Performance Indicator (KPI)</td>
<td>ProfitPercentExcludingOHTargetPrincipal</td>
</tr>
<tr>
<td>Drill Down</td>
<td>None</td>
</tr>
</tbody>
</table>

Use the Key Performance Indicators tab of the Analysis Cubes form in Vision (Configuration » General » Analysis Cubes) to specify company target values for the ProfitPercentExcludingOHTargetPrincipal KPI. (The performance dashboards will not display the targets you specify until you use the Vision Resource Kit to update the Analysis Cubes to include those targets.)

Vision does not include overhead in the calculation of values for the Gross Margin Percent measure.
Trend Analysis at Cost Table
The Trend Analysis at Cost chart tracks the change in the value, over time, of several key metrics. The values are based on cost rates.
This chart illustrates how you can use multiple measures on the same chart.

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Type</td>
<td>Line chart</td>
</tr>
<tr>
<td>Measures</td>
<td>Revenue</td>
</tr>
<tr>
<td></td>
<td>Billed</td>
</tr>
<tr>
<td></td>
<td>Unbilled</td>
</tr>
<tr>
<td></td>
<td>Labor Total Hours</td>
</tr>
<tr>
<td></td>
<td>Labor Total Cost</td>
</tr>
<tr>
<td></td>
<td>Expense Cost</td>
</tr>
<tr>
<td></td>
<td>Gross Margin</td>
</tr>
<tr>
<td></td>
<td>Effective Multiplier</td>
</tr>
<tr>
<td>Drill Down</td>
<td>None</td>
</tr>
</tbody>
</table>

Revenue Analysis at Cost Chart
Each pair of bars represents total revenue and labor cost. The + data points reference the Gross Margin Percent scale on the right axis to indicate the gross margin percentages.
The Revenue Analysis at Cost chart illustrates how you can use multiple measures on the same chart.

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Type</td>
<td>Dual Axis Bar Chart</td>
</tr>
<tr>
<td>Measures</td>
<td>Left axis: Revenue, Labor Total Cost</td>
</tr>
<tr>
<td></td>
<td>Right axis: Gross Margin Percent (+)</td>
</tr>
<tr>
<td>Drill Down</td>
<td>From fiscal year to quarter to period</td>
</tr>
</tbody>
</table>

Automatic Filters
Vision automatically filters the data to only include projects for which the principal assigned to the project is the current Vision user.

Filter Options
You can filter the project data for this performance dashboard based on any or all of the following:
- Project manager
- Project type
- Project status
- Project charge type (Default: Regular)
- Fiscal year (Default: most recent three years)

**Chart Selections as Filters**

When you click on a data point on one of the charts, the other charts are filtered also based on the dimension associated with that data point.

<table>
<thead>
<tr>
<th>Chart Selection Filters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trend Analysis at Cost</td>
</tr>
<tr>
<td>Revenue Analysis at Cost</td>
</tr>
</tbody>
</table>

*Other filters available when you drill down: Fiscal quarter, fiscal period*

**Principal Profit Drilldown Performance Dashboard**

The Principal Sample – Profit Drilldown performance dashboard compares revenue, labor total cost, expense total cost, and gross margin by project manager.

**Profit Drilldown by Project Manager Chart**

Each bar on this chart includes a layer for revenue, labor total cost, expense total cost, and gross margin. For further analysis, you can drill down from project manager to the project level.

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Type</td>
<td>Layered Bar Chart</td>
</tr>
<tr>
<td>Measures</td>
<td>Revenue</td>
</tr>
<tr>
<td></td>
<td>Labor Total Cost</td>
</tr>
<tr>
<td></td>
<td>Expense Cost</td>
</tr>
<tr>
<td></td>
<td>Gross Margin</td>
</tr>
<tr>
<td>Drill Down</td>
<td>From project manager through the lowest level of the work breakdown structure</td>
</tr>
</tbody>
</table>

**Automatic Filters**

Vision automatically filters the data to only include projects for which both of the following are true:

- The charge type is Regular.
- The principal assigned to the project is the current Vision user.

**Filter Options**

You can filter the project data for this performance dashboard based on any or all of the following:
Principal Sample – Variance Drilldown Performance Dashboard

The Principal Sample – Variance Drilldown performance dashboard compares revenue, labor total billing, expense total billing, and variance by project manager.

Variance Drilldown by Project Manager Chart

Each bar on this chart includes a layer for revenue, labor total billing, expense total billing, and the variance. For further analysis, you can drill down from project manager to the project level.

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Type</td>
<td>Layered Bar Chart</td>
</tr>
<tr>
<td>Measures</td>
<td>Revenue, Labor Total Billing, Expense Billing, Variance (Revenue – (Labor Total Billing + Expense Total Billing))</td>
</tr>
<tr>
<td>Drill Down</td>
<td>From project manager through the lowest level of the work breakdown structure</td>
</tr>
</tbody>
</table>

Automatic Filters

Vision automatically filters the data to only include projects for which both of the following are true:

- The charge type is Regular.
- The principal assigned to the project is the current Vision user.

Filter Options

You can filter the project data for this performance dashboard based on any or all of the following:

- Project
- Project manager
- Project type
- Project status
- Fiscal year (Default: most recent three years)
Project Manager Sample – Project Status Performance Dashboard

The Project Manager Sample – Project Status performance dashboard helps you monitor performance of labor billing against budget for your projects.

Project Budget Table

Use the Project Budget table to view comparisons of actual, budgeted, and projected financial indicators for your projects. This table illustrates how you can use multiple measures in the same table.

To make full use of this table, you must have the Planning module. If you do not have Planning, the table only displays data for the Labor Total Billing and AR Over 60 measures.

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Type</td>
<td>Table</td>
</tr>
<tr>
<td>Measures</td>
<td>Labor Total Billing</td>
</tr>
<tr>
<td></td>
<td>EAC Labor Billing</td>
</tr>
<tr>
<td></td>
<td>Total Baseline – EAC Labor Billing</td>
</tr>
<tr>
<td></td>
<td>EAC Multiplier Billing</td>
</tr>
<tr>
<td></td>
<td>AR Over 60: Calculated as AR Balance 61-90 + AR Balance 91-120 + AR Balance Over 120</td>
</tr>
<tr>
<td>Drill Down</td>
<td>None</td>
</tr>
</tbody>
</table>

Only actual hours for the current active period are used in the calculation of EAC data in the Project Budget table. In other words, EAC does not include planned hours for the current period.

Automatic Filters

Vision automatically filters the data to only include projects for which the project manager is the current Vision user.

Filter Options

You can filter the project data for the Project Budget table based on any or all of the following:

- Project type
- Project primary client
- Project charge type (Default: Regular)
- Project status
Project Manager Sample – Days Outstanding Metrics Performance Dashboard

The Project Manager Sample – Days Outstanding Metrics performance dashboard contains two charts that help you monitor days sales outstanding (DSO) and days WIP outstanding (DWO for your projects.

**Days Sales Outstanding Chart**

Use the Days Sales Outstanding chart to view DSO for your projects for the 90-day period preceding the most recent selected period, and compare that value to the target value:

\[
DSO = \frac{\text{Accounts Receivable Balance}}{(\text{Revenue Total for the last 90 transaction days} / 90)}
\]

If you select multiple fiscal years in the Year filter, the dashboard displays a separate chart for each year.

The Standard Edition of Microsoft SQL Server 2008/2008 R2 does not support this chart. You must have the Enterprise Edition. If you have the Standard Edition, the dashboard does not display this chart.

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Type</td>
<td>Bullet Chart</td>
</tr>
<tr>
<td>Chart Components</td>
<td><strong>Black horizontal bar</strong> — DSO value for past 90 days</td>
</tr>
<tr>
<td></td>
<td><strong>Black vertical bar</strong> — DSO target value</td>
</tr>
<tr>
<td></td>
<td><strong>Shaded areas</strong> — 0 – 60% of target, 60 – 80% of target, 80 – 100+% of target</td>
</tr>
<tr>
<td>Measures</td>
<td>DSO 90</td>
</tr>
<tr>
<td>Key Performance Indicator (KPI)</td>
<td>DSOTargetProject Manager</td>
</tr>
<tr>
<td>Drill Down</td>
<td>None</td>
</tr>
</tbody>
</table>

Use the Key Performance Indicators tab of the Analysis Cubes form in Vision (Configuration » General » Analysis Cubes) to specify target values for the DSOTargetProject Manager KPI. (The performance dashboards will not display the targets you specify until you use the Vision Resource Kit to update the Analysis Cubes to include those targets.)

**Days WIP Outstanding Chart**

Use the Days WIP Outstanding chart to view DWO for your projects for the 90-day period preceding the most recent selected period, and compare that value to the target value:

\[
DWO = \frac{\text{Unbilled Total}}{(\text{Revenue Total for the last 90 transaction days}/90)}
\]

If you select multiple fiscal years in the Year filter, the dashboard displays a separate chart for each year.
The Standard Edition of Microsoft SQL Server 2008/2008 R2 does not support this chart. You must have the Enterprise Edition. If you have the Standard Edition, the dashboard does not display this chart.

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Type</td>
<td>Bullet Chart</td>
</tr>
<tr>
<td>Chart Components</td>
<td>Black horizontal bar — DWO value for past 90 days</td>
</tr>
<tr>
<td></td>
<td>Black vertical bar — DWO target value</td>
</tr>
<tr>
<td></td>
<td>Shaded areas — 0 - 60% of target, 60 - 80% of target, 80 – 100+% of target</td>
</tr>
<tr>
<td>Measures</td>
<td>DWO 90</td>
</tr>
<tr>
<td>Key Performance Indicator (KPI)</td>
<td>DWOTargetProject Manager</td>
</tr>
<tr>
<td>Drill Down</td>
<td>None</td>
</tr>
</tbody>
</table>

Use the Key Performance Indicators tab of the Analysis Cubes form in Vision (Configuration » General » Analysis Cubes) to specify target values for the DWOTargetProject Manager KPI. (The performance dashboards will not display the targets you specify until you use the Vision Resource Kit to update the Analysis Cubes to include those targets.)

**Automatic Filters**

Vision automatically filters the data to only include projects for which the project manager is the current Vision user.

**Filter Options**

You can filter the project data for the Days Sales Outstanding and Days WIP Outstanding charts based on any or all of the following:

- Project type
- Project primary client
- Fiscal year (Default: most recent year)

**Project Manager Sample – Project AR Performance Dashboard**

The Project Manager Sample – Project AR performance dashboard contains the Accounts Receivable by Project chart. Each stacked bar represents the total current AR balance for a project, and each segment of the stacked bar represents the AR balance for an AR aging category.

**Accounts Receivable by Project Chart**

The Accounts Receivable by Project chart illustrates how you can use multiple measures on the same chart.
Vision Performance Management — Sample Performance Dashboards

7.1 Online Help Updates

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Type</td>
<td>Stacked bar</td>
</tr>
</tbody>
</table>
| Measures       | AR Balance 0-30  
|                | AR Balance 31-45  
|                | AR Balance 46-60  
|                | AR Balance 61-90  
|                | AR Balance 91-120  
|                | AR Balance Over 120 |
| Drill Down     | From higher levels of the work breakdown structure to lower levels |

**Automatic Filters**
Vision automatically filters the data to only include projects for which the project manager assigned to the project is the current Vision user.

**Filter Options**
You can filter the data for this dashboard based on either or both of the following:
- Project type
- Project billing client

**Project Manager Sample – Charts at Billing Performance Dashboard**
The Project Manager Sample – Charts at Billing performance dashboard contains four charts that each focuses on key billing-based metrics for a project manager's projects.

**Realization Ratio Chart**
The Realization Ratio measure value is calculated as Net Revenue @ Billing / Direct Labor Billing.

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Type</td>
<td>Bullet Chart</td>
</tr>
</tbody>
</table>
| Chart Components | Black horizontal bar — Realization ratio value  
|                | Black vertical bar — Realization ratio target value  
|                | Shaded areas — 0 – 60% of target, 60 – 80% of target, 80 – 100+% of target |
| Measures       | Realization Ratio |
### Characteristic |
**Description**

<table>
<thead>
<tr>
<th>Key Performance Indicator (KPI)</th>
<th>RealizationRatioTargetProject Manager</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drill Down</td>
<td>None</td>
</tr>
</tbody>
</table>

Use the Key Performance Indicators tab of the Analysis Cubes form in Vision (Configuration ➔ General ➔ Analysis Cubes) to specify company target values for the RealizationRatioTargetProject Manager KPI. (The performance dashboards will not display the targets you specify until you use the Vision Resource Kit to update the Analysis Cubes to include those targets.)

**Variance Percent Chart**

The Variance Percent measure value is calculated as Variance / Revenue.

(Variance = Revenue – Spent @ Billing)

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Type</td>
<td>Bullet Chart</td>
</tr>
<tr>
<td>Chart Components</td>
<td><strong>Black horizontal bar</strong> — Variance percent</td>
</tr>
<tr>
<td></td>
<td><strong>Black vertical bar</strong> — Variance percent target</td>
</tr>
<tr>
<td></td>
<td><strong>Shaded areas</strong> — 0 – 60% of target percentage, 60 – 80% of target percentage, 80 – 100% of target percentage</td>
</tr>
<tr>
<td>Measures</td>
<td>Variance Percent</td>
</tr>
<tr>
<td>Key Performance Indicator (KPI)</td>
<td>VariancePercentTargetProject Manager</td>
</tr>
<tr>
<td>Drill Down</td>
<td>None</td>
</tr>
</tbody>
</table>

Use the Key Performance Indicators tab of the Analysis Cubes form in Vision (Configuration ➔ General ➔ Analysis Cubes) to specify company target values for the VariancePercentTargetProject Manager KPI. (The performance dashboards will not display the targets you specify until you use the Vision Resource Kit to update the Analysis Cubes to include those targets.)

**Revenue Analysis at Billing Chart**

Each pair of bars represents total revenue and labor billing. The + data points reference the Variance Percent scale on the right axis to indicate the variance percentages.

The Revenue Analysis at Billing chart illustrates how you can use multiple measures on the same chart. Revenue and total labor billing display as bars graphed against the vertical axis on the left, while variance percentages display as points graphed against the vertical axis on the right.

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Type</td>
<td>Dual Axis Bar Chart</td>
</tr>
</tbody>
</table>
**Variance Tracking Chart**

The Variance Tracking chart displays total revenue by quarter as a charted line and total amount spent at billing rates by quarter as a gray filled area. The Revenue line changes color based on the type and size of the variance. Blue indicates positive variances (Revenue > Spent @ Billing), and orange indicates negative variances. The values at the ends of the color bar below the chart indicate the largest negative and positive variances represented on the chart.

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Chart Type</strong></td>
<td>Line Chart with Filled Area</td>
</tr>
<tr>
<td><strong>Measures</strong></td>
<td>Revenue, Spent @ Billing</td>
</tr>
<tr>
<td><strong>Drill Down</strong></td>
<td>None</td>
</tr>
</tbody>
</table>

**Automatic Filters**

Vision automatically filters the data to only include projects for which the project manager is the current Vision user.

**Filter Options**

You can filter the project data for this performance dashboard based on any or all of the following filters:

- Project billing client
- Project status
- Project charge type (Default: Regular)
- Project
- Fiscal year (Default: most recent three years)

**Project Manager Sample – Charts at Cost Performance Dashboard**

The Project Manager Sample – Charts at Cost performance dashboard contains three charts that each focuses on key cost-based metrics for a project manager’s projects.

**Profit Percent Excluding Overhead Chart**

If you select more than one fiscal year in the Year filter, one bullet chart displays for each year.
### Chart Type
- **Bullet Chart**

### Chart Components
- **Black horizontal bar** — Profit percent excluding overhead
- **Black vertical bar** — Profit percent excluding overhead target
- **Shaded areas** — 0 – 60% of target percentage, 60 – 80% of target percentage, 80 – 100+% of target percentage

### Measures
- **Gross Margin Percent**

### Key Performance Indicator (KPI)
- **ProfitPercentExcludingOHTargetProject Manager**

### Drill Down
- **None**

Use the Key Performance Indicators tab of the Analysis Cubes form in Vision (Configuration » General » Analysis Cubes) to specify company target values for the **ProfitPercentExcludingOHTargetProject Manager** KPI. (The performance dashboards will not display the targets you specify until you use the Vision Resource Kit to update the Analysis Cubes to include those targets.)

Vision does not include overhead in the calculation of values for the **Gross Margin Percent** measure.

### Effective Multiplier Chart
If you select more than one fiscal year in the **Year** filter, one bullet chart displays for each year.

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Type</td>
<td>Bullet Chart</td>
</tr>
<tr>
<td>Chart Components</td>
<td><strong>Black horizontal bar</strong> — Effective multiplier value</td>
</tr>
<tr>
<td></td>
<td><strong>Black vertical bar</strong> — Effective multiplier target</td>
</tr>
<tr>
<td></td>
<td><strong>Shaded areas</strong> — 0 – 60% of target, 60 – 80% of target, 80 – 100+% of target</td>
</tr>
<tr>
<td>Measures</td>
<td><strong>Effective Multiplier</strong></td>
</tr>
<tr>
<td>Key Performance Indicator (KPI)</td>
<td><strong>EffectiveMultiplierTargetProject Manager</strong></td>
</tr>
<tr>
<td>Drill Down</td>
<td>None</td>
</tr>
</tbody>
</table>

Use the Key Performance Indicators tab of the Analysis Cubes form in Vision (Configuration » General » Analysis Cubes) to specify company target values for the **EffectiveMultiplierTargetProject Manager** KPI. (The performance dashboards will not display
the targets you specify until you use the Vision Resource Kit to update the Analysis Cubes to include those targets.)

**Revenue Analysis at Cost Chart**

Each pair of bars represents total revenue and labor cost. The data points reference the **Gross Margin Percent** scale on the right axis to indicate the gross margin percentages.

The Revenue Analysis at Cost chart illustrates how you can use multiple measures on the same chart.

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Type</td>
<td>Dual Axis Bar Chart</td>
</tr>
<tr>
<td>Measures</td>
<td>Left axis: Revenue, Labor Total Cost Right axis: Gross Margin Percent (↑)</td>
</tr>
<tr>
<td>Drill Down</td>
<td>From fiscal year to quarter to period</td>
</tr>
</tbody>
</table>

Vision does not include overhead in the calculation of values for the **Gross Margin Percent** measure.

**Automatic Filters**

Vision automatically filters the data to only include projects for which the project manager is the current Vision user.

**Filter Options**

You can filter the project data for this performance dashboard based on any or all of the following filters:

- Billing client
- Project status
- Project charge type (Default: Regular)
- Project
- Fiscal year (Default: most recent year)

**Project Manager Sample – Profit Drilldown Performance Dashboard**

The Project Manager Sample – Profit Drilldown performance dashboard uses a large, layered bar chart to compare revenue, labor total cost, expense total cost, and gross margin by project.

**Profit Drilldown by Project Chart**

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Type</td>
<td>Layered Bar Chart</td>
</tr>
<tr>
<td>Measures</td>
<td>Revenue</td>
</tr>
<tr>
<td>Characteristic</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Labor Total Cost</td>
<td></td>
</tr>
<tr>
<td>Expense Cost</td>
<td></td>
</tr>
<tr>
<td>Gross Margin</td>
<td></td>
</tr>
<tr>
<td><strong>Drill Down</strong></td>
<td>From higher levels of the work breakdown structure to lower levels</td>
</tr>
</tbody>
</table>

**Automatic Filters**

Vision automatically filters the data to only include projects for which both of the following are true:

- The charge type is Regular.
- The project manager assigned to the project is the current Vision user.

**Filter Options**

You can filter the project data for this performance dashboard based on any or all of the following:

- Billing client
- Project status
- Project
- Fiscal year (Default: most recent year)

**Project Manager Sample – Variance Drilldown Performance Dashboard**

The Project Manager Sample – Variance Drilldown performance dashboard uses a large, layered bar chart to compare revenue, labor total billing, expense total billing, and variance by project.

**Project Manager Variance Drilldown Chart**

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Chart Type</strong></td>
<td>Layered Bar Chart</td>
</tr>
<tr>
<td><strong>Measures</strong></td>
<td>Revenue</td>
</tr>
<tr>
<td></td>
<td>Labor Total Billing</td>
</tr>
<tr>
<td></td>
<td>Expense Billing</td>
</tr>
<tr>
<td></td>
<td>Variance (Revenue – (Labor Total Billing + Expense Total Billing))</td>
</tr>
<tr>
<td><strong>Drill Down</strong></td>
<td>From higher levels of the work breakdown structure to lower levels</td>
</tr>
</tbody>
</table>
**Automatic Filters**

Vision automatically filters the data to only include projects for which both of the following are true:

- The charge type is Regular.
- The project manager assigned to the project is the current Vision user.

**Filter Options**

You can filter the project data for this performance dashboard based on any or all of the following:

- Billing client
- Project status
- Project
- Fiscal year (Default: most recent three years)

**Resource Manager Sample – Pipeline Revenue Performance Dashboard**

The Resource Manager Sample – Pipeline Revenue performance dashboard enables you to view historical revenue trends while projecting future workload based on data from the Planning module.

**Pipeline Revenue Chart**

The Pipeline Revenue chart displays a stacked bar for each year. Each bar segment represents either the actual amount billed or the total planned compensation.

For comparison, the chart also displays a black broken line across each bar that represents the organization revenue target.

The Pipeline Revenue chart illustrates how you can use multiple measures on the same chart.

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Type</td>
<td>Stacked bar chart</td>
</tr>
<tr>
<td>Measures</td>
<td>Billed</td>
</tr>
<tr>
<td></td>
<td>Plan Total Compensation Billing</td>
</tr>
<tr>
<td>Key Performance Indicator (KPI)</td>
<td>RevenueTargetProjectOrg1</td>
</tr>
<tr>
<td>Drill Down</td>
<td>From calendar year to quarter to month</td>
</tr>
</tbody>
</table>

Use the Key Performance Indicators tab of the Analysis Cubes form in Vision (Configuration » General » Analysis Cubes) to specify target values for the RevenueTargetProjectOrg1 KPI. (The performance dashboards will not display the targets you specify until you use the Vision Resource Kit to update the Analysis Cubes to include those targets.)

**Automatic Filter**

Vision automatically filters the data to only include pipeline revenue for the top-level organization to which the current Vision user is assigned in the Employee Info Center. ("Top-level
organization” is an organization at the highest organization level selected as a filter option in Vision Performance Management configuration.)

Filter Options
You can filter the project data for this performance dashboard based on any or all of the following:

- One organization level or no organization level filter (depending on Vision Performance Management configuration)
- Project type
- Client
- Project manager
- Project charge type (Default: Regular)
- Project status
- Transaction year (Default: most recent three years)

Resource Manager Sample – Utilization and Realization Performance Dashboard

The Resource Sample – Utilization and Realization performance dashboard enables you to monitor actual labor utilization and realization, compare actual labor utilization to planned utilization, and review planned utilization for future time periods.

Utilization and Realization Chart

The Utilization and Realization chart displays the following for each calendar year:

- A bar for actual utilization rate (Direct hours / Standard hours)
- A bar for actual realization rate (Labor realization hours / Standard hours)
- A data point for the planned utilization rate

The chart only displays values for Standard Planned Billable Utilization if you have the Planning module.

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Type</td>
<td>Bar Chart</td>
</tr>
<tr>
<td>Measures</td>
<td>Direct Over Standard Hours</td>
</tr>
<tr>
<td></td>
<td>Labor Realization Over Standard Hours</td>
</tr>
<tr>
<td></td>
<td>Standard Planned Billable Utilization</td>
</tr>
<tr>
<td>Drill Down</td>
<td>From calendar year to quarter to month</td>
</tr>
</tbody>
</table>

Automatic Filter

Vision automatically filters the data to only include data for the top-level organization to which the current Vision user is assigned in the Employee Info Center. (“Top-level organization” is an organization at the highest organization level selected as a filter option in Vision Performance Management configuration.)
Filter Options
You can filter the data for this performance dashboard based on any or all of the following:

- One organization level or no organization level filter (depending on Vision Performance Management configuration)
- Employee
- Employee labor category
- Employee status
- Transaction year (Default: most recent three years)

Resource Manager Sample – Opportunity Wins and Projections Performance Dashboard
The Resource Manager Sample – Opportunity Wins and Projections performance dashboard helps you compare the projected revenue associated with opportunities to your revenue targets.

Wins and Projections from Opportunities Chart
Each chart bar in the Wins and Projections from Opportunities chart represents the total revenue that is associated with opportunities that are assigned to the manager’s level 1 organization and that have an estimated start date in the year indicated. Each segment of the bar represents the revenue associated with opportunities currently assigned to that opportunity stage.

For comparison, target revenue amounts for each time period are displayed as a superimposed broken line.

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Type</td>
<td>Stacked Bar Chart</td>
</tr>
<tr>
<td>Measures</td>
<td>Opportunity Revenue</td>
</tr>
<tr>
<td>Key Performance Indicator (KPI)</td>
<td>OpportunitySalesTargetOrg1</td>
</tr>
<tr>
<td>Drill Down</td>
<td>From calendar year to quarter to month</td>
</tr>
</tbody>
</table>

Use the Key Performance Indicators tab of the Analysis Cubes form in Vision (Configuration » General » Analysis Cubes) to specify target values for the OpportunitySalesTargetOrg1 KPI. (The performance dashboards will not display the targets you specify until you use the Vision Resource Kit to update the Analysis Cubes to include those targets.)

Automatic Filter
Vision automatically filters the data to only include opportunities for the top-level organization to which the current Vision user is assigned in the Employee Info Center. ("Top-level organization" is an organization at the highest organization level selected as a filter option in Vision Performance Management configuration.)

Filter Options
You can filter the opportunity data for this performance dashboard based on any or all of the following:
- One organization level or no organization level filter (depending on Vision Performance Management configuration)
- Opportunity project manager
- Opportunity primary client
- Opportunity stage
- Opportunity type
- Transaction year (Default: most recent three years)

**Performance Management Reports**

If Vision Performance Management performance dashboards have been made available to you, you can add them as dashparts to your Vision Dashboard. However, you can also display those performance dashboards from within Vision from the Performance Management reports form ([Reporting » Performance Management](#)).

When you open the Performance Management reports form, the grid lists the performance dashboards that have been made available to you. To display a performance dashboard, select it in the grid and click **Preview** on the Reporting toolbar. Vision displays the dashboard in a separate window. You can then filter the data reflected in the dashboard, drill down to supporting detail, and so on.
Exchange Rates

Daily Exchange Rates Overview
The Daily Exchange Rates feature allows you to set up exchange rates from one currency to another currency for a specific date.

You specify:
- The “from” currency and “to” currency
- The date to which the exchange rate applies
- The exchange rate, to 10 decimal places

If Vision cannot find an exchange rate for a specific date (you have not set one up), Vision looks at the period exchange rate table for the date within the specified range of dates.

Because these rates are retained indefinitely, the Daily Exchange Rates feature provides filters that you can use to limit the number of rates that appear. You can filter by currency or by period. For example, you can limit the list to display only currency exchange rates between Canadian dollars and American dollars. Vision retains these individual user settings until you change them.

Translation Methods
In consolidations groups setup, you specify a “translation method” for an account range or an account, and this method applies to all translations for that account. The choices for translation method are:
- Period end rate
- Period avg rate
- Historical rate

The first two settings use rates from the period exchange rates table and use rates for the “period” of the transaction. The last setting, historical rates, uses rates from the daily exchange rates table and uses the transaction date to get the rate. These translations are done when consolidating data from a company whose functional currency is different than the reporting currency for the group.

To set up the translations, use the options on the Translations tab of Consolidated Reporting Setup. For information about how Vision handles gains and losses resulting from translations between a company’s functional currency and its consolidation group's report currency, see the Concepts section of the Vision online help.

XE.com Exchange Rate Data Feed Services
The XE.com Currency Exchange Rate Service is an online exchange rate data feed service, which you can incorporate into Vision's Daily Exchange Rates feature. If your firm wishes to use this service, contact XE.com directly.

Daily Exchange Rates Form
Use the Daily Exchange Rates form of General System Setup to configure exchange rates from one currency to another currency for a specific date. If your firm uses the Multicompny feature, the available currencies are limited to those enabled for the active company.
**Location**

To display the form, complete the following step:

1. From the Vision Navigation menu, click **Configuration » General » Daily Exchange Rates**.

**Contents**

<table>
<thead>
<tr>
<th>Currency Filtering</th>
<th>If you generally need to view only one exchange rate, you can use the <strong>From Currency</strong> and <strong>To Currency</strong> fields to filter out other exchange rates. You can also select a currency just from the <strong>From Currency</strong> field and leave the <strong>To Currency</strong> field blank. Vision displays all the currency exchanges from that currency to all the other currency exchange rates. Vision remembers filtering settings from one login session to the next. These settings are individually set, and can be changed at any time.</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Currency</td>
<td></td>
</tr>
<tr>
<td>To Currency</td>
<td>If you generally need to view only one exchange rate, you can use the <strong>From Currency</strong> and <strong>To Currency</strong> fields to filter out other exchange rates. You can also select a currency just from the <strong>To Currency</strong> field and leave the <strong>From Currency</strong> field blank. Vision displays all the currency exchanges to that currency from all the other currency exchange rates. Vision remembers filtering settings from one login session to the next. These settings are individually set, and can be changed at any time.</td>
</tr>
<tr>
<td>Date Filtering</td>
<td>Use the <strong>Start Date</strong> and the <strong>End Date</strong> fields to filter exchange rate records by date. For example, if you enter 2/15/13 in this field and 2/20/13 in the <strong>End Date</strong> field, Vision displays only those exchange rate records that fall within those dates. You can also filter records by date by entering a date in the <strong>Start Date</strong> field and leaving the <strong>End Date</strong> field blank. Vision displays all records from the <strong>Start Date</strong> to the present. To filter by dates, you need to enter a date in the <strong>Date</strong> field on this form. You can also use the calendar button in this field to select a date.</td>
</tr>
<tr>
<td>Start Date</td>
<td></td>
</tr>
<tr>
<td>End Date</td>
<td>Use the <strong>Start Date</strong> and the <strong>End Date</strong> fields to filter exchange rate records by date. For example, if you enter 2/15/13 in the <strong>Start Date</strong> field and 2/20/13 in this field, Vision displays only those exchange rate records that fall within those dates. You can also filter records by date by entering a date in the <strong>End Date</strong> field and leaving the <strong>Start Date</strong> field blank. Vision displays all records from the first exchange rate you entered to the <strong>End Date</strong>. To filter by dates, you need to enter a date in the <strong>Date</strong> field on this form. You can also use the calendar button in this field to select a date.</td>
</tr>
<tr>
<td>Rate Download Exchange Date</td>
<td><strong>Today’s Date</strong> Select this option if you want to default to the current day for the download rate. <strong>Specific Date</strong> Select this option and then select a date from the calendar to specify an exact date for the download rate.</td>
</tr>
<tr>
<td>Rate Download Exchange Date</td>
<td></td>
</tr>
</tbody>
</table>

**Exchange Rates Grid**

<table>
<thead>
<tr>
<th>Exchange Rates Drop-down</th>
<th>The Vision grids contain a drop-down list that displays a combination of the following options: Print grid information</th>
</tr>
</thead>
</table>
### Exchange Rates Overview

You can set up exchange rates from one currency to another currency for a specific period. For example, your firm may use period exchange rates for re-evaluations and consolidated financial reporting.

You specify:

- The "from" currency and "to" currency
- The date to which the exchange rate applies
- The exchange rate, to 10 decimal places

Because these rates are retained indefinitely, the Period Exchange Rates feature provides filters that you can use to limit the number of rates that appear. You can filter either by currency or period. For example, you can limit the list to show only currency exchange rates between Canadian dollars and American dollars. Vision retains these individual user settings until you change them.
Period Exchange Rates Form

Use the Period Exchange Rates form of General System Setup to configure exchange rates from one currency to another currency for a specific period. If your firm uses the Multicompany feature, the available currencies are limited to those enabled for the active company.

Location

To display the form, complete the following step:

1. From the Vision Navigation menu, click Configuration » General » Period Exchange Rates.

Contents

<table>
<thead>
<tr>
<th>Currency Filtering From Currency</th>
<th>If you generally need to view only one exchange rate, you can use the From Currency and To Currency fields to filter out other exchange rates. You can also select a currency from the From Currency field and leave the To Currency field blank. Vision displays all the currency exchanges from that currency to all the other currency exchange rates. Vision remembers the filtering settings from one login session to the next. These settings are individually set, and can be changed at any time.</th>
</tr>
</thead>
<tbody>
<tr>
<td>To Currency</td>
<td>If you generally need to view only one exchange rate, you can use the From Currency and To Currency fields to filter out other exchange rates. You can also select a currency from the To Currency field and leave the From Currency field blank. Vision displays all the currency exchanges to that currency from all the other currency exchange rates. Vision remembers the filtering settings from one login session to the next. These settings are individually set, and can be changed at any time.</td>
</tr>
<tr>
<td>Period Filtering Start Period</td>
<td>Use the Start Date and the End Date fields to filter exchange rate records by date. For example, if you enter 2/15/13 in this field and 2/20/13 in the End Date field, Vision displays only those exchange rate records that fall within those dates. You can also filter records by date by entering a date in the Start Date field and leaving the End Date field blank. Vision displays all records from the Start Date to the present. To filter by dates, you need to enter a date in the Date field on this form.</td>
</tr>
<tr>
<td>End Period</td>
<td>Use the Start Date and the End Date fields to filter exchange rate records by date. For example, if you enter 2/15/13 in the Start Date field and 2/20/13 in this field, Vision displays only those exchange rate records that fall within those dates. You can also filter records by date by entering a date in the End Date field and leaving the Start Date field blank. Vision displays all records from the first exchange rate you entered to the End Date. To filter by dates, you need to enter a date in the Date field on this form.</td>
</tr>
</tbody>
</table>

Exchange Rates Grid

<table>
<thead>
<tr>
<th>Exchange Rates Drop-down</th>
<th>The Vision grids contain a drop-down list that displays a combination of the following options: Print grid information Export grid data to Excel Enable Grouping</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Currency</td>
<td>Select the From currency. The drop-down list contains the list of currencies you specified in Configuration » General » Company Settings.</td>
</tr>
</tbody>
</table>
To Currency
Select the To currency. The drop down list contains the list of currencies you specified in Configuration » General Company Settings.

Period
Select the period for which you want to create an exchange rate. Periods are for months.

Average Rate
Enter the average rate for that period (month), using up to 10 decimals.

End Rate
Enter the exchange rate for the period (month) end, using up to 10 decimals.

Currency Override Dialog Box
If you use the Multicurrency feature, you can use the Currency Override dialog box to select a different transaction currency for the current transaction or to override the exchange rate used for the current transaction.

Location
To display the dialog box, complete the following steps:

1. Click Transaction Center » Transaction Entry from the Vision Navigation menu.
2. From the drop-down list for the Transaction Type option, select the transaction type. Vision displays all existing transaction files for that type.
3. Either create a new transaction file or select an existing one, then click Open.
4. Click Currency (in the toolbar) to display the Currency Override dialog box.

Contents

<table>
<thead>
<tr>
<th>Transaction Currency</th>
<th>Select the transaction currency.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Method</td>
<td>Select the method for the exchange override: Date or Rate. If the selected currency is the same as the functional currency, you must instead make the Date or Rate override at the detail level (on the appropriate line in the grid). Vision displays a Date or Rate dialog box message indicating the conflict.</td>
</tr>
<tr>
<td>Date</td>
<td>If you select Date in the Method field, use this field to specify the date you want to use in place of the date the transaction took place. You can enter a date directly or click the calendar icon to scroll to and select the date you want.</td>
</tr>
<tr>
<td>Rate</td>
<td>If you select Rate in the Method field, enter the rate (using up to 10 decimals) that you want to use in place of the currency exchange rate set up in Configuration.</td>
</tr>
<tr>
<td>Payment Currency</td>
<td>This is the currency in which payments are to be made, if it is different from the transaction currency.</td>
</tr>
<tr>
<td>Method</td>
<td>Select the method for the exchange override: Date or Rate.</td>
</tr>
<tr>
<td>Date</td>
<td>If you select Date in the Method field, use this field to specify the date you want to use in place of the date the transaction took place. You can enter a date directly or click the calendar icon to scroll to and select the date</td>
</tr>
<tr>
<td>Rate</td>
<td>If you select Rate in the Method field, enter the rate (using up to 10 decimals) that you want to use in place of the currency exchange rate set up in Configuration.</td>
</tr>
</tbody>
</table>
Reporting

Turn HTML Formatting On or Off for Memo Fields

If you include a column for a memo field on a report and you do not want to apply HTML formatting (bold, underlining, colors, and so on) to the contents of the column based on the formatting applied when the text was originally entered in each memo field, you can turn off the HTML formatting for that report column.

You can also use the HTML Formatting check box on the Layout tab of the Options dialog box to turn off or on HTML formatting for all memo fields on the report.

To turn HTML formatting on or off for a memo field column, complete the following steps:

1. Click the Columns tab on the Options dialog box.
2. To turn off HTML formatting for a memo field, clear the HTML check box in the grid column.
   To turn on HTML formatting for a memo field column, select the HTML check box in the grid column.
3. After you set all report options, click Apply.

Columns Tab of the Options Dialog Box

Use the Columns tab to select the columns on the report. Each report has a default set of columns but you can modify it. You can also modify column attributes.

If you select Automatic as your page orientation on the Layout tab and then select so many columns for a report that it exceeds the page size, Vision displays a warning message. If that happens, try one or more of the following to make the columns fit the page: Adjust column widths, select fewer columns, change the report margins, or change the page dimensions.

This table contains options that display on the Columns tab for all reports.

<table>
<thead>
<tr>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Drop-down list in the upper left corner of the grid</strong></td>
</tr>
<tr>
<td>The Vision grids contain a drop-down list that displays a combination of the following options:</td>
</tr>
<tr>
<td>Print grid information</td>
</tr>
<tr>
<td>Export grid data to Excel</td>
</tr>
<tr>
<td>Enable Grouping</td>
</tr>
<tr>
<td>Not all options are available on all grids.</td>
</tr>
</tbody>
</table>

| Move to top                                                                                                             |
| Click this grid option to move all selected columns (rows with Select selected) to the top of the list. (The current order of the remaining rows does not change.) |

| Find                                                                                                                      |
| Click this grid option to search the Column Name grid column for text that you specify.                                  |

| Find next                                                                                                                |
| If you use Find and the first instance of the search text is not the one you expect, this grid option moves to the next row. |
| **Find next** | Find next grid option to find the next instance. |
| **Edit calculation** | Click this grid option to modify an existing calculated field on the report. |
| **New Calculation** | Click this grid option to add a calculated field of your own design to the report. |
| **Row selection column** | When you click in a row in the grid, the first column of the grid displays next to it to mark the currently selected column. |
| **Select** | Select the columns for the current report:  
To add a column, select Select for that column in the grid. You can select as many columns as you want for a single report.  
To remove a column, clear the Select check box for that column.  
To move a column, click in the row for the column and click up or down in the list. Columns appear on the report in the order they are listed on the Columns tab. |
| **Column Name** | This grid column displays the column name.  
The column name is not the column heading for the report. **Line 1 Heading** and **Line 2 Heading** (described below) display the default column heading. If you want a different heading on your report, enter it in **Line 1 Heading** and **Line 2 Heading**. |
| **Section** | For some Customer Relationship Management (CRM) reports, you can specify user-defined sections on the User Defined Sections tab. Use **Section** to assign report columns to those user-defined sections. |
| **Section Column** | For some CRM reports, you can specify user-defined sections on the User Defined Sections tab and use the **Section** grid column to assign report columns to each section. If you do, you can use **Section Column** in the grid on the Columns tab to specify the order of the columns in each section. For example, enter 1 in **Section Column** for the first column in the section, 2 for the second column, and so on. |
| **Line 1 Heading, Line 2 Heading** | Enter the heading that is displayed on the report for the column.  
The headings can have one line or two. If the heading requires only one line, enter it in **Line Heading 2**.  
If you enter a heading that is longer than the default heading, you may need to adjust the column width in **Width**. |
| **Width** | Enter the width of the column in either inches or millimeters based on which one you selected in the **Unit of Measure** field on the Layout tab of the Options dialog box.  
If you select inches, enter fractions using decimals (for example 1.00, 1.5, and so on).  
By default, Vision provides column widths suitable for the default heading text in **Line Heading 1** and **Line Heading 2**. If you enter a longer heading, you can adjust the column width. |
| **Format** | For date, currency, and number columns, **Format** displays the format in which
the report presents the column value.

To change the format, click in **Format** and click to open the Format dialog box.

<table>
<thead>
<tr>
<th><strong>Alignment</strong></th>
<th>Specify how you want the data aligned in the column: left justified, centered, or right justified.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>HTML</strong></td>
<td>This check box is only available for memo field columns. By default, it is selected. Select <strong>HTML</strong> if you want to apply HTML formatting (bold, underlining, colors, and so on) to the contents of the column based on the formatting applied when the text was originally entered in each memo field. If you do not want to apply HTML formatting, clear this check box to print or display the text without any special formatting. You may want to do this if, for example, the formatting was applied inconsistently during data entry or the formatting is unsatisfactory for some other reason.</td>
</tr>
<tr>
<td><strong>Type</strong></td>
<td>This grid column displays the type of column: <strong>Standard</strong> — Standard Vision column. <strong>Standard Grid</strong> — Standard Vision column for the grid type you selected on the General tab of the Options dialog box. <strong>User Defined</strong> — User-defined column. <strong>User Defined Grid</strong> — User-defined column for the grid type you selected on the General tab of the Options dialog box. <strong>Calculated</strong> — Calculated field column.</td>
</tr>
<tr>
<td><strong>Left margin indent for first column</strong></td>
<td>Enter the number of inches or millimeters that you want the first column indented (offset) from the left margin of the page. Use either inches or millimeters based on which one you selected in the <strong>Unit of Measure</strong> field on the report Options Layout tab. To determine the position of the first column, Vision adds your entry in <strong>Left margin for first column</strong> to the entry in <strong>Left Margin</strong> on the Layout tab. For example, if you use inches and the <strong>Left Margin</strong> contains 1.00 and <strong>Left margin for first column</strong> contains .25, Vision prints the report header information with a 1.00-inch margin but prints the first column 1.25 inches from the left edge of the page.</td>
</tr>
</tbody>
</table>

### Layout Tab of the Options Dialog Box

Use the Layout tab to set the font, margins, orientation, page size, and other formatting options for the report. (For client, contact, employee, lead, and vendor mailing labels, formatting options are on the General tab instead of the Layout tab.)

The default margins for a report are one of the following:

- The Vision default margins
- The default margins set up for your username and password on the Users and Passwords form ([Configuration » Security » Users and Passwords](#))
- The default margins that you specified on the Reporting tab of the User Options dialog box
- The margins specified in the report file

You can specify different margins for a report, no matter what the default source is.
### Contents

| Unit of Measure | From the drop-down list, select the unit of measure, inches or millimeters, to use for the following measurement fields on the report Options dialog box:  
**Top, Bottom, Left, and Right** margin fields on the Layout tab.  
**Dimension Width** and **Height** fields on the Layout tab.  
**Left margin for first column** and **Width** fields on the Columns tab.  
**Left margin indent for groups** on the Sorting/Grouping tab.  
**Height, Width, Top,** and **Left** fields on the Graph tab.  
When you switch from one unit of measure to the other, the measurements that are currently entered or displayed in the measurement fields are automatically converted to the new unit of measure (1 inch = 25.4 millimeter). |
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Margins: Top</td>
<td>Enter the margin for the top of the page. Use the unit of measure (inches or millimeters) that you entered in the <strong>Unit of Measure</strong> field on this tab. If your unit of measure is inches, use decimals for fractions of an inch (for example, 0.75 or 1.20).</td>
</tr>
<tr>
<td>Margins: Bottom</td>
<td>Enter the margin for the bottom of the page. Use the unit of measure (inches or millimeters) that you entered in the <strong>Unit of Measure</strong> field on this tab. If your unit of measure is inches, use decimals for fractions of an inch (for example, 0.75 or 1.20).</td>
</tr>
<tr>
<td>Margins: Left</td>
<td>Enter the margin for the left edge of the page. Use the unit of measure (inches or millimeters) that you entered in the <strong>Unit of Measure</strong> field on this tab. If your unit of measure is inches, use decimals for fractions of an inch (for example, 0.75 or 1.20).</td>
</tr>
<tr>
<td>Margins: Right</td>
<td>Enter the margin for the right edge of the page. Use the unit of measure (inches or millimeters) that you entered in the <strong>Unit of Measure</strong> field on this tab. If your unit of measure is inches, use decimals for fractions of an inch (for example, 0.75 or 1.20).</td>
</tr>
<tr>
<td>Override Heading Dates</td>
<td>By default, Vision uses the starting and ending dates for the accounting period you selected when you logged in to Vision. To specify different period dates for the report heading, select <strong>Override Heading Dates</strong> and enter the dates you want in the <strong>For the Period</strong> date fields. You can enter dates directly, or you can click <img src="image" alt="Date Field" /> and select them.</td>
</tr>
</tbody>
</table>
| Default Formats: Override regional settings | If you want to use formatting for numbers or currency amounts for a report that is different than the default formatting in Regional and Language Options in Windows Control Panel, select the **Override regional settings** check box and select the culture associated with the format you want from the drop-down list. If you select a different culture, Vision automatically displays the default formats associated with that culture in the **Number**, **Currency**, and **Date** fields.  
If you do not select **Override regional settings**, the format settings are the settings specified for your computer in Regional and Language Options in Windows Control Panel. |
| Default Formats: Number | This field displays the default format for non-currency numbers for the report. This format is the default format for each numeric field on the report.  
To change the default format, click ![Format Number](image) to open the Format Number dialog. |
To change the format for an individual report column, go to the Columns tab, click the Format grid column for the report column, and click to open the Format Number dialog box.

**Default Formats: Currency**

This field displays the default format for currency amounts for the report. This format is the default format for each currency field on the report.

To change the default format, click to open the Format Currency dialog box.

To change the format for an individual report column, go to the Columns tab, click the Format grid column for the report column, and click to open the Format Currency dialog box.

**Default Formats: Date**

This field displays the default date and time format for the report. This format is the default format for each date or date-and-time field on the report.

To change the default format, click to open the Format Date dialog box.

To change the format for an individual date column, go to the Columns tab, click the Format grid column for the report column, and click to open the Format Date dialog box.

**Default Formats: Report language**

If you use the Multilingual feature, this field displays the language in which the report will be generated. If you do not use the Multilingual feature, Vision does not display this field.

For standard Vision reports, this field displays the language you specified when you logged in. For favorite reports or reports for which you select a saved set of options, it displays the language that was active when you created the favorite or the options set.

You cannot use this field to change the language. To generate a report in a different language, do one of the following:

- Select that language when you log in to Vision and then generate the report. (This only applies to standard reports. For favorite reports, Vision always uses the language specified when you created the favorite, whether or not it matches the language you selected when you logged in.)
- Select a set of saved options that you created for that language.
- Select a favorite version of the report that you created for that language.

**Page: Orientation**

From the drop-down list, select one of the following options for the orientation of the report on the printed page:

- **Automatic** — Vision selects the most appropriate orientation based on the columns you select for the report, the page size, and the margins. If the columns fit across the narrow dimension of the page, Vision uses portrait orientation. If the columns do not fit across the narrow dimension, Vision uses the landscape orientation.
- **Portrait** — Select this option if you always want the long dimension of the page to be vertical.
- **Landscape** — Select this option if you always want the long dimension of the page to be horizontal.

The Orientation option is available only for reports for which you can select columns.
### Page: Size
From the drop-down list, select the page size for the report. The width and height of the page size that you select in this field display in the **Dimension Width** and **Height** fields below the **Size** field.
When you select the **Custom** size, the **Dimension Width** and **Height** fields are enabled so you can enter a width and height of your choice.

### Page: Dimensions (Width and Height)
The **Width** and **Height** fields display the width and height of the page size that you select in the **Size** field. The measurements display in either inches or millimeters based on which one you selected in the **Unit of Measure** field on this tab.
If you select **Custom** in **Size**, enter the width and height that you want.

### Miscellaneous: Font Name
Use **Font Name** to change the font for the report. The default font for a report is one of the following:
The Vision default font (Arial)
The default font set up for your username and password in the Users and Passwords form ([Configuration » Security » Users and Passwords](#))
The default font that you selected on the Reporting tab of the User Options dialog box.

### Miscellaneous: Heading background color
From the drop-down list, select a background color for the report row that displays column headings. Use this option to make the headings stand out from the rest of the report data, for example.

### Miscellaneous: Use Dashpart Report Layout
Select this check box to generate the report using the special formatting that Vision applies when you display a report as a dashpart on the Vision Dashboard.
The following are the main formatting characteristics:
The report header information is displayed in the lower-left corner of the final report page.
The default font size is applied to the report title, replacing the larger font that is normally used.
Page headers and footers are not displayed.
You normally do not use this option except when you want to generate a report as an archive report and you want to display that archive report as a dashpart. When Vision displays an archive report as a dashpart, it does not actually run the report, so it cannot automatically apply the dashpart report layout as it does with other reports. As a result, you must use this option when you generate the archive report if you want the normal dashpart report layout.

### Miscellaneous: Show grid lines on report
To generate the report with grid lines separating data fields, select this check box. Some reports are easier to read with grid lines displayed.

### Miscellaneous: HTML Formatting
This option only applies to memo fields.
Select this check box if you want to apply HTML formatting (bold, underlining, colors, and so on) to the contents of all memo fields based on the formatting applied when the text was originally entered in each memo field.
If you do not want to apply HTML formatting, clear this check box to print or display the text in all memo fields without any special formatting. You may want to do this if, for example, the formatting was applied inconsistently during data entry or the formatting is unsatisfactory for some other reason.
For reports for which you can select memo fields for the report on the Columns tab of the Options dialog box, you can also turn HTML formatting.
Use the Document Map to Find Data

When you preview a report, you can use the document map to locate and jump to a specific section of the report. The document map is not available if you change the display in the Preview window to page layout mode.

To use the document map to locate data in a report, complete the following steps:

1. Preview a report or preview a favorite.
2. Click the bar on the left edge of the Preview window to display the document map.
3. Click \( \rightarrow \) next to map components to display subgroups under them. (To hide the subgroups again, click \( \leftarrow \).)
4. When you find the value in the map corresponding to the location in the report that you want to review (a specific project number, for example), click that value.
   Vision displays that portion of the report.
5. To hide the document map, click the bar on the right edge of the document map pane.

Change Report Parameters in the Preview Window

For some reports, you can change selected report parameters in the Preview window and generate the report again without returning to the Options dialog box.

To change parameters in the Preview window, complete the following steps:

1. Preview a report or preview a favorite.
2. Click the bar on the top edge of the Preview window toolbar to display the parameter area.
3. At the top of the Preview window, Vision displays fields for the parameters that you can change.
4. Change the parameters.
5. Click **View Report**.
6. Vision generates the report based on the new parameters.
7. To hide the parameters, click the bar at the bottom edge of the parameter area.

**Preview Window Options**

When you preview a report, use the toolbar at the top of the Preview window to perform actions such as navigate within the report or print the report.

| **Show or Hide Document Map** | Click the bar on the left edge of the Preview window to display the document map. Use the document map to locate and jump to a specific section of the report.  
| | ![Image of document map](image)
| | Click the similar bar on the right edge of the document map pane to hide the document map.  
| | The document map is an outline of the structure of the report, based on the sorting and grouping criteria you set up for the report. The document map contains a link for each sorting and grouping value. When you click a link in the map, Vision displays that portion of the report in the Preview window.  
| | For example, if you sort and group data on a report by project number and phase number, the document map contains a link for each project number at the top level of the map hierarchy and a link for each phase within each project at the next level of the hierarchy.  
| | The document map is not available when you display the report in print layout mode. |

| **Show or Hide Parameter Area** | Click the bar on the top edge of the Preview window toolbar to display the parameter area. In the parameter area, you can change selected report parameters and click **View Report** to generate the report again without returning to the Options dialog box.  
| | ![Image of parameter area](image)
| | Click the similar bar at the bottom edge of the parameter area to hide the parameter area.  
| | This option is not available for all reports. |

| **First Page** | Click this option to display the first page of the report. |
| **Previous Page** | Click this option to display the previous page of the report. |
| **___ of ___** | This option displays the current page number and the total number of pages in the report (for example, **27 of 50**). |
### Reporting

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Next Page</strong></td>
<td>Click this option to display the next page of the report.</td>
</tr>
<tr>
<td><strong>Last Page</strong></td>
<td>Click this option to display the last page of the report.</td>
</tr>
<tr>
<td><strong>Stop</strong></td>
<td>If Vision is generating a report and you want to stop that process rather than wait for Vision to display the report, click this option.</td>
</tr>
<tr>
<td><strong>Refresh</strong></td>
<td>Click this option to regenerate the report with the current data in the database.</td>
</tr>
<tr>
<td><strong>Print</strong></td>
<td>Click this option to display the Print dialog box and then select a printer and set other printing options.</td>
</tr>
<tr>
<td><strong>Print Layout</strong></td>
<td>Click this option to display the report as it would look if you printed it. If you click <img src="image" alt="printer" /> and change the page setup options (the margins, for example), Vision regenerates the report based on the new settings. In print layout mode, you cannot do the following: Use <img src="image" alt="document map" /> to display the document map. Use <img src="image" alt="search" /> to search for data in the report. Drill down to view supporting detail. Click <img src="image" alt="preview" /> again to display the report in preview mode.</td>
</tr>
<tr>
<td><strong>Page Setup</strong></td>
<td>Click this option to display the Page Setup dialog box. On that dialog box, you can complete the following actions: Specify paper size Specify orientation (portrait or landscape) Set margins Select a printer Change printer properties</td>
</tr>
<tr>
<td><strong>Email Report</strong></td>
<td>To send the report as an email attachment or to send a link to the report in an email message, click this option. On the Email Report dialog box, specify the recipients, subject, message text, and file format.</td>
</tr>
<tr>
<td><strong>Download Report</strong></td>
<td>To save the report to a file, click this option to display the Download dialog box. In that dialog box, select the file format and indicate if you want to include all report pages or only a range of pages. You can save reports in any of the following formats: <strong>Adobe PDF</strong> — Vision generates the report as an Adobe portable document format (PDF) file with the .PDF file extension. <strong>Rich Text Format (RTF)</strong> — Vision generates the report as a Rich Text Format file with the .RTF file extension. <strong>Microsoft Word Document</strong> — Vision generates the report as a Microsoft Word document with the .DOC file extension. You can then use Word formatting options to modify the appearance of the report. If you generated the report in landscape orientation, we recommend that you set the page orientation in Word to landscape also to preserve the report layout.</td>
</tr>
</tbody>
</table>

---

**7.1 Online Help Updates**
| **Microsoft Excel Spreadsheet** — Vision generates the file in a format that you can open and work with in Excel. The file extension is .XLS. Use this option if you want to add your own calculations to the report in Excel. |
| **Tagged Image File Format (TIFF)** — Vision generates the report as a Tagged Image File with the .TIF file extension. |
| **Comma-separated File Format** — Vision generates the report as a text file that contains a set of data items separated by commas. The file extension is .TXT. |
| **XML Document** — Vision generates the report as an XML file. The file extension is .XML. |
| **HTML Document** — Vision generates the report as an HTML file. The file extension is .MHTML. |

To open the report file after Vision generates it, click **Open** in the Download dialog box. Vision opens the file in the application that is associated with the file type in Microsoft Windows. (You can review or change those associations in Windows Control Panel. Open the Control Panel window, double-click **File Options**, and click the File Types tab.) When you click **Open**, Vision also saves the report file on your computer in the Documents and Settings\<windows user>\Local Settings\Temp folder.

To save the report file after Vision generates it, click **Save** in the Download dialog box and specify the file name and location. To open the saved file, double-click it in Windows Explorer.

---

| **Show or Hide Advanced Search** |
| **Help** |
| **Zoom** |

---

| **Find** |

To do a simple search for text in the report, enter that text in **Find** and click **Find**. Vision displays and highlights the first occurrence of the text. To find the next occurrence, click **Find** again.

The search feature has the following characteristics:

- It does not differentiate between upper case and lower case letters. If you search for **project**, it will find **project**, **Project**, and **PROJECT**.
- You cannot use wildcard characters or Boolean search operators. It only finds exact matches for your search text.
- The search begins on the page of the report that is currently displayed.
- The search only finds the target text if it is visible when you do the search. It does not find data that is hidden in collapsed groups.
- This option is not available in print layout mode.
Find

Click this option to display the first occurrence of the text in Find. To find other occurrences, click .

This option is not available in print layout mode.

Find Next

After you click to display the first occurrence of the text in Find, click this option to find other occurrences.

This option is not available in print layout mode.

Archived Reports Tab

Use the Archived Reports tab to preview, print, or download archived reports. You can also distribute archived reports by email. The option to archive reports is only available if you are using the Standard Edition or Enterprise Edition of Microsoft SQL Server. If you use a different version of SQL Server, the Reporting form does not have a Create Report Archive option or an Archived Reports tab.

Reports drop-down

The Vision grids contain a drop-down list that displays a combination of the following options:
- Print grid information
- Export grid data to Excel
- Enable Grouping

Not all options are available on all grids.

Delete

To delete an archived report, select that report in the grid and click this option.

Vision automatically deletes archived reports based on the number of archive hours specified when each archived report is created. You can also use the Report Administration utility to delete archived reports.

Refresh

Click this option to retrieve and display the current list of archived reports.

Normally, Vision displays the current list. However, if you start the archive process for a report and click the Archived Reports tab before that process is finished, the list does not show the newly archived report. If you click Refresh, Vision updates the list.

Row selection column

When you click in a row in the grid, the first column of the grid displays a check mark to mark the currently selected report.

Report Name

This column displays the names of the reports. A report name can be the Vision default name or a name that you or another user specified.

Created Date

This column displays the date and time that you archived the report.

Expiration Date

This column displays the date and time that Vision will remove the archived report. The expiration date and time is based on the number of hours you specified in Archive report output (Hours) when you archived the report.

Pages

This column displays the number of pages in the report.
Report Administration Utility

Delete Archived Reports

Vision automatically deletes archived reports based on the number of archive hours specified when each archived report is created. However, you can also use the Report Administration utility to delete archived reports.

To delete archived reports, complete the following steps:

2. On the Reporting Administration form, click the Database Cleanup tab.
3. In Report Archives That Are Older Than This Number of Days, specify the minimum age in days for the files you want to display in the grid (for example, all files older than 10 days).
4. To display the reports in the grid, click Refresh.
5. To delete all archived reports that are currently displayed in the grid, click Delete.

Database Cleanup Tab of Report Administration

Use the Database Cleanup tab to delete orphaned reports and old log files.

Contents

Orphaned Report Files

<table>
<thead>
<tr>
<th>Description</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report RDL Files That Have Been Orphaned for This Number of Days</td>
<td>Enter the minimum age in days for orphaned report files that can be deleted. For example, to delete report files that are 10 or more days old, enter 10.</td>
</tr>
<tr>
<td>Total Orphaned Reports (Including Subreports)</td>
<td>This field displays the total number of orphaned reports and subreports that will be deleted, based on the number of days you entered.</td>
</tr>
<tr>
<td>Delete Reports</td>
<td>Click this option to delete orphaned report files that are older than or equal to the specified number of days.</td>
</tr>
<tr>
<td>Schedule Delete</td>
<td>Click this option to schedule the deletion process to run at a later time.</td>
</tr>
</tbody>
</table>

Report Log Rows

<table>
<thead>
<tr>
<th>Description</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report Log Rows That Are Older Than This Number of Days</td>
<td>Enter the minimum age in days for log file rows that can be deleted. For example, to delete rows that are 10 or more days old, enter 10.</td>
</tr>
<tr>
<td>Total Report Log Entries</td>
<td>This field displays the total number of log file rows that will be deleted, based on the number of days you entered.</td>
</tr>
<tr>
<td>Delete Log Rows</td>
<td>Click this option to delete report log rows that are older than or equal to the specified number of days.</td>
</tr>
<tr>
<td>Schedule Delete</td>
<td>Click this option to schedule the deletion process to run at a later time.</td>
</tr>
</tbody>
</table>
### Report Archives

<table>
<thead>
<tr>
<th>Description</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Report Archives That Are Older Than This Number of Days</strong></td>
<td>Enter the minimum age in days for archived report files that you want to display in the grid. For example, to display report files that are 10 or more days old, enter 10. After you enter the number of days, click <strong>Refresh</strong> on the grid toolbar to display the archived reports that are that old or older. If you leave this field blank and click <strong>Refresh</strong>, the grid displays all archived reports.</td>
</tr>
<tr>
<td><strong>Report Archives Grid Dropdown</strong></td>
<td>Click the down-arrow to display these options: Print Export to Excel</td>
</tr>
<tr>
<td><strong>Refresh</strong></td>
<td>After you enter a number of days old in <strong>Report Archives That Are Older Than This Number of Days</strong>, click <strong>Refresh</strong> to display the reports that are that old or older. If you leave <strong>Report Archives That Are Older Than This Number of Days</strong> blank and click <strong>Refresh</strong>, the grid displays all archived reports.</td>
</tr>
<tr>
<td><strong>Delete</strong></td>
<td>To delete a report, click the report and click <strong>Delete</strong>.</td>
</tr>
<tr>
<td><strong>Username</strong></td>
<td>This column displays the Vision username of the person who created the archived report.</td>
</tr>
<tr>
<td><strong>Folder</strong></td>
<td>This column displays the area of Reporting from which you generate the report. For example, if you go to <strong>Reporting » Client</strong> to generate the report, this field displays <strong>Client</strong>.</td>
</tr>
<tr>
<td><strong>Report Name</strong></td>
<td>This column displays the name of the archived report.</td>
</tr>
<tr>
<td><strong>Created Date</strong></td>
<td>This column displays the date that the archived report was created.</td>
</tr>
<tr>
<td><strong>Expiration Date</strong></td>
<td>This column displays the date and time that Vision will automatically remove the archived report. The expiration date and time is based on the number of archive hours that was specified when the report was archived or scheduled to be archived.</td>
</tr>
</tbody>
</table>
Reporting - Tax Analysis Report

Use the Tax Analysis report to review purchases, sales, and associated taxes. You can also use it to review tax entries for employee expenses.

Leading Zeros in Invoice Numbers, Voucher Numbers

If your firm uses leading zeros in invoice numbers but you do not want to display the zeros on this report, clear the Display invoice leading zeros option on the General tab of the Accounting System Settings form.

If your firm uses leading zeros in voucher numbers but you do not want to display the zeros on this report, clear the Display voucher leading zeros option on the Accounts Payable tab of System AP Configuration.

Configuration

This report is only available if Enable Tax Auditing Feature is selected on the Accounting Company Settings form (Configuration » Accounting » Company Settings).

You can only generate the cash-basis version of this report if Cash-basis reporting is selected on the Accounting System Settings form (Configuration » Accounting » System Settings).

Retainage Invoices

This report shows retainage invoices that include tax amounts. Because the retainage invoice number is the same as the number of the original invoice from which it was withheld, Vision displays Retainage Billing in the Description column to identify the retainage invoices.

The report does not show retainage invoices for which no taxes are due.

Multicompany

If you are using the Multicompany feature, only information for the active company is included in this report.

As a result, if you have projects for which lower work breakdown structure levels belong to companies other than the company that owns the project, billing transactions associated with those levels will not appear on this report when you generate it for the company that owns the project. To see those transactions, generate the report for the company to which the lower work breakdown structure level belongs.

Multicurrency

If you are using the Multicurrency feature, you have the option to have the report display net amounts, tax basis amounts, and tax amounts in any of the following types of currency:

- **Transaction currency** — If you choose to use transaction currency, you also indicate if you want to include all currencies or only selected currencies. Vision then limits the transactions on the report to those with the specified transaction currencies.

- **Functional currency** — If you choose to use functional currency, the report displays the amounts in the functional currency of the active company.

- **Tax currency** — This option is only available if tax auditing is enabled for the active company. If you choose to use tax currency, the report displays the amounts in the
currency specified for the tax code in the Tax Codes form. Normally, this is the currency in which the tax is reported and paid to the taxing authority.

Vision stores amounts in these types of currencies when the transaction is posted. The amounts are calculated using the exchange rates in effect on the posting date.
Reporting - Tax Analysis General Tab

Use the General tab to do the following:

- Rename the report
- Set report options
- Save sets of options
- Apply an existing set of saved options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report Name</td>
<td>You can change the default report name. [Link](<a href="http://hq1apprd44vs/Vision70/Help/en-us/rept_Tax_Analysis_General_Tab.htm">http://hq1apprd44vs/Vision70/Help/en-us/rept_Tax_Analysis_General_Tab.htm</a> - Tax_Analysis_General_Tab)</td>
</tr>
<tr>
<td>Tax Code</td>
<td>Select &lt;all tax codes&gt; if you want the report to include transactions for all tax codes. To select one or more tax codes, click ![Link](<a href="http://hq1apprd44vs/Vision70/Help/en-us/rept_Tax_Analysis_General_Tab.htm">http://hq1apprd44vs/Vision70/Help/en-us/rept_Tax_Analysis_General_Tab.htm</a> - Tax_Analysis_General_Tab) to display the Tax Code Lookup dialog box. [Link](<a href="http://hq1apprd44vs/Vision70/Help/en-us/rept_Tax_Analysis_General_TAB.htm">http://hq1apprd44vs/Vision70/Help/en-us/rept_Tax_Analysis_General_TAB.htm</a> - Tax_Analysis_General_Tab)</td>
</tr>
<tr>
<td>Input</td>
<td>Select this option for purchases to display on the report. This option is selected by default.</td>
</tr>
<tr>
<td>Output</td>
<td>Select this option for sales to display on the report. This option is selected by default.</td>
</tr>
</tbody>
</table>
| Time Frame        | Specify the period for the report:  
- **Current Period** — Select this option to generate the report for the accounting period that is currently open.  
- **Year-to-Date** — Select this option to generate the report for the current fiscal year through the current accounting period.  
- **Range of Periods** — Select this option to generate the report for a range of accounting periods. Select accounting periods from the drop-down lists, or enter them in mm/yyyy format.  
- **Range of Dates** — Select this option to generate the report for a range of dates. Enter the start and end dates, or click the calendar icons to select the dates. [Link](http://hq1apprd44vs/Vision70/Help/en-us/rept_Tax_Analysis_General_Tab.htm - Tax_Analysis_General_Tab) |
| Tax Detail Summary| Use this drop-down list box to select the type of summary version for the Tax Analysis report.  
- **Tax Code Detail** — Select this option to generate a detailed version of the Tax Analysis report. That version displays the following for each purchase and sale transaction: transaction date, transaction type, invoice or reference number, vendor or client identification and description of transaction, fiscal period, posting sequence number, project number, phase number, task number, general ledger account number, net amount or tax basis, and tax amount. The report groups transactions by tax code.  
- **Tax Code Summary** — Select this option to generate the summary version of the Tax Analysis report. The report displays total net amount or tax basis and total tax amount for each tax code. It does not display individual transactions. When you select Tax Code Summary, the report does not display transaction detail, so... |
7.1 Online Help Updates

<table>
<thead>
<tr>
<th>the Sort By option is not available.</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Vendor Client Summary — Select this option for the tax analysis report to summarize the report by vendor/client. [<a href="http://hq1apprd44vs/Vision70/Help/en-us/rept_Tax_Analysis_General_Tab.htm">http://hq1apprd44vs/Vision70/Help/en-us/rept_Tax_Analysis_General_Tab.htm</a> - Tax_Analysis_General_Tab](<a href="http://hq1apprd44vs/Vision70/Help/en-us/rept_Tax_Analysis_General_Tab.htm">http://hq1apprd44vs/Vision70/Help/en-us/rept_Tax_Analysis_General_Tab.htm</a> - Tax_Analysis_General_Tab)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Sort By</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>If you select Tax Code Detail, the report displays transaction detail for each tax code. Use <strong>Sort By</strong> to select the value by which Vision should sort the transactions for each tax code:</td>
</tr>
<tr>
<td>• Tax Point Date (transaction date)</td>
</tr>
<tr>
<td>• Transaction Type</td>
</tr>
<tr>
<td>• Invoice Number</td>
</tr>
<tr>
<td>• Account Number [<a href="http://hq1apprd44vs/Vision70/Help/en-us/rept_Tax_Analysis_General_Tab.htm">http://hq1apprd44vs/Vision70/Help/en-us/rept_Tax_Analysis_General_Tab.htm</a> - Tax_Analysis_General_Tab](<a href="http://hq1apprd44vs/Vision70/Help/en-us/rept_Tax_Analysis_General_Tab.htm">http://hq1apprd44vs/Vision70/Help/en-us/rept_Tax_Analysis_General_Tab.htm</a> - Tax_Analysis_General_Tab)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Cash Basis Reporting</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Select this option to generate the cash-basis version of the report for paid vouchers and invoices.</td>
</tr>
<tr>
<td>This option is not available if the cash-basis reporting feature is not enabled in Configuration. [<a href="http://hq1apprd44vs/Vision70/Help/en-us/rept_Tax_Analysis_General_Tab.htm">http://hq1apprd44vs/Vision70/Help/en-us/rept_Tax_Analysis_General_Tab.htm</a> - Tax_Analysis_General_Tab](<a href="http://hq1apprd44vs/Vision70/Help/en-us/rept_Tax_Analysis_General_Tab.htm">http://hq1apprd44vs/Vision70/Help/en-us/rept_Tax_Analysis_General_Tab.htm</a> - Tax_Analysis_General_Tab)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Report in</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>If you are using the Multicurrency feature, you have the option to have the report display net amounts, tax basis amounts, and tax amounts in any of the following types of currency:</td>
</tr>
<tr>
<td>• <strong>Transaction Currency:</strong> If you choose to use transaction currency, the report displays the amounts in the currency associated with the individual transactions. Use the <strong>Currency</strong> field to indicate if you want to include all currencies or only selected currencies. Vision then limits the transactions on the report to those with the specified transaction currencies.</td>
</tr>
<tr>
<td>• <strong>Functional Currency:</strong> If you choose to use functional currency, the report displays the amounts in the functional currency of the active company.</td>
</tr>
<tr>
<td>• <strong>Tax Currency:</strong> (This option is only available if tax auditing is enabled for the active company.) If you choose to use tax currency, the report displays the amounts in the currency specified for the tax code in the Tax Codes form. Normally, this is the currency in which the tax is reported and paid to the taxing authority. [<a href="http://hq1apprd44vs/Vision70/Help/en-us/rept_Tax_Analysis_General_Tab.htm">http://hq1apprd44vs/Vision70/Help/en-us/rept_Tax_Analysis_General_Tab.htm</a> - Tax_Analysis_General_Tab](<a href="http://hq1apprd44vs/Vision70/Help/en-us/rept_Tax_Analysis_General_Tab.htm">http://hq1apprd44vs/Vision70/Help/en-us/rept_Tax_Analysis_General_Tab.htm</a> - Tax_Analysis_General_Tab)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Currency</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>If you are using the Multicurrency feature and you select <strong>Transaction Currency</strong> in <strong>Report in</strong>, use this field to indicate if you want to include all currencies or only selected currencies. Vision then limits the transactions on the report to those with the specified transaction currencies. Click to display the Currency Lookup dialog box, and select the currencies. [<a href="http://hq1apprd44vs/Vision70/Help/en-us/rept_Tax_Analysis_General_Tab.htm">http://hq1apprd44vs/Vision70/Help/en-us/rept_Tax_Analysis_General_Tab.htm</a> - Tax_Analysis_General_Tab](<a href="http://hq1apprd44vs/Vision70/Help/en-us/rept_Tax_Analysis_General_Tab.htm">http://hq1apprd44vs/Vision70/Help/en-us/rept_Tax_Analysis_General_Tab.htm</a> - Tax_Analysis_General_Tab)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Saved Options and Buttons</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>These fields and buttons are always available at the bottom of the Options dialog box:</td>
</tr>
<tr>
<td>• Saved Options</td>
</tr>
<tr>
<td>• Organize</td>
</tr>
</tbody>
</table>
• Default
• Help
• Run or Apply
• Cancel
Reporting – Tax Analysis Layout Tab

Use the Layout tab to set the font, margins, orientation, page size, and other formatting options for the report.

Mailing Labels

For client, contact, employee, lead, and vendor mailing labels, formatting options are on the General tab instead of the Layout tab.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unit of Measure</td>
<td>From the drop-down list, select the unit of measure to use for the following measurement fields on the report Options dialog box:</td>
</tr>
<tr>
<td></td>
<td>• Top, Bottom, Left, and Right margin fields on the Layout tab.</td>
</tr>
<tr>
<td></td>
<td>• Dimension Width and Height fields on the Layout tab.</td>
</tr>
<tr>
<td></td>
<td>• Left margin for first column and Width fields on the Columns tab.</td>
</tr>
<tr>
<td></td>
<td>• Left margin indent for groups on the Sorting/Grouping tab.</td>
</tr>
<tr>
<td></td>
<td>• Height, Width, Top, and Left fields on the Graph tab.</td>
</tr>
</tbody>
</table>

The Unit of Measure options are:

• Inches
• Millimeters

When you switch from one unit of measure to the other, the measurements that are currently entered or displayed in the measurement fields are automatically converted to the new unit of measure.

(1 inch = 25.4 millimeter) [http://hq1apprd44vs/Vision70/Help/en-us/rept_Misc_Tab.htm - Miscellaneous_tab]

Margins

The default margins for a report are one of the following:

• Vision default margins.
• Default margins set up for your username and password in the Users and Passwords form (Configuration » Security » Users and Passwords).
• Default margins that you specified on the Reporting tab of the User Options dialog box.
• Margins specified in the report file.

Regardless of the source of the default settings, you can specify different margins for a report.

<table>
<thead>
<tr>
<th>Top</th>
<th>Enter the margin for the top of the page. Use the unit of measure (inches or millimeters) that you entered in the Unit of Measure field on this tab. If your unit of measure is inches, use decimals for fractions of an inch (for example, 0.75 or 1.20). [<a href="http://hq1apprd44vs/Vision70/Help/en-us/rept_Misc_Tab.htm">http://hq1apprd44vs/Vision70/Help/en-us/rept_Misc_Tab.htm</a> - Miscellaneous_tab]</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bottom</td>
<td>Enter the margin for the bottom of the page.</td>
</tr>
</tbody>
</table>
Use the unit of measure (inches or millimeters) that you entered in the Unit of Measure field on this tab.

If your unit of measure is inches, use decimals for fractions of an inch (for example, 0.75 or 1.20).

**Left**

Enter the margin for the left edge of the page.

Use the unit of measure (inches or millimeters) that you entered in the Unit of Measure field on this tab.

If your unit of measure is inches, use decimals for fractions of an inch (for example, 0.75 or 1.20).

**Right**

Enter the margin for the right edge of the page.

Use the unit of measure (inches or millimeters) that you entered in the Unit of Measure field on this tab.

If your unit of measure is inches, use decimals for fractions of an inch (for example, 0.75 or 1.20).

**Report Heading**

Override Heading Dates

By default, Vision uses the starting and ending dates for the accounting period you selected when you logged in to Vision. To specify different period dates for the report heading, select Override Heading Dates and enter the dates you want in the For the Period date fields. You can enter dates directly, or you can click the calendar icon and select them.

**Default Formats**

Override regional settings

If you want to use formatting for numbers or currency amounts for a report that is different than the default formatting in Regional and Language Options in Windows Control Panel, select the Override regional settings check box and select the culture associated with the format you want from the drop-down list. If you select a different culture, Vision automatically displays the default formats associated with that culture in the Number, Currency, and Date fields.

If you do not select Override regional settings, the format settings are the settings specified for your computer in Regional and Language Options in Windows Control Panel.

**Number**

This field displays the default format for non-currency numbers for the report.

This format is the default format for each numeric field on the report. To change the default format, click the calendar icon to open the Format Number dialog box. In that dialog box, change the settings.

To change the format for an individual report column, go to the Columns tab, click the Format grid column for the report column, and click the calendar icon to open the Format Number dialog box.

**Currency**

This field displays the default format for currency amounts for the report.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Currency format</strong></td>
<td>This format is the default format for each currency field on the report. To change the default format, click <img src="image" alt="Format button" /> to open the Format Currency dialog box. In that dialog box, change the settings.</td>
</tr>
<tr>
<td></td>
<td>To change the format for an individual report column, go to the Columns tab, click the Format grid column for the report column, and click <img src="image" alt="Format button" /> to open the Format Currency dialog box. [<a href="http://hq1apprd44vs/Vision70/Help/en-us/rept_Misc_Tab.htm">http://hq1apprd44vs/Vision70/Help/en-us/rept_Misc_Tab.htm</a> - Miscellaneous_tab](<a href="http://hq1apprd44vs/Vision70/Help/en-us/rept_Misc_Tab.htm">http://hq1apprd44vs/Vision70/Help/en-us/rept_Misc_Tab.htm</a> - Miscellaneous_tab)</td>
</tr>
<tr>
<td><strong>Date</strong></td>
<td>This field displays the default date and time format for the report. To change the default format, click <img src="image" alt="Format button" /> to open the Format Date dialog box. In that dialog box, change the settings.</td>
</tr>
<tr>
<td></td>
<td>To change the format for an individual date column, go to the Columns tab, click the Format grid column for the report column, and click <img src="image" alt="Format button" /> to open the Format Date dialog box. [<a href="http://hq1apprd44vs/Vision70/Help/en-us/rept_Misc_Tab.htm">http://hq1apprd44vs/Vision70/Help/en-us/rept_Misc_Tab.htm</a> - Miscellaneous_tab](<a href="http://hq1apprd44vs/Vision70/Help/en-us/rept_Misc_Tab.htm">http://hq1apprd44vs/Vision70/Help/en-us/rept_Misc_Tab.htm</a> - Miscellaneous_tab)</td>
</tr>
<tr>
<td><strong>Language</strong></td>
<td>If you use the Multilingual feature, this field displays the language in which the report will be generated. If you do not use the Multilingual feature, Vision does not display this field.</td>
</tr>
<tr>
<td></td>
<td>For standard Vision reports, this field displays the language you specified when you logged in. For favorite reports or reports for which you select a saved set of options, it displays the language that was active when you created the favorite or the options set.</td>
</tr>
<tr>
<td></td>
<td>You cannot use this field to change the language. To generate a report in a different language, do one of the following:</td>
</tr>
<tr>
<td></td>
<td>• Select that language when you log in to Vision and then generate the report. (This only applies to standard reports. For favorite reports, Vision always uses the language specified when you created the favorite, whether or not it matches the language you selected when you logged in.)</td>
</tr>
<tr>
<td></td>
<td>• Select a set of saved options that you created for that language.</td>
</tr>
<tr>
<td></td>
<td>• Select a favorite version of the report that you created for that language. [<a href="http://hq1apprd44vs/Vision70/Help/en-us/rept_Misc_Tab.htm">http://hq1apprd44vs/Vision70/Help/en-us/rept_Misc_Tab.htm</a> - Miscellaneous_tab](<a href="http://hq1apprd44vs/Vision70/Help/en-us/rept_Misc_Tab.htm">http://hq1apprd44vs/Vision70/Help/en-us/rept_Misc_Tab.htm</a> - Miscellaneous_tab)</td>
</tr>
<tr>
<td><strong>Orientation</strong></td>
<td>From the drop-down list, select one of the following options for the orientation of the report on the printed page:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Automatic</strong> — Vision selects the most appropriate orientation based on the columns you select for the report, the page size, and the margins. If the columns fit across the narrow dimension of the page, Vision uses portrait orientation. If the columns do not fit across the narrow dimension, Vision uses the landscape orientation.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Portrait</strong> — Select this option if you always want the long dimension of the page to be vertical.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Landscape</strong> — Select this option if you always want the long dimension of the page to be horizontal.</td>
</tr>
<tr>
<td></td>
<td>The <strong>Orientation</strong> option is available only for reports for which you can select...</td>
</tr>
</tbody>
</table>
**Size**

From the drop-down list, select the page size for the report. The options are:

- Letter
- Legal
- Ledger
- Tabloid
- A4
- A3
- Executive
- Custom

The width and height of the page size that you select in this field display in the **Dimension Width** and **Height** fields below the **Size** field.

When you select the **Custom** size, the **Dimension Width** and **Height** fields are enabled so you can enter a width and height of your choice.

**Dimensions (Width and Height)**

The **Width** and **Height** fields display the width and height of the page size that you select in the **Size** field.

The measurements display in either inches or millimeters based on which one you selected in the **Unit of Measure** field on this tab.

The page size dimensions are as follows:

<table>
<thead>
<tr>
<th>Page Size</th>
<th>Inches Width x Height</th>
<th>Millimeters Width x Height</th>
</tr>
</thead>
<tbody>
<tr>
<td>Letter</td>
<td>8.5 x 11</td>
<td>216 x 279</td>
</tr>
<tr>
<td>Legal</td>
<td>8.5 x 14</td>
<td>216 x 356</td>
</tr>
<tr>
<td>Ledger</td>
<td>17 x 11</td>
<td>432 x 279</td>
</tr>
<tr>
<td>Tabloid</td>
<td>11 x 17</td>
<td>279 x 432</td>
</tr>
<tr>
<td>A4</td>
<td>8.3 x 11.7</td>
<td>210 x 297</td>
</tr>
<tr>
<td>A3</td>
<td>11.7 x 16.5</td>
<td>297 x 420</td>
</tr>
<tr>
<td>Executive</td>
<td>7.25 x 10.5</td>
<td>184 x 267</td>
</tr>
<tr>
<td>Custom</td>
<td>Enter the width and height of your choice.</td>
<td>Enter the width and height of your choice.</td>
</tr>
</tbody>
</table>

[http://hq1apprd44vs/Vision70/Help/en-us/rept_Misc_Tab.htm - Miscellaneous_tab](http://hq1apprd44vs/Vision70/Help/en-us/rept_Misc_Tab.htm - Miscellaneous_tab)
### Miscellaneous

#### Font Name

Use **Font Name** to change the font for the report.

The default font for a report is one of the following:

- Vision default font (Arial)
- Default font set up for your username and password in the Users and Passwords form ([Configuration » Security » Users and Passwords](http://hq1apprd44vs/Vision70/Help/en-us/rept_Misc_Tab.htm#Miscellaneous_tab))
- Default font that you selected on the Reporting tab of the User Options dialog box [http://hq1apprd44vs/Vision70/Help/en-us/rept_Misc_Tab.htm#Miscellaneous_tab](http://hq1apprd44vs/Vision70/Help/en-us/rept_Misc_Tab.htm#Miscellaneous_tab)

#### Heading background color

Use **Heading Background Color** to specify a background color for the report row that displays column headings. Use this option to make the headings stand out from the rest of the report data, for example.

Select the background color from the drop-down list [http://hq1apprd44vs/Vision70/Help/en-us/rept_Misc_Tab.htm#Miscellaneous_tab](http://hq1apprd44vs/Vision70/Help/en-us/rept_Misc_Tab.htm#Miscellaneous_tab)

#### Use Dashpart Report Layout

Select this check box to generate the report using the special formatting that Vision applies when you display a report as a dashpart on the Vision Dashboard.

The following are the main formatting characteristics:

- The report header information is displayed in the lower-left corner of the final report page.
- The default font size is applied to the report title, replacing the larger font that is normally used.
- Page headers and footers are not displayed.

You normally do not use this option except when you want to generate a report as an archive report and you want to display that archive report as a dashpart. When Vision displays an archive report as a dashpart, it does not actually run the report, so it cannot automatically apply the dashpart report layout as it does with other reports. As a result, you must use this option when you generate the archive report if you want the normal dashpart report layout [http://hq1apprd44vs/Vision70/Help/en-us/rept_Misc_Tab.htm#Miscellaneous_tab](http://hq1apprd44vs/Vision70/Help/en-us/rept_Misc_Tab.htm#Miscellaneous_tab)

#### Show grid lines on report

To generate the report with grid lines separating data fields, select this check box.

Some reports are easier to read with grid lines displayed [http://hq1apprd44vs/Vision70/Help/en-us/rept_Misc_Tab.htm#Miscellaneous_tab](http://hq1apprd44vs/Vision70/Help/en-us/rept_Misc_Tab.htm#Miscellaneous_tab)

#### Alternate detail background color

To generate the report with alternating detail lines against a background color, select this check box.

Some reports are easier to read with a color background for every other detail line [http://hq1apprd44vs/Vision70/Help/en-us/rept_Misc_Tab.htm#Miscellaneous_tab](http://hq1apprd44vs/Vision70/Help/en-us/rept_Misc_Tab.htm#Miscellaneous_tab)

#### Report Footer

Enter the text for the report footer. Do not remove the `[version] - [options]` portion of the footer.
For more formatting options, click Edit to open the Vision Text Editor.

http://hq1apprd44vs/Vision70/Help/en-us/rept_Misc_Tab.htm - Miscellaneous_tab

**Options and Buttons**

These fields and buttons are always available at the bottom of the Options dialog box:

- Options
- Organize
- Default
- Help
- Apply (or Run)
- Cancel
Reporting – Tax Analysis Report - Tax Code Lookup Dialog Box

Use the Tax Code Lookup dialog box to select the tax codes that you want to include in the report that you are generating.

To select tax codes, complete the following steps:

1. Click 📚 in the Tax Code field on the General tab in the Options dialog box for the report. This is a standard lookup.
2. In Search By, select either Tax Code or Description.
3. Click Search.
4. Do one of the following:
   - To select a single tax code, click it.
   - To select a group of tax codes in consecutive rows, hold down the Shift key and click the first and last tax codes in the group.
   - To select a group of tax codes that are not in consecutive rows, hold down the Ctrl key and click each tax code.
5. Click Select.
Reporting – Tax Analysis Report - Tax Analysis Columns

The **Tax Code Summary** check box on the Tax Analysis General tab determines whether the report displays transaction detail or only summary data.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date</td>
<td>This column displays the date of the transaction.</td>
</tr>
<tr>
<td>Type</td>
<td>This column displays the two-letter abbreviation for the type of transaction.</td>
</tr>
<tr>
<td>Invoice/Ref. No.</td>
<td>This column displays the invoice number associated with the transaction. Retainage invoice has the same invoice number as the original invoice.</td>
</tr>
<tr>
<td>Description</td>
<td>This column displays a brief description of the transaction.</td>
</tr>
<tr>
<td>Vendor/Client Description2 or Vendor/Client Description2/Tax ID</td>
<td>If <strong>Include Vendor/Client Tax ID</strong> is not selected on the General tab of the Options dialog box, this column displays the name of the vendor or client associated with the transaction. If <strong>Include Vendor/Client Tax ID</strong> is selected on the General tab of the Options dialog box, this column displays the name of the vendor or client associated with the transaction and the tax registration number of the vendor or client.</td>
</tr>
<tr>
<td>Fiscal Period</td>
<td>This column displays the accounting period in which the transaction was posted.</td>
</tr>
<tr>
<td>Post Seq</td>
<td>This column displays the posting sequence number for the transaction. Vision assigns the sequence numbers during the posting process.</td>
</tr>
<tr>
<td>Project</td>
<td>This column displays the project number associated with the transaction. If a transaction is not related to a project, no project number displays.</td>
</tr>
</tbody>
</table>

To see a numbered list of all of the postings for the current accounting period, click **Transaction Center » Posting Review Report** from the Vision Navigation menu.
<table>
<thead>
<tr>
<th><strong>Phase</strong></th>
<th>This column displays the phase number associated with the transaction. <a href="http://hq1apprd44vs/Vision70/Help/en-us/rept_Tax_Analysis_Columns.htm">Link</a> - Tax_Analysis_Columns</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Task</strong></td>
<td>This column displays the task number associated with the transaction. <a href="http://hq1apprd44vs/Vision70/Help/en-us/rept_Tax_Analysis_Columns.htm">Link</a> - Tax_Analysis_Columns</td>
</tr>
</tbody>
</table>
| **Expense/Tax Account** | In the **Inputs (Purchases)** section of the report, this column displays the expense account to which the transaction was posted.  
In the **Outputs (Sales)** section of the report, it displays the credit account for the tax code. [Link](http://hq1apprd44vs/Vision70/Help/en-us/rept_Tax_Analysis_Columns.htm) - Tax_Analysis_Columns |
| **Net Amount/Tax Basis** | In the **Inputs (Purchases)** section of the report, this column displays the net amount for the transaction or tax code. In the **Outputs (Sales)** section of the report, it displays the tax basis for the transaction or tax code. The tax basis can be either the net amount for the transaction or tax code or, if a compound tax is involved, the net amount plus a tax amount that is subject to the tax.  
For invoices from which retainage is withheld, the tax basis includes the retainage if **Tax when Withheld** is selected under **Retainage** on the Misc tab of the Billing Terms form. The tax basis does not include retainage if **Tax when Invoiced** is selected. In that case, the tax on the retainage amount is billed on the retainage invoice when the retainage is due.  
**Multicurrency**  
If you are using the Multicurrency feature, you have the option to have the report display net amounts, tax basis amounts, and tax amounts in any of the following types of currency: transaction currency, functional currency, or tax currency (if tax auditing is enabled for the company). You specify the type of currency you want to use in **Report in** on the General tab of the Options for Tax Analysis dialog box. [Link](http://hq1apprd44vs/Vision70/Help/en-us/rept_Tax_Analysis_Columns.htm) - Tax_Analysis_Columns |
| **Tax Amount** | This column displays the amount of tax for the transaction.  
**Multicurrency**  
If you are using the Multicurrency feature, you have the option to have the report display net amounts, tax basis amounts, and tax amounts in any of the following types of currency: transaction currency, functional currency, or tax currency (if tax auditing is enabled for the company). You specify the type of currency you want to use in **Report in** on the General tab of the Options for Tax Analysis dialog box. [Link](http://hq1apprd44vs/Vision70/Help/en-us/rept_Tax_Analysis_Columns.htm) - Tax_Analysis_Columns |
| **Tax ID** | This column displays the Tax ID Number for the Client or Vendor that is associated with the transaction. [Link](http://hq1apprd44vs/Vision70/Help/en-us/rept_Tax_Analysis_Columns.htm) - Tax_Analysis_Columns |
| **Recoverable Tax** | If you select **Include Recoverable and Non-Recoverable Tax** on the General tab, this column displays the portion of the tax amount for the transaction that is recoverable.  
**Multicurrency** |
If you are using the Multicurrency feature, you have the option to have the report display net amounts, tax basis amounts, and tax amounts in any of the following types of currency: transaction currency, functional currency, or tax currency (if tax auditing is enabled for the company). You specify the type of currency you want to use in **Report in** on the General tab of the Options for Tax Analysis dialog box. 

Non-Recoverable Tax

If you select **Include Recoverable and Non-Recoverable Tax** on the General tab, this column displays the portion of the tax amount for the transaction that is not recoverable.

**Multicurrency**

If you are using the Multicurrency feature, you have the option to have the report display net amounts, tax basis amounts, and tax amounts in any of the following types of currency: transaction currency, functional currency, or tax currency (if tax auditing is enabled for the company). You specify the type of currency you want to use in **Report in** on the General tab of the Options for Tax Analysis dialog box. 

Non-Recoverable Tax

If you select **Include Recoverable and Non-Recoverable Tax** on the General tab, this column displays the portion of the tax amount for the transaction that is not recoverable.

**Multicurrency**

If you are using the Multicurrency feature, you have the option to have the report display net amounts, tax basis amounts, and tax amounts in any of the following types of currency: transaction currency, functional currency, or tax currency (if tax auditing is enabled for the company). You specify the type of currency you want to use in **Report in** on the General tab of the Options for Tax Analysis dialog box.
# Reporting – Tax Analysis Report - Tax Analysis Options Tab

Use the Options tab to do the following:

- Set report options
- Select information to include on the report

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Include Optional Columns</strong></td>
<td></td>
</tr>
<tr>
<td>Recoverable and Non-Recoverable Tax</td>
<td>If you have tax codes for which you are tracking recoverable and non-recoverable portions of tax amounts, select this option if you want the report to display recoverable and non-recoverable tax amounts. <a href="http://hq1apprd44vs/Vision70/Help/en-us/rept_Tax_Analysis_General_Tab.htm">http://hq1apprd44vs/Vision70/Help/en-us/rept_Tax_Analysis_General_Tab.htm</a></td>
</tr>
<tr>
<td>Vendor/Client Tax ID</td>
<td>Select this option if you want the detail and client/vendor summary reports to display the vendor or client tax registration number for each transaction on the report. When this check box is checked, the Tax ID displays in a row under the detail or summary information on the report. If this option is selected as a Favorite report, then the tax id will display in its own column for the favorite report <a href="http://hq1apprd44vs/Vision70/Help/en-us/rept_Tax_Analysis_General_Tab.htm">http://hq1apprd44vs/Vision70/Help/en-us/rept_Tax_Analysis_General_Tab.htm</a></td>
</tr>
<tr>
<td>Gross Amount</td>
<td>Select this option for the report to display the total gross amount for each transaction on the report. When selected, this data will be displayed as its own column in the report. The gross amount is the net amount plus the tax (tax basis + tax).</td>
</tr>
<tr>
<td>Address</td>
<td>Select this option if you want the detail and client/vendor summary reports to display the address for each transaction on the report. Clients and vendors can have multiple addresses, and each address can have its own tax registration number. If the vendor/client id or address column is selected, and the user is summarizing by vendor/client, then Vision displays that vendor or client as many times as there are unique addresses/tax ids with tax. When the address is selected, it displays as follows on the report: <strong>Address line 1, Address line 2, Address line 3, Address line 4, City, State, Zip, Country</strong> When selected, this data will be displayed as the bottom row in the report. The address data will be linked and wrap to the next line if the column width is not sufficient.</td>
</tr>
</tbody>
</table>

**Selections**

Select one or more of these options to specify the tax analysis information to
include on the report. If no selections are made, the report will include all tax analysis data per the defined report options.

If all are selected, all vendors, employees, and client transactions charged to the selected project are included on the report.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vendor</td>
<td>Select the Vendor option to include tax analysis data for vendors on the report. You can also use the lookup to select a vendor record and display all associated transactions.</td>
</tr>
<tr>
<td>Employee</td>
<td>Select the Employee option to include tax analysis data for employees on the report. You can also use the lookup to select an employee record and display all associated transactions.</td>
</tr>
<tr>
<td>Project</td>
<td>Select the Project option to include tax analysis data for any clients related to the select project on the report. You can also use the lookup to select a project record and display all associated transactions charged to that project.</td>
</tr>
</tbody>
</table>

**Saved Options and Buttons**

These fields and buttons are always available at the bottom of the Options dialog box:

- Saved Options
- Organize
- Default
- Help
- Run or Apply
- Cancel
Reporting – Tax Analysis Report - Personal Tab of Employee Info Center

Use the Personal tab of the Employee Info Center to enter, edit, or review an employee's address, home phone number, social security number, and other personal information.

To ensure the confidentiality of employee personal information, only users with security access can view the information on the Personal tab.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address and Phone</td>
<td>Use this group box to enter the employee's address and phone information.</td>
</tr>
<tr>
<td>Address 1,2,3</td>
<td>Enter the employee's address.</td>
</tr>
<tr>
<td>City</td>
<td>Enter the employee's city.</td>
</tr>
<tr>
<td>State/Province</td>
<td>Use this drop-down list to enter the employee's state or province.</td>
</tr>
<tr>
<td>Zip/Postcode</td>
<td>Enter the employee's zip or postal code.</td>
</tr>
<tr>
<td>Country</td>
<td>Use this drop-down list to enter the employee's country.</td>
</tr>
<tr>
<td>Home Phone</td>
<td>Enter the employee's home telephone number.</td>
</tr>
<tr>
<td></td>
<td>Your system administrator defines the format for your phone number entry.</td>
</tr>
<tr>
<td>Hours/Day</td>
<td>Enter the number of hours per day the employee is generally expected to work.</td>
</tr>
<tr>
<td>Social Security Number</td>
<td>Enter the numeric digits of the employee's Social Security number.</td>
</tr>
<tr>
<td>Raise Date</td>
<td>Enter the date of the employee's next scheduled raise.</td>
</tr>
<tr>
<td></td>
<td>You can enter a date directly in this field, or click and select a date using the drop-down list calendar.</td>
</tr>
<tr>
<td>Termination Date</td>
<td>Enter the date that the employee was terminated. When there is a date in this field, the Standard Hours on the Time Analysis report stop on the entered date. For example, if the Termination Date is 05/01/2006, there are no Standard Hours on the Time Analysis Report past 05/01/2006 when using the Hours-per-Day method to calculate Standard Hours. If you terminate and then rehire the employee, you must clear the Termination Date field for the correct data to display on the Time Analysis report. You can enter a date directly in this field, or click and select a date using the drop-down list calendar.</td>
</tr>
<tr>
<td>Tax Reg #</td>
<td>This field displays the tax registration number.</td>
</tr>
<tr>
<td>Memo</td>
<td>Enter any notes or information related to the employee.</td>
</tr>
<tr>
<td></td>
<td>You can enter information directly in this field, or click and enter information using the Vision Text Editor.</td>
</tr>
</tbody>
</table>
Resource Kit

Performance Management Tab of the Database Tab of Resource Kit

Use the Performance Management tab on the Database tab of Resource Kit to specify settings related to the Tableau workbooks that contain the Vision performance dashboards, to publish the sample dashboards and dashboards that you or Deltek Global Services create, and to apply system labels and key performance indicators (KPIs) to the dashboards.

If you have multiple cubes configured, you must first select a database and language to configure for Performance Management on the Analysis Services tab before you can proceed.


Location

To display the Performance Management tab, complete the following steps:

1. Click Start » All Programs » Deltek Vision » Deltek Vision Resource Kit.
2. Click the Database tab.
3. Click the Performance Management tab.

Contents

<table>
<thead>
<tr>
<th>Currently Selected Database</th>
<th>This field displays the Vision database that is currently selected in Vision Database for BI on the Analysis Services tab.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analysis Cube Database</td>
<td>This field displays the database name from Analysis Database Name on the Analysis Services tab.</td>
</tr>
<tr>
<td>Tableau Server Configuration: Use SSL</td>
<td>If Tableau Server is configured for Secure Sockets Layer (SSL) for secure communications, select this check box. If Vision uses SSL, Tableau Server must also use SSL.</td>
</tr>
<tr>
<td>Tableau Server Configuration: Validate SSL Certificate</td>
<td>If Tableau is configured for SSL, clear this check box if you receive a &quot;certificate verify failed&quot; error publishing workbooks when an SSL certificate issued by an internal certificate authority is used. If this check box is cleared, the TabCmd utility does not validate the certificate during the publish process.</td>
</tr>
<tr>
<td>Tableau Server Configuration: Port</td>
<td>If Use SSL is not selected, enter the port that the Tableau server is configured to use. If Tableau Server is configured to use port 80, you can leave this field blank. If Use SSL is selected, this field is not available.</td>
</tr>
<tr>
<td>Tableau Server Configuration: Server Name</td>
<td>Enter the server name for the instance of Tableau Server that you want to associate with the Vision database and data warehouse database currently displayed in Currently Selected Database and Analysis Cube Database.</td>
</tr>
</tbody>
</table>
### Tableau Server Configuration: Username
Enter a Tableau administrator account with Publish rights to the Tableau server. If you use Active Directory authentication, enter the username in this format: `<Domain>\<Username>`. If the site has not yet been created, this account must have system-level administrator rights. If the site exists, the user must be a site administrator. Refer to the *Deltek Vision Installation and Configuration Guide for Performance Management* for more information.

### Tableau Server Configuration: Password
Enter the password for the Tableau administrator account.

### Tableau Server Configuration: Authentication Type
Indicate the type of authentication for which you configured Tableau Server: Local (Tableau) or Active Directory. Tableau Server authentication should match the authentication that you use for Vision. If you use Windows Integrated Authentication with Vision, configure Tableau Server for Active Directory security. If you use Vision security, select Local (Tableau) authentication.

### Tableau Server Configuration: Save Settings
Tableau Server configuration settings are saved automatically when you publish one or more workbooks. However, if you want to modify the saved Tableau Server configuration settings without publishing workbooks, click **Save Settings**. The configuration information is stored in the `FW_PerfManagement` table in the Vision database.

### Language
This field displays the language for the chosen Analysis Cube database. Databases with different languages are published to separate sites in Tableau Server. See the *Deltek Vision Installation and Configuration Guide for Performance Management* for more information.

### Org Levels to Use (max of 2)
If your firm uses organizations in Vision, select one or two organization levels by which you want to filter workbooks that are designed to be filtered by organization.

By default the workbooks that include filtering by organization use levels 1 and 2 of the organization structure.

Workbooks that automatically apply an "organization is mine" filter, such as the Organization Manager workbooks, apply it based on the highest organization level you select here. If you select two levels, those workbooks display a quick filter so you can also filter by that second organization level. Executive workbooks, which are designed for analysis across multiple organizations, display quick filters for both organization levels if you select two levels.

**Note:** These settings do not affect the organizations for which data is displayed. Organization data is always displayed for level 1 or level 2. For example, if you select levels 2 and 3 of your organization structure in the Resource Kit as the levels at which you want to filter dashboards, Executive sample dashboards still display or drill down to data for levels 1 and 2 of your organization. However, that data may be filtered for specific organizations at level 2 or 3.

**Note:** If you later publish workbooks with different organization levels selected in the Resource Kit, the newly selected organization levels replace the original levels as the filter levels, but only for the workbooks published at that time. To avoid confusion if you change the organization levels, it is highly recommended that you also republish all workbooks for all Tableau Server sites so that they all use the same organization levels.
<table>
<thead>
<tr>
<th><strong>Template Workbook Location</strong></th>
<th>If the template workbook file (Template.tbw) is not in the default location on the database server (&lt;Vision installation folder&gt;\Workbooks\Template), enter the correct path and folder.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Workbook Name Filter</strong></td>
<td>To publish all workbooks, leave this field blank. If you do not want to publish all workbooks, you can enter a full workbook name to publish a single workbook or a partial name with one or more wildcard characters to publish multiple workbooks (Org*, for example, to publish only workbooks that start with Org).</td>
</tr>
<tr>
<td><strong>Overwrite existing workbooks</strong></td>
<td>If you select this check box and a workbook with the same name already exists on the Tableau server, the publishing process replaces the existing workbook with the new one without a confirmation message. If you do not select this check box, the publishing process displays an overwrite confirmation message each time a new workbook name matches an existing workbook name on the Tableau server.</td>
</tr>
<tr>
<td><strong>Image Path (on Tableau server)</strong></td>
<td>Initially, this field displays the default location on the Tableau server in which the Deltek Vision Performance Management installation installs the images used on the performance dashboards: C:\Program Files (x86)\Deltek\Workbooks\Images. If you chose to install the images to a different location on the Tableau server, enter that location (the complete local path). To display on the either the sample performance dashboards or on custom dashboards that you create, images must be located on the Tableau server in the folder you specify in this field and must be one of the following image file formats: .JPG or .JPEG .GIF .TIF or .TIFF .PNG .BMP</td>
</tr>
<tr>
<td><strong>Publish Workbooks</strong></td>
<td>Click this button to publish the sample workbooks provided with Vision or new workbooks created by you or for you by Deltek Global Services to the Tableau server. This enables you to display the workbooks as dashboards in Vision. When you publish workbooks, any changes you made to Tableau Server configuration settings are saved also. The workbook files are published from the following folder: &lt;Vision installation folder&gt;\Workbooks (for example, C:\Program Files\Deltek\Vision\Workbooks). The publish process publishes all workbooks located in that folder. The publish process modifies the workbooks with the following information: Data source information to connect to your Vision cubes System labels settings from your Vision database Key performance indicators (KPIs) After it publishes the workbooks, the publish process moves the workbook files from the &lt;Vision installation folder&gt;\Workbooks location to the Processed subfolder so that you do not mistakenly import them again. The Standard Edition of Microsoft SQL Server does not support some features of the sample workbooks. Because of that, the Workbooks folder contains two versions of sample workbooks that use those features. The versions with EE at the end of the names are published if you have the Enterprise Edition of Microsoft SQL Server. The versions with SE at the end of the names are...</td>
</tr>
</tbody>
</table>
published if you have the Standard Edition. The SE versions do not contain dashboards that use the unsupported features.

<table>
<thead>
<tr>
<th><strong>Apply KPIs to Template Workbook</strong></th>
<th>Click this button to apply the Vision Analysis Cubes KPIs to the template workbook so they are available as calculated members in new workbooks that are created based on the template.</th>
</tr>
</thead>
</table>
| **Export Vision Users**           | Click this button to export your Vision users to a .CSV file. You can then import the users into Tableau Server to set them up with the correct access to the performance dashboards.  

The users exported are filtered in the following ways:

**If you use Local (Tableau) authentication** — The export only includes "non-disabled," Vision Security (non-Active Directory) logins.  

**If you use Active Directory authentication** — The export only includes "non-disabled," Active Directory logins for which the domain has been specified in Vision security configuration.  

See the Deltek Vision Installation and Configuration Guide for Performance Management for more information. |
Security

General Tab of Users Security

On the General tab you create a username for an employee, assign the user to a security role, and set up default report settings for the user. You cannot exceed the number of users that you are licensed to set up.

Location

To display the tab, complete the following steps:

2. Click the General tab.

Contents

<table>
<thead>
<tr>
<th>User Information</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Username</strong></td>
</tr>
<tr>
<td>Enter a username in this field. You can use a combination of uppercase and lowercase characters, blank spaces, and periods. Alternatively, you can use one of the predefined formats from the Name Type field on the Generate Users tab.</td>
</tr>
<tr>
<td>For example, the format [last][firstInit][midInit] displays the username Richard M. Freeman as FreemanRM.</td>
</tr>
<tr>
<td>After you save the user record, the Username field becomes view-only.</td>
</tr>
</tbody>
</table>

| **Windows Integrated Security** |
| If your firm uses Windows Integrated Security, review the following guidelines: |
| • The Username field is disabled and your Windows username automatically displays in this field. |
| • Embedded spaces (for example, firstname_lastname) are helpful in usernames because usernames are required to match the Windows usernames. Windows usernames often include embedded spaces. |

| **Password** |
| Enter the password, and document and save it in another location. |
| For security purposes, after you enter and save a password, Vision converts it to an encrypted password that is stored in the database. This means that the password that you enter is not a string of characters that displays in the Password field; the characters represent the encrypted password, which you cannot convert back to the original password. |
| If you leave a user's password blank, the user must leave the Password field blank on the Vision Login dialog box. However, you can change the user's record to include a password at any time. |
| Vision disables this field if you select the Integrated Enabled option for the user. |
| Password policies assigned on the Password Policies tab do not apply to this field. |

| **Windows Authentication** |
| Select this option to set up the user for Windows Integrated Security. When you select this option, the user does not have to log in to Vision in order to use it, as long as the user logs into Windows with the proper network credentials. |
| The login page detects the Windows username and domain, and attempts to log in to Vision with that username. If the username exists as a valid Vision user with a valid
role, the user can proceed and the login page does not display.

If the user is not logged into the network, Vision prompts the user for a network identification and password. Configure the Integrated and Domain fields on the Users tab of the Users and Passwords form and save your work.

<table>
<thead>
<tr>
<th><strong>Domain</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>This field lists the available domain servers and is enabled when you select the Integrated Enabled option. Use the drop-down list to select the user's domain server name, which is necessary for Windows Integrated Security. If your firm uses a hosted instance of Vision, such as Deltek First Vision Essentials or Vision Essentials Plus, this field may not be available.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Disable Login</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Select this option to revoke the user's ability to use Vision. If this option is cleared, the user is automatically enabled to use Vision.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Force User to Reset Password at Next Login</strong></th>
</tr>
</thead>
</table>
| Select this option to force the user to reset their password the next time they log in. When this option is selected, the following occurs: 
  • The Vision Welcome screen displays with an active Change Password dialog box.
  • The Cancel and Exit buttons are disabled. The user must complete the fields on the Change Password dialog box and click **OK**. The password is reset and the **Force User to Reset Password at Next Login** option is no longer selected upon logging in. |

<table>
<thead>
<tr>
<th><strong>Role</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Use this drop-down list to select the role for the user or group of users. The role defines the user's access rights to Vision. Each user must have one assigned role. You create and maintain roles on the Roles form.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Employee</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter the employee's unique identification number or click <img src="image" alt="Find icon" /> to display the Employee lookup and select an employee record. Vision automatically creates a relationship between the selected employee record and the username that you specify in the Username field. This relationship is important for timesheet entry, expense entry, and other employee functions. If you want to create a generic user, you do not enter an employee number. A username that is not assigned an employee number cannot access the parts of Vision that require an employee number, but can still use other parts of Vision. For example, you create a username that is not associated with an employee if you have an outside consultant who does not need to use Vision Time and Expense.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Support Username</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>If you use Deltek's Customer Care Connect site, enter a username for accessing the site.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Support Password</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>If you use Deltek's Customer Care Connect site, enter a password for accessing the site.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Default Report Settings</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>The following fields determine how the user's Vision reports display and print.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Page Size</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>From the drop-down list, select the default page size for Vision reports. The page size that you select in this field determines the Page Width and Page Height values. When you select Custom, you can enter the width and height of your choice. Users can modify the page size in Reporting.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Page Width and Page Height</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Your setting for the Page Size option determines the width and height settings. The measurements display in either inches or millimeters, based on your selection in the Unit of Measure field. If you select Custom in the Page Size field, these fields are enabled so you can enter a width and height of your choice.</td>
</tr>
<tr>
<td><strong>Top Margin</strong></td>
</tr>
<tr>
<td><strong>Bottom Margin</strong></td>
</tr>
<tr>
<td><strong>Unit of Measure</strong></td>
</tr>
<tr>
<td><strong>Left Margin</strong></td>
</tr>
<tr>
<td><strong>Right Margin</strong></td>
</tr>
<tr>
<td><strong>Printer</strong></td>
</tr>
<tr>
<td><strong>Font</strong></td>
</tr>
<tr>
<td><strong>Country</strong></td>
</tr>
</tbody>
</table>

**Generate Users Tab of Users Security**

Use the Generate Users tab to create Vision users from employee records in the Employee Info Center. This is helpful when you need to create many users at one time. You cannot exceed the number of users that your firm is licensed to set up.

**Location**

To display the tab, complete the following steps:

1. From the Vision Navigation menu, click **Configuration » Security » Users**.
2. Click the **Generate Users** tab.

**Contents**

| **Role** | Use this drop-down list to select the role for the user or group of users. The role defines the user’s access rights to Vision. Each user must have one assigned role. You create and maintain roles on the Roles form. |
| **Name Type** | Use this drop-down list to select the format for the usernames that will be generated. For example, the format [last][firstInit][midInit] creates the username for Richard M. Freeman as FreemanRM. |
| **Password** | Use this drop-down list to select the format for the user passwords that will be generated. For example, the format [last][firstInit] sets the initial password for Richard M. Freeman as FreemanR. |
| **Printer** | Use this drop-down list to select the default printer for the user. |
| **Active Employees Only** | Select this option to display active employees only on this tab. These are employees designated with a status of Active on the General tab of the Employee Info Center. |
| **Select All** | Select this button to select all of the employee records to generate as users. |

7.1 Online Help Updates 350
Generate | Select this button to generate the new user and user name.

## Password Policies

Use Password Policies Security to establish policies that dictate the criteria for acceptable Vision passwords. These policies apply when users change their own passwords, which they can do after the initial log in. These policies do not apply to the Password field on the Users tab.

### Location

To display the tab, complete the following steps:

1. From the Vision Navigation menu, click **Configuration » Security » Password Policies**.
2. Click the General tab.

### Contents

<table>
<thead>
<tr>
<th>Minimum password length</th>
<th>Enter a numeric value for the minimum password length.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Require at least one digit in all passwords</td>
<td>Select this option to require a digit in each password.</td>
</tr>
<tr>
<td>Require at least one special character in all passwords</td>
<td>Select this option to require a special character in each password.</td>
</tr>
<tr>
<td>Passwords expire after X days</td>
<td>Enter a numeric value for the number of days before a password expires. After a password expires, the user is locked out of Vision until the user changes the password.</td>
</tr>
<tr>
<td>Do not allow passwords to be reused for X days</td>
<td>Enter a numeric value for the number of days during which the user cannot reuse a password. If you enter 0 in this field, there are no restrictions on password reuse.</td>
</tr>
<tr>
<td>Disable users after X invalid login attempts</td>
<td>Enter a numeric value for the number of invalid login attempts allowed before a user is disabled from using Vision. Each time a login is successful, the counter clears and restarts at zero. After Vision locks out a user, his or her password will not work until the administrator reinstates the user’s login rights on the Users tab.</td>
</tr>
</tbody>
</table>

## Create a New User

On the Users tab you can create a new user record. You cannot exceed the number of users that your firm is licensed to set up.

To create a new user, complete the following steps:

1. From the Vision Navigation menu, click **Configuration » Security » Users**.
2. On the Users form, click the General tab.
3. From the New menu option, click **New User**. Vision displays a blank user record.
4. Complete the fields on this tab. The username must be unique.
5. Click Save.

**Postrequisites**

After you create a new user, you can add the user to the Employee Info Center.

**Create a New User from an Employee Record**

If an employee has an employee record in the Employee Info Center, you can use that employee record as the basis for a Vision user record, for security purposes. This process generates a Vision username for the employee. You cannot exceed the number of users that your firm is licensed to set up.

**To create a user from an employee record, complete the following steps:**

2. On the Users form, click the General tab.
3. From the New menu option, click Select User to Copy. The User lookup displays.
4. Select a user record and click Select. The record’s information displays on the General tab.
5. Modify the fields on the tab.
6. Click Save.

**Create Multiple New Users from Employee Records**

If employees have employee records in the Employee Info Center, you can use those records as the basis for Vision user records, for security purposes. This process generates Vision usernames for the employees. You cannot exceed the number of users that your firm is licensed to set up.

**To create multiple new users, complete the following steps:**

2. On the Users form, click the Generate Users tab, which lists all employee records from the Employee Info Center that do not yet have a corresponding user record.
3. Select employees from the grid.
   - To select multiple users in any order, press CTRL and select users.
   - To select multiple users in sequential order, press SHIFT and select users.
   - To select all employees listed, click the Select All button.
4. Complete the fields on the tab.
5. Click Generate to generate the new users and their usernames.
6. Optional. Modify the information on the grid.
7. Click Save.
Copy a User
To create a new user record, you can copy and modify an existing user record. The new user record must have a unique username. The newly created user record inherits the first user’s access rights and privileges, including record level security.

To create a user from an employee record, complete the following steps:
2. On the Users form, click the General tab.
3. From the New menu option, click Copy Current User. The current’s user’s record information displays.
4. Enter a new, unique username and modify the remaining user information.
5. Click Save.

Modify User Information
You can modify a user’s setup information at any time.

To modify user information, complete the following steps:
2. On the Users form, click the General tab.
3. Select the user whose information you want to modify.
4. Update the fields on the tab.
5. Click Save.

Delete Users from the Users Grid
You can delete a user from the Users grid, but this does not delete the associated employee record from the Vision database. When you delete from the Users grid, the username is removed and that individual can no longer log in to Vision. (To remove an employee record from Vision, delete the record in the Employee Info Center.) After you log in to Vision, you cannot delete or disable your own username.

To delete a user from the Users grid, complete the following steps:
2. On the Users form, click the General tab.
3. Search for and select the user record that you want to delete.
4. Click Delete User.
5. Click Save.

After you are logged in to Vision, you cannot delete or disable your own username.
Enable and Disable Users to Use Vision

Enable All Users to Use Vision
You can enable all users at the same time. This is helpful when you need to enable all users quickly after you disable users in order to perform system maintenance.

To enable all users, complete the following steps:
2. Open the List view.
3. Click Enable All to enable all users displayed on the User grid.
4. Click Save.

Enable a Single User to Use Vision
When you enable a user, you activate that user's access rights and ability to use Vision. The user's invalid login attempt total is automatically reset to zero. This is necessary when the user's login is automatically disabled after a certain number of consecutive unsuccessful log in attempts, as defined by Password Policies.

To enable a single user, complete the following steps:
2. Open the List view.
3. Select the user you want to enable.
5. Click Save.

Disable All Users from Using Vision
You can disable all users from using Vision. This is helpful if you need to lock all users out of Vision when you perform system maintenance. You cannot disable your own username.

To disable all users, complete the following steps:
2. Open the List view.
3. Click Disable All.
4. Click Save.

Disable a Single User from Using Vision
You can disable a user so that he or she cannot use Vision. You cannot disable your own username.
To disable a single user, complete the following steps:

2. Open the List view.
3. Select the user that you want to disable.
4. Select Disable Login.
5. Click Save.

**Print User Information**

Review usernames, roles, employee numbers, employee names, and login status on the User Accounts report, available from the Users form.

**To print the User Accounts report, complete the following steps:**

2. On the Users form, click a tab.
3. Click Print to generate the User Accounts report.

**Users Toolbar**

Use the toolbar on the Users form to save or print user records.

**Location**

**To display the toolbar, complete the following step:**


**Contents**

<table>
<thead>
<tr>
<th><strong>Save</strong></th>
<th>Click this option to save entries for the current record.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>New</strong></td>
<td>Click this option to create a new user record.</td>
</tr>
<tr>
<td><strong>Delete User</strong></td>
<td>Click this option to delete the current user record.</td>
</tr>
<tr>
<td><strong>Print</strong></td>
<td>Click this option to access the User Accounts report, which lists usernames, roles, employee numbers, employee names, and login statuses for the current user. You can print this for the current user, an active group of users, or a different user record.</td>
</tr>
<tr>
<td><strong>List View</strong></td>
<td>Click this option to change from the grid view to the list view.</td>
</tr>
<tr>
<td><strong>Help</strong></td>
<td>Click this option to view help for Vision Security.</td>
</tr>
</tbody>
</table>
Password Policies Toolbar
Use the toolbar on the Password Policies form to save or print user records.

Location
To display the toolbar, complete the following step:


Contents

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="icon" alt="Save" /></td>
<td><strong>Save</strong> Click this option to save entries for the current record.</td>
</tr>
<tr>
<td><img src="icon" alt="Help" /></td>
<td><strong>Help</strong> Click this option to view help for Vision Security.</td>
</tr>
</tbody>
</table>

Security - Security View Overview
The List View and Detail View toolbar buttons display in the Roles and Users Security forms. Use these toolbar buttons to select the type of view to use for your security settings. Options are:

- **Detail View** — This is the default view that displays all tabs for the security forms, and the fields on each of these tabs. The Detail View is the format that is referenced within the Vision Online Help System.

- **List View** — This view displays several security records at one time in a grid format. You can customize the columns and fields that display within the grid to quickly locate and evaluate data. For example, to locate a user record, you can use the List View to filter the records by name, and then review the list to locate the desired record.

Customize the Security Grid View
You can customize the fields and columns that display in the Grid View for the Roles and Users Security forms.

To customize the grid view, complete the following steps:

1. Open Roles or Users security.

2. Select List View from the toolbar. The respective grid view displays.

3. Click Select Fields. The Select Fields dialog box displays.

4. Select the tab for which you want to select grid fields from the Tab drop-down list. This drop-down list displays all security tabs as defined in Configuration » User Defined Tabs for which you have Security access.

5. The Tab drop-down list filters the list of fields in the Available Fields list based on the selected tab. Click Select All to display all fields. Vision defaults to all for this drop-down list.

6. Complete one of the following:

   - To add fields to the grid, select the fields in the Available Fields list that you want to display on the grid and click Add>.
To remove fields that display on the grid, select the fields in the Selected Fields list and click Remove. Vision moves the fields to the Available Fields list.

To change the display order of fields on the grid, complete one of the following:

7. Highlight the field you want to move in the Selected Fields box and click Up or Down. Vision moves the column as directed. Continue this process until the selected fields are in the desired order. Click OK for Vision to display the fields in the selected order.

8. While using the Grid View, drag and drop columns to change their order. Click the column header, drag the columns to the desired location, and drop the column. Changes made on the grid are not reflected back in the Selected Fields list, so you must reorder the Selected Fields list to maintain the changed display order.

9. Click OK to save your changes, or Cancel to cancel your changes and return to the security form.

Record Access Tab of Roles

Use the Record Access tab to determine a role's access rights to specific menus and records in Vision. For example, a project manager needs full access to records in the Project Info Center, but a project consultant only needs read access to these records.

Even if a role does not have access to an Info Center, you can still set up record level read and update criteria for reporting purposes.

Before you can assign access rights to any Vision module, you must activate the module in Configuration » Module Activation.

Location

To display the Record Access tab, complete the following steps:


2. On the Roles form, click the Record Access tab.

Contents

| Application Record Access Grid | Use this grid to control the role's access to portions of the Vision application, including access to menu items and records. Options on this grid depend on the Vision applications that are installed. |
| Application Record Access Drop-down | The Vision grids contain a drop-down list that displays a combination of the following options: |
| | • Print grid information |
| | • Export grid data to Excel |
| | • Enable Grouping |
| | Not all options are available on all grids. |
| Application | Select the Vision application for which you want to establish access rights. The applications that display depend on the Vision applications that you install. |
| Access | Click in the Access column and use the drop-down list to select the access |
- **Read Only** — The role can look at records but not add, modify, or delete record information.
- **Modify Only** — The role can read records and modify information, but cannot add new records or delete records.
- **Add/Modify** — The role can read, modify, and add records, but cannot delete records.
- **Full** — The role can read, add, modify, and delete records.
- **None** — The role has no access to records.

The **Access** column is view-only for certain applications. You must use the Vision default for these applications.

### Special Options for Billing Terms

If Billing Terms is not selected on the General tab, this column has the following options for Billing Terms access:

- **Percent Complete** — Users assigned to a role for which Percent Complete is selected can view all information on the Fees tab on the Billing Terms form but can only update percent complete and fee-to-date fields on the Fees tab and the Description field on the General tab.
- **None** — Users assigned to a role for which None is selected can view all information on the Fees tab and General tab on the Billing Terms form but cannot update any of that information.

Users who only have this access to fee information and the description in Billing Terms cannot use the Billing Terms link in the Navigation pane, in the Project Info Center, or in Interactive Billing to display the Billing Terms form. They can only display the fee information using the Update Fees options in Invoice Approvals, Interactive Approvals, or Interactive Billing (assuming they have access to one or more of those forms).

### Record Level View

Click the **Record Level View** column to set up queries that control the records that this role can view within an application. For example, you might give a role the ability to see information about only a subset of clients in the Client Info Center.

You use Vision lookups to set up these queries. The default for this field is **Not in Use**.

The role’s **Access** settings supersede **Record Level View** rights. You cannot give a role permission to view a record if the role doesn’t have permission to access the corresponding application.

### Record Level Update

Click the **Record Level Update** column to set up queries that control the records that this role can update within an application. For example, you might give a role the ability to update information about only a subset of clients in the Client Info Center.

You use Vision lookups to set up these queries. The default for this field is **Same as View**, meaning that the **Record Level Update** setting is the same as the **Record Level View** setting.

The role’s **Access** settings supersede **Record Update View** rights. You cannot give a role permission to update a record if the role doesn’t have permission to access the corresponding application.
| **Apply record access to all transaction centers** | Select this option to apply record level security to limit access to certain records within the Vision Transaction Center. |
| **Enable self service in Employee Review** | Select this option to allow employees to view a summary of their own payroll and expense check information on the Employee Review screen. Your role determines access to the Employee Review features. |
| **Timesheets** | Select this option to apply project record level security to limit which projects a user can see when entering personal Timesheet information. This option displays if your firm uses the Vision Time application. |
| **Expense Reports** | Select this option to apply project record level security to limit which projects a user can see when entering personal Expense Report information. This option displays if your firm uses the Vision Expense application. |
| **Billing** | Select this option to apply project record level security to Vision Billing. This option controls the projects you can access when you perform the following Billing functions:  
  - Interactive Billing  
  - Batch Billing  
  - Billing Terms  
  - Billing Groups  
  - Billing Rate Tables  
  - Refresh Billing Extensions  
  - Invoice Template Editor  
  If you do not select this option, your billing personnel will have access to all projects. This option displays if your firm uses Vision Billing.  
  If your firm uses Vision Multicompany, and you do not select this option, your billing personnel will have access to all projects where the main billing project belongs to the active company. |
| **Sub Projects in Billing Groups** | Select this option to restrict subproject lookups based on project record level security when setting up billing groups.  
  When you select this option, the role can view and edit information for all of the accessible main projects, and can add any sub-project to which the role has security access. If the role does not have access to the main project, however, it cannot view the sub-projects, regardless of the rights to access these sub-projects individually. |
| **Activity Access** | Use these fields to determine access to Vision activities. |
| **Record Level View** | Use the lookup to select one of the following options as the criteria for the chosen info center:  
  - **Not in Use** — Select this option to eliminate Record Level View from the Activity access rights. This is the default setting.  
  - **Use info center access** — Select this option to apply info center access to the activity record access.  
    For example, Record Access for the Client Info Center is set to all clients in California. If you set the activity access to **Use info center access**, only clients in California can be used when entering activity information. |
access, then of all activities associated with a client, the role will only be able to view the activities of the clients to which it has rights (in other words, all clients in California).

- **Use query** — Select this option to use a query to determine the activity access rights.

### Record Level Update

Use the lookup to select one of the following options as the update access for the record level:

- **Read Only** — The role can look at records but not add, modify, or delete record information.
- **Modify Only** — The role can look at records and make modifications to information, but cannot add new records or delete records.
- **Add/Modify** — The role can look at, modify, and add records, but cannot delete records.
- **Full**

### Allow modification of Disable Login user setting in Users when read-only access

Select this option to give users in this role access to modify the enable/disable login user setting when they only have read-only access to the Users application.

### Allow modification of Passwords in Users when read-only access

Select this option to give users in this role access to modify user passwords even if they only have read-only access to the Users application.

### Allow Changes to Supporting Documents

This option is available if the role has access to Interactive Billing or Interactive Approvals. Select this option to give the users in this role the ability to modify supporting documents that have been uploaded for transactions. Possible modifications include:

- Change the description of a supporting document
- Upload a supporting document in Interactive Billing
- Delete a supporting document
- Change the Print with Invoice setting of the supporting document

By default, this option is not selected, and users can only view the supporting documents.

### Accounting Tab of Roles

Use the Accounting tab to control users’ access to accounting-related functions and records in Vision.

### Location

**To display the Accounting tab, complete the following steps:**

1. From the Vision Navigation menu, click **Configuration » Security » Roles**.
2. On the Roles form, click the Accounting tab.
<table>
<thead>
<tr>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Full access to all transaction types</strong></td>
</tr>
<tr>
<td><strong>Transaction Type grid</strong></td>
</tr>
<tr>
<td><strong>Transaction Type Drop-down</strong></td>
</tr>
<tr>
<td><strong>Allow Processing in Closed Periods</strong></td>
</tr>
<tr>
<td><strong>Allow Processing in Prior Periods</strong></td>
</tr>
<tr>
<td>Security</td>
</tr>
<tr>
<td>---</td>
</tr>
<tr>
<td><strong>Allow Modifications in Vendor Reviews</strong></td>
</tr>
<tr>
<td><strong>Accounts Receivable Comment Review Access</strong></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td><strong>Accounts Receivable Comment Update Access</strong></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td><strong>Project Budget Worksheet</strong></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td><strong>Labor Cost Rates/Amounts</strong></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

*Keep these facts in mind when assigning cost rate access:*

Because cost rates impact many areas of Vision, it is important to ensure that the correct level of security is assigned. Contact your implementation specialist for further details.

The cost rates setting applies to JTD labor cost and associated calculations (for example, EAC labor cost). This setting does not apply to planned labor costs; users with **No Access** can view all planned labor costs.

A role must have **Full Access** to view a plan that has a Labor/Cost Rate Method of From
<table>
<thead>
<tr>
<th>Security</th>
</tr>
</thead>
</table>

**Employee Provisional Rate in Vision Planning.**

<table>
<thead>
<tr>
<th>Include Cost Amounts in Spent and Profit Calculations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select this option if you want users in this role to see spent and profit calculations when viewing labor cost amounts when a report is run at cost rates.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Labor Burden Rates/Amounts</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select this option to specify the type of access that you want users in this role to have for reviewing labor detail, including overhead, on Project reports. The default is <strong>No Access</strong>.</td>
</tr>
<tr>
<td>- <strong>No Access</strong> — The user cannot access burden rates or burden amounts on screens and reports.</td>
</tr>
<tr>
<td>- <strong>Subtotals Only</strong> — The user can access burden amounts on subtotal lines on reports but not on detail lines or screens.</td>
</tr>
<tr>
<td>- <strong>Final Totals Only</strong> — The user can access burden amounts on grand total lines on reports but not on detail lines, screens, or subtotal lines.</td>
</tr>
<tr>
<td>- <strong>Full Access</strong> — The user can access all burden rates and burden amounts.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Include Burden Amounts in Spent and Profit Calculations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select this option if you want users in this role to see spent and profit calculations when viewing labor cost amounts when a report is run at burden rates.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Billing Security</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use these options to specify privileges for roles that have access to Vision Billing.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Interactive Billing and Invoice Approvals</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specify the type of access that you want users in this role to have to Vision Interactive Billing. If your firm enables invoice approval, some of these settings also control access to options on the Interactive Approvals form.</td>
</tr>
<tr>
<td>- <strong>Allow hold</strong> — Select this check box for access to the <strong>Hold</strong> button on the transaction detail tabs of the Interactive Billing form and Interactive Approvals form so you can save a transaction for billing at a later date.</td>
</tr>
<tr>
<td>- <strong>Allow write-off</strong> — Select this check box for access to the <strong>Write-off</strong> button on the transaction detail tabs of the Interactive Billing form and Interactive Approvals form. Use write-offs to mark hours that have been charged but cannot be billed. Selecting this option prevents the transaction from being billed, but allows the amount to appear on reports. When you write off a transaction, no accounting entries are made.</td>
</tr>
<tr>
<td>- <strong>Allow delete</strong> — Select this check box for access to the <strong>Delete</strong> button on the transaction detail tabs of the Interactive Billing form and Interactive Approvals form. Use delete to remove a transaction from the set of billable transactions. Changing the status to Delete does not actually delete the transaction. The status of Delete allows you to run reports that distinguish between a write-off and a transaction that was entered but removed before invoicing, possibly due to a data entry error.</td>
</tr>
<tr>
<td>- <strong>Allow final processing</strong> — Select this check box for access to accept an invoice, void an invoice, assign an invoice number, bill retainage, and enter notes on the General tab of Interactive Billing. This option must be selected before you can select the <strong>Allow invoices on file to be deleted</strong> check box.</td>
</tr>
<tr>
<td>- <strong>Allow invoices on file to be deleted</strong> — This check box is enabled only if the <strong>Allow final processing</strong> check box is selected. Select <strong>Allow invoices on file to be deleted</strong> if you want users in this role to be allowed to delete invoices from Invoices on File in Interactive Billing. Deleting an invoice prevents you from being able to re-print or void the invoice. Use caution in permitting users to have this access.</td>
</tr>
<tr>
<td>- <strong>Allow insert</strong> — Select this check box for access to the <strong>Insert</strong> option to review,</td>
</tr>
</tbody>
</table>
modify, and add new billing information on the transaction detail tabs of the Interactive Billing form and Interactive Approvals form.

- **Allow modify** — Select this check box to allow modification of billing information on the transaction detail tabs of the Interactive Billing form and Interactive Approvals form.
- **Allow transfer** — Select this check box to allow transfer of transactions on the transaction detail tabs of the Interactive Billing form and Interactive Approvals form.
- **Allow edit/upload** — Select this check box to enable the Upload option in Interactive Billing.

If none of these check boxes are selected, the role will only be able to view the **Status** column in the detail grid on the Labor tab in Interactive Billing.

<table>
<thead>
<tr>
<th>Batch Billing: Allow Final Processing</th>
<th>Select this option to enable the Run Type field on the Batch Billing form, which allows the role to process final bills. By default, this option is not selected.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Payroll Security</td>
<td>Use these options to specify privileges for roles that have access to Vision Payroll.</td>
</tr>
<tr>
<td>Include paychecks on check register and bank reconciliation</td>
<td>If this role has access to the Bank Reconciliation and Check Register Accounting options on the General tab, you can select this option to make payroll processing entries available to the role.</td>
</tr>
<tr>
<td></td>
<td>For the role to access the Check Register report, the Check Register report must be selected in the Accounting reports, Reports for this Role area on the Access Rights tab.</td>
</tr>
<tr>
<td>Allow payroll processing in prior W2 quarter</td>
<td>Select this option to allow payroll processing in a prior or closed period, or prior W2 quarter. Deltek recommends that you do not process payroll in a previous period. Doing so could invalidate any data already processed in subsequent periods, such as limits on withholdings, wage base considerations for withholdings, and so on.</td>
</tr>
<tr>
<td>Allow Cash Receipts for Other Companies</td>
<td>If you use the Multicompany feature, select this option to allow this role to enter invoice related receipts in Cash Receipt Transaction Entry. These receipts are entered across companies for all projects in the database. If this option is not selected, users only have access to enter cash receipts for projects that were billed in the same company in which the cash receipt is being recorded.</td>
</tr>
<tr>
<td>Allow reprocessing of intercompany billing files</td>
<td>If you use the Multicompany feature, select this option to allow this role to reprocess intercompany billing files in Accounting » Intercompany Billing with a status of Processed. Reprocessing intercompany billing files may result in a duplicate General Ledger posting. When you select this option, the role can access the Show posting logs where intercompany billing has already been run option on the General tab of Accounting » Intercompany Billing.</td>
</tr>
</tbody>
</table>
SEPA XML File Formats for Export to Text Payments

Bank Codes Setup Overview

Bank codes represent the bank accounts that you use when you enter cash-related transactions (cash receipts, cash disbursements, accounts payable payments, and so on) in Vision.

Bank codes direct the implicit posting of any cash-related transaction. This means that Vision automatically uses the default general ledger account that you enter for a bank (such as 101 — Checking) during data entry for cash-related transactions. Bank codes eliminate the need to manually enter the general ledger account during data entry processing.

In Banks Configuration, you can also set up the following information for your bank accounts:

- Direct Deposit and NACHA (National Automated Clearing House Association) electronic funds transfer information
- Export to Text file format information, including user-defined file formatting and SEPA (Single Euro Payments Area) file formatting
- Wire transfer fee information

If you use the Organization Reporting feature, your firm has multiple organizations, and each organization has one or more accounts at one or more banks, you can set up a bank code for each account, at each bank, for each organization. You can use the same account for each organization bank code. If you maintain separate balance sheets for your organizations, Vision displays the account totals for each.

The Bank Code List shows all the bank codes that are entered in the Vision database and their configuration information. Use this list to verify the information entered through Banks Configuration.

After you enter and save bank code information, you cannot modify the bank code itself. To modify a bank code, use the Bank Code Conversion utility.

If you use the Multicompany feature, you must set up bank codes and electronic funds transfers for each company in your enterprise.

If you use the Multicurrency feature, bank codes determine payment currencies for a number of transactions. When you set up a bank code, you must select an account for which you have specified a currency in the Chart of Accounts Info Center.

Export to Text Overview

When you process checks for accounts payable or employee expense payments, you have the option to create a file that contains check payment information that can be processed by a third-party software application.

Use this feature if:

- Another company prints your vendor or employee expense payment checks with the accounts payable, employee expense, and check information that you provide in a .txt file or an .xml file.
- You want to import check information into banking software. This supports the electronic funds transfer requirements of many international banks.
Configuration
In Vision Banks Configuration, you select a file format for the export-to-text files that will be created for payments made from a bank.

If you select the SEPA file format (commonly used in the Netherlands), you must also set up SEPA information for the bank on the SEPA File Format tab and SEPA information for employees and vendors on the Accounting tabs in the Employees Info Center and the Vendor Info Center.

If you use the Multicompany feature, you must set up export-to-text file information for each company in your enterprise.

Processing
You create a .txt or .xml file in Accounts Payable Payment Processing and Employee Expense Payment Processing when you select the **Export to Text** option on the Check Printing and Numbering form after you assign check numbers.

The files that you create with the Export to Text feature are not used for Vision payroll and employee expense direct deposit or Accounts Payable EFT processing. These payment types use the NACHA file format, which you set up on the NACHA File Format tab in Banks Configuration.

Bank Codes Tab of Bank Codes
Use the Bank Codes tab to set up the bank codes for your firm. Bank codes direct the implicit posting of any cash-related transaction.

If you use the Export to Text feature in Vision Accounts Payable or Employee Expenses Payment Processing, you choose the format for the text file on this tab.

If you use the Multicurrency feature, bank codes determine payment currencies for a number of transactions. When you set up the bank code, you must select an account for which you have specified a currency in the Chart of Accounts Info Center.

**Location of the Bank Codes Tab**
To open this tab, complete the following step:

1. From the Vision Navigation menu, click **Configuration » Accounting » Banks**.

**Contents of the Bank Codes Tab**

**Code**
Enter a bank code for this bank account. These codes allow you to identify a bank account (for example, FirstNatl could be used as the code for your checking account at the First National Bank). Do not use punctuation such as /, -, or ; or spaces when you enter a code. If you use punctuation, errors occur when you process data.

**Currency**
After you enter an account in the **Account** field on this tab, this field displays the currency code entered for the account in **Info Center --> Chart of Accounts --> Accounts**.

This is the currency in which the bank account is denominated.

**Description**

Enter a description for the bank code. Descriptions must be unique for each bank code.

**Account**

Enter the general ledger account number associated with this bank code. Enter an account or click and select an account on the Account Lookup. This account receives the implicit posting when the bank code is specified in data entry. The account that you enter here must be a balance sheet account.

Deltek recommends that you have a different general ledger account number associated with each bank code, regardless of whether or not you use the Organization application.

**Organization**

If you use Organization reporting, specify the organization to use when transactions are posted to this bank code. Enter an organization or click and select an organization on the Organization Lookup.

**Export to Text Format**

From the drop-down list, select the file format to use for creating export-to-text files when you process accounts payable or employee expense payments for a bank. These files contain check payment information to be processed by a third-party software application. The .txt or .xml files are created when you use the Export to Text feature on the Check Printing and Numbering form in Accounts Payable Payment Processing and Employee Expense Payment Processing.

The file format options are:

- **Check** — A predetermined file format is provided for the .txt file. This format is commonly used to create a text file for a third party to print your checks. See the "Export to Text Check Option" topic for more information.

- **SEPA** — This is the Single Euro Payments Area (SEPA) .xml file format that is commonly used in the Netherlands. When you select this option, the SEPA File Format tab on the Bank Codes form is enabled. On this tab you enter additional information for the SEPA file format.

- **User Defined** — You set up the specific format that your bank requires on the User Defined File Format tab in Banks Configuration. This format is commonly used to create a .txt file with check information to import into your banking software to process the checks electronically. You can use this option for the electronic funds transfer (EFT) requirements of many international banks, including the BACS (Bankers Automated Clearing System) payments that are used in the United Kingdom.

**Wire Transfer Fee Debit section**

**Account**

Enter or select the account number used for a wire transfer.

**Project**

Enter or select the project name used for a wire transfer.

**Phase**

If phases exist, enter or select the appropriate phase.

**Task**
If tasks exist, enter or select the appropriate task.

**SEPA File Format Tab of Bank Codes**

Use this tab to enter information for the SEPA file format if you selected SEPA in the Export to Text Format field on the Bank Codes tab of the Bank Codes form.

The SEPA file format is the Single Euro Payments Area .xml file format that is commonly used in the Netherlands.

**Location--SEPA File Format Tab**

To display the tab, complete the following steps:

1. From the Vision Navigation menu, click Configuration -- Accounting -- Bank Codes.
2. On the Bank Codes tab on the Bank Codes form, select SEPA in the drop-down list in the Export to Text Format field.

The SEPA File Format tab now display on the Bank Codes form.

**Contents of the SEPA File Format Tab**

**Address Line 1**

This prefills with your company's address from General tab in Configuration » General » Company Settings. You can change it as needed.

**Address Line 2**

This prefills with your company's address from General tab in Configuration » General » Company Settings. You can change it as needed.

**Country**

This prefills with your company's country from General tab in Configuration » General » Company Settings. You can change it as needed.

**IBAN**

Enter the international bank account number (maximum 34 characters) for your company. The bank uses this to identify the company that is distributing the payments.

**BIC**

Enter the bank identification code (either 8 or 11 characters) for your company. The bank uses this to identify the company that is distributing the payments.

**Accounting Tab of Employee Info Center**

Use the Accounting tab to enter, edit, or review employee accounting information. The Accounting tab is available only if you use Vision Accounting.

Added the following new field descriptions to this topic:

**SEPA section**

These settings apply if you make employee expense payments to employees using export to text files with the SEPA file format. The SEPA (Single Euro Payments Area) .xml file format is commonly used in the Netherlands.
IBAN
Enter the international bank account number (maximum 34 characters) for an employee. This is used to transmit the payment to a payee when the .xml file is sent to the bank.

BIC
Enter the bank identification code (either 8 or 11 characters) for an employee. This is used to transmit the payment to a payee when the .xml file is sent to the bank.

Accounting Tab of Vendor Info Center
Use the Accounting tab to enter, edit, or review vendor accounting information. This tab is available in the Vendor Info Center if you use Vision Accounting.

Contents
Added the following new field descriptions to this topic:

SEPA section
These settings apply if you make accounts payable payments to vendors using export to text files with the SEPA file format. The SEPA (Single Euro Payments Area) .xml file format is commonly used in the Netherlands.

IBAN
Enter the international bank account number (maximum 34 characters) for a vendor. This is used to transmit the payment to a payee when the .xml file is sent to the bank.

BIC
Enter the bank identification code (either 8 or 11 characters) for a vendor. This is used to transmit the payment to a payee when the .xml file is sent to the bank.

Export Accounts Payable Check Payments to a SEPA .Xml File
Use the Export to Text option in Accounts Payable Payment Processing to create a SEPA .xml file that contains accounts payable check payment information to be processed by a third-party software application.

The SEPA (Single Euro Payments Area) .xml file format is commonly used in the Netherlands.

Prerequisites:
- The bank from which you are making the payment must have:
  - The SEPA format selected in the Export to Text Format field on the Bank Codes tab in Configuration » Accounting » Banks.
  - Entries in the IBAN and BIC fields on the SEPA File Format tab in Configuration » Accounting » Banks.

- The vendors being paid must have entries in the IBAN and BIC fields in the SEPA section on the Accounting tab in the Vendor Info Center.

To export accounts payable check data to a SEPA .xml file, complete the following steps:
1. From the Vision Navigation menu, click Accounting » Accounts Payable » Payment Processing.

2. In the Select Posting Run dialog box, click New to create a new payment processing run.

3. On the General tab of the A/P Payment Processing form, enter processing run information.
   - In the Payment Type field, you must select Check/EFT.

4. If you selected a manual run, select vendors and vouchers to pay on the Vendor Review tab.

5. On the A/P Payment Processing form toolbar, click Process Checks.

6. On the Check Printing and Numbering form, preview checks and assign check numbers using the Preview Checks and Assign Numbers toolbar icons on the lower grid.

7. Click Export to Text toolbar option on the lower grid. If the Export to Text option does not display on the toolbar, click >>= at the right end of the toolbar.
   - If any of the payees in the payment processing run or the bank from which the payments are made do not have an IBAN or BIC, you receive warning messages that ask whether you want to proceed with the Export to Text process. If you click No, the process is stopped. You can populate the payees’ and/or bank’s IBAN and BIC fields, and then return to Employee Expense Payment Processing. If you click Yes, the Export to Text process will proceed, but the .xml file will not contain the IBANs or BICs for the payees and/or bank.

8. On the Download Checks To Text File dialog box, click Create File.

9. On the File Download dialog box, complete one of the following actions:
   - Click Save to save the file without viewing it first.
   - To view the file first before saving, click Open. Then, close the file and on the Download Checks to Text File dialog box, click Create File and then click Save.

10. In the Save As dialog box, navigate to the location in which to save the .xml file. The File name field displays a name (for example, BT_AP_200604_150_Boston.xml) that includes the following components, which you can modify: the company code (if you use the Multicompany feature), the check type (AP), the period, the run number, and the bank code.

11. Click Save.

12. Close the Download Checks To Text File dialog box.

13. On lower grid’s toolbar, click Print File Copy to print a file copy of the check.

14. On the Check Printing and Numbering form toolbar, click Post to post the A/P payment processing run.
Export Employee Expense Check Payments to a SEPA .Xml File

Use the Export to Text option in Employee Expense Payment Processing to create a SEPA .xml file that contains employee expense check payment information to be processed by a third-party software application.

The SEPA (Single Euro Payments Area) .xml file format is commonly used in the Netherlands.

Prerequisites:

- The bank from which you are making the payment must have:
  - The SEPA format selected in the Export to Text Format field on the Bank Codes tab in Configuration » Accounting » Banks.
  - Entries in the IBAN and BIC fields on the SEPA File Format tab in Configuration » Accounting » Banks.
- The employees being paid must have entries in the IBAN and BIC fields in the SEPA section on the Accounting tab in the Employee Info Center.

To export employee expense check data to a SEPA .xml file, complete the following steps:

1. From the Vision Navigation menu, click Accounting » Employee Expenses » Payment Processing.
2. In the Select Posting Run dialog box, click New to create a new payment processing run.
3. On the General tab of the Employee Payment Processing form, enter processing run information.
   - In the Payment Type field, you must select Check/EFT.
4. If you selected a manual run, select employees and expense reports to pay on the Employee Review tab.
5. On the Employee Payment Processing form toolbar, click Process Checks.
6. On the Check Printing and Numbering form, preview checks and assign check numbers using the Preview Checks and Assign Numbers toolbar icons on the lower grid.
7. Click Export to Text toolbar option on the lower grid.
   - If the Export to Text option does not display on the toolbar, click >> at the right end of the toolbar.
   - If any of the payees in the payment processing run or the bank from which the payments are made do not have an IBAN or BIC, you receive warning messages that ask whether you want to proceed with the Export to Text process. If you click No, the process is stopped. You can populate the payees’ and/or bank’s IBAN and BIC fields and then return to Employee Expense Payment Processing. If you click Yes, the Export to Text process will proceed, but the .xml file will not contain the IBANs or BICs for the payees and/or bank.
8. On the Download Checks To Text File dialog box, click Create File.
9. On the File Download dialog box, complete one of the following actions:
   - Click Save to save the file without viewing it first.
   - To view the file first before saving, click Open. Then, close the file and on the Download Checks to Text File dialog box, click Create File and then click Save.
10. In the Save As dialog box, navigate to the location in which to save the .xml file. The **File name** field displays a name (for example, BT_EP_200604_150_Boston.xml) that includes the following components, which you can modify: the company code (if you use the Multicompany feature), the check type (EP), the period, the run number, and the bank code.

11. Click **Save**. Click **Save**.

12. Close the Download Checks To Text File dialog box.

13. On lower grid’s toolbar, click **Print File Copy** to print a file copy of the check.

14. On the Check Printing and Numbering form toolbar, click **Post** to post the Employee Expense payment processing.
Vision Navigator

Configuration

Planning » Plan Settings » General Tab

The General tab of Plan Settings topic was updated to reflect the Navigator Consultants feature. The fields that display on this tab are based on the use of the Vision Resource Planning module.

Resource Planning Module in Use

These fields display when using the Vision Resource Planning Module:

<table>
<thead>
<tr>
<th>Enable Planning Tabs</th>
<th>Use the Enable Planning Tabs options to enable the Expense, Consultant, and Unit tabs in Planning.</th>
</tr>
</thead>
</table>
| Expenses             | Select this option to enable the Expenses tab in Project Planning. When you select this option, fields related to the Expenses tab also display in Summary Grid Configuration.  
This option does not apply to Vision Navigator plans. |
| Consultants          | Select this option to enable the Consultants tab in Project Planning. When you select this option, fields related to the Consultants tab also display in Summary Grid Configuration.  
If using Vision Navigator, select this option for Consultants to be planned for a project in Navigator. |
| Units                | Select this option to enable the Units tab in Project Planning. When you select this option, fields related to the Units tab also display on the following forms:  
• Summary Grid Configuration  
• Rates tab of Project Planning  
• Summary tab of Project Planning  
• Analysis tab of Project Planning  
If you do not select this option, the Units tab and related fields do not display in Project Planning, and Job to Date unit numbers display under the Expense or Consultant tabs.  
This option does not apply to Vision Navigator plans. |
| Decimal Digits       | Use the decimal digits fields to specify the number of decimal digits for hours, quantities, and amounts in plans. |
| Hour                 | Select the number of decimal digits for hours. |
| Quantity             | Select the number of decimal digits for quantities.  
This setting does not affect multipliers or percents, other than Probability. |
| Amount | Select the number of decimal digits for amounts. When the amount is set to **Currency**, all amounts will follow the decimal digit setting of the currency unit of that amount.  
By default, Vision sets all Labor Rates and Unit Rates to **Currency**.
This setting does not affect Cost Rate, Billing Rate, EAC Cost, or EAC Bill. |
|---|---|
| Create Plan from Project | Use this field to determine the amount of detail to copy when creating plans.  
This option does not apply to Vision Navigator plans. |
| Copy Down To | Select the default for the amount of detail to include when using the **New » New Plan from Existing Project** menu item on the Project Planning toolbar.  
Options are:  
- **Project** — Select this option to include project information when you create a plan from a project.  
- **Phase** — Select this option to include project and phase information when you create a plan from a project.  
- **Task** — Select this option to include project, phase, and task information when you create a plan from a project.  
- **Labor Code** — Select this option to include project, phase, task, and labor code information when you create a plan from a project. |
| Plan Compensation Values By Row and Period | When you select this option, the following areas are affected within Project Planning.  
- Users can enter compensation values by period and by row on the Labor tab in Project Planning.  
- The Summary tab of Project Planning displays the sum of all compensation columns from data on the Labor tab of Project Planning.  
- The **Actions** button on the Project Planning toolbar displays the **Refresh Analysis Compensation** option.  
- If the **Project Fee Entering Method** option on the General tab of Configuration » Accounting » System Settings is set to **At all levels of work breakdown structure**, all WBS level fees in the project are updated with the plan’s corresponding fees.  
- If the **Project Fee Entering Method** option on the General tab of Configuration » Accounting » System Settings is set to **At lowest level only**, all compensation will be summed to update the project's fees.  
- When the **Compensation Values by Row and Period**, **Synchronize fees from Plan to Project**, and **Include in Utilization and Project Reports** options are all selected, Vision synchronizes fees only for those of the project’s WBS levels that match.  
- When the **Compensation Values by Row and Period** and **Limit plan fees to contract totals** options are selected, you can enter... |
<table>
<thead>
<tr>
<th>Table Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>compensation amounts on the Labor tab.</strong></td>
<td>This option does not apply to Vision Navigator plans.</td>
</tr>
<tr>
<td><strong>Synchronize fees from Plan to Project</strong></td>
<td>Select this option to synchronize all of a plan's compensation to its project when saving the plan. If you select the <strong>Synchronize fees from Plan to Project</strong> option, you cannot select the <strong>Synchronize fees from contract to project</strong> option on the General tab of Accounting System Settings. This option does not apply to Vision Navigator plans.</td>
</tr>
<tr>
<td><strong>Limit Plan fees to Contract Totals</strong></td>
<td>Select this option to limit the plan compensation amounts at the WBS1 level by the amounts entered in the Contract Management tab of the Project Info Center. This includes the Compensation, Consultant Fee, and Reimbursable amounts in Project Planning. If you also select the <strong>Exact decimal limits</strong> option, Vision verifies that the planned amount does not exceed the contract amount by more than 0.5 (applicable currency). If the planned amount exceeds the contract amount by more than the applicable currency, Vision limits the amount to exactly the contract amount, down to the decimal amount.</td>
</tr>
<tr>
<td></td>
<td>• When the <strong>Compensation Values by Row and Period</strong> and <strong>Limit plan fees to contract totals</strong> options are selected, you can enter compensation amounts on the Labor tab.</td>
</tr>
<tr>
<td></td>
<td>• When the <strong>Compensation Values by Row and Period</strong> option is not selected, but the <strong>Limit plan fees to contract totals</strong> option is selected, you can enter the compensation amounts on the Analysis tab, but Vision disables the compensation fields on the Labor tab. This option does not apply to Vision Navigator plans.</td>
</tr>
<tr>
<td><strong>Exact Decimal Limits</strong></td>
<td>Select this option to verify that the planned amount doesn’t exceed the contract amount by more than 0.5 (applicable currency). If the planned amount exceeds the contract amount by more than the applicable currency, Vision limits the amount to exactly the contract amount, down to the decimal amount. This option does not apply to Vision Navigator plans.</td>
</tr>
<tr>
<td><strong>Default Settings for Creating a New Plan</strong></td>
<td>Use these options to specify the default settings used to create a new plan. Even though you establish the initial default settings, users may modify and override those settings. For example, when you select the <strong>Include in Utilization and Project Reports</strong> option, that same option displays on the General tab of Project Planning. The user may remove the selection on that option for a Vision plan. When the user saves the plan, Vision saves the option specified by the user.</td>
</tr>
<tr>
<td><strong>Starting Day of the Week</strong></td>
<td>Select the day of the week on which business starts. This option does not apply to Vision Navigator plans.</td>
</tr>
<tr>
<td><strong>Planned Revenue</strong></td>
<td>Use these fields to calculate revenue based on planned labor, expense, and consultant information. This option does not apply to Vision Navigator plans.</td>
</tr>
<tr>
<td><strong>Labor Multiplier Type</strong></td>
<td>The options for this field depend on the <strong>Budget Type</strong> entry on the Rates tab.</td>
</tr>
<tr>
<td>--------------------------</td>
<td>----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>• If the <strong>Budget Type</strong> is set to <strong>Cost and Billing</strong>, the Labor Multiplier Type defaults to <strong>User Entered (Cost)</strong> and the options list displays:</td>
</tr>
<tr>
<td></td>
<td><strong>User Entered (Cost)</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Planned Multiplier</strong></td>
</tr>
<tr>
<td></td>
<td><strong>User Entered (Billing)</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Planned Ratio</strong></td>
</tr>
<tr>
<td></td>
<td>• If the <strong>Budget Type</strong> is set to <strong>Cost</strong>:</td>
</tr>
<tr>
<td></td>
<td>The Labor Multiplier Type defaults to <strong>User Entered (Cost)</strong>, which is the planned labor cost amount, and the options list displays <strong>User Entered (Cost)</strong> and <strong>Planned Multiplier</strong>.</td>
</tr>
<tr>
<td></td>
<td>The Planned Multiplier that displays on the Analysis tab is calculated as follows:</td>
</tr>
<tr>
<td></td>
<td><strong>Planned Total Compensation (Compensation + Consultant Fee + Reimbursable Allowance) - Direct and Reimbursable Expenses/Planned Labor Cost</strong></td>
</tr>
<tr>
<td></td>
<td>• If the <strong>Budget Type</strong> is set to <strong>Billing</strong>:</td>
</tr>
<tr>
<td></td>
<td>The Planned Multiplier defaults to <strong>User Entered (Billing)</strong>, which is the planned labor amount at billing value, and the options list displays <strong>User Entered (Billing)</strong> and <strong>Planned Ratio</strong>.</td>
</tr>
<tr>
<td></td>
<td>The Planned Ratio that displays on the Analysis tab is calculated as follows:</td>
</tr>
<tr>
<td></td>
<td><strong>Planned Total Compensation (Compensation + Consultant Fee + Reimbursable Allowance) - Direct and Reimbursable Expenses/Planned Labor Billing</strong></td>
</tr>
<tr>
<td></td>
<td>If using Vision Navigator, all Navigator plans are set to <strong>Planned Ratio</strong>.</td>
</tr>
<tr>
<td><strong>Multiplier</strong></td>
<td>If the <strong>Labor Multiplier Type</strong> is set to <strong>User Entered (Cost)</strong> or <strong>User Entered (Billing)</strong>, you can enter a value in this field to specify the Multiplier.</td>
</tr>
<tr>
<td></td>
<td>If the <strong>Labor Multiplier Type</strong> is set to <strong>Planned Ratio</strong> or <strong>Planned Multiplier</strong>, this field displays the <strong>Planned Ratio</strong> or <strong>Planned Multiplier</strong> as calculated on the Analysis tab.</td>
</tr>
<tr>
<td></td>
<td>This option does not apply to Vision Navigator plans.</td>
</tr>
<tr>
<td><strong>Reimbursable Method</strong></td>
<td>Select the Reimbursable Method that you want to use to display the project revenue from reimbursable expenses and consultants.</td>
</tr>
<tr>
<td></td>
<td>If using Vision Navigator, all Navigator plans are set to <strong>Billing</strong>.</td>
</tr>
<tr>
<td><strong>Percent Complete Formula</strong></td>
<td>Select the percent complete formula to be used as the default for the plans. This option is available only with the proper configuration settings on the Planning tab of Role Security.</td>
</tr>
<tr>
<td></td>
<td>If using Vision Navigator, all Navigator plans are set to <strong>JTD/(JTD + ETC)</strong>.</td>
</tr>
<tr>
<td><strong>Overhead Percent</strong></td>
<td>Enter the overhead percent applied to the project.</td>
</tr>
<tr>
<td>---------------------</td>
<td>--------------------------------------------------</td>
</tr>
</tbody>
</table>
| **Include in Utilization and Project Reports** | Select this option for the **Include in Utilization and Project Reports** option to display on the General tab of Project Planning.  
When users select the **Include in Utilization and Project Reports** option, Vision includes the current plan when running Planning reports and Resource Management searches.  
If using Vision Navigator, all Navigator plans are included in utilization. |
| **Default WBS Mapping Grid** | Use these fields to determine how data summarizes in the default work breakdown structure. The system defaults are:  

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Project</strong></td>
<td>1</td>
</tr>
<tr>
<td><strong>Phase</strong></td>
<td>2</td>
</tr>
<tr>
<td><strong>Task</strong></td>
<td>3</td>
</tr>
<tr>
<td><strong>Labor Code</strong></td>
<td>4</td>
</tr>
</tbody>
</table>
You may specify more than three levels in the WBS. However, you can only map the first three levels to the WBS levels in accounting.  
This option does not apply to Vision Navigator plans. |
| **Default WBS Mapping Drop-down** | The Vision grids contain a drop-down list that displays a combination of the following options:  

- Print grid information  
- Export grid data to Excel  
- Enable Grouping  
Not all options are available on all grids. See each topic for additional information.  
This option does not apply to Vision Navigator plans. |
| **WBS Element** | This column displays the defined WBS elements.  
This option does not apply to Vision Navigator plans. |
| **Plan Level** | Use this column to specify the level of each WBS element. You may specify more than three levels in the WBS. However, you can only map the first three levels to the WBS levels in accounting.  
A WBS element at a higher level summarizes data from the level below it. Thus, using the default project-phase-task levels would mean that task data rolls up to the phase level and that phase data, in turn, summarizes at the project level.  
If any of the levels are set to 0, they will not be available on the Planning Grid Configuration dialog box or on the Default WBS Mapping dialog box. |
### Match JTD

Use the **Match Job to Date** option to specify the level of matching between Job to Date information and each WBS level. When you select a level, all subsequent levels are automatically selected. When you do not select a level, Job to Date is calculated by summing numbers from lower levels.

This option does not apply to Vision Navigator plans.

### Navigator Plans Only

These options are used to create Navigator plans.

### Calendar Scale

Select the default calendar scale for the Navigator plans. The default is Weekly.

### Consultants Plan Level

Use this drop-down list to specify the default WBS level that will be used to plan the consultants for the project:

- **Project** — Select this option to plan consultants at the Project level.
- **Phase** — Select this option to plan consultants at the Phase level, if the project has phases. Otherwise, consultants are planned at the Project level.
- **Lowest Level** — Select this option to plan consultants at the lowest level of the branch.

The options in this list are based on the WBS settings that are defined in Vision Utilities Key Formats. For example, if the WBS 2 length is set to zero, then Project is the only option that displays in the Consultants Plan Level list.

This option is only available when **Consultants** is selected in the Enable Planning Tabs group box.

---

### Resource Planning Module Not in Use

These fields display when the Vision Resource Planning Module is not in use:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Hours Decimal</strong></td>
<td>Use the hours decimal field to specify the number of decimal digits for hours, quantities, and amounts in plans.</td>
</tr>
<tr>
<td><strong>Overhead Percent</strong></td>
<td>Enter the overhead percent applied to the project.</td>
</tr>
<tr>
<td><strong>Use Rate Tables with Effective Dates</strong></td>
<td>Select this option to view rate tables with effective dates. If this option is not selected, Vision only displays rate tables that do not contain effective dates. Effective dates allow you to specify when a change will occur in the cost/pay rate associated with a specified labor rate, labor category, labor code, or labor override table. The date that a change will occur is the &quot;effective date&quot; of the change. This option is only available if the <strong>Enable effective dates for labor billing rates</strong> option in Vision Billing is selected.</td>
</tr>
<tr>
<td><strong>Enable Consultants Planning Tab</strong></td>
<td>Select this option to plan consultants for the company’s projects.</td>
</tr>
<tr>
<td><strong>Default Settings for Creating New Plan</strong></td>
<td>Use these options to define the default settings when creating a new plan.</td>
</tr>
<tr>
<td>Calendar Scale</td>
<td>Select the default calendar scale for the Navigator plans. The default is <strong>Weekly</strong>.</td>
</tr>
<tr>
<td>----------------</td>
<td>----------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| **Consultants Plan Level** | This option is available when the **Enable Consultants Planning Tab** option is selected. Use this drop-down list to specify the default WBS level that will be used to plan the consultants for the project:  
  - **Project** — Select this option to plan consultants at the Project level.  
  - **Phase** — Select this option to plan consultants at the Phase level, if the project has phases. Otherwise, consultants are planned at the Project level.  
  - **Lowest Level** — Select this option to plan consultants at the lowest level of the branch.  
  The options in this list are based on the WBS settings that are defined in Vision Utilities Key Formats. For example, if the WBS 2 length is set to zero, then Project is the only option that displays in the Consultants Plan Level list. |
| **Labor Rates** | These options are available if the **Allow Changes to Rate/Method Tables** option is selected in Vision Security Roles. |
| **Generic Method** | Use this drop-down list to select the default generic resource method that will be used to plan generic resources for the project:  
  - **Labor Category**  
  - **Labor Code** |
| **Labor Cost Rates** |  |
| **Rate Method** | Select one of the following options from the drop-down list:  
  - **From Employee Provisional Rate Table** (Employee Info Center)  
  - **From Labor Rate Table** (Billing Rate Tables)  
  - **From Labor Category Table** (Billing Rate Tables)  
  - **From Labor Code Table** (Billing Rate Tables)  
  If you select a rate method other than Employee Provisional Rate Table, you must also specify a **Rate Table**.  
  Your security role for **Labor Cost Rates/Amounts** must be **Full Access** for you to select **From Employee Provisional Rate Table**. |
| **Rate Table** | If the **Rate Method** field is set to:  
  - **From Employee Provisional Rate**, then no selection is available in this field.  
  - **From Employee Labor Table**, **From Labor Category Table**, or **From Labor Code Table**, then use the Rate table lookup to select the appropriate rate table for your plan's cost rates from pre-defined tables. Only rate tables marked as available for planning are included in the lookup list. |
<table>
<thead>
<tr>
<th><strong>Vision Navigator</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>7.1 Online Help Updates</strong></td>
</tr>
<tr>
<td><strong>This rate table will provide the default cost rate for employees assigned to the Navigator plan.</strong></td>
</tr>
<tr>
<td><strong>Generic Table</strong></td>
</tr>
<tr>
<td><strong>Labor Billing Rates</strong></td>
</tr>
<tr>
<td><strong>Rate Method</strong></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td><strong>Rate Table</strong></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td><strong>Generic Table</strong></td>
</tr>
<tr>
<td><strong>Billing Multiplier</strong></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td><strong>Consultants Rates</strong></td>
</tr>
<tr>
<td><strong>Calculate Consultant Billing Amounts</strong></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>
Rate Method

Select one of the following options:

- **Multiplier Only**: Select this option to multiply all planned cost amounts by the assigned multiplier. Selecting this option disables the Rate Table field.
- **From Expense Account Table**: Select this option to apply the table’s multiplier to the account’s planned cost.
- **From Expense Category Table**: Select this option to apply the table’s multiplier to the expenses category’s planned cost.

Rate Table

If the Rate Method field is set to:

- **Multiplier Only**, then no selection is available in this field.
- **From Account Rate Table** or **From Category Rate Table**, then use the Rate Table lookup to select the appropriate rate table for your plan’s consultant billing rates from pre-defined tables. Only rate tables marked as available for planning are included in this lookup list. This rate table will provide the default billing multiplier for consultants assigned to the Navigator plan.

Multiplier

Enter a numeric multiplier to be used with the Multiplier Only rate method or as the multiplier for accounts not listed in the selected rate tables.

---

**General » System Settings » Miscellaneous Tab**

In the topic that describes the Miscellaneous tab of General » System Settings, a new **Vision Navigator Online Help** group box was added. Use the **Type of Help** option to select hosted or local help. Hosted help is updated automatically to match the version or release updates that apply, but requires the Vision administrator to save their Deltek Customer Care Connect site credentials in Vision. This is a one-time requirement so that end-users can access help system seamlessly. Local help is installed locally as part of the Navigator installation.

**Navigator Online Help**

<table>
<thead>
<tr>
<th>Type of Help</th>
<th>There are two types of help available: Hosted and Local.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Hosted</strong> — Select this option for online help that is updated automatically to match the version or release updates that apply. This help requires the Vision Administrator to save their Deltek Customer Care Connect site credentials in Vision. This is a one-time requirement so that users can access the help seamlessly.</td>
</tr>
<tr>
<td></td>
<td><strong>Local</strong> — Select this option to use online help that is installed locally as part of the Vision Navigator installation.</td>
</tr>
</tbody>
</table>

| Support Username | Enter a username that is used to access the Deltek Customer Care Connect site. This entry allows any Navigator user to access the hosted help for the version of Navigator that your firm is using. |

| Support Password | Enter a password that is used with the username to access the Deltek Customer Care Connect side. This entry allows any Navigator user to access the hosted help for the |
Roles » Navigator Tab

Use the Navigator tab to determine a role’s access rights to the Vision Navigator application.

Before you can assign access rights to any Vision module, you must activate the module in Configuration » Module Activation.

Location

To display the Navigator tab, complete the following steps:

2. On the Roles form, click the Navigator tab.

<table>
<thead>
<tr>
<th>Navigator Access</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Navigator</td>
<td>Select this option for the role to have access to log in to Vision Navigator. When you select this option, all other Navigator options on this form are selected.</td>
</tr>
<tr>
<td>Employee Workspace</td>
<td>Select this option to enable access to the Employee Workspace and automatically enable the Timesheet Tab option.</td>
</tr>
<tr>
<td>Timesheet Tab</td>
<td>Select this option to enable access to the Timesheet features within Navigator. If this option is not selected, users assigned to this role cannot access the Employee Workspace.</td>
</tr>
<tr>
<td>Project Management Workspace</td>
<td>Select this option to enable access to the Project Management Workspace and automatically enable the Dashboard Tab and Planning Tab options.</td>
</tr>
<tr>
<td>Dashboard Tab</td>
<td>Select this option to enable access to the Dashboard features within Navigator. If this option is not selected, the Dashboard tab does not display within Navigator.</td>
</tr>
<tr>
<td>Planning Tab</td>
<td>Select this option to enable access to the Planning Tab within Navigator and automatically enable the Labor and Consultants options. If this option is not selected, the Planning tab does not display within Navigator.</td>
</tr>
<tr>
<td>Labor</td>
<td>This option enables the Labor charts and grids within the Planning tab. If the Planning tab option is selected, this option is automatically selected and cannot be turned off.</td>
</tr>
<tr>
<td>Consultants</td>
<td>Select this option to enable the Consultants charts and grids within the Planning tab. If not selected, the Consultant information does not display.</td>
</tr>
<tr>
<td>Additional Planning Security</td>
<td>These options display when the Resource Planning module is not licensed in Vision.</td>
</tr>
</tbody>
</table>
### Allow Changes to Baseline
Select this option if the role can change the baseline. You can have only one baseline version for the current plan at any given time. If you use the **Save Baseline** option again for the same plan, you will overwrite the previous contents of the baseline.

### Allow Changes to Rate/Method Tables
Select this option if the role can change the rate and method tables.

### Apply Employee Record Level Access
Select this option to restrict employee access by this role to only those employee records defined by employee record level security established on the Record Access tab of Roles.

Do not select this option if users with this security role need full access to all employee records.

### Record Level Access

#### Projects
The following options define the record level access to projects in Navigator. You have the option to use the same access rights that are defined for the Projects application on the Record Access tab of Roles, or you can set up a different strategy for accessing projects within Navigator.

#### Record Access
Select one of the following options to define the user access to perform project functions.

- **Same as Project Record Access** – Select this option to apply the same access rights as those defined in the Access column for the Projects application on the Record Access tab. Selecting this option disables the Access option.
- **Access** – Use this option to define the specific access rights for the projects accessed in Navigator. Access right options are as follows:
  - Read Only
  - Modify Only
  - Add/Modify
  - Full

Read Only access stops the user from choosing a different image and selecting a Kona space for the project while within Navigator. The other access options allow the user to make these changes within Navigator.

#### Record Level View
Select one of the following options to define the projects the role can view in the Navigator Project list.

- **Same as Project Record Level View** – Select this option to apply the same access rights as those defined in the Record Level View column for the Projects application on the Record Access tab. Selecting this option disables the Lookup option.
- **Lookup** – Use the project lookup dialog to build a query that grants or restricts the projects listed in Navigator. After you make your selections, this field displays **In Use**. This field displays **Not In Use** when there are no options selected which means there are no restrictions placed on which projects display in Navigator.

When you clear the Same as Project Record Level View option, the system defaults the Lookup field to match how Record Level View was set for the Projects application on the Record Access tab. You can change the query or remove what defaulted.

#### Record Level Update
Select one of the following options to define the projects the role will be able
### Project Plans
The following options define the record level access to project plans in Navigator. You have the option to use the same access rights that are defined for the Project Planning application on the Record Access tab of Roles, or you can set up a different strategy for accessing project plans within Navigator.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Same as Vision Project Record Level Update</strong></td>
<td>Select this option to apply the same access rights as those defined for the Projects application in the Record Level Update column on the Record Access tab. Selecting this option disables the Record Level Update lookup option.</td>
</tr>
<tr>
<td><strong>Lookup</strong></td>
<td>Use the project lookup dialog to build a query that grants or restricts which projects that the role will be able to update in Navigator. After you make your selections, this field displays In Use. This field displays Not in Use when there are no options selected which means there are no restrictions placed on which projects can be updated in Navigator. When you clear the Same as Vision Project Record Level Update option, the system defaults the Lookup field to match how Record Level Update was set for the Projects application on the Record Access tab. You can change the query or remove what defaulted.</td>
</tr>
</tbody>
</table>

The selections made here and in Record Access determine whether the user can choose a different image and select a Kona space for the project while within Navigator.

### Record Access
Select one of the following options to define the user access to perform plan functions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Same as Project Planning Record Access</strong></td>
<td>Select this option to apply the same access rights as those defined in the Access column for the Project Planning application on the Record Access tab. Selecting this option disables the Access option. This option is not available if you do not have the Resource Planning module. You must use the Access option to determine access rights.</td>
</tr>
</tbody>
</table>
| **Access** | Use this option to define the specific access rights for the project plans accessed in Navigator. Access right options are as follows:  
  - Read Only  
  - Modify Only  
  - Add/Modify  
  - Full |

**Record Level View**
Select one of the following options to define the project plans the role can view in the Navigator Planning tab.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Same as Project Planning Record Level View</strong></td>
<td>Select this option to apply the same access rights as those defined in the Record Level View column for the Project Planning application on the Record Access tab. Selecting this option disables the Lookup option. <strong>This option is not available if you do not have the Resource Planning module. You must use the Lookup option to determine plan view access.</strong></td>
</tr>
<tr>
<td><strong>Lookup</strong></td>
<td>Use the plan lookup dialog to build a query that grants or restricts access to the plans displayed in Navigator. After you make your selections, this field displays In Use. This field displays Not in Use.</td>
</tr>
</tbody>
</table>

**Record Level View** Select one of the following options to define the project plans the role can view in the Navigator Planning tab.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Same as Project Planning Record Level View</strong></td>
<td>Select this option to apply the same access rights as those defined in the Record Level View column for the Project Planning application on the Record Access tab. Selecting this option disables the Lookup option. <strong>This option is not available if you do not have the Resource Planning module. You must use the Lookup option to determine plan view access.</strong></td>
</tr>
<tr>
<td><strong>Lookup</strong></td>
<td>Use the plan lookup dialog to build a query that grants or restricts access to the plans displayed in Navigator. After you make your selections, this field displays In Use. This field displays Not in Use.</td>
</tr>
</tbody>
</table>
**Vision Navigator**

<table>
<thead>
<tr>
<th>Use</th>
<th>when there are no options selected which means there are no restrictions placed on which plans display in Navigator. When you clear the Same as Project Planning Record Level View option, the system defaults the Lookup field to match how Record Level View was set for the Project Planning application on the Record Access tab. You can change the query or remove what defaulted.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Record Level Update</th>
<th>Select one of the following options to define the project plans the role will be able to update in Navigator.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Same as Project Planning Record Level Update</strong></td>
<td>Select this option to apply the same access rights as those defined in the Record Level Update column for the Project Planning application on the Record Access tab. Selecting this option disables the Lookup option. <strong>This option is not available if you do not have the Resource Planning module. You must use the Lookup option to determine plan update access.</strong></td>
</tr>
<tr>
<td><strong>Lookup</strong></td>
<td>Use the plan lookup dialog to build a query that grants or restricts access to the plans that the role will be able to update in Navigator. After you make your selections, this field displays <strong>In Use</strong>. This field displays <strong>Not In Use</strong> when there are no options selected which means there are no restrictions placed on which plans can be updated in Navigator. When you clear the Same as Project Planning Record Level Update option, the system defaults the Lookup field to match how Record Level Update column was set for the Project Planning application on the Record Access tab. You can change the query or remove what defaulted.</td>
</tr>
</tbody>
</table>

### Change a Vision Navigator Plan to a Vision Plan

You can create plans in either Vision or in Vision Navigator. If you create a plan in Navigator, you can only view the plan’s information in Vision. However, you can change a Navigator plan to a Vision plan so that you can edit the plan in Vision. From that point forward, the plan must be maintained in Vision and no updates or modifications can be made to the plan in Navigator.

You must have **Full**, **Add/Modify**, or **Modify Only** access rights to Project Planning on the Navigator tab in Vision Role Security to convert a plan.

To change a plan created in Vision Navigator to a Vision plan, complete the following steps:

1. Open the plan record in Vision. The plan displays with the following text: **Planned in Navigator…**
2. From the Vision menu, click **Actions » Change Navigator Plan to Vision Plan**.
3. Click **Yes** to confirm changing the plan. The Navigator plan is changed to a Vision plan and can only be maintained within Vision.

### Info Center

**Project Info Center » Time & Expense Tab**

The Labor Code Levels field was updated to include information about Navigator plans.
Labor Code Levels

Select one or more labor code levels. The options you select in this field determine what labor code levels employees can use when they charge time to the project. Your options are used by the Timesheet application to validate labor charges against budgeted labor charges.

The budgeted labor code level options available vary based on the number of labor code levels established in Utilities.

This field is enabled in the following situations:

- When you select **Warning** or **Error** in the **Budgeted Validation** field and the **Budget Worksheet** option in the **Budgeted Source** field.
- When you select the **Project Planning** option in the **Budgeted Source** field and the **Labor Codes Only** or **Both** option in the **Budgeted Level** field.

If you use Vision Navigator and the project has an associated Navigator plan, the warning or error is not checked against labor codes. Vision Navigator does not use labor codes as a plan level.

Create a New Project from a Plan

The Create a New Project from a Plan procedure was updated to include that you cannot select a Navigator plan as a template, and you cannot select a project to merge with if it is associated with a Navigator plan.

Planning

**Project Planning Toolbar Topic**

The Change Navigator Plan to Vision Plan option was added to the Actions menu on the Project Planning form. This option is described in the Project Planning Toolbar topic. Access to this toolbar option depends on your security settings in Role Security Configuration.

The Actions menu offers these options:

- **Change Navigator Plan to Vision Plan** — Select this option to start maintaining a Vision Navigator plan in Vision. This option is only available if you are viewing a Vision Navigator plan and have the appropriate access rights.

  **procedure**: Change a Vision Navigator Plan to a Vision Plan

**Resource Management Toolbar Topic**

The Navigator Plan Status option was added to the Resource Utilization and Generic Resource Assignments toolbars. This option is described in the Resource Management Toolbar topic. Access to this toolbar option depends on your security settings in Role Security Configuration.

If you use Vision Navigator, click **Navigator Plan Status** to display the Navigator Plan Status dialog box. This lists the Vision Navigator plans that are currently checked out and/or have unpublished changes.

**Creating Plan Records Overview Topic**

This topic lists the different ways to create a new Vision plan record and how the options are affected by Navigator plans.
Use a Vision Navigator Plan

You can create plans in Vision Navigator. These plans can be viewed as read-only in Vision Project Planning. However, you have the option to change a Vision Navigator plan to a Vision plan, which will allow you to edit the plan within Vision. Going forward, you must maintain the plan in Vision and view the plan as read-only in Vision Navigator.

Create a New Plan from a Project

Step 3 of the procedure in this topic was updated as follows:

3. Click  to Select Specific Project and use the Project Lookup dialog box to select the project to serve as the basis of the new plan. You cannot select a project that is associated with a Vision Navigator plan.

Step 10 of the procedure in this topic was updated as follows:

10. Select option to merge an existing plan with the selected project. This is useful when you have projects that are “in progress” and need to incorporate year-to-date information with an already existing plan structure. This will append the information from an existing plan to the bottom of the new plan being created. Note that you cannot select a Vision Navigator plan for the merge.

Create a New Project from a Plan

Step 2 of the procedure in this topic was updated as follows:

2. Click  to display the Plan Lookup dialog box and select the Vision plan that you want to open. This is the plan that will be used as the template for the new project. You cannot select a Vision Navigator plan as the template, and you cannot select a project to merge with if it is associated with a Navigator plan.

Spread Variance Overview

The following information was added to the overview topic for the Spread Variance feature:

The Spread Variance feature does not apply to Vision Navigator plans.

Utilities

Project Closeout Overview and Close Out Projects Topics

The Project Closeout Overview topic and the Close Out Projects topic were updated to include the following information:

- If you are using Vision Navigator, you cannot close out a project that contains Vision Navigator data. Vision will notify you that the project cannot be selected because it contains Vision Navigator data.

Key Convert Projects, Phase, and Tasks Form of Key Conversions

The Combine field description was updated in the following topics:

- Key Conversion Tasks Fields
- Key Conversion Phase Fields
- Key Conversion Projects Fields
**Combine Existing Projects**
Select this option if you want to consolidate existing projects. You can enter an existing project number in the **New Project** field.

If you are using Vision Navigator and you select a project that has a Navigator plan, Vision displays an error message at run time that states you cannot combine project information because there is an associated plan in Vision Navigator.

**Key Convert Vendor**
The **Combine** field description was updated to include information about combining under the same WBS ID.

**Combine Existing Vendors**
Select this option if you want to consolidate existing vendors. Vision allows you to enter an existing vendor code in the **New Vendor** field.

**Note:** When plan rows have the same vendor and account and are under the same Work Breakdown Structure ID, they are combined. When the vendor is the same, but the account numbers are different, they are not combined.

**Key Convert Account**
The **Combine** field description was updated to include information about combining under the same WBS ID.

**Combine Existing Accounts**
Select this option if you want to consolidate existing accounts. Vision allows you to enter an existing account in the **New Account** field.

**Note:** When plan rows have the same account number and vendor and are under the same Work Breakdown Structure ID, they are combined. When the account is the same, but the vendor is different, they are not combined.

**Key Convert Enable Phase/Task**
The following note was added to this topic:

**Note:** When using Vision Navigator, planned Labor is moved when your run key conversion to enable the first phase or a phase’s first task. Planned Consultant information is only moved down if the Consultants Plan Level option, in Navigator Plan Settings, is set to use the lower level. For example, if you have planned labor and consultants at the Project level, and then enable phases, all planned labor is moved down to the new phase. Planned consultants are moved down if the Consultants Plan Level is set to Phase or Lowest Level.

**Key Convert Disable Phase/Task**
The following note was added to this topic:

**Note:** When using Vision Navigator, planned Labor is moved up when you run a key conversion to disable a phase or task. Planned Consultant information is only moved up if it is assigned at the level being disabled. Planned labor rows for the same resource are combined when moved up under the same Work Breakdown Structure ID. Planned consultant rows are combined when moved up under the same Work Breakdown Structure ID if the account and vendor are the same.
For example, if you have planned labor and consultants at the phase level, and then disable phases, all planned labor and consultants are moved up to the Project level.

**Search and Replace**

The following note was added to the Select Records field on this topic:

*Note: When a Search and Replace is performed on the Project Planning application area, Vision Navigator plans are excluded from the Plan Lookup.*
Weblink Utility

Database Grid List Tab of Weblink Utility

Use the Database Grid List tab to view all of the databases that are currently set up within the Weblink utility and to run scripts that exist on the Vision application server against any of those databases.

This tab contains the following grids:

- **Grid View** — This grid provides a quick glance at all the databases that are currently set up within the Weblink utility.
- **Scripts** — This grid allows you to run scripts that exist on the Vision application server against any database in the Grid View grid. Scripts must already exist in the /Databases/Scripts folder on the application server to run them from the Scripts grid.

**IMPORTANT:** Run scripts only on the advice of a Deltek consultant, who can verify that the scripts are for the current version of Vision.

Tab Toolbar

<table>
<thead>
<tr>
<th>Save</th>
<th>Select this option to save your changes.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Password</td>
<td>Select this option to change your Weblink password.</td>
</tr>
<tr>
<td>Delete Old Databases</td>
<td>This option is typically used for internal Deltek purposes. Click this button to remove all databases whose version is different from the database version used with Deltek Vision (for example, if you are running multiple databases at one site, perhaps in a test scenario). Weblink also removes all databases to which a connection cannot be made. If there are any pending Weblink changes, a message displays asking if these changes should be saved before removing the old database. After the old and unreachable databases are removed, Weblink is refreshed with the new data.</td>
</tr>
<tr>
<td>Help</td>
<td>Select this option to access online Help related to the Weblink utility.</td>
</tr>
</tbody>
</table>

Grid View Grid Toolbar

| Select All | Click this icon to select all the databases in Weblink at once, before you run scripts. |
| Move Up and Move Down | Use these icons to move a database up or down in the grid. First, select the Select check box for a database that you want to move, and then click Move Up or Move Down. The order of the databases in this grid can control the order of the databases in the drop-down list in Deltek Vision Login dialog box, but only if you complete the additional steps to modify the web.config file. For instructions on how to modify this file, see the help topic titled “Modify the Web.config File to Add the Vision Database Sort Order.” If you do not modify the web.config file, the order of the databases in the drop-down list in the Deltek Vision Login dialog box is alphabetical by database description. |
| Delete | To remove a database profile from the Weblink utility, select the Select check box for a database that you want to delete, and then click Delete. |
## Grid View Grid Contents

<table>
<thead>
<tr>
<th>Select</th>
<th>Select this check box for one or more databases for which you want to run a particular script, as specified in the <strong>Scripts</strong> grid. Then click <strong>Run Scripts</strong> on the <strong>Scripts</strong> grid.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>This field displays the database description, as entered on the Weblink General tab.</td>
</tr>
<tr>
<td>Disable Process Server</td>
<td>Select this option if you do not want to use this database for scheduled jobs. If selected, this database is not polled for jobs.</td>
</tr>
<tr>
<td>Disable Sync Server</td>
<td>Select this option if you do not want to use this database for synchronization.</td>
</tr>
<tr>
<td>Report Server URL</td>
<td>This field displays the report server URL for the database. You can change this information.</td>
</tr>
<tr>
<td>Windows Username</td>
<td>This field displays the Windows username for the database. You can change this information.</td>
</tr>
<tr>
<td>Windows Password</td>
<td>This field displays the Windows password for the database. You can change this information.</td>
</tr>
<tr>
<td>Server Name</td>
<td>This field displays the report server for the database. You can change this information.</td>
</tr>
<tr>
<td>Database Name</td>
<td>This field displays the database name for the database. You can change this information.</td>
</tr>
<tr>
<td>Windows Authentication</td>
<td>This field is selected if Windows authentication applies to the database. You can change this information.</td>
</tr>
<tr>
<td>Database Username</td>
<td>This field displays the database username for the database. You can change this information.</td>
</tr>
<tr>
<td>Database Password</td>
<td>This field displays the database password for the database. You can change this information.</td>
</tr>
<tr>
<td>Root Folder</td>
<td>This field displays the root folder for the database. You can change this information.</td>
</tr>
</tbody>
</table>

### Scripts Grid Toolbar

<table>
<thead>
<tr>
<th>Run Scripts</th>
<th>Click to run the scripts you have added in the grid against the database or databases you have selected in the Grid View grid. You select databases by checking the Select field for a database profile in the Grid View grid.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insert</td>
<td>Click <strong>Insert</strong> to add a script to the grid. You have the following options:</td>
</tr>
<tr>
<td></td>
<td>- <strong>New Script</strong> — Select to add a blank line to the grid. Then enter the name of the script in the <strong>File Name</strong> field. The script must already exist on the Vision application server.</td>
</tr>
<tr>
<td></td>
<td>- Select any one of the following scripts that exist by default on the Vision application server in the \Databases\Scripts folder:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Functions</strong> — fn_*.sql</td>
</tr>
<tr>
<td></td>
<td>- <strong>Stored Procedures</strong> — sp_*.sql</td>
</tr>
</tbody>
</table>
**Modify the Web.config File to Add the Vision Database Sort Order**

Modify the web.config file if you want to change the order of the Vision databases that display in the drop-down list in Deltek Vision Login dialog box.

**Prerequisites:** In the Grid View grid on the Database List View tab in the Weblink utility, use the Move Up and Move Down toolbar options to order the Vision databases as you want them to appear in the drop-down list in the Deltek Vision Login dialog box.

To modify the web.config file, complete the following steps:

1. Backup the existing web.config file.
   The default location is C:\Program Files\Deltek\Vision\Web\.

2. Open Notepad using the Run as administrator option: Right-click the Notepad shortcut and from the shortcut menu select Run as administrator.

3. In Notepad, click File » Open.

4. In the Open dialog box, browse to the web.config file, and click Open.
   The default location is C:\Program Files\Deltek\Vision\Web\.

5. In the <appSettings> section (that appears near the beginning of the file), insert the following line as the last entry for the group of <Add Key=....... /> line entries:
   <add key="UseWeblinkSortOrder" value="Y" />

6. Click File » Save.

7. On your desktop, click Windows Start » All Programs » Accessories, and right-click the Command Prompt submenu. From the shortcut menu, select Run as administrator.
8. In the Administrator: Command Prompt dialog box, enter the following command to reset IIS:
   
   ```
iisreset /restart
   ```
   
   This reloads the web.config file that now contains the Vision database sort order.

**General Tab of Weblink Utility**

Use the General tab to specify the database connection information, such as the server name, user name, and password. You can also disable the process server or the server-to-server synchronization server on a given database from this tab.

**Contents**

<table>
<thead>
<tr>
<th>Current Database</th>
<th>Select the database that you want to configure. Use the menu to add or remove databases from this list.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• <strong>New</strong> — Click <strong>New</strong> to add a database to the list of databases available for configuration.</td>
</tr>
<tr>
<td></td>
<td>• <strong>New &gt;&gt; Copy Current</strong> — Select a database from the list and click <strong>Copy Current</strong> to copy all information except the name of the database into a new record. After copying an existing database record, enter a new database name, and edit other configuration information as needed. Click <strong>Save</strong> when done.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Delete</strong> — Select a database and click <strong>Delete</strong> to delete the database information from the Weblink utility.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SQL Server</th>
<th>Enter the name of the database server, as entered in Microsoft SQL Server.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database Name</td>
<td>Enter the name of the Vision database to which you are connecting.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter the description for the preceding database, as it will appear on the Vision logon form.</td>
</tr>
</tbody>
</table>

**Windows Authentication**

Specify a Windows User account to use to connect to your SQL Server database. This user account must have been created as a valid user account in SQL Server and must have the appropriate rights to the Vision database.

This account also needs to be configured as the Identity of the IIS Application Pool. The default Application Pool is DeltekVisionAppPool and the default identity is a local administrator account, `\DeltekVision` which is created by the Vision installation.

If this box is selected, then the **SQL Username** and **SQL Password** fields are disabled. (The Windows username and password will be used instead.)

If this box is not selected, then you must specify a database username and password to use.

<table>
<thead>
<tr>
<th>SQL Username</th>
<th>Enter the username of the Microsoft SQL Server administrative who will manage this database. By default, this is DeltekVision, but it can be any SQL username that you want to specify. Deltek does not recommend using the sa account.</th>
</tr>
</thead>
<tbody>
<tr>
<td>SQL Password</td>
<td>Enter the corresponding password for this user account.</td>
</tr>
<tr>
<td>Disable Process Server</td>
<td>Select this option if you do not want to use this database for scheduled jobs. If selected, this database is not polled for jobs. If you change this option (select or clear it), you must restart your process servers for the change to take effect.</td>
</tr>
</tbody>
</table>
Select this option if you do not want to use the current database for server to server synchronization. Otherwise, remove the selection for this option.

Enter a specific virtual directory (for example, VisionTest) for this database to appear as an available database only for the specified virtual directory. If you leave this field blank, the database will be accessible by all virtual directories on a given Web server.

If you are setting up a hosted instance of Vision, select this check box. Otherwise, leave this check box cleared.

This option enables Deltek or other vendors who offer hosted instances of Vision to hide or disable system-level functionality that is not appropriate in a "software as a service" environment.

When you select this check box, the following are no longer available to users of the hosted instance of Vision:

- **Location of Reports on Application Server** field on the Load Reports tab of the Report Server form (Utilities » Report Administration)
- Process Server Management form (Utilities » Process Server » Server Management)
- Backup Database utility (Utilities » Backup Database)
- Email Server, Port, Username, Password, and Application URL fields on the Email tab of the General System Settings form (Configuration » General » System Settings)
- Servers tab of the General System Settings form (Configuration » General » System Settings)
- Integrated Enabled, Domain, and Report Printer on the Users tab of the Users and Passwords form (Configuration » Security » Users and Passwords)
- Option to select a printer in Default Printer on the Reporting tab of the User Options dialog box (Options on the Vision main toolbar)

When you select this check box, the **Number of days to retain audit history** field in the Info Center Audit Trail section on the Audit Trail tab in Configuration » General » System Settings, allows a value of only 30 or less.

If you need to restore this functionality, clear the check box.

Select this option to save your changes.

Select this option to create a new database entry.

Select this option to delete the current database entry.

Click **Test** to test the connection for the session state storage database.

If the database specified in the **Database Setup** fields does not contain the necessary tables to store the session state, when you test the database connection, the Weblink utility asks you if it should create the necessary tables. Click **Yes** at this prompt to create the tables and configure the specified database for session state.
Weblink Utility

7.1 Online Help Updates

<table>
<thead>
<tr>
<th>Change Password</th>
<th>Select this option to change your Weblink password.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete Old Databases</td>
<td>This option is typically used for internal Deltek purposes. Click this button to remove all databases whose version is different from the database version used with Deltek Vision (for example, if you are running multiple databases at one site, perhaps in a test scenario). Weblink also removes all databases to which a connection cannot be made. If there are any pending Weblink changes, a message displays asking if these changes should be saved before removing the old database. After the old and unreachable databases are removed, Weblink is refreshed with the new data.</td>
</tr>
<tr>
<td>Help</td>
<td>Select this option to access online Help related to the Weblink utility.</td>
</tr>
</tbody>
</table>

Document Management Tab of Weblink Utility

Use the Document Management tab of the Weblink utility to specify the username and password that Vision uses to access SharePoint.

Location

To display the Document Management tab of the Weblink utility, complete the following steps:

1. Access the Vision Web/Application server using the Weblink utility URL (http://[Vision Web/Application Server Name]/[name of virtual directory for Vision]/weblink.htm).
2. Click the Document Management tab.

Contents

<table>
<thead>
<tr>
<th>SharePoint Username</th>
<th>If you use the Document Management module, enter a SharePoint administrator username. Vision will use this username to impersonate that user in order to access SharePoint.</th>
</tr>
</thead>
<tbody>
<tr>
<td>SharePoint Password</td>
<td>Enter the password for the SharePoint administrator username.</td>
</tr>
</tbody>
</table>


Deltek is the leading global provider of enterprise software and information solutions for professional services firms, government contractors, and government agencies. For decades, we have delivered actionable insight that empowers our customers to unlock their business potential. Over 14,000 organizations and 1.8 million users in approximately 80 countries around the world rely on Deltek to research and identify opportunities, win new business, optimize resource, streamline operations, and deliver more profitable projects. Deltek – Know more. Do more.®

deltek.com